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Audience

Preface

Oracle Business Intelligence Enterprise Edition (Oracle Business Intelligence) is a
comprehensive set of enterprise business intelligence tools and infrastructure,
including a scalable and efficient query and analysis server, an ad-hoc query and
analysis tool, interactive dashboards, proactive intelligence and alerts, real-time
predictive intelligence, and an enterprise reporting engine. Oracle Business
Intelligence is designed to bring greater business visibility and insight to a wide
variety of users.

The components of Oracle Business Intelligence share a common service-oriented
architecture, data access services, analytic and calculation infrastructure, metadata
management services, semantic business model, security model and user preferences,
and administration tools. Oracle Business Intelligence provides scalability and
performance with data-source specific optimized request generation, optimized data
access, advanced calculation, intelligent caching services, and clustering.

Oracle Fusion Middleware Metadata Repository Builder’s Guide for Oracle Business
Intelligence Enterprise Edition is part of the documentation set for Oracle Business
Intelligence. This guide contains information about building an Oracle Business
Intelligence metadata repository and includes topics on setting up and connecting to
data sources, building the Physical layer, Business Model and Mapping layer, and
Presentation layer, how to use the multiuser development environment, and a Logical
SQL reference.

This document is intended for anyone who intends to design and build a metadata
repository using the Oracle Business Intelligence Administration Tool, such as a
Business Intelligence strategist, metadata provider, or ETL developer.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http://www.oracle.com/accessibility/.
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Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/support/contact .html or visit
http://www.oracle.com/accessibility/support.html if you are hearing
impaired.

Related Documents

For more information, see the following documents in the Oracle Business Intelligence
Enterprise Edition 11g Release 1 (11.1.1) documentation set:

»  Oracle Fusion Middleware Release Notes for your platform
»  Oracle Fusion Middleware Installation Guide for Oracle Business Intelligence
»  Oracle Fusion Middleware Upgrade Guide for Oracle Business Intelligence

»  Oracle Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition

»  Oracle Fusion Middleware Enterprise Deployment Guide for Oracle Business Intelligence

»  Oracle Fusion Middleware Security Guide for Oracle Business Intelligence Enterprise
Edition

»  Oracle Fusion Middleware Integrator’s Guide for Oracle Business Intelligence Enterprise
Edition

»  Oracle Fusion Middleware User’s Guide for Oracle Business Intelligence Enterprise
Edition

»  Oracle Fusion Middleware Developer’s Guide for Oracle Business Intelligence Enterprise
Edition

Conventions

XX

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.




New Features for Oracle Bl Metadata

Repository Builders

This section describes changes to metadata repository features for Oracle Business
Intelligence Enterprise Edition 11g Release 1 (11.1.1). If you are upgrading to Oracle
Business Intelligence from a previous release, read the following information carefully,
because there are significant differences in features, tools, and procedures.

This preface contains the following topics:

New Features

New Features

Upgrade Considerations

New metadata repository features in Oracle Business Intelligence include:

New SampleApp.rpd Demonstration Repository

Hierarchy Objects in the Presentation Layer

Support for Unbalanced (Ragged) and Skip-Level Hierarchies

Support for Parent-Child Hierarchies

Creating Subject Areas for Logical Stars and Snowflakes
Multicurrency Support

Generating and Applying XML Patch Files

Enhancements for Multiuser Development and Repository Lifecycle Management
Metadata Repository File Encryption

Metadata Repository File Compression

Embedded Database Functions

SQL Functions for Time Series Calculations and Level-Based Measures
Support for SELECT_PHYSICAL

Support for Calculated Members

Access to Essbase Data Sources

Access to Hyperion Financial Management Data Sources

Access to ADF Business Component Data Sources
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= Access to Oracle RPAS Data Store Through ODBC

= Ability to Connect to Oracle Database Through OCI

= Support for Dragging and Dropping XMLA Objects

= Support for Using a Standby Database with Oracle Business Intelligence
= Aggregate Persistence Auto-Indexing

= Pruning Utility to Delete Unwanted Repository Objects

= Ability to Defer Execution of Session Variable Initialization Blocks

= Improved Usability in the Administration Tool

New SampleApp.rpd Demonstration Repository

A new demonstration repository called SampleApp.rpd is available for this release of
Oracle Business Intelligence. This repository provides best practice information about
modeling many different types of objects.

A basic version of SampleApp.rpd, called SampleAppLite.rpd, is automatically
installed as the default repository when you choose the Simple Install option. The full
version of SampleApp.rpd, which contains many additional examples and features, is
available on the Oracle Technology Network. See "About the SampleApp.rpd
Demonstration Repository” for more information.

Hierarchy Objects in the Presentation Layer

You can now define presentation hierarchies and presentation levels in the
Presentation layer. These objects provide an explicit way to expose the
multidimensional model in Oracle BI Answers and enables users to create
hierarchy-based queries. Presentation hierarchies expose analytic functionality such as
member selection, custom member groups, and asymmetric queries. See "Working
with Presentation Hierarchies and Levels" for more information.

Support for Unbalanced (Ragged) and Skip-Level Hierarchies

Oracle Business Intelligence now supports unbalanced and skip-level hierarchies. An
unbalanced (or ragged) hierarchy is a hierarchy where the leaves (members with no
children) do not necessarily have the same depth. A skip-level hierarchy is a hierarchy
where there are members that do not have a value for a particular ancestor level. See
"About Level-Based Hierarchies" for more information.

Support for Parent-Child Hierarchies

Oracle Business Intelligence now supports parent-child hierarchies. Parent-child
hierarchies (also called value hierarchies) contain members that all have the same type.
For example, an organizational chart has a distinct parent-child hierarchy, but all
members are employees. See "Creating and Managing Dimensions with Parent-Child
Hierarchies" for more information.

Creating Subject Areas for Logical Stars and Snowflakes

You can automatically create one subject area (formerly called presentation catalog) for
each logical star or logical snowflake in your business model. See "Automatically
Creating Subject Areas Based on Logical Stars and Snowflakes" for more information.

Multicurrency Support

You can configure logical columns so that Oracle Business Intelligence users can select
the currency in which they prefer to view currency columns in analyses and



dashboards. See "Configuring Logical Columns for Multicurrency Support" for more
information.

Generating and Applying XML Patch Files

You can now generate an XML patch file that contains only the changes made to a
repository. This patch can be then applied to the old (original) version of the repository
to create the new version. This is very useful for development-to-production scenarios,
and can also be used for Oracle BI Applications customers to upgrade their repository.
See "Performing Patch Merges" for more information.

You can also use the Oracle BI Server XML utilities to create a generic, XML-based
representation of the Oracle Business Intelligence repository metadata, on any
supported Oracle Bl Server operating system. See "About the Oracle BI Server XML
API" in Oracle Fusion Middleware Integrator’s Guide for Oracle Business Intelligence
Enterprise Edition for more information.

Enhancements for Multiuser Development and Repository Lifecycle Management

The following list summarizes improvements and new features for multiuser
development and repository lifecycle management:

= MUD projects now explicitly include subject areas (formerly called presentation
catalogs). Object security permissions no longer affect which presentation objects
are included in a checked-out repository.

= You can select options in the Merge Repository Wizard or set options in the MUD
options file to automatically check consistency and equalize during merges.

= Improved Merge Repository Wizard integration enables a single step input for
repositories. You no longer have to select repositories one by one and wait for
them to load.

= You can now extract objects on all platforms using the command-line utility
extractprojects.

= The two-way merge feature (full merge without a common parent) enables easier
consolidation of separate repositories.

Metadata Repository File Encryption

Repositories now have a repository password that encrypts the repository contents
using a strong encryption algorithm. This feature ensures that repository metadata is
secure, including data source credentials in connection pool objects. See "Changing the
Repository Password" for more information.

Metadata Repository File Compression

To reduce storage needs, repositories are now stored in a compressed format. Because
of this, you may notice that the size of an RPD file opened and saved in this release is
significantly smaller than the size of RPD files from previous releases. See "About the
Multiuser Development Environment" for more information about using and storing
multiple repositories.

Embedded Database Functions

Users and administrators can create requests by directly calling database functions
from either Oracle BI Answers, or by using a Logical column (in the Logical Table
source) within the metadata repository. These functions provide the ability to access
custom written functions or procedures on the underlying database. Supported
functions include EVALUATE, EVALUATE_AGGR, and EVALUATE_PREDICATE. See
"Database Functions" for more information.
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In addition, Evaluate functions can be leveraged significantly for Essbase users. See
"Examples Using EVALUATE_AGGREGATE and EVALUATE to Leverage Unique
Essbase Functions" for more information.

SQL Functions for Time Series Calculations and Level-Based Measures

The following new and revised SQL functions enable users to create time series
calculations and level-based measures:

= PERIODROLLING is a new function that computes the aggregate of a measure over
the period starting x units of time and ending y units of time from the current
time.

= AGGREGATE AT is a new function that aggregates columns based on the level or
levels specified.

= AGO is a time series aggregation function that calculates the aggregated value from
the current time back to a specified time period. In this release, the time_level
argument is optional, and there are additional syntax changes. This function was
called PERIODAGO in a previous release.

= TODATE is a time series aggregation function that aggregates a measure attribute
from the beginning of a specified time period to the currently displayed time. The
syntax for this function has changed in this release. This function was called
PERIODTODATE in a previous release.

See "Aggregate Functions" for more information about these functions. See also
"Modeling Time Series Data" for information about using the time series functions
AGO, TODATE, and PERIODROLLING.

Support for SELECT_PHYSICAL

SELECT_PHYSICAL statements provide the functionality to directly query objects in
the Physical layer of the metadata repository, and to nest such a statement within a
query against the Business Model and Mapping layer or the Presentation layer. See
"Syntax and Usage Notes for SELECT_PHYSICAL" for more information.

Support for Calculated Members

Calculated members are user-defined dimension members whose measure values are
calculated at run time. You can define a calculated member within a dimension
through a formula that references other members of the same dimension. See
"Calculated Members" for more information.

Access to Essbase Data Sources

Oracle Business Intelligence now supports Essbase as a data source. See "Working with
Essbase Data Sources" for more information.

Access to Hyperion Financial Management Data Sources

Oracle Business Intelligence now supports Hyperion Financial Management as a data
source. See "Working with Hyperion Financial Management Data Sources" for more
information.

Access to ADF Business Component Data Sources

Oracle Business Intelligence now supports using ADF Business Components as data
sources. With this feature, users can integrate operational reporting with any
application that is built on top of the ADF Framework. See "Working with ADF
Business Component Data Sources" for more information.



Access to Oracle RPAS Data Store Through ODBC

The Oracle BI Server can now access Oracle Retail Predictive Application Server
(RPAS) data stores using the RPAS ODBC driver. See "Setting Up Oracle RPAS Data
Sources" for more information.

Ability to Connect to Oracle Database Through OCI

Administrators can now use the native Oracle Call Interface (OCI) when importing
physical objects from an Oracle Database. Because using OCl is faster than using an
ODBC connection, administrators should always use OCI when importing from or
setting up connections to an Oracle Database. See "Setting Up Oracle Database Data
Sources" for more information.

Support for Dragging and Dropping XMLA Objects

You can now drag and drop XMLA objects (whole XMLA database or cube tables, at
the same time or one by one) into the logical layer to automatically create a consistent
business model. See "Creating the Business Model and Mapping Layer" and
"Automatically Creating Business Model Objects for Multidimensional Data Sources"
for more information.

Support for Using a Standby Database with Oracle Business Intelligence

You can now use a standby database with Oracle Business Intelligence. A standby
database is used mainly for its high availability and failover functions as a backup for
the primary database. See "Using a Standby Database with Oracle Business
Intelligence" for more information.

Aggregate Persistence Auto-Indexing

For greater performance, Oracle Business Intelligence now creates indexes and
statistics on relational tables when aggregates are persisted. See Chapter 12 for more
information about aggregate persistence.

Pruning Utility to Delete Unwanted Repository Objects

Oracle Business Intelligence now includes a pruning utility to remove unwanted
objects from your repository. This utility is especially useful for Oracle BI Applications
customers who only need to use a subset of the objects included in the shipped Oracle
BI Applications repository. See Appendix E, "Deleting Unwanted Objects from the
Repository” for more information.

Ability to Defer Execution of Session Variable Initialization Blocks

To improve session logon time and save resources, administrators can defer execution
of selected session variable initialization blocks until the associated session variables
are actually used within the session. See "Creating Initialization Blocks" for more
information.

Improved Usability in the Administration Tool

Many Administration Tool screens, wizards, and other parts of the user interface were
updated and streamlined for this release of Oracle Business Intelligence. Updated
wizards include the Create New Repository Wizard, Aggregate Persistence Wizard,
and Merge Wizard. Expression Builder and the Consistency Checker also contain
usability enhancements in this release.

Additional changes include updated and improved icons, a simpler process flow to
create joins, improvements to the Query Repository feature, and a simplified way to
add some repository objects. Also, shortcuts were added to enable keyboard access to
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menu options, dialog navigation, and navigation in the Physical and Business Model
Diagrams.

Upgrade Considerations

Be aware of the following upgrade considerations:

XXVi

You must upgrade your repository files from previous releases before they will
work in this release of Oracle Business Intelligence. See Oracle Fusion Middleware
Upgrade Guide for Oracle Business Intelligence for full information about upgrading a
repository from a previous release.

Many configuration settings that affect repository development, including the
default published repository, are now centrally managed in Fusion Middleware
Control. You can no longer manually change these configuration settings in
NQSConfig.INI. See Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition for more information.

Be aware of the following security-related changes:

— Repositories now have repository-specific passwords that are used to encrypt
the repository contents. The repository password is stored in an external
credential store when you publish a repository in Fusion Middleware Control,
so that the Oracle BI Server can retrieve the password to load the repository.
See "Changing the Repository Password" for more information.

Note that a blank repository password is not allowed.

— Groups no longer exist in the repository as objects. Instead, you implement
data access security based on the application roles to which a user belongs.

Application roles are managed in an external policy store. Application role
objects exist in the repository, but these objects are pointers (references) to the
externally managed roles.

— Users are managed in an external authentication provider and are no longer
managed in the repository. User objects exist in the repository, but these
objects are pointers (references) to the externally managed users.

See Oracle Fusion Middleware Security Guide for Oracle Business Intelligence Enterprise
Edition for information about these and other security changes. See also

Chapter 13, "Applying Data Access Security to Repository Objects" for additional
information.

The connection parameters in the default ODBC DSN for the Oracle BI Server are
now centrally managed by Fusion Middleware Control and cannot be manually
changed.

In addition, Oracle Business Intelligence is now deployed in a clustered
configuration by default. Because of this, the default ODBC DSN for the Oracle BI
Server points to the Cluster Controller by default, rather than to the Oracle BI
Server.

See "Integrating Other Clients with Oracle Business Intelligence" in Oracle Fusion
Middleware Integrator’s Guide for Oracle Business Intelligence Enterprise Edition for
more information about ODBC DSNss for the Oracle BI Server.

This release of Oracle Business Intelligence has additional dependencies for a
running system, including:



— The relational database specified upon installation must be running. This
database must contain required Oracle Business Intelligence schemas loaded
using the Repository Creation Utility (RCU).

- Oracle WebLogic Server must be running.

You can no longer restart the Oracle BI Server using the Administration Tool in
online mode. Instead, you can restart the Oracle Bl Server and other system
processes using Fusion Middleware Control and the Oracle WebLogic Server
Administration Console.

You can also use the BI Systems Management API to programmatically start and
stop Oracle Business Intelligence. This feature is especially helpful for automating
rolling restart of Oracle BI Servers in a cluster, to enable repository upgrade with
zero end-user downtime.

For more information, see "Starting and Stopping Oracle Business Intelligence"
and "Starting and Stopping Oracle Business Intelligence Using the BI Systems
Management API" in Oracle Fusion Middleware System Administrator's Guide for
Oracle Business Intelligence Enterprise Edition.

Before you can run any of the Oracle BI Server command-line utilities, you must
now run bi-init.cmd (or bi-init.sh on UNIX) to launch a command prompt or shell
window that is initialized to your Oracle instance. See "Running bi-init to Launch
a Shell Window Initialized to Your Oracle Instance" for more information.

If you want to use a net service name in a connection pool for an Oracle Database
data source, you must set up a tnsnames.ora file in the following location within
the Oracle Business Intelligence environment, so that the Oracle BI Server can
locate the entry:

ORACLE_HOME /network/admin
You might need to create the admin directory, if it does not exist.

You can no longer open the Administration Tool by double-clicking a repository
file. The resulting Administration Tool window is not initialized to your Oracle
instance, and errors will result later in your session. Instead, always use the Start
menu to open the Administration Tool, or launch the Administration Tool from the
command line using bi-init.cmd. See "Opening the Administration Tool" for more
information.

Presentation catalogs in the Presentation layer are now called subject areas.

Static repository variables must now have default initializers that are constant
values. See "About Repository Variables" for more information.

If you configured write-back capability in a previous release of Oracle Business
Intelligence, you must now explicitly select the Writeable option for each logical
column for which you want to enable write-back. See "Enabling Write Back On
Columns" for more information.

The Consistency Check Manager now enforces additional validation rules to help
ensure that your repository is consistent, including the following:

- Repository objects can no longer have leading or trailing spaces in their
names. Leading and trailing spaces in object names can cause query and
reporting issues.

- Logical columns that are mapped to logical table sources that are disabled are
reported as consistency errors, because the logical table source mappings are
invalid and would cause queries to fail. These consistency errors appear
similar to the following:
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[38012] Logical column DIM_PO_Offer_Start_Date.YEAR_QUARTER_NBR does not
have a physical data type mapping, nor is it a derived column.

[38001] Logical column DIM_PO_Offer_Start_Date.YEAR_QUARTER_NBR has no
physical data source mapping.

See "About Converting Older Projects During Repository Upgrade" for
information about how projects are upgraded when you upgrade a repository

from Oracle Business Intelligence versions before 10.1.3.2.
For more information about upgrading to Oracle Business Intelligence 11g, see Oracle
Fusion Middleware Upgrade Guide for Oracle Business Intelligence.
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Introduction to Building Your Metadata
Repository

This chapter explains how to plan and design your metadata repository, including
how to plan your business model, how to work with the physical content for your
business model, and general repository design guidelines.

To effectively plan and build your metadata repository, you need to have experience
with SQL queries and be familiar with reporting and analysis. You should also have
experience with industry-standard data warehouse modeling practices, and be
familiar with general relational entity-relationship modeling.

This chapter contains the following topics:

= About Oracle Bl Server and Oracle Bl Repository Architecture
= Planning Your Business Model

s Identifying the Data Source Content for the Physical Layer

s Guidelines for Designing a Repository

»  Topics of Interest in Other Guides

= System Requirements and Certification

About Oracle Bl Server and Oracle Bl Repository Architecture

The architecture of the Oracle BI Server and the Oracle Bl repository provides a layer
of abstraction that lets users send simple Logical SQL queries against complex
federated data sources.

This section contains the following topics:
= About Oracle Bl Server Architecture

= About Layers in the Oracle Bl Repository

About Oracle Bl Server Architecture

The Oracle BI Server is an Oracle Business Intelligence component that processes user
requests and queries underlying data sources. The Oracle Bl Server maintains the
logical data model and provides client access to this model through ODBC.

The Oracle BI Server uses the metadata in the Oracle Bl repository to perform the
following two tasks:

= Interpret Logical SQL queries and write corresponding physical queries against
the appropriate data sources

Introduction to Building Your Metadata Repository 1-1



About Oracle Bl Server and Oracle Bl Repository Architecture

s  Transform and combine the physical result sets and perform final calculations

The Oracle BI Server connects to the underlying data sources through either ODBC or
through native APIs, such as OCI for Oracle Database.

The Administration Tool client is a Windows application that you can use to create and
edit your Oracle Bl repository. The Administration Tool can connect directly to the
repository in offline mode, or it can connect to the repository through the Oracle BI
Server. Some options are only available in online mode. See "Using Online and Offline
Repository Modes" for more information.

Figure 1-1 shows how the Oracle BI Server interacts with query clients, data sources,
the Oracle BI repository, and the Administration Tool.

Figure 1-1 Oracle Bl Server Architecture

Query Clients
Presentation Services Administration
Bl Publisher Tool
- ¥
Smart View ... Online | Offline
lTODBC Mode ! Mode
v
Oracle Bl Server Repository

LT ODBC or Native

Data Sources

Relational, Multidimensional, Files, ADF ...
T .

Example 1-1 shows how the Oracle BI Server interprets and converts Logical SQL
queries.

Example 1-1 Logical Requests Are Transformed Into Complex Physical Queries
Assume the Oracle BI Server receives the following simple client request:

SELECT

"DO Time"."T02 Per Name Month" saw_0,

"D4 Product"."P0l Product" saw_1,

"F2 Units"."2-01 Billed Qty (Sum All)" saw_2
FROM "Sample Sales"

ORDER BY saw_0, saw_1

The Oracle BI Server can then convert the Logical SQL query into a sophisticated
physical query, as follows:

WITH SAWITHO AS (
select T986.Per_Name_Month as cl, T879.Prod_Dsc as c2,
sum(T835.Units) as c3, T879.Prod_Key as c4
from
Product T879 /* AQ05 Product */ ,
Time_Mth T986 /* A08 Time Mth */ ,
FactsRev T835 /* All Revenue (Billed Time Join) */
where ( T835.Prod_Key = T879.Prod_Key and T835.Bill_Mth = T986.Row_Wid)

1-2 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition
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group by T879.Prod_Dsc, T879.Prod_Key, T986.Per_Name_Month

)
select SAWITHO.cl as cl, SAWITHO.c2 as c2, SAWITHO.c3 as c3

from SAWITHO
order by cl, c2

About Layers in the Oracle Bl Repository
An Oracle Bl repository has the following layers:

s Physical layer. This layer defines the objects and relationships that the Oracle BI
Server needs to write native queries against each physical data source. You create
this layer by importing tables, cubes, and flat files from your data sources.

Separating the logical behavior of the application from the physical model
provides the ability to federate multiple physical sources to the same logical
object, enabling aggregate navigation and partitioning, as well as dimension
conformance and isolation from changes in the physical sources. This separation
also enables the creation of portable BI Applications.

= Business Model and Mapping layer. This layer defines the business or logical
model of the data and specifies the mapping between the business model and the
physical schemas. This layer determines the analytic behavior seen by users, and
defines the superset of objects and relationships available to users. It also hides the
complexity of the source data models.

Each column in the business model maps to one or more columns in the Physical
layer. At run time, the Oracle BI Server evaluates Logical SQL requests against the
business model, and then uses the mappings to determine the best set of physical
tables, files, and cubes for generating the necessary physical queries. The
mappings often contain calculations and transformations, and might combine
multiple physical tables.

= Presentation layer. This layer provides a way to present customized, secure,
role-based views of a business model to users. It adds a level of abstraction over
the Business Model and Mapping layer and provides the view of the data seen by
users building requests in Presentation Services and other clients.

You can create multiple subject areas in the Presentation layer that map to a single
business model, effectively breaking up the business model into manageable
pieces.

Before you build any repository layers in the Administration Tool, it is important to
create a high-level design of the Business Model and Mapping layer based on the
analytic requirements of your users. After you have a conceptual design to work
toward, you can then build your metadata objects.

The typical order is to create the Physical layer objects first, the Business Model and
Mapping layer objects next, and the Presentation layer objects last. However, you can
work on each layer at any stage. After you complete all three layers, you can set up
security when you are ready to begin testing the repository.

Figure 1-2 shows how a Logical SQL query traverses the layers of an Oracle BI
repository.
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Figure 1-2 Logical SQL Query Traversing the Layers in an Oracle Bl Repository
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Planning Your Business Model

Planning your business model is the first step in developing a usable data model for
decision support. After you have followed the planning guidelines in this section, you
can begin to create your repository.

Analyzing Your Business Model Requirements

Your first task is to thoroughly understand your business model requirements. You
must first understand what business model you want to build before you can
determine what the Physical layer needs to have in it.

In a decision support environment, the objective of data modeling is to design a model
that presents business information in a manner that parallels business analysts'
understanding of the business structure. A successful model allows the query process
to become a natural process by enabling analysts to structure queries in the same
intuitive fashion as they would ask business questions. This model must be one that
business analysts inherently understand and that answers meaningful questions
correctly.

Unlike visual SQL tools such as Oracle BI Publisher, the business model defines the
analytic behavior of your Bl application. In contrast, the Physical layer only provides
the components used to assemble a physical query mapped from business model logic.

This requires breaking down your business into several components to answer the
following questions:

= What kinds of business questions are analysts trying to answer?
= What are the measures required to understand business performance?

= What are all the dimensions under which the business operates? Or, in other
words, what are the dimensions used to break down the measurements and
provide headers for the reports?
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»  Are there hierarchical elements in each dimension, and what types of relationships
define each hierarchy?

After you have answered these questions, you can identify and define the elements of
your business model.

Identifying the Content of the Business Model

To determine what content to include in your business model, you must first identify
the logical columns on which users need to query. Then, to establish the role played by
each column, identify whether it is a measure column or a dimensional attribute.
Finally, arrange the logical columns in a dimensional model based on the relevant
roles, relationships between columns, and logic.

Businesses are analyzed by relevant dimensional criteria, and the business model is
developed from these relevant dimensions. These dimensional models form the basis
of the valid business models to use with the Oracle BI Server.

Although not all dimensional models are built around a star schema, it is a best
practice to use a simple star schema in the business model layer. In other words, the
dimensional model should represent some measurable facts that are viewed in terms
of various dimensional attributes.

After you analyze your business model requirements, you need to identify the specific
logical tables and hierarchies that you need to include in your business model.

This section contains the following topics:
= Identifying Logical Fact Tables

= Identifying Logical Dimension Tables
= Identifying Dimensions

s Identifying Lookup Tables

Identifying Logical Fact Tables

Logical fact tables in the Business Model and Mapping layer contain measures that
have aggregations built into their definitions. Logical fact tables are different from
physical fact tables in relational models, which instead define facts at the lowest grain
of the table.

Measures aggregated from facts must be defined in a logical fact table. Measures are
typically calculated data such as dollar value or quantity sold, and they can be
specified in terms of dimensions. For example, you might want to determine the sum
of dollars for a given product in a given market over a given time period.

Each measure has its own aggregation rule such as SUM, AVG, MIN, or MAX. A business
might want to compare values of a measure and need a calculation to express the
comparison. Also, aggregation rules can be specific to particular dimensions. The
Oracle BI Server lets you define complex, dimension-specific aggregation rules.

You do not explicitly label tables in the Business Model and Mapping layer as fact
tables or dimension tables. Rather, the Oracle BI Server treats tables at the "one" end of
a join as dimension tables, and tables at the "many" end of a join as fact tables.

Figure 1-3 illustrates the many-to-one joins to a fact table in a Business Model
Diagram. In the diagram, all joins have the crow's feet symbol (indicating the many
side) pointing into the Fact-Pipeline table and no joins pointing out of it. For an
example of this in a business model, open a repository in the Administration Tool,
right-click a fact table, and select Business Model Diagram > Whole Diagram.

Introduction to Building Your Metadata Repository 1-5



Planning Your Business Model

Figure 1-3 Diagram of Fact Table Joins
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Identifying Logical Dimension Tables

A business uses facts to measure performance by well-established dimensions, for
example, by time, product, and market. Every dimension has a set of descriptive
attributes. Dimension tables contain attributes that describe business entities (such as
Customer Name, Region, Address, Country and so on). Dimension tables also contain
primary keys that identify each member. Unlike logical fact tables, which are different
from physical fact tables in relational models, logical dimension tables behave very
much like relational dimension tables.

Dimension table attributes provide context to numeric data, such as being able to
categorize Service Requests. Attributes stored in this dimension might include Service
Request Owner, Area, Account, Priority, and so on.

Dimensions in the business model are conformed dimensions. In other words, even if
a particular data source has five different instances of a particular Customer table, the
business model should only have one table. To achieve this, all five physical source
instances of Customer are mapped to a single Customer logical table, with
transformations in the logical table source as necessary. Conformed dimensions hide
the complexity of the Physical layer from users and enable you to combine data from
multiple fact sources at different grains. They also enable you to federate multiple data
sources.

Also note that dimension and level keys in the business model should be business
keys rather than generated surrogate keys. In other words, use "Customer Name" with
values like "Oracle" instead of "Customer Key" with values like "1076823." Using
business keys in the business model ensures that all sources for that dimension can be
conformed to the same logical dimension table with the same logical key and level
key.

Although generated surrogate keys can still exist in the Physical layer, where they are
useful for their query performance advantages on joins, you typically do not have
surrogate key columns in the Business Model and Mapping layer at all.

Identifying Dimensions

Dimensions are categories of attributes by which the business is defined. Common
dimensions are time periods, products, markets, customers, suppliers, promotion
conditions, raw materials, manufacturing plants, transportation methods, media types,
and time of day. Within a given dimension, there may be many attributes. For
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example, the time period dimension can contain the attributes day, week, month,
quarter, and year. Exactly what attributes a dimension contains depends on the way
the business is analyzed.

Dimensions typically contain hierarchies, which are sets top-down relationships
between members within a dimension. There are two types of hierarchies: level-based
hierarchies (structure hierarchies), and parent-child hierarchies (value hierarchies).
Level-based hierarchies are those in which members of the same type occur only at a
single level, while members in parent-child hierarchies all have the same type. Oracle
Business Intelligence also supports a special type of level-based dimension, called a
time dimension, that provides special functionality for modeling time series data.

In level-based hierarchies, levels roll up from lower level to higher level; for example,
months can roll up into a year. These rollups occur over the hierarchy elements and
span natural business relationships.

In parent-child hierarchies, the business relationships occur between different
members of the same real-world type, such as the manager-employee relationship in
an organizational hierarchy tree. Parent-child hierarchies do not have explicitly named
levels. There is no limit to the number of implicit levels in a parent-child hierarchy.

To define your hierarchies, you define the "contains" relationships in your business
(geographical, product, time, and so on) to drive rollup aggregations in all
calculations, as well as drill-down navigation in reports and dashboards. For example,
if month rolls up into year and an aggregate table exists at the month level, that table
can be used to answer questions at the year level by adding up all of the month-level
data for a year.

It is important to use the right type of hierarchy for your needs. To determine which
type to use, consider the following:

= Are all the members of the same type (such as employee, assembly, or account), or
are they of different types that naturally fall into levels (such as
year-quarter-month, continent-country-state/province, or brand-line-product)?

s Do members have the same set of attributes? For example, in a parent-child
hierarchy like Employees, all members might have a Hire Date attribute. In a
level-based hierarchy like Time, however, the Day type might have a Holiday
attribute, while Month does not.

= Are the levels fixed at design time (year-quarter-month), or can run-time business
transactions add or subtract levels? For example, a level could be added when the
current lowest-level employee hires a subordinate, who then becomes the new
lowest level.

= Are there constraints in your primary data source that require a certain hierarchy
type? If your primary data source is modeled in one way or the other, you might
need to use the same hierarchy type in your business model, regardless of other
factors.

See Chapter 9, "Working with Logical Dimensions" for more information.
About Dimensions with Multiple Hierarchies Sometimes, dimensions can contain multiple
hierarchies. For example, time dimensions often have one hierarchy for the calendar

year, and another hierarchy for the fiscal year. Note that dimensions with multiple
hierarchies must always end with the same leaf table.

Figure 1-4 shows a dimension with multiple hierarchies in the Business Model and
Mapping layer of the Administration Tool.
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Figure 1-4 Dimension with Multiple Hierarchies
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Identifying Lookup Tables

When you need to display translated field information from multilingual schemas,
you create a logical lookup table that corresponds to a lookup table in the Physical
layer. A lookup table stores multilingual data corresponding to rows in the base tables.
Before you can use a particular logical lookup table, you must designate it as a lookup
table in the General tab of the Logical Table dialog. See "Localizing Oracle Business
Intelligence Deployments" in Oracle Fusion Middleware System Administrator's Guide for
Oracle Business Intelligence Enterprise Edition for more information about localization
and lookup tables.

In addition to localization, lookup tables can be used any time you need to display one
set of values to users, while using a different, corresponding set of values in the
physical query. If necessary, the human-readable value can be looked up in a
completely different data source.

Identifying the Data Source Content for the Physical Layer

After you have determined the requirements for your business model, you can look at
what data source content you need in the Physical layer. Unlike the Business Model
and Mapping layer, which is always dimensional, each physical model mirrors the
shape of the source (for example, normalized, cube, and so on).

This section contains the following topics:
= About Types of Physical Schemas in Relational Data Sources
= About Cubes in Multidimensional Data Sources

= Identifying the Data Source Table Structure

About Types of Physical Schemas in Relational Data Sources

You can successfully model any physical schema in the Oracle Bl repository, regardless
of its type, because the model of any physical source can be broken down into
overlapping subsets that are dimensional.

There are four types of physical schemas (models):
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Star Schemas. A star schema is a set of dimensional schemas (stars) that each have
a single fact table with foreign key join relationships to several dimension tables.
When you map a star to the business model, you first map the physical fact
columns to one or more logical fact tables. Then, for each physical dimension table
that joins to the physical fact table for that star, you map the physical dimension
columns to the appropriate conformed logical dimension tables.

Snowflake Schemas. A snowflake schema is similar to a star schema, except that
each dimension is made up of multiple tables joined together. Like star schemas,
you first map the physical fact columns to one or more logical tables. Then, for
each dimension, you map the snowflaked physical dimension tables to a single
logical table. You can achieve this by either having multiple logical table sources,
or by using a single logical table source with joins.

Normalized Schemas. Normalized schemas distribute data entities into multiple
tables to minimize data storage redundancy and optimize data updates. Before
mapping a normalized schema to the business model, you need to understand
how the distributed structure can be understood in terms of facts and dimensions.

After analyzing the structure, you pick a table that has fact columns and then map
the physical fact columns to one or more logical fact tables. Then, for each
dimension associated with that set of physical fact columns, you map the
distributed physical tables containing dimensional columns to a single logical
table. Like with snowflake schemas, you can achieve this by having multiple
logical table sources, or by using a single logical table source with joins. Mapping
normalized schemas is an iterative process because you first map a certain set of
facts, then the associated dimensions, and then you move on to the next set of
facts.

Note that when a single physical table has both fact and dimension columns, you
may need to create a physical alias table to handle the multiple roles played by
that table.

Fully Denormalized Schemas. This type of dimensional schema combines the
facts and dimensions as columns in one table (or flat file), and is mapped
differently than other types of schemas. When you map a fully denormalized
schema to the star-shaped business model, you map the physical fact columns
from the single physical fact table to multiple logical fact tables in the business
model. Then, you map the physical dimension columns to the appropriate
conformed logical dimension tables.

About Cubes in Multidimensional Data Sources

Cubes are made up of measures and organized by dimensions. Because they are
already dimensional, each cube maps easily to the logical fact and dimension tables in
the business model.

Note the following about measures and dimensions:

Measures in multidimensional cubes and relational fact columns both map to
logical measures in the Business Model and Mapping layer. However, measures in
multidimensional cubes already include calculations and aggregations, unlike
relational fact columns, which require the calculations and aggregations to be
applied in the business model. Rather than treating cubes like relational sources,
the Oracle BI Server can take advantage of the pre-aggregated data and powerful
calculations in the cube.

Multidimensional physical objects and relational physical objects both map to
logical dimensions in the Business Model and Mapping layer. However,
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dimensional and hierarchical semantics are already built into multidimensional
data sources, unlike relational sources. The Oracle BI Server can take advantage of
the more complete hierarchy and dimensional support in the cube, both during
import and at query time.

Identifying the Data Source Table Structure

The Administration Tool provides an interface to map logical tables to the underlying
physical tables in your data sources. Before you can map the tables, you need to
identify the contents of the physical data sources as it relates to your business model.
To do this correctly, you need to identify the following contents of the physical data
source:

= Identify the contents of each table
s  Identify the detail level for each table

s Identify the table definition for each aggregate table. This lets you set up aggregate
navigation. The following detail is required by the Oracle BI Server:

— The columns by which the table is grouped (the aggregation level)
— The type of aggregation (SUM, AVG, MIN, MAX, or COUNT)

For information on how to set up aggregate navigation in a repository, see
Chapter 10.

= Identify the contents of each column
= Identify how each measure is calculated
s Identify the joins defined in the database

To acquire this information about the data, you could refer to any available
documentation that describes the data elements created when the data source was
implemented, or you might need to spend some time with the DBA for each data
source to get this information. To fully understand all the data elements, you might
also need to ask people in the organization who are users of the data, owners of the
data, or the application developers of applications that create the data.

Guidelines for Designing a Repository

After analyzing your business model needs and identifying the database content your
business needs, you can complete your repository design. This section contains some
design best practices that can help you implement a more efficient repository.

Typically, you should not make performance tuning changes until you have imported
and tested your databases. These tasks are performed during the final steps in
completing the setup of your repository. For more information about these final steps,
see Chapter 14.

This section contains the following topics:

=  General Tips for Working on the Repository

s Design Tips for the Physical Layer

s Design Tips for the Business Model and Mapping Layer

s Design Tips for the Presentation Layer
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General Tips for Working on the Repository

Follow these recommended design strategies for structuring your Oracle BI repository:

s If you work in online mode, save backups of the online repository before and after
every completed unit of work. If needed, use Copy As on the File menu to make
an offline copy containing the changes.

= Use the Physical Diagrams in the Administration Tool to verify sources and joins.

s Decide whether you want to set up row-level security controls in the database, or
in the repository. This decision determines whether you share connection pools
and cache, and may limit the number of separate source databases you want to
include in your deployment. See Chapter 13, "Applying Data Access Security to
Repository Objects" for more information.

Most dialogs in the Administration Tool have Help that provides information about
how to complete a task. To access a help topic, click the Help button in a dialog, or
select Help from some menus.

Design Tips for the Physical Layer

The Physical layer contains information about the physical data sources. The most
common way to create the schema in the Physical layer is by importing metadata from
databases and other data sources. If you import metadata, many of the properties are
configured automatically based on the information gathered during the import
process. You can also define other attributes of the physical data source, such as join
relationships, that might not exist in the data source metadata.

The Physical layer can contain data sources of many different types, including
multidimensional, relational, and XML sources. See "System Requirements and
Certification" for information about supported databases.

For each data source, there is at least one corresponding connection pool. The
connection pool contains data source name (DSN) information used to connect to a
data source, the number of connections allowed, timeout information, and other
connectivity-related administrative details. See "About Connection Pools" for more
information.

The following is a list of tips to use when designing the Physical layer:

s Itis recommended that you use table aliases frequently in the Physical layer to
eliminate extraneous joins, including the following:

- Eliminate all physical joins that cross dimensions (inter-dimensional circular
joins) by using aliases.

— Eliminate all circular joins (intra-dimensional circular joins) in a logical table
source in the Physical Model by creating physical table aliases.

For example, say you have a Customer table that can be used to look up
ship-to addresses, and using a different join, to look up bill-to addresses.
Avoid the circular joins by aliasing the table in the Physical layer so that there
is one instance for each purpose, with separate joins.

= You might import some tables into the Physical layer that you might not use right
away, but that you do not want to delete. To identify tables that you do want to
use right away in the Business Model and Mapping layer, you can assign aliases to
physical tables before mapping them to the business model layer.
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Note: To have the name of a table to which you assigned an alias
appear, select Display original name for alias in diagrams in Tools >
Options > General.

An opaque view (a Physical layer table that consists of a SELECT statement)
should be used only if there is no other solution to your modeling problem.
Ideally, a physical table should be created, or alternatively a materialized view.
Opaque views prevent the Oracle BI Server from generating its own optimized
SQL, because they contain fixed SQL statements that are sent to the underlying
data source.

Design Tips for the Business Model and Mapping Layer

The Business Model and Mapping layer organizes information by business model. In
this layer, each business model is effectively a separate application.

The logical schema defined in each business model must contain at least two logical
tables. Relationships need to be defined between all the logical tables. See "About
Layers in the Oracle BI Repository" for more information about business model
schemas. See Chapter 8 for more information about setting up the Business Model and
Mapping layer.

The following is a list of tips to use when designing the Business Model and Mapping
layer:

Create the business model with one-to-many logical joins between logical
dimension tables and the fact tables wherever possible. The business model
should ideally resemble a simple star schema in which each fact table is joined
directly to its dimensions.

Every logical fact table must join to at least one logical dimension table. Note that
when the source is a fully denormalized table or flat file, you must map its
physical fact columns to one or more logical fact tables, and its physical dimension
columns to logical fact tables.

Every logical dimension table should have a dimensional hierarchy associated
with it. This rule holds true even if the hierarchy has only one level, such as a
scenario dimension {actual, forecast, plan}.

Make sure that all appropriate fact sources map to the proper level in the
hierarchy using aggregation content. You set up aggregation content in the Levels
tab of the Logical Column dialog for the measure. Note that this is different from
the Content tab of the Logical Table Source dialog, which is used to specify the
grain of the source tables to which it maps.

Typically, logical fact tables should not contain any keys. The only exception is

when you need to send Logical SQL queries against the Oracle BI Server from a
client that requires keys. In this case, you need to expose those keys in both the
logical fact tables, and in the Presentation layer.

Normally, all columns in logical fact tables are aggregated measures, except for
keys required by external clients, or dummy columns used as a divider. Other
non-aggregated columns should instead exist in a logical dimension table.

In some situations, you might want to have multiple logical fact tables in a single
business model. For Logical SQL queries, the multiple logical fact tables behave as
if they are one table.

Reasons to have multiple logical fact tables include:
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- To assign projects. See "Setting Up Projects” for more information.

- To automatically create small subject areas in the Presentation layer. See
"Automatically Creating Subject Areas Based on Logical Stars and Snowflakes"
for more information.

- For organization and simplicity of understanding.

Unlike relational fact tables, logical fact tables can contain measures of different
grains. Because of this, grain is not a reason to split up logical fact tables.

You can define calculations in either of the following ways:
— Before the aggregation, in the logical table source. For example:

sum(col_A *( col_B))

-  After the aggregation, in a logical column derived from two other logical
columns. For example:

sum(col A) * sum(col B)

You can also define post-aggregation calculations in Answers or in Logical SQL
queries.

If you plan to use Oracle Scorecard and Strategy Management, it is a best practice
to implement at least one time dimension in the Oracle Bl repository you are using
for your KPIs. This action is necessary because you use KPIs in scorecards to
measure progress and performance over time. Note that an individual scorecard
automatically picks up any dimension used by KPIs in that scorecard.

Aggregate sources should be created as separate logical table sources. For fact
aggregates, use the Content tab of the Logical Table Source dialog to assign the
correct logical level to each dimension.

Each dimension level in a hierarchy must have a unique level key. Also, each
logical dimension table must have a unique primary key. Normally, this key is
also used as the level key for the lowest hierarchy level.

Renaming columns in the Business Model and Mapping layer automatically
creates aliases (synonyms) for Presentation layer columns that have the property
Use Logical Column Name selected.

To prevent problems with aggregate navigation, ensure that each logical level of a
dimension hierarchy contains the correct value in the field named Number of
elements at this level. Fact sources are selected on a combination of the fields
selected as well as the levels in the dimensions to which they map. By adjusting
these values, you can alter the fact source selected by the Oracle Bl Server. See
"Creating Logical Levels in a Dimension" for more information about setting this
value.

Modeling Outer Joins
The following guidelines provide tips on how to model outer joins:

Due to the nature of outer joins, queries that use them are usually slower. Because
of this, define outer joins only when necessary. Where possible, use ETL
techniques to eliminate the need for outer joins in the reporting SQL.

Outer joins are always defined in the Business Model and Mapping layer. Physical
layer joins do not specify inner or outer.
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You can define outer joins by using logical table joins, or in logical table sources.
Which type of outer join you use is determined by whether the physical join maps
to a business model join, or to a logical table source join.

Be aware that outer joins in logical table sources are always included in a query,
even if the none of the columns in one of the mapped physical tables are used.

For example, assume that a logical table source is mapped to physical tables A and
B. When no outer joins are defined, if physical table A is not required to satisfy a
request, it is not included in the physical query. However, if the logical table
source has an outer join defined to table A, table A is still included in the physical
query, even if only physical table B is required to satisfy the request.

If you must define an outer join, try to create two separate dimensions, one that
uses the outer join and one that does not. Make sure to name the dimension with
the outer join in a way that clearly identifies it, so that client users can use it as
little as possible.

Design Tips for the Presentation Layer

You set up the user view of a business model in the Presentation layer. The names of
folders and columns in the Presentation layer can appear in localized language
translations. The Presentation layer is the appropriate layer in which to set user
permissions. For complete information about working in the Presentation layer, see
Chapter 11.

In this layer, you can do the following:

You can show fewer columns than exist in the Business Model and Mapping layer.
For example, you can exclude the key columns because they have no business
meaning.

You can organize columns using a different structure from the table structure in
the Business Model and Mapping layer.

You can display column names that are different from the column names in the
Business Model and Mapping layer.

You can set permissions to grant or deny users access to individual subject areas,
tables, and columns.

You can export logical keys to ODBC-based query and reporting tools.
You can create multiple subject areas for a single business model.

You can create a list of aliases (synonyms) for presentation objects that can be used
in Logical SQL queries. This feature lets you change presentation column names
without breaking existing reports.

The following is a list of tips to use when designing the Presentation layer:

Because there is no automatic way to synchronize all changes between the
Business Model and Mapping layer and the Presentation layer, it is best to wait
until the Business Model and Mapping layer is relatively stable before adding
customizations in the Presentation layer.

There are many ways to create subject areas, such as dragging and dropping the
entire business model, dragging and dropping incremental pieces of the model, or
automatically creating subject areas based on logical stars or snowflakes. See
"Creating Subject Areas" for information about each of these methods. Dragging
and dropping incrementally works well if certain parts of your business model are
still changing.
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s Itis a best practice to rename objects in the Business Model and Mapping layer
rather than the Presentation layer, for better maintainability. Giving user-friendly
names to logical objects rather than presentation objects ensures that the names
can be reused in multiple subject areas. Also, it ensures that the names persist
even when you need to delete and re-create subject areas to incorporate changes to

your business model.

= Be aware that members in a presentation hierarchy are not visible in the
Presentation layer. Instead, you can see hierarchy members in Answers.

= You can use the Administration Tool to update Presentation layer metadata to give
the appearance of nested folders in Answers. See "Nesting Folders in Answers" for

more information.

= When setting up data access security for a large number of objects, consider
setting object permissions by role rather than setting permissions for individual
columns. See Chapter 13, "Applying Data Access Security to Repository Objects"

for details.

= When setting permissions on presentation objects, you can change the default
permission by setting the DEFAULT_PRIVILEGES configuration setting in the
NQSConfig.INI file. See Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition for more information.

Topics of Interest in Other Guides

Some topics that may be of interest to metadata repository builders are covered in
other guides. Table 1-1 lists these topics, and indicates where to go for more

information.

Table 1-1

Topics Covered in Other Guides

Topic

Where to Go for More Information

Starting and stopping Oracle
Business Intelligence processes

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Using the Oracle BI Server XML
API to work with your
repository

Oracle Fusion Middleware Integrator’s Guide for Oracle
Business Intelligence Enterprise Edition

Setting up and managing query
caching

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Managing configuration settings
that affect repository
development in Fusion
Middleware Control and
NQSConfig.INI

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Managing users, groups, and
application roles

Oracle Fusion Middleware Security Guide for Oracle Business
Intelligence Enterprise Edition

Moving from test to production
environments

Oracle Fusion Middleware Administrator’s Guide

Setting up DSNs for the Oracle
BI Server

Oracle Fusion Middleware Integrator’s Guide for Oracle
Business Intelligence Enterprise Edition

Localizing Oracle Business
Intelligence deployments

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Information about the SA System
subject area

Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Introduction to Building Your Metadata Repository 1-15




System Requirements and Certification

Table 1-1 (Cont.) Topics Covered in Other Guides

Topic Where to Go for More Information

Managing logging Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Managing usage tracking Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition

Converting Oracle Business Oracle Fusion Middleware System Administrator’s Guide for

Intelligence proprietary Oracle Business Intelligence Enterprise Edition

metadata to an XML file and
importing the metadata into
your Oracle or IBM DB2
database

General information about Oracle Fusion Middleware Administrator’s Guide
managing Oracle WebLogic
Server

System Requirements and Certification

Refer to the system requirements and certification documentation for information
about hardware and software requirements, platforms, databases, and other
information. Both of these documents are available on Oracle Technology Network
(OTN).

The system requirements document covers information such as hardware and
software requirements, minimum disk space and memory requirements, and required
system libraries, packages, or patches:

http://www.oracle.com/technology/software/products/ias/files/fus
ion_requirements.htm

The certification document covers supported installation types, platforms, operating
systems, databases, JDKs, and third-party products:

http://www.oracle.com/technology/software/products/ias/files/fus
ion_certification.html
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Before You Begin

This chapter provides an overview of the Administration Tool, and explains other
concepts that you need to know before beginning to build your metadata repository.

This chapter contains the following topics:

About the Oracle BI Administration Tool

About the Oracle BI Server Command-Line Utilities

About Options in Fusion Middleware Control and NQSConfig.INI
About the SampleApp.rpd Demonstration Repository

Using Online and Offline Repository Modes

Checking the Consistency of a Repository or a Business Model

About the Oracle Bl Administration Tool

The Oracle BI Administration Tool is a Windows application that you can use to create
and edit repositories.

This section describes the Administration Tool main window, how to set preferences,
Administration Tool menus, and other related information.

This section contains the following topics:

Opening the Administration Tool

About the Administration Tool Main Window

Setting Preferences

About Administration Tool Menus

Editing, Deleting, and Reordering Objects in the Repository
Using the Browse Dialog to Browse for Objects

Changing Icons for Repository Objects

Sorting Objects in the Administration Tool

About Features and Options for Oracle Marketing Segmentation

Opening the Administration Tool

To open the Administration Tool, choose Start > Programs > Oracle Business
Intelligence > BI Administration.
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Note: Do not open the Administration Tool by double-clicking a
repository file. The resulting Administration Tool window is not
initialized to your Oracle instance, and errors will result.

You can also launch the Administration Tool from the command line, as follows:

1. In Windows Explorer, go to the following location:

ORACLE_INSTANCE /bifoundation/OracleBIApplication/coreapplication/setup
2. Double-click bi-init.cmd.

3. Type admintool and press Enter.

About the Administration Tool Main Window

The main window of the Administration Tool shows a graphical representation of the
three layers of a repository (the Physical layer, Business Model and Mapping layer,
and Presentation layer). See "About Layers in the Oracle BI Repository" for more

information.

The Administration Tool main window also contains the following:

m  Menus. See "About Administration Tool Menus" for more information.

= Toolbar. Provides access to global functionality such as Open and Save, and also
includes functions for the Physical Diagram and Business Model Diagram.

= Status bar. Provides contextual information about the current dialog or selected
object, as well as other useful information.

»  Title bar. In offline mode, displays the name of the open repository. In online
mode, displays the DSN for the Oracle BI Server to which you are connected.

Figure 2-1 shows the Administration Tool main window.

Figure 2-1 Example Administration Tool Main Window

O Oracle BI Administration Tool - SampleApp.rpd ) ﬂ
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DEssd|[r=R|E|s3E
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Setting Preferences

You can use the Options dialog to set preferences for the Administration Tool.

To set preferences:

1. In the Administration Tool, select Tools, then select Options to display the

Options dialog.

2. On the General tab, select the options you want to choose.

Table 2-1 describes the options on the General tab.

Table 2-1 Options on the General Tab

Option

Action When Selected

Tile when resizing

Automatically tiles the layer panes of the repository when you
resize the Administration Tool. When this option is selected, the
Cascade and Tile options are not available in the Windows
menu of the Administration Tool.

Display qualified names in
diagrams

Displays fully qualified names in the Physical Diagram and
Business Model Diagram. For example, selecting this option
displays "B - Sample Fcst Data"..."B02 Market" rather than B02
Market in the Physical Diagram.

Selecting this option can help identify objects by including the
name of the parent database or business model, but it can also
make the diagram harder to read because the fully qualified
names are longer.

Note: If you choose not to select this option, you can still see
fully qualified names by moving the cursor over an object in the
diagram, or by selecting an object in the diagram and then
viewing the text in the status bar.

Display original names for
alias in diagrams

Displays the names of original physical tables rather than the
names of alias tables in the Physical diagram. Select this option
when you want to identify the original table rather than the
alias table name.

Show Calculation Wizard
introduction page

Displays the Calculation Wizard introduction page. The
introduction page also contains an option to suppress its
display in the future.

Use the Calculation Wizard to create new calculation columns
that compare two existing columns and to create metrics in bulk
(aggregated), including existing error trapping for NULL and
divide by zero logic. See "Using the Calculation Wizard" for
more information.

Check out objects
automatically

Automatically checks out an object when you double-click it. If
you do not select this option, you are prompted to check out
objects before you can edit them.

This option only applies when the Administration Tool is open
in online mode. See "Opening a Repository in Online Mode" for
more information.
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Table 2-1 (Cont.) Options on the General Tab

Option

Action When Selected

Show row count in physical
view

Displays row counts for physical tables and columns in the
Physical layer. Row counts are not initially displayed until they
are updated. To update the counts, select Tools > Update All
Row Counts. You can also right-click a table or column in the
Physical layer and select the option Update Row Count.

Note: Row counts are not shown for items that are stored
procedure calls (from the Table Type list in the General tab of
the Physical Table dialog). Row counts are not available for
XML, XML Server, or multidimensional data sources. When you
are working in online mode, you cannot update row counts on
any new objects until you check them in.

Show toolbar

When selected, displays the Administration Tool toolbar.

Show statusbar

When selected, displays the Administration Tool status bar.

Prompt when moving
logical columns

Lets you ignore, specify an existing, or create a new logical table
source for a moved column.

Remove unused physical
tables after Merge

Executes a utility to clean the repository of unused physical
objects. It might make the resulting repository smaller.

Allow import from
repository

When selected, the Import from Repository option on the File
menu becomes available.

Note: By default, the Import from Repository option on the File
menu is disabled and this option will not be supported in the
future. It is recommended that you create projects in the
repository that contain the objects that you want to import, and
then use repository merge to bring the projects into your current
repository. See "Merging Repositories" for more information.

Allow logical foreign key
join creation

When selected, provides the capability to create logical foreign
key joins with the Joins Manager. This option is provided for
compatibility with previous releases and is generally not
recommended.

Skip Gen 1 levels in Essbase
drag and drop actions

When selected, excludes Gen 1 levels when you drag and drop
Essbase cubes or dimensions from the Physical layer to the
Business Model and Mapping layer. Often, Gen 1 levels are not
needed for analysis, so they can be excluded from the business
model.

See "Working with Essbase Data Sources" for more information.

Hide unusable logical table
sources in Replace wizard

By default, the Replace Wizard shows all logical table sources,
even ones that are not valid for replacement. When this option
is selected, unusable logical table sources are hidden in the
Replace Wizard screens. Click Info for details on why a logical
table source that maps to that column does not appear in the
list.

Selecting this option might result in the Wizard page loading
more quickly, especially for large repositories.

3. On the Repository tab, you can set the following options:

= Show tables and dimensions only under display folders. You can create
display folders to organize objects in the Physical and Business Model and
Mapping layers. They have no metadata meaning. After you create a display
folder, the selected objects appear in the folder as a shortcut and in the
database or business model tree as an object. You can hide the objects so that
only the shortcuts appear in the display folder.
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See "Setting Up Display Folders in the Physical Layer" and "Setting Up
Display Folders in the Business Model and Mapping Layer" for more
information about creating display folders.

= Hide level based measure. By default, each level of a dimension hierarchy in
the Business Model and Mapping layer shows both dimension columns that
are assigned to that level, and level-based measures that have been fixed at
that level. Level-based measures are objects that are not part of the dimension
table, but that have been explicitly defined as being at a particular level.

Hiding level-based measures in dimension hierarchies can reduce clutter.
Note that the measures are still visible in the logical fact tables.

See Example 9-1, "Level-Based Measure Calculations" for more information
about level-based measures.

s Default logging level. This option determines the default query logging level
for all users. You can override this level for individual users in the User
dialog. A query logging level of 0 (the default) means no logging.

See "Managing the Query Log" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information about the query log and query logging levels.

s LDAP. If you are using any alternative LDAP servers, the Oracle BI Server
maintains an authentication cache in memory for user identifiers and
properties, which improves performance when using LDAP to authenticate
large numbers of users. Disabling the authentication cache can slow
performance when hundreds of sessions are being authenticated. Note that the
authentication cache is not used for Oracle WebLogic Server’s embedded
directory server.

Properties for the authentication cache include:

— Cache refresh interval. The interval at which the authentication cache
entry for a logged on user is refreshed.

— Number of Cache Entries. The maximum number of entries in the
authentication cache, preallocated when the Oracle BI Server starts. If the
number of users exceeds this limit, cache entries are replaced using the
LRU algorithm. If this value is 0, then the authentication cache is disabled.

You need to specify some additional LDAP properties when you are using a
secure connection to your LDAP server. In other words, provide the following
information when you have selected SSL on the Advanced tab of the LDAP
Server dialog:

- Key file name. The name of the key file that holds the client certificate and
Certificate Authority (CA) certificate.

- Password and Confirm password. The password for the key file.

Note that the authentication cache properties and key file properties are
shared for all defined LDAP server objects.

4. On the Sort Objects tab, specify which repository objects appear in the
Administration Tool in alphabetical order. For example, if you want the database
objects that appear in the Physical layer to appear in alphabetical order, select the
Database option.

5. On the Cache Manager tab, select the columns you want to display in the Cache
Manager. To change the order of columns in the Cache Manager, select an item,
then use the Up and Down buttons to change its position.
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6. On the Multiuser tab, specify the path to the multiuser development directory and
the name of the local developer for this Administration Tool. See "Setting Up a
Pointer to the Multiuser Development Directory” for more information.

7.  On the More tab, you can set the scrolling speed for Administration Tool dialogs,
as well as set the default window size for the join diagrams.

= To set the scrolling speed, position the cursor on the slider.

n  To set the default window size, in the Default diagram zoom list, choose a
percentage or Best Fit.

The default window size is Best Fit. If you use the Best Fit option, the
following rules apply:

— If there are five or fewer objects, the zoom level is 50%.

—  If there are more than five objects, the zoom level changes automatically to

Zoom to Fit.

8. (Click OK when you are finished setting preferences.

About Administration Tool Menus

The Administration Tool includes menus for File, Edit, View, Manage, Tools, Actions,
Window, and Help. These menus are described in the following sections.

File Menu

The File menu provides options to work with repositories, like Open and Save, as well
as several server-related options like Check Out All that are only active when a
repository is open in online mode. The File menu also provides a list of recently

opened files.

Table 2-2 lists the options in the File menu.

Table 2-2  File Menu Options

Menu Option

Description

New Repository

Opens the Create New Repository Wizard and closes the
currently open repository, if any. If a repository is currently
open with unsaved changes, you are prompted to save them
before proceeding.

See "Creating New Oracle BI Repository Files" for more
information.

Open

Provides options for opening a repository in either offline or
online mode.

See "Using Online and Offline Repository Modes" for more
information.

Multiuser

Provides options to check out projects in a multiuser
development environment and view multiuser development
history.

See Chapter 3, "Setting Up and Using the Multiuser
Development Environment" for more information.

Close

Closes the currently open repository. If you have unsaved
changes, you are prompted to save them.

Save

Saves your latest changes.
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Table 2-2 (Cont.) File Menu Options

Menu Option Description

Save As Opens the Save As dialog so that you can save the repository to
a different file. The new file remains open in the Administration
Tool.

Copy As Opens the Save Copy As dialog so that you can copy the

repository to a different file. The current file, not the new file,
remains open in the Administration Tool.

Change Password

Lets you change the repository password for the currently open
repository.

See "Changing the Repository Password" for more information.

Import Metadata

Opens the Import Metadata Wizard.

See the following sections for more information:

= "Importing Metadata from Relational Data Sources"

= "Importing Metadata from Multidimensional Data Sources"
= "Working with ADF Business Component Data Sources"

= "Importing Metadata from XML Data Sources"

Compare

Prompts you to select the repository with which you want to
compare the currently open repository and opens the Compare
repositories dialog.

See "Comparing Repositories" for more information.

Turn off Compare Mode

Turns off any highlighted changed objects. This option is only
available if you have turned on compare mode by choosing
Mark in the Compare repositories dialog.

Merge

Opens the Merge Repository Wizard.

See "Merging Repositories" for more information.

Check Global Consistency

Checks the repository for consistency and opens the
Consistency Check Manager.

See "Checking the Consistency of a Repository or a Business
Model" for more information.

Check Out All Checks out all repository objects. This option is only available in
online mode.

Check In Changes Checks in all repository objects. This option is only available in
online mode.

Undo All Changes Rolls back all changes made since the last check-in. This option
is only available in online mode.

Exit Closes the currently open repository and then closes the
Administration Tool. If you have unsaved changes, you are
prompted to save them.

Edit Menu

The Edit menu provides access to the following basic editing functions for repository
objects: Cut, Copy, Paste, Duplicate, and Delete. You can also choose Properties to
view and edit properties for a selected object.

View Menu

The View menu options let you hide or display the panes that show the three layers of
the repository (Presentation, Business Model and Mapping, and Physical). You can
also display the Business Model Diagram and Physical Diagram.
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Choose Refresh to refresh the repository view. This feature can be useful in online
mode to reveal changes made by other clients. It can also be used in either online or
offline mode when the repository view has become out of sync and does not display a
recent change or addition. Refreshing the repository view collapses any expanded
objects in the tree panes and helps reduce clutter.

Manage Menu

The Manage menu enables you to access the management functions described in

Table 2-3.

Table 2-3 Manage Menu Options

Menu Option

Description

Jobs

Opens the Job Manager. The Job Manager is the management interface to
Oracle BI Scheduler. This option is available when a repository is open in
online mode.

See "Using Oracle BI Scheduler Job Manager" in Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for more information.

Sessions

Opens the Session Manager. In the Session Manager, you can monitor
activity on the system, including the current values of repository and
session variables. This option is available when a repository is open in
online mode.

See "Managing Server Sessions" in Oracle Fusion Middleware Security Guide
for Oracle Business Intelligence Enterprise Edition for more information.

Cache

Opens the Cache Manager. The Cache Manager enables you to monitor
and manage the cache. This option is available when a repository is open
in online mode and caching is enabled.

See "Using the Cache Manager" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for
more information about enabling the cache and using the Cache Manager.

Clusters

Opens the Cluster Manager. The Cluster Manager monitors and manages
the operations and activities of the cluster. This option is available when
the Oracle BI Cluster Server is installed.

See "Using the Cluster Manager" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for
more information.

Identity

Opens the Security Manager. The Security Manager provides access to
data access security functions and other identity-related options.

See Chapter 13, "Applying Data Access Security to Repository Objects”
for more information.

Joins

Opens the Joins Manager. The Joins Manager enables you to work with
both physical and logical joins in a list format. The Joins Manager
provides an alternative to working with joins in the Physical and Logical
diagrams and shows all join types in one place.

See "Defining Physical Joins with the Joins Manager" and "Defining
Logical Joins with the Joins Manager" for more information.

Variables

Opens the Variable Manager. The Variable Manager enables you to
create, edit, or delete variables and initialization blocks.

See Chapter 18, "Using Variables in the Oracle BI Repository" for more
information.
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Table 2-3 (Cont.) Manage Menu Options

Menu Option Description

Projects Opens the Project Manager. The Project Manager enables you to create,
edit, or remove projects or project elements. Project elements include
subject areas (formerly called presentation catalogs), logical fact tables,
groups, users, variables, and initialization blocks. You use projects during
multiuser development.

See "Setting Up Projects" for more information.

Marketing Applies to the Oracle Marketing Segmentation product. For information
about using the Marketing options in Oracle Business Intelligence, see
Oracle Marketing Segmentation Guide.

Tools Menu

The Tools menu options enable you to access the functions described in Table 2—4.

Table 2-4 Tools Menu Options

Menu Option

Description

Update All Row Counts

Updates row counts in the Physical layer.

See "Displaying and Updating Row Counts for Physical Tables
and Columns" for more information.

Show Consistency Checker

Opens the Consistency Check Manager.

See "Checking the Consistency of a Repository or a Business
Model" for more information.

Query Repository

Opens the Query Repository dialog.

See "Querying and Managing Repository Metadata" for more
information.

Utilities

Opens the Utilities dialog, which lets you select from a list of
Administration Tool utilities.

See "Using Administration Tool Utilities" for more information.

Options

Opens the Options dialog, which lets you customize
Administration Tool display preferences and other options.

See "Setting Preferences" for more information.

Actions Menu

The Actions menu options are available when working with the Physical Diagram or
Business Model Diagram. The options enable you to select elements, create new joins,

or create new tables.

Window Menu

The Window menu options enable you to cascade or tile open layer windows and

toggle among them.

Help Menu

The Help menu provides the following options:

»  Help Topics. Access the Help system for the Administration Tool.

= Oracle BI on the Web. Access the Oracle Business Intelligence home page on the
Oracle Technology Network (OTN).
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s About Oracle BI Administration Tool. Obtain version information about the
Administration Tool.

Editing, Deleting, and Reordering Objects in the Repository

This section provides information about editing, deleting, and reordering objects.

= To edit objects, double-click an object, or right-click an object and select
Properties. Then, complete the fields in the dialog that is displayed. In some
dialogs, you can click Edit to open the appropriate dialog.

n  To delete objects, select one or more objects and click Delete, or press the delete
key. You can also right-click an object and select Delete.

= To reorder objects, drag and drop an object to a new location. Note the following;:
— Reordering is only possible for certain objects and in certain dialogs.

- Insome dialogs, you can use an up or down arrow to move objects to a new
location.

- Inthe Administration Tool main window, you can drag and drop an object
onto its parent to duplicate the object. For top-level objects like business
models and subject areas, drag and drop the object onto white space to
duplicate it.

Using the Browse Dialog to Browse for Objects

The Browse dialog appears in many situations in the Administration Tool. You use it to
find and select an object.

The Browse dialog is accessible from several dialogs that let you make a selection from
among existing objects.

The left pane of the Browse dialog lets you browse the tree view for a particular object.
It contains the following parts:

= A tree listing all of the objects in the Presentation layer, Business Model and
Mapping layer, or the Physical layer of a repository.

= Tabs at the bottom of the left pane let you select a layer. Some tabs might not
appear if objects from those layers are not appropriate for the task you are
performing.

The right pane of the Browse dialog lets you search for the object you want. It contains
the following parts:

= Query enables you to query objects in the repository by name and type. The Name
field accepts an asterisk (*) as the wildcard character, so you can query for partial
matches.

s The Show Qualified Names option lets you identify to which parents an object
belongs.

= View lets you view properties of a selected object in read-only mode.

Note that in general, the left pane and the right pane of the Browse dialog are not
connected. Rather, the panes provide alternate methods to locate the object you want.

The exception to this is the Synchronize Contents feature, which lets you synchronize
an object from the query results list with the tree view. This feature is a helpful
contextual tool that locates a particular object in the tree view.

Table 2-5 lists and describes the tasks you can perform in the Browse dialog.
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Table 2-5 Tasks You Can Perform in the Browse Dialog

Task

Description

Querying for an object

Follow these steps to query for an object:
1. Select the object type from the Type list.

2. Type the name of the object, or a part of the name and the
wildcard character (*), in the Name field. For example:

- To search for logical tables that have names beginning
with the letter Q, select Logical Tables from the Type list,
and then type Q* in the Name field.

- To search for logical tables that have names ending with
the letters dim, type *dim in the name field.

3. Click Query.

Relevant objects appear in the query results list.

Selecting an object

Use the tree view in the left pane or the filtered view in the right
pane to locate the object you want, then double-click the object.

The Browse dialog closes, and the object is displayed in the
previous dialog.

Synchronizing an object in
the query results list with
the tree view

Select an object in the Query list and then click the Synchronize
Contents button.

The object you selected is highlighted in the tree view in the left
pane.

Finding multiple
occurrences of an object in
the tree view

Select an object in the tree view, such as a logical column, then
click the down arrow button.

The next occurrence of that object is highlighted in the tree
view.

Changing Icons for Repository Objects

In the Administration Tool, you can change the icon that represents a particular object
in the repository. Changing the icon for a particular object does not have any
functional effect, and is not visible in Answers or other clients. This feature is intended
as a useful way to visually distinguish objects for the convenience of repository

developers.

For example:

= You can use a special icon for objects that are in the Business Model and Mapping
layer, but not the Presentation layer, for easier maintenance of the repository.

= You can mark objects that are logical calculations with a separate icon.

= You can choose an icon to visually distinguish tables in the Presentation layer that
appear as nested folders in Answers.

= You can use an icon to denote objects in a logical table that pertain to a specific
functional area, or that are sourced from a particular logical table source.

You can only change the icon for individual objects. You cannot globally change the
icon for all objects of a particular type.

To change the icon for a particular repository object:

1. In the Administration Tool, right-click an object in the Physical, Business Model
and Mapping, or Presentation layer (for example, a particular logical table).

2. Select Set Icon.
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3. In the Select Icon dialog, select the icon you want to use for that object and click
OK.

Sorting Objects in the Administration Tool

Many dialogs in the Administration Tool show lists of objects, such as a list of physical
columns in the Physical Table dialog, a list of logical levels for Preferred Drill Path in
the Logical Level dialog, and a list of presentation hierarchies in the Presentation Table
dialog.

You can click the header to sort the objects in ascending or descending order. An up
arrow or down arrow icon is displayed next to the header name, indicating how the
list has been sorted.

Each list also has a default order that is persisted from session to session. The default
order appears when you view a list in a dialog for the first time each session. The
default order is displayed when there is no ascending or descending arrow icon in the
header. Click the header three times to toggle between ascending, descending, and
default order. In some cases, the default order is the ascending or descending order.

Some dialogs provide the capability to move items up or down in a list. In these
dialogs, if you click Up or Down while the list is sorted in ascending or descending
order, the selected item moves, and the resulting order becomes the new default order.
Note that clicking the header eliminates any manually determined order.

About Features and Options for Oracle Marketing Segmentation

Some features and options in the Administration Tool are for use by organizations that
have the Oracle Marketing Segmentation product. For information about these
features and options, see Oracle Marketing Segmentation Guide.

Note that additional information about Oracle Marketing Segmentation features is
provided in the Presentation Services Help.

About the Oracle Bl Server Command-Line Utilities

You can use a variety of command-line utilities with the Oracle BI Server to make
programmatic changes to your repository file, run sample queries, delete unwanted
repository objects, and perform other tasks.

Table 2—6 describes the Oracle BI Server command-line utilities.
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Table 2-6 Oracle Bl Server Command-Line Utilities

Utility Name

Description

Where to Go for More Information

XML utilities
(biserverxmlgen,
biserverxmlexec,
biserverxmlcli)

Used to leverage the Oracle BI Server
XML API for metadata migration,
programmatic metadata generation and
manipulation, metadata patching, and
other functions.

The XML utilities include:

= biserverxmlgen: generates XML from
an existing RPD

s biserverxmlexec: executes the XML in
offline mode to create or modify a
repository file

= biserverxmlcli: executes the XML
against the Oracle BI Server

"About the Oracle BI Server XML API"
in Oracle Fusion Middleware Integrator’s
Guide for Oracle Business Intelligence
Enterprise Edition

Oracle BI ODBC client
utilities (nqemd, NQClient)

Used to run test queries against the
repository. Both utilities connect using an
Oracle BI Server ODBC DSN.

"Testing and Refining the Repository"

patchrpd

Used to generate and apply an XML patch
file. This utility is especially useful for
patching repository files on Linux or
UNIX systems.

"Using patchrpd to Apply a Patch"

extractprojects

Used to extract projects from a given
repository.

"Using the extractprojects Utility to
Extract Projects”

equalizerpds

Used to equalize objects in two
repositories that have the same name, but
different upgrade IDs. Running this utility
before merging repositories prevents
unintended renaming during the merge.

"Equalizing Objects"

prunerpd

Used to delete unwanted repository
objects from your repository file, such as
databases, tables, columns, initialization
blocks, and variables.

"Deleting Unwanted Objects from the
Repository”

sametaexport

Used to generate the information
necessary for the Oracle Database SQL
Access Advisor or IBM DB2 Cube Views
tool to preaggregate relational data and
improve query performance.

"Exchanging Metadata with
Databases" in Oracle Fusion Middleware
System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition

Running bi-init to Launch a Shell Window Initialized to Your Oracle Instance

Before running any of the Oracle BI Server command-line utilities, you must first run
bi-init.cmd (or bi-init.sh on UNIX) to launch a command prompt or shell window that
is initialized to your Oracle instance. You can find this utility in:

ORACLE_INSTANCE /bifoundation/OracleBIApplication/coreapplication/setup

Then, run the appropriate command-line tool from the resulting shell window with
the desired options.

About Options in Fusion Middleware Control and NQSConfig.INI

Many configuration settings that affect the Administration Tool and repository
development are managed in either Fusion Middleware Control, or the
NQSConfig.INI configuration file. Repository developers must be familiar with Fusion
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Middleware Control and NQSConfig.INI configuration settings to effectively work
with the Administration Tool and with their repositories.

Some of the most common configuration settings that affect repository development
include:

= Repository File: This option is set in Fusion Middleware Control. It controls the
current published repository.

= Disallow Online RPD Updates: This option is set in Fusion Middleware Control.
It controls whether the Administration Tool opens in read-only mode when
connected to the Oracle BI Server.

s LOCALE: This option is set in NQSConfig.INL. It specifies the locale in which data
is returned from the server and determines the localized names of days and
months.

= DATE_TIME_DISPLAY FORMAT, DATE _DISPLAY FORMAT, TIME_
DISPLAY_FORMAT: These options are set in NQSConfig.INI. They control the
display of date/time formats.

s DEFAULT_PRIVILEGES: This option is set in NQSConfig.INI. It determines the
default privilege (NONE or READ) granted to users and application roles for
repository objects without explicit permissions set.

See Oracle Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition for full information about Fusion Middleware Control and
NQSConfig.INI configuration settings.

About the SampleApp.rpd Demonstration Repository

Oracle Business Intelligence provides a sample repository called SampleApp.rpd that
provides best practices for modeling many different types of objects described in this
guide.

A basic version of SampleApp.rpd, called SampleAppLite.rpd, is automatically
installed as the default repository when you choose the Simple Install option.
SampleAppLite.rpd is located in the following directory:

ORACLE_INSTANCE\bifoundation\OracleBIServerComponent\coreapplication_
obisn\repository

The full version of SampleApp.rpd contains many additional examples and features.
This version can be found on the Oracle Technology Network at:

http://oracle.com/technology/products/bi/enterprise-edition.html

The default password for SampleAppLite.rpd is Admin123. You must immediately
change this default password the first time you open SampleAppLite.rpd in the
Administration Tool. See "Changing the Repository Password" for more information.
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Note: The paint repository shipped with previous versions of Oracle
Business Intelligence is also available with this release in the following
directory:

ORACLE_
INSTANCE\bifoundation\OracleBIServerComponent\coreapplication_
obisn\sample\paint

Paint.rpd is not automatically set up as the default repository. In
addition, paint.rpd is not optimized for this release of Oracle Business
Intelligence and should not be used as a basis for any repositories in
production environments.

Using Online and Offline Repository Modes

You can open a repository for editing in either online or offline mode. The tasks you
can perform depend on the mode in which you opened the repository.

To open a repository, you must enter the repository password. This password is
specific to each repository and is used to encrypt the repository.

This section contains the following topics:

= Opening a Repository in Offline Mode
= Opening a Repository in Online Mode
s Checking Out Objects

s Checking In Changes

= About Read-Only Mode

Opening a Repository in Offline Mode

Use offline mode to view and modify a repository while it is not loaded into the Oracle
BI Server. If you attempt to open a repository in offline mode while it is loaded into
the Oracle BI Server, the repository opens in read-only mode. Only one
Administration Tool session at a time can edit a repository in offline mode. See "About
Read-Only Mode" for more information.

You do not need to enter a user name and password to open a repository in offline
mode. You only need to enter the repository password.

Note: In offline editing, remember to save your repository from time
to time. You can save a repository in offline mode even though the
business models might be inconsistent.

To open a repository in offline mode:

1. In the Administration Tool, select File > Open > Offline.

2. Go to the repository you want to open, and then select Open.

3. In the Open Offline dialog, enter the repository password, and then click OK.

If the server is running and the repository you are trying to open is loaded, the
repository opens in read-only mode. If you want to edit the repository while it is
loaded, you must open it in online mode. Also, if you open a repository in offline
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mode and then start the server, the repository becomes available to users. Any
changes you make become available only when the server is restarted.

When you open a repository in the Administration Tool in offline mode, the titlebar
displays the name of the open repository.

Opening a Repository in Online Mode

Use online mode to view and modify a repository while it is loaded into the Oracle BI
Server. The Oracle BI Server must be running to open a repository in online mode.
There are certain things you can do in online mode that you cannot do in offline mode.
In online mode, you can perform the following tasks:

= Manage scheduled jobs

= Manage user sessions

= Manage the query cache

= Manage clustered servers

To open a repository in online mode:

1. In the Administration Tool, select File > Open > Online to display the Open
Online Repository dialog.

The Oracle BI Server DSNs that have been configured on your computer are
displayed in the dialog. If no additional DSNs have been configured for this
version of the Oracle BI Server, you might see only the default DSN that is
configured for you during installation.

See "Integrating Other Clients with Oracle Business Intelligence" in Oracle Fusion
Middleware Integrator’s Guide for Oracle Business Intelligence Enterprise Edition for
information about how to create an ODBC DSN for the Oracle BI Server.

2. Enter the repository password for the repository currently loaded in the Oracle BI
Server.

You can use Repository tab of the Deployment page in Fusion Middleware Control
to view the name of the current repository.

3. Provide a valid user name and password.

4. If you expect to work extensively with the repository (for example, you plan to
check out many objects), select the Load all objects on startup option. This loads
all objects immediately, rather than as selected. The initial connect time might
increase slightly, but opening items in the tree and checking out items is faster.

5. Select the appropriate DSN and click OK.

When you open a repository in the Administration Tool in online mode, the titlebar
displays the DSN for the Oracle BI Server to which you are connected, not the name of
the current repository.

Guidelines for Using Online Mode

Use caution when making changes to your repository in online mode, and always
perform a consistency check to ensure the repository is consistent before checking in
objects.

In addition, you should limit the number of concurrent online users. The best practice
is to have only one user working in online mode at a time. Even when users have
different objects checked out, there might be dependencies between the objects that
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can cause conflicts when the changes are checked in. In general, only one user should
make online changes in a single business model at a time.

If you must have multiple concurrent users in online mode, do not have more than
five users. For situations where you need more than five users, use the multiuser
development environment. See Chapter 3, "Setting Up and Using the Multiuser
Development Environment" for more information.

Even with a single user making changes, be aware that online mode is riskier than
offline mode because you are working against a running server. If you check in
changes that are not consistent, it might cause the Oracle BI Server to shut down.
When you work in online mode, make sure to have a backup of the latest repository so
that you can revert to it if needed. You can also use File > Undo All Changes to roll
back all changes made since the last check-in.

Checking Out Objects

When you are working in a repository open in online mode, you are prompted to
check out objects when you attempt to perform various operations. Select the objects
you want to check out and click Yes to check out the objects.

If you are performing a task in a wizard, the Checkout screen displays a summary of
the objects that need to be checked out to complete the operation. Click Next to check
out the objects and complete the task.

Checking In Changes

When you are working in a repository open in online mode, you are prompted to
perform a consistency check before checking in the changes you make to a repository.

If you have made changes to a repository and then attempt to close the repository
without first checking in your changes, a dialog opens automatically asking you to
select an action to take. If you move an object from beneath its parent and then attempt
to delete the parent, you are prompted to check in changes before the delete is allowed
to proceed.

Use the Check in Changes dialog to make changes available immediately for use by
other applications. Applications that query the Oracle BI Server after you have
checked in the changes will recognize them immediately. Applications that are
currently querying the server will recognize the changes the next time they access any
items that have changed.

To make changes available and have them saved to disk immediately:
= In the Administration Tool, select File, then select Check In Changes.

If the Administration Tool detects an invalid change, a message is displayed to alert
you to the nature of the problem. Correct the problem and perform the check-in again.
Note that you can select a message row and click Go To, or double-click a message
row, to go directly to the affected object.

You must save changes to persist the changes to disk. You must check in changes
before you can save, but you do not need to save to check in changes.

About Read-Only Mode

Only one component (either the Oracle BI Server, or a single Administration Tool
client in offline mode) can have a repository open in read /write mode at a time. If a
second component opens a repository that is already in use, the repository is opened
in read-only mode.
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For example, assume the Oracle BI Server loads a repository in read/write mode. Any
number of Administration Tool clients connecting to that repository in online mode
will also get read /write mode, because they are accessing the repository through the
Oracle BI Server. However, Administration Tool clients opening that repository in
offline mode will get read-only mode, because the repository is already open for
read/write through the Oracle BI Server.

Alternatively, assume an Administration Tool client opens a repository offline in
read/write mode. When the Oracle BI Server starts, it will get read-only mode, as will
any Administration Tool clients connecting to that repository in either offline or online
modes. To enable the server to load the repository in read /write mode in this
situation, you must first close the Administration Tool client that has the repository
locked, and then restart the Oracle BI Server.

The Administration Tool also opens a repository in read-only mode when Oracle
Business Intelligence has been clustered, and the Administration Tool is connected in
online mode to a slave server. This occurs because the Master BI Server holds a lock on
the repository. To avoid this situation when running in a clustered environment,
ensure that the Oracle BI Server ODBC DSN used by the Administration Tool has been
configured to point to the Cluster Controllers rather than to a particular Oracle BI
Server.

In addition, the Administration Tool opens repositories in read-only mode when the
configuration setting Disallow Online RPD Updates has been selected in Fusion
Middleware Control. See "Using Fusion Middleware Control to Disallow RPD
Updates" in Oracle Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information about this configuration setting.

Checking the Consistency of a Repository or a Business Model

Repository metadata must pass a consistency check before you can make the
repository available for queries. The Consistency Check Manager lets you enable and
disable rules for consistency checks, find and fix inconsistent objects, and limit the
consistency check to specific objects.

This section contains the following topics:
= About the Consistency Check Manager
»  Checking the Consistency of Repository Objects

About the Consistency Check Manager

The Consistency Check Manager checks the validity of your repository to ensure that
it can load at run time, and to identify any syntax or semantic errors that may cause
queries to fail.

Each time you save the repository, a dialog asks if you want to check global
consistency. You have the following options:

= Yes. Checks global consistency and then saves the repository file.
= No. Does not check global consistency and then saves the repository file.
= Cancel. Does not check global consistency and does not save the repository file.

The Consistency Check Manager does not check the validity of objects outside the
metadata using the connection. It only checks the consistency of the metadata and not
any mapping to the physical objects outside the metadata. If the connection is not
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working or objects have been deleted in the database, the Consistency Check Manager
does not report these errors.

If you use lookup tables to store translated field names with multilingual schemas,
note that consistency checking rules are relaxed for the lookup tables. See "Localizing
Oracle Business Intelligence Deployments" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information about localization and lookup tables.

The consistency checker returns the following types of messages:

s Errors. These messages describe errors that need to be fixed. Use the information
in the message to correct the inconsistency, then run the consistency checker again.
The following is an example of an error message:

[38082] Type of Hierarchy '"ORT C41"..."ORT_C41/MDF_BW_QO02"."Product Hierarchy
for Material MARA"' in Cube Table '"ORT_C41"..."ORT_C41/MDF_BW_Q02"' needs to
be set.

If you disable an object and it is inconsistent, a message is displayed, asking if you
want to make the object unavailable for queries.

= Warnings. These messages indicate conditions that may or may not be errors. For
example, you might receive a warning message about a disabled join that was
intentionally disabled to eliminate a circular join condition. Other messages may
warn of inconsistent values, or feature table changes that do not match the
defaults. The following is an example of a warning message:

[39024] Dimension '"Paint"."MarketDim"' has defined inconsistent values in its
levels' property 'Number of elements'.

»  Best Practices. These messages provide information about conditions, but do not
indicate an inconsistency. The message appears if a condition violates a best
practice recommendation.

Note: After upgrading from a previous software version and
checking the consistency of your repository, you might notice
messages that you had not received in previous consistency checks.
This typically indicates inconsistencies that had been undetected
before the upgrade, not new errors.

In the Consistency Check Manager, you can sort the rows of messages by clicking the
column headings. Additionally, the status bar provides a summary of all the rows
displayed.

Checking the Consistency of Repository Objects

You can check consistency in the following ways:

s To check consistency for all objects in the repository, select File, then select Check
Global Consistency.

»  To check the consistency of a particular repository object, such as a physical
database, business model, or subject area, right-click the object and select Check
Consistency.

s If you already have the Consistency Check Manager open, you can check global
consistency by clicking Check All Objects.
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To view the Consistency Check Manager without performing a global consistency
check, select Tools, then select Show Consistency Checker. If you have checked
consistency in the current session, the messages from the last check appear in the
Messages pane.

To check the consistency of a repository:

1. In the Administration Tool, select File, then select Check Global Consistency. The
Consistency Check Manager is displayed, listing any messages relating to the
current repository.

Note: If you disable an object and it is inconsistent, a dialog appears,
asking whether you want to make the object unavailable for queries.

2. To edit the repository to correct inconsistencies, double-click any cell in a row to
open the properties dialog for that object. Then, correct the inconsistency and click
OK.

3. To copy the messages so that you can paste them in another file such as a
spreadsheet, select one or more rows and click Copy. Note that clicking Copy
without any rows selected copies all messages.

4. To check consistency again, click Check All Objects to perform a global check. Or
click the Refresh button in the top right corner to check only the objects that were
listed as inconsistent in the last check.

5. When finished, click Close.

To check the consistency of a single object in a repository:

1. In the Administration Tool, right-click an object, then select Check Consistency.
If the object is not consistent, a list of messages appears.

2. To edit the repository to correct inconsistencies, double-click any cell in a row to
open the properties dialog for that object. Then, correct the inconsistency and click
OK.

3. To copy the messages so that you can paste them in another file such as a
spreadsheet, click Copy.

4. To check consistency of the object again, click the refresh button at the top right
corner of the dialog.

If you click Check All Objects, all objects in the repository are checked.
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Setting Up and Using the Multiuser
Development Environment

Multiuser development (MUD) provides a mechanism for concurrent development on
overlapping code bases. Oracle Business Intelligence provides a MUD environment
that manages subsets of metadata, in addition to multiple users, by providing a
built-in versioning system for repository development. This chapter explains how to
set up and use the multiuser development environment in Oracle Business
Intelligence, including defining projects, setting up the multiuser development
directory, checking out and checking in projects, and merging metadata.

See also "Managing the Repository Lifecycle in a Multiuser Development
Environment" for additional information about working in a multiuser development
environment.

This chapter contains the following topics:

= About the Multiuser Development Environment

»  Setting Up Projects

= Setting Up the Multiuser Development Directory

= Making Changes in a Multiuser Development Environment
»  Checking In Multiuser Development Repository Projects

s Branching in Multiuser Development

= Viewing and Deleting History for Multiuser Development

= Setting Multiuser Development Options

About the Multiuser Development Environment

In Oracle Business Intelligence, multiuser development facilitates the development of
application metadata in enterprise-scale deployments. Application metadata is stored
in a centralized metadata repository (RPD) file. The Administration Tool is used to
work with these repositories.

The following are examples of how you might use a multiuser development
environment:

= Several developers work concurrently on subsets of the metadata and then merge
these subsets back into a master repository without their work conflicting with
other developers. For example, after completing an implementation of data
warehousing at a company, an administrator might want to deploy Oracle
Business Intelligence to other functional areas.
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Note: In this chapter, "master repository" refers to the copy of a
repository in the multiuser development directory

= Asingle developer manages all development. For simplicity and performance, this
developer might want to use the multiuser development environment to maintain
metadata code in smaller chunks instead of in a large repository.

In both examples, an administrator creates projects in the repository file in the
Administration Tool, then copies this repository file to a shared network directory
(called the multiuser development directory). Developers are able to check out
projects, make changes and then merge the changes into the master repository. When
developers check out projects using the Administration Tool, files are automatically
copied and overwritten in the background. Therefore, it is important for the
administrator to perform setup tasks and for the developers to perform check-out and
check-in procedures carefully, paying close attention to the Administration Tool
messages that appear.

When developers check out projects, repository files are not automatically copied or
overwritten. Instead, the Administration Tool creates two new files when projects are
checked out: one to hold the original project data, and one to hold the project changes.

For example, when a repository developer checks out project A from master.rpd in the
C:\multiuser development directory, the Administration Tool extracts all metadata
related to project A and prompts the developer for a new file name to save the data.
When the developer chooses a new file name, for example Mychanges.rpd, the
Administration Tool creates two new files:

= A file called MyChanges.rpd that will contain the changes made by the developer
= A file called originalMyChanges.rpd that contains the original project data

The originalMyChanges.rpd file helps determine what changes have been made by the
developer in Mychanges.rpd. This information is needed during the multiuser
development merge process.

Note: To reduce storage needs, repositories in Oracle Business
Intelligence Enterprise Edition 11¢ Release 1 (11.1.1) are stored in a
compressed format. Because of this, you may notice that the size of an
RPD file opened and saved in this release is significantly smaller than
the size of RPD files from previous releases.

About the Multiuser Development Process

Multiuser development presupposes a clear understanding of customer technical and
business objectives. It also requires that you follow clearly defined development
processes and adhere rigorously to those processes, including consistent merging and
reconciliation practices.

The following procedure shows the general steps to follow when deploying a
multiuser development environment. The first three steps are usually performed by an
administrator, and the remaining steps are usually performed by one or more
developers.

To deploy a multiuser development environment:

1. Define projects to organize voluminous metadata into manageable components.
See "Creating Projects" for more information. Consider these tips:
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s Use smaller RPDs to shorten and simplify development effort and unit testing.

= Organize development resources by projects to spread workload and reduce
inconsistencies and overwrites.

Set up a shared network directory to use as the multiuser development directory.
Copy the master repository to the multiuser development directory.

Extract one or more projects for local development.

o ©Dbd

Merge repository objects and resolve conflicts.

= Because metadata objects are often highly interrelated, several developers
could be working on the same objects.

= When configuration conflicts occur during check in, developers are prompted
for the correct process.

= The master repository is locked for check-ins when you merge your local
changes. However, other developers can still perform check-outs.

6. Publish changes to the network.

= Many developers can simultaneously work on the same objects, but only one
can publish at a time. During the publish, no check-outs are allowed.

7. Use Logging and Backup features to identify points of erroneous or incorrect
configuration.

s The log file tracks multi-development activity, along with comments.

s The master repository and developer repositories are automatically backed up
for future reference and for use in manual rollback.

Setting Up Projects

Projects are the central enabler of metadata management. A project consists of a
discretely-defined subset of the repository metadata, in the form of groups of logical
stars with associated metadata. A project has the following characteristics:

» Islargely defined by logical fact tables in the applicable business model

= Automatically adds related logical dimension tables and other metadata during
extract

= Can have one to many logical fact tables

For projects that are just beginning, the best practice is to begin with a repository
containing all the necessary physical table and join definitions. In this repository, you
create a logical fact table as a placeholder in the Business Model and Mapping layer
and a subject area as a placeholder in the Presentation layer. As you add business
model and subject area metadata, new projects based on individual subject areas and
logical facts can be created.

Note: Only one person at a time can create projects in a master
repository.

This section contains the following topics:
= About Projects

s Creating Projects
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= About Converting Older Projects During Repository Upgrade

About Projects

Projects can consist of Presentation layer subject areas and their associated business
model logical facts, dimensions, groups, users, variables, and initialization blocks.
Administrators can create projects so that developers and groups of developers can
work on projects in their area of responsibility.

The primary reason to create projects is to support multiuser development. During the
development process, you can split up the work (metadata) between different teams
within your company by extracting the metadata into projects so that each project
group can access a different part of the metadata.

In addition to multiuser development, you may want to create projects for licensing
reasons. Before releasing a new software version, you may want to ensure that only
the metadata that is relevant to the licensed application is in a project and that
everything is consistent and complete. You can accomplish this by adding only the fact
tables that are relevant to the application.

Project extractions are fact table centric. This ensures that project extracts are
consistent and makes licensing much easier to manage.

About the Project Dialog

In the Project dialog, the left pane contains objects that you can use to create a project.
The objects in the right pane are all the objects you chose (directly or indirectly) that
reflect the complete set of data that makes each addition consistent. For example, if
you select a subject area from the top node of the left-hand tree to add to your project,
underlying fact tables of other subject areas are automatically added if needed to make
the extract consistent.

The following describes the left pane of the Project dialog;:

= You can choose to group fact tables by Business Model or Subject Area, to help
select the fact tables you want. Typically, grouping fact tables according to which
ones are used by a particular subject area is a more convenient way to choose fact
tables for your project. Note that a fact table can be associated with multiple
subject areas, but belongs to one and only one business model.

Although it appears that you can add a subject area from the top node when you
group facts by subject area, you are actually adding only the underlying fact
tables. The subject areas only appear as choices to help you to add the elements
you want in your project. Additionally, it adds any other objects that are necessary
to make the extract consistent. To add an actual subject area, use the Presentation
node at the bottom of the tree.

= When grouped by business model, the left pane displays only facts that belong to
the business model.

s The Presentation node contains presentation layer objects. You must explicitly
include these objects in your project if you want to work with them; they are not
added automatically.

If you add presentation objects that are not related to any fact tables in the project,
a warning appears when you click OK. The consistency checker also notes this
discrepancy.

The right pane of the Project dialog shows the objects you select to be extracted, such
as fact tables (under the Business Models folder), Presentation layer objects (under the
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Presentation folder), users, application roles, variables, and initialization blocks. These
objects are extracted when you click OK.

Figure 3-1 shows the Project dialog.

Figure 3—1 Project Dialog with Fact Tables Grouped by Business Model
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Creating Projects

When creating a project, you typically select a subject area or a subset of logical fact
tables related to the selected subject area, and the Administration Tool automatically
adds any business model and Physical layer objects that are related. An object can be
part of multiple projects. Alternatively, if you choose to group facts by business
model, you can select a particular business model or a set of logical fact tables that are
part of a business model. You also need to explicitly add any Presentation layer objects
if you want them to be part of your project.

Note that although the project definition itself does not include Physical layer objects,
these objects are extracted and determined through the project definition.

After you create projects, they become part of the metadata and are available to
multiple developers who need to perform development tasks on the same master
repository. When defined this way, projects typically become a consistent repository
after a developer checks out the projects and saves them as a new repository file.

To create a project for a multiuser development environment:
1. In the Administration Tool, choose File > Open > Offline.

2. Inthe Open dialog, select the repository that you want to make available for
multiuser development, then click OK. Provide the repository password, then
click OK again.

3. Select Manage, then select Projects.

4. In the Project Manager dialog, in the right pane, right-click and then select New
Project.

The left pane contains the objects that are available to be placed in a project. The
right pane contains the objects that you select to be part of the project.

5. In the Project dialog, type a name for the project.
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6. Choose whether to group facts by business model, or subject area. It is typically
more convenient to group facts by subject area.

7. Perform one or more of the following steps to add fact tables to your project:

— In the left pane, select a subject area or business model and then click Add.
The Administration Tool automatically adds all the associated logical fact
tables.

— In the left pane, expand the subject areas or business models and select one or
more logical fact tables that are related to the subject area or that are within
the business model, then click Add.

The project is defined as explicitly containing the selected logical fact tables
and implicitly containing all logical dimension tables that are joined to the
selected logical fact tables (even though they do not appear in the right pane).

See "About the Project Dialog" for more information about the objects that appear
in the left and right panes.

8. To remove fact tables from the project, in the right pane, select a fact table and
click Remove. You can also remove all fact tables associated with a subject area or
business model by selecting a subject area or business model and clicking
Remove.

9. Optionally, add any application roles, users, variables, or initialization blocks
needed for the project. Although objects like variables and initialization blocks
that are directly referenced by other extracted objects are included automatically,
you might want to include objects in your project that are not referenced. For
example:

= If you are using initialization blocks for authentication, include any necessary
initialization blocks.

s Include repository variables or other objects that are not yet referenced by
other objects, but that you might want to use in future repository
development.

s Include users and application roles that are currently being used, or will be
used in the future, as part of your data access security settings.

Tip: You may want to add the top node for each object type (for example,
Variables), then selectively remove individual objects from the right pane.

10. Select the Presentation layer objects that you want to include in your project from
the left pane and click Add. You must add these objects to see them in the project;
they are not added automatically.

You can also remove particular presentation tables or columns from the project
definition by double-clicking the object in the right pane, or selecting the object
and clicking Remove.

Note: If you do not see the set of subject areas you expect after the
project is created, edit the project to explicitly add the subject areas
you need.

11. Click OK.
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About Converting Older Projects During Repository Upgrade

When you upgrade a repository from Oracle Business Intelligence versions before
10.1.3.2, the project definition is upgraded. During the upgrade, the project definition,
subject areas, target levels, list catalogs, and existing fact tables are automatically
converted into simple fact tables in the following way:

= Get presentation columns related to the target levels through the qualifying keys.
= Get presentation columns related to the list catalogs through the qualifying keys.
= Get presentation columns related to the subject areas.

s Get all the logical columns from all the presentation columns.

s Get all the logical columns from the fact tables in the project.

= Get the fact tables from all the logical columns.

After the upgrade, projects contain only simple fact tables. All the security objects
remain unchanged.

In addition, projects in repositories from any version before 11g Release 1 (11.1.1) are
upgraded so that they explicitly contain Presentation layer objects. In previous
releases, Presentation layer objects were implicitly included based on the permissions
of the users included in the project.

Setting Up the Multiuser Development Directory
To prepare for multiuser development, an administrator performs the following tasks:

»  Identify or create a shared network directory that will be dedicated to multiuser
development.

= After creating all projects, copy the repository file in which you created the
projects to the multiuser development directory where it will be used as your
master repository for multiuser development.

After the administrator has identified the multiuser development directory and copied
the repository file, developers must set up to the Administration Tool to point to the
multiuser development directory before they can check out projects.

This section contains the following topics:

» Identifying the Multiuser Development Directory

= Copying the Master Repository to the Multiuser Development Directory
= Setting Up a Pointer to the Multiuser Development Directory

Identifying the Multiuser Development Directory

After defining all projects, the administrator must identify or create a shared network
directory (called the multiuser development directory) that all developers can access,
and then upload the new master repository to that location. This shared network
directory should be used only for multiuser development. This directory typically
contains copies of repositories that need to be maintained by multiple developers. The
multiuser development directory must be on a Windows system.

Developers create a pointer to the multiuser development directory when they set up
the Administration Tool on their computers.
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Caution: The administrator must set up a separate, shared network
directory that is dedicated to multiuser development. If not set up and
used as specified, critical repository files can be unintentionally
overwritten and repository data can be lost.

Copying the Master Repository to the Multiuser Development Directory

After the multiuser development directory is identified, the administrator must copy
the master repository file to the multiuser development directory. Projects from this
master repository will be extracted and downloaded by the developers who will make
changes and then merge these changes back into the master repository.

After you copy the repository to the multiuser development network directory, notify
developers that the multiuser development environment is ready.

Setting Up a Pointer to the Multiuser Development Directory

Before checking out projects, each developer must set up their Administration Tool to
point to the multiuser development directory on the network. The Administration Tool
stores this path in a hidden Windows registry setting on the workstation of the
developer and uses it when the developer checks out and checks in objects in the
multiuser development directory.

Note: Until the pointer is set up, the multiuser options are not
available in the Administration Tool.

Initially, the network directory contains the master repositories. The repositories in
this location are shared with other developers. Later, the network directory contains
additional multiuser development history files, including historical subsets and
repository versions. Do not manually delete any files in the multiuser development
directory; these files are important and are used by the system.

When setting up the pointer, the developer can also complete the Full Name field.
Although the field is optional, it is recommended that the developer complete this
field to allow other developers to know who has locked the repository. The Full Name
value is stored in HKEY_CURRENT_USER in the registry, and is unique for each login.

To set up a pointer to the multiuser development directory:
1. From the Administration Tool menu, choose Tools > Options.
2. In the Options dialog, click the Multiuser tab.

3. In the Multiuser tab, for Multiuser development directory, enter the full path to
the network directory.

Alternatively, click Browse, select the multiuser development directory, and then
click OK.

4. In the Full Name field, type your complete name, then click OK.

Making Changes in a Multiuser Development Environment

During check-out and check-in, a copy of the master repository is temporarily copied
to the developer's local repository directory (typically, ORACLE_
INSTANCE\Dbifoundation\OracleBIServerComponent\coreapplication_
obisn\repository by default). After checking out projects and making changes in a
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local repository file, each developer can check in (merge) changes into the master
repository or discard the changes.

To make changes in a multiuser development environment, perform the tasks
described in the following sections:

s Checking Out Repository Projects
s About Changing and Testing Metadata

= About Multiuser Development Menu Options

Checking Out Repository Projects

After setting up a pointer to the multiuser development default directory, a developer
can check out projects, change metadata, and test the metadata. In the File > Multiuser
submenu, the Checkout option is only available when there is a multiuser
development directory defined in the Multiuser tab of the Options dialog.

If a developer checks out a local repository and attempts to exit the application before
publishing it to the network or discarding local changes, a message appears to allow
the developer to select an action. See "About Closing a Repository Before Publishing It
to the Network" for more information.

This section contains the following topics:

= About Repository Project Checkout

s Checking Out Projects

= Using the extractprojects Utility to Extract Projects

About Repository Project Checkout
During checkout, the Administration Tool performs the following tasks:

= Inthe developer's local repository directory, the Administration Tool makes a
temporary copy of the master repository.

Note: If a repository with that name exists in this location, the
developer is asked to confirm overwriting the existing repository. If
the developer clicks Yes, the existing local repository is immediately
overwritten in the background and after the new repository is saved,
the temporary master repository file is automatically deleted.

= In the developer's local repository directory, the Administration Tool saves a local
copy of the selected projects in a new repository, such as Metadatal.rpd. The
developer provides a name for the local copy. The developer makes metadata
changes in this file. The number is incremented for each checkout for that session.

= In the developer's local repository directory, the Administration Tool saves a
second local copy of the new repository, adding 'original’ as the prefix (for
example, originalMetadatal.rpd).

= After the developer saves the new repository file, check out is complete. In the
developer's local repository directory, the temporary copy of the master repository
is automatically deleted.
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Caution: When the developer selects and saves the projects to a local
repository file, the Administration Tool does not place a lock on the
projects in the master repository on the shared network drive.
Therefore, nothing physically prevents others from working on the
same project. To determine if a project has been checked out, you need
to look in the log file in the multiuser development directory on the
shared network drive.

Checking Out Projects

This section explains how to check out projects using the Administration Tool.
To check out projects:
1. From the Administration Tool menu, choose File > Multiuser > Checkout.

2. If there is more than one repository in the multiuser development directory, the
Multiuser Development Checkout dialog appears. Select the appropriate
repository, and then click OK.

This dialog does not appear if there is only one repository in the multiuser
development directory.

3. In the Extract from dialog, type the repository password, and then click OK.

If no projects exist in the repository, a message appears and the repository does
not open.

4, If there is more than one project in the master repository, the Browse dialog
appears. Select the projects that you want to be part of your project extract, and
then click OK.

Figure 3-2 shows the Browse dialog for selecting projects.

Figure 3-2 Browse Dialog for Selecting Projects
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If only one project exists in the master repository, it is selected automatically and
the Browse dialog does not appear.

5. In the Create new subset repository dialog, type a name for the new repository
(for example, Metadatal.rpd) and then click Save.

A working project extract repository is saved on your local computer. The name is
exactly as you specified and is opened in offline mode. A log file is also created.
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Caution: A second copy of the project extract repository is saved in
the same location. The name of this version contains the word
"original" added to the beginning of the name that you assigned to the
repository extract. Do not change the original project extract
repository. It is used during the multiuser development merge
process, and when you want to compare your changes to the original
projects.

Using the extractprojects Utility to Extract Projects

You can use the Oracle BI Server utility extractprojects to extract projects from a given
repository without the overhead of the MUD environment. You can run this utility on
any platform supported by the Oracle BI Server.

The extractprojects utility generates an RPD file that includes the set of projects you
specify. The utility does not perform other tasks that are performed when you check
out projects using the Administration Tool, like saving an original repository file or

tracking the extract as a check-out in the MUD directory.

Before running extractprojects, you must first run bi-init.cmd (or bi-init.sh on UNIX
systems) to launch a command prompt that is initialized to your Oracle instance. You
can find this utility in:

ORACLE_INSTANCE /bifoundation/OracleBIApplication/coreapplication/setup

Then, run extractprojects from the resulting command prompt with the desired
options. You can run the utility from this directory with no arguments or parameters
to see usage information.

The utility takes the following parameters:

extractprojects -B base_repository name -0 output_repository_name {-I input_
project_name} [-P repository_password] [-L]

Where:

base_repository_name is the name and path of the repository from which you
want to extract projects.

output_repository name is the name and path of the repository generated by the
utility.

input_project_name is the name of a project you want to extract. You can enter
multiple projects. Be sure to precede each project entry with -I (for example, -I projectl
-1 project2). If the project name contains spaces, enclose it in double quotes (for
example, "project 1").

repository._password is the password for the repository from which you want to
extract projects.

Note that the repository_ password argument is optional. If you do not provide
the password argument, you are prompted to enter the password when you run the
command. To minimize the risk of security breaches, Oracle recommends that you do
not provide password arguments either on the command line or in scripts. Note that
the password argument is supported for backward compatibility only, and will be
removed in a future release.

- L enables logging. When logging is enabled, a log file in the format
ProjExtr.YYYYMMDD.HHMMSS xml is created in the Oracle BI Server logging
directory. For example:
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ORACLE_INSTANCE/diagnostics/logs/OracleBIServerComponent/coreapplication_
obisn/ProjExtr.20100616.082904.xml
Example

The following example extracts projectl and project2 from my_repos.rpd and creates a
new repository called extract_repos.rpd:

extractprojects -B my_repos.rpd -0 extract_repos.rpd -I projectl -I project2
Give password: my_rpd_password

Note: Be sure to provide the full pathnames to your repository files,
both the input file and the output file, if they are located in a different
directory.

About Changing and Testing Metadata

Most types of changes that can be made to standard repository files are also supported
for local repository files. Developers can add new logical columns, logical tables,
change table definitions, logical table sources, and so on. Developers may also work
simultaneously on the same project locally. It is important to note, however, that
Oracle Business Intelligence assumes the individual developer understands the
implications these changes might have on the master repository. For example, if a
developer deletes an object in a local repository, this change is propagated to the
master repository when local changes are merged without a warning prompt.

To ensure metadata integrity, you should not remove a physical column unless there
are no logical table source mappings to that physical column. Because of this, if you
are using a multiuser development environment, you cannot delete a logical column
and its associated physical column at the same time. Instead, you must first delete the
logical column and perform a merge. Then, you can delete the physical column and
perform another merge to safely remove the object.

You should not modify physical connection settings in a local repository. These are
intentionally not propagated, and developers should not test the master connection
pool settings in local environments. Instead, developers should apply settings for their
local test data sources to perform unit testing of their model changes.

Physical connection settings, security settings, and database feature table changes are
not retained in a multiuser development merge to prevent developers from
overwriting passwords and other important objects in the master repository.

After making changes to a local repository, the developer can edit the local
NQSConfig.INI file, enter the name of the repository as the default repository, and test
the edited metadata.

Note: DSNs specified in the metadata must exist on the developer's
workstation.

About Multiuser Development Menu Options

After the local developer makes changes, tests the changes, and saves the repository
locally, the local developer can perform the following tasks from the File > Multiuser
submenu:

s Compare with Original. Compares the working extracted local repository to the
original extracted repository. When this option is selected, the Compare
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repositories dialog opens and lists all the changes made to the working extracted
repository since you checked out the projects.

s Merge Local Changes. Locks the master repository on the network multiuser
directory to allow you to check in your changes. See "Checking In Multiuser
Development Repository Projects" for more information.

= Publish to Network. After you successfully merge your changes, the master
repository opens locally and the Publish to Network submenu item is available.
When you select this option, the lock is removed, the repository is published, and
the repository closes. See "Checking In Multiuser Development Repository
Projects" for more information.

= Undo Merge Local Changes. Rolls back any previously merged local changes, and
leaves the repository checked out so that you can make additional changes and
then merge your local changes again. This option is only available after you have
already merged local changes.

s Discard Local Changes. Any time after check out and before check in, you can
discard your changes. When you select this option, the working repository closes
without giving you an opportunity to save your work.

Caution: If you select this option, there is no opportunity to change
your mind. For example, no confirmation dialog appears.

About Closing a Repository Before Publishing It to the Network

If you attempt to close an unpublished, locked repository without selecting an option
in the File > Multiuser submenu, the Closing MUD repository dialog opens with the
following options:

»  Publish repository. Publishes the merged repository to the network share as the
new master, releases the lock on the master, and the event is logged. This option is
available after a Merge Local Changes event occurs. This option is also available
on the File > Multiuser submenu.

s Discard local changes. Releases the lock on the master repository and records the
event in the log. This option is available after a Checkout or Merge Local Changes
is performed and can be found on the File > Multiuser submenu.

= Close repository and keep lock. This closes the repository, leaving the master
repository locked.

= Undo merge local changes. Rolls back your previously merged local changes, and
leaves the repository checked out so that you can make additional changes and
then merge your local changes again.

Checking In Multiuser Development Repository Projects

After changing and testing the metadata on a local computer, the developer must
check the projects into the master repository in the multiuser development directory.
Only one developer at a time can merge metadata from a local repository into the
master repository. Therefore, the master repository is locked at the beginning of the
merge process.

The Oracle BI repository development process uses a three-way merge to manage
concurrent development. Metadata merges are done first on local environments and
then merged with the master repository. A three-way merge identifies local changes
based on the following repository characteristics:
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The Master RPD
The Baseline RPD or Master RPD snapshot at time of project extraction
The current locally developed and changed RPD

Changes are managed by merge and reconciliation. Most of the merging process is
automatic, and changes do not conflict. In case of any conflicting metadata sources,
developers can locate and resolve them.

An administrator can also merge the changes from multiple repositories manually, or
import objects from different repositories outside of a particular MUD environment.

Make sure to merge your changes frequently. The merge process is very complex and
can become difficult if there are too many changes. See Appendix D, "Merge Rules" for
more information about how objects are merged during the merge process.

This section contains the following topics:

About the Multiuser Development Merge Process
Checking In Projects
Tracking Changes to the Master Repository

About the Multiuser Development Merge Process

The merge process involves the following files:

Original of the local (subset) repository. Contains the state of the projects as
originally extracted. This repository name begins with "original." An example of
the file name for this copy might be originalDevelopment2.rpd. This version is
stored in the same location as the modified (or working) version of the local
repository.

Modified local (subset) repository. Contains the extracted projects after being
modified by the developer. This version is stored in the same location as the
original version of the local repository.

Latest master repository in the multiuser development directory. Note that this
file may have been modified by other developers before this merge.

During the merge, the Administration Tool checks for added objects and if found, a
warning message appears. The following list describes what happens during this step:

Warning about added objects. When a person checks out a project, they have the
ability to modify that project in any way and check it back in. Deletions and
modifications are ways in which the integrity of the project is maintained.
However, adding objects might introduce objects into the repository that do not
belong to any project. Therefore, all project related objects are checked and if a
new object is found, a warning message appears.

Caution: You must add newly created metadata to the project
definition in the master repository for it to be visible in future
extracted versions of the project. For example, if a developer checks
out a project, adds a new object, and then checks it in, the new object
is not visible in extracted versions of the project until it is explicitly
added to the project definition. See "Creating Projects” for instructions.

Aggregation of related objects. In the warning message, only the parent object is
reported. The Administration Tool aggregates all the objects to make the message
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more usable. For example, if a developer added a new business model, only the
business model appears in the warning message to the user, not the tables,
columns, dimensions, and so on.

When a developer publishes changes to the network, the following actions occur:

= The master repository in the multiuser development directory is overwritten with
the repository containing the developer's changes.

»  The master_repository.Ick file is deleted. If another developer checks out the
changed project from the master repository, the changes made by the first
developer are exposed to the other developer.

How are Multiuser Merges Different from Standard Repository Merges?

The multiuser development check-in process uses the same technology as the standard
repository merge process with a few important differences. See "Performing Full
Repository Merges" for more information about the standard repository merge.

The following list describes the differences that occur during a multiuser development
merge:

s Inserts (created objects) are applied automatically. Because a subset of the master
repository is being used as the original repository, most objects in the master
repository appear to be new. This would result in many unnecessary prompts that
the developer would have to manually approve. Therefore, new objects are
created without a prompt during a multiuser development merge.

s Conlflicts that are not inserts but are resolved because of the automatic inserts are
applied without a prompt during a multiuser development merge.

s The database and connection pool properties in the master repository take
precedence over the same properties on the developer's computer. This
precedence are applied without a prompt during a multiuser development merge.

= Changes to security settings are not retained when you perform a MUD merge to
prevent developers from overwriting passwords and other important objects in
the master repository.

To change security settings or database features in a multiuser development
environment, you must edit the master repository directly. To do this, remove the
master repository from the multiuser development directory, edit it in offline mode,
then move it back.

Checking In Projects

When the check-in process begins, the following actions occur:

s The Administration Tool determines if the master repository is currently locked. If
not, it locks the master repository, preventing other developers from performing a
merge until the current merge is complete, and records the lock in the log file.

= For other developers, the Merge Local Changes option on the File > Multiuser
menu is unavailable until the current check-in process has been successfully
completed.

s The Administration Tool automatically copies the current version of the master
repository from the multiuser development directory to the local repository
directory on the developer's computer (typically ORACLE_BI_

HOMEN\ orainst\bifoundation\OracleBIServerComponent\ coreapplication\reposi
tory) and updates the log files in the local and multiuser development directories.
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This is necessary because the master repository in the multiuser development
directory might have changed after the developer checked out the projects.

To check in projects to the master repository:

1. In the Administration Tool, select File > Multiuser > Merge Local Changes, then
click Yes if prompted to save changes.

2. Inthe Lock Information dialog, in the Comment field, type a description of the
changes that you made, then click OK.

Figure 3-3 shows the Lock Information dialog.

Figure 3-3 Lock Information Dialog
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3. If there are any conflicts, the Merge Repository Wizard opens and displays the
Define Merge Strategy screen. Make merge decisions about whether to include or
exclude objects by choosing Current or Modified from the Decision list. When
you select an object in the decision table, the read-only text box below the decision
table describes what changes were made to that object in the current repository.
You can also click View Change Statistics to see a summary of changes. Click
Finish when you are finished making merge decisions.

See "Performing Full Repository Merges" for additional information about the
Define Merge Strategy screen.

A lack of conflicts does not mean that there are no differences between the
repositories. Instead, it means that there are no decisions that have to be explicitly
made by the developer to check in changes. See "How are Multiuser Merges
Different from Standard Repository Merges?" for information about conflicts that
are resolved automatically in a MUD merge.

In both cases, a CSV file is created in the local directory that contains details of the
merged changes.

4, After you confirm all the changes, click Save.

This saves the merged repository locally, and then uploads this repository to the
multiuser development directory with an incremented numeric file extension (for
example, Master_Sales.000, Master_Sales.001, and so on).

At this point, the changes made by the developer are still not saved to the master
repository in the multiuser development directory.

5. To commit these changes to the master repository in the multiuser development
directory, select File > Multiuser > Publish to Network, then click OK.
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The master repository in the multiuser development directory is overwritten with
the copy of the repository containing the developer's changes.

Tracking Changes to the Master Repository

You can find a summary of the development activities on the master repository in
master_repository.log. This log contains a record of the following activities:

= Projects that have been checked in and checked out and when these actions
occurred

s The Windows login name and computer name initiating the transaction

s When locks are created and removed

Branching in Multiuser Development

Branching is a further refinement of the merging development process. Branching can
provide higher efficiencies over large development teams that have overlapping
releases, but it requires significant administrative overhead.

This section contains the following topics:

= About Branching

s Using the Multi-Team, Multi-Release Model in Oracle Business Intelligence
= Synchronizing RPD Branches

About Branching

In branching, developers work on private branches to isolate their code from other
developers and merge changes back to the main branch. Different strategies can be
followed, depending on the size of the development team.

In the Simple Development Model, all development occurs on a single main branch.
This strategy has the following characteristics:

= Only for emergency fixes
s Checkouts may not be most current code
»  Carries a stability risk for the mainline branch

Figure 3—4 shows the Simple Development Model.

Figure 3—4 Simple Development Model
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In the Small Team Development Model, development occurs on a single Dev branch,
with a separate Main branch strictly for releases. This strategy has the following
characteristics:
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s The Mainline is the official release branch

= Development occurs on a separate branch

= Stable code is merged back to Main at key milestones
= Branches are synchronized periodically

Figure 3-5 shows the Small Team Development Model.

Figure 3-5 Small Team Development Model
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In the Multi-Team, Multi-Release Model, development occurs on multiple Dev
branches, again with a separate Main branch strictly for releases. This strategy has the
following characteristics:

= Supports more efficiency over disparate teams

= Development occurs on separate branches

= Stable code is merged back to Main at key milestones
= Branches are synchronized periodically

Figure 3-6 shows the Multi-Team, Multi-Release Model.

Figure 3—-6 Multi-Team, Multi-Release Model
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Using the Multi-Team, Multi-Release Model in Oracle Business Intelligence

Using complex branching strategies in Oracle Business Intelligence requires attentive
organization of repository files, as well as altering the Multiuser setting in the
Administration Tool. The following procedure provides an overview of the required
steps.

To use the multi-team, multi-release model branching strategy:

1.

Create a Main repository (Master Repository) and store it in the Master multiuser
development directory.

= Projects must be explicitly defined.
= Branch developers should not have access to the Master directory.

Create a subset of branch repositories by extracting from Main and storing them as
the Team1 and Team?2 multiuser development directories. The Main and Team
RPDs must be stored and secured in separate directories on the network.

Developers must check out, develop, merge, and publish from their respective
Team RPDs. Developers Al through A3 and B1 through B3 should manage their
metadata work and merge to their Team repository.

s Teams 1 and 2 must maintain their own repositories and periodically
synchronize from Main to Team branches.

s The Team repositories must be merged back into and published in the Main
repository.

One specific group (for example, release management) should manage all project
definitions, perform merges, publish, and synchronize the Team RPDs back to
Main.

Synchronizing RPD Branches

For large development teams, it is a good practice to perform periodic branch
synchronization as Main changes, in order to ease the ultimate Team check-in. Use the
Administration Tool to synchronize repositories in a three-way merge.

To synchronize repository branches:

1.

Check in all changes from your Team development branch and open the RPD in
the Administration Tool. This the current repository.

Extract a fresh Branch subset from Main. This is the modified repository.

In the Administration Tool, select File, then select Merge and browse to the
backup of the previous Branch subset. This is the original repository.

Resolve all issues and perform the merge.

The RPD named in the Save merged repository as field becomes the new branch
development RPD and is called the Original in future synchronizations.

Viewing and Deleting History for Multiuser Development

You can view and delete the development history of a multiuser development
repository.

This section contains the following topics:

Viewing Multiuser Development History
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s Deleting Multiuser Development History

Viewing Multiuser Development History

You can view the development history of a multiuser development repository. In the
Administration Tool, multiuser development history is only available when no
repository is open and after the administrator sets up the shared network directory.
This prevents the confusion that could occur if a user opened a history log that did not
match an open, unrelated repository.

To view multiuser development history:

1. Open the Administration Tool.

2. Without opening a repository, select File > Multiuser > History.
3. Inthe Multiuser Development History dialog, select a repository.

A list of all master repositories in the multiuser development directory appears. If
directory contains only one master repository, it is selected by default, and no list
appears.

4. In the Open Offline dialog, type the password for the repository. The Multi User
History dialog appears.

Figure 3-7 shows the Multi User History dialog.

Figure 3—7 Multi User History Dialog
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5. Inthe Multi User History dialog, right-click a row and select an option. Table 3-1
describes the options in the Multi User History dialog.

Tip: To see details for all revisions, right-click in the background with no rows
selected and select View > Details.

Table 3-1 Options in the Multi User History Dialog

Action Description

View > Repository Loads the selected master version of the repository in the
Administration Tool in read-only mode.

View > Prior to Merge > Loads the selected version of a modified subset repository in the

Projects Administration Tool in read-only mode.

View > Conflict Resolution | Loads all necessary repositories of the selected version. Also
shows the Merge dialog in read-only mode with all selected
decisions as they were during the Merge Local Changes activity
at that time. Double-clicking a row for a version with conflict
resolutions has the same effect as selecting this menu item.

Note: This menu item is only enabled for versions that had
conflict resolutions.

3-20 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition




Setting Multiuser Development Options

Table 3-1 (Cont.) Options in the Multi User History Dialog

Action Description

View > Details Displays a log with details for the selected versions, or displays
details for all versions if no specific versions are selected.

View > Prior to Merge > Compares modified subset repository of the selected version

Changes with original subset repository and shows all changes made by
the user in the selected version.

Find and Find Again Lets you search the list.

Select All Selects all items displayed in the dialog.

Delete Available only to multiuser development administrators.

Deleting Multiuser Development History

Only multiuser development administrators can delete history. Administrators are
defined in a special hidden option file in the multiuser development directory. See
"Setting Multiuser Development Options" for more information.

An administrator can delete the entire MUD history, or the oldest 1 to n versions. It is
not possible to delete versions in the middle of the range. For example, an
administrator cannot delete version 3 if there are still versions 1 and 2. If an
administrator deletes the entire MUD history, newly assigned version numbers restart
at version 1.

Setting Multiuser Development Options

You can create a multiuser development option file to specify options for multiuser
development. The option file is a text file, in standard Windows INI format. It has the
following properties and characteristics:

= The option file must be placed in the multiuser development directory. The file
has the same name as the corresponding master repository, but with an .opt
extension. For example, for \ \network\MUD\sales.rpd, create an option file
called \\network\MUD\sales.opt.

»  The file should have the Hidden flag turned on.

= In general, the option file should be managed only by multiuser development
administrators. To ensure this, you may want to change the sharing permissions
for the file.

The following example shows a multiuser development option file:

[Options]

BuildNumber = Yes

Admin = adminl;admin2

Mandatory Consistency Check = Yes
Equalize During Merge = Yes

Options that are not explicitly set are turned off by default. To turn an option on, set
its value to Yes. To turn an option off, either remove it from the option file, or set its
value to No.

Table 3-2 explains the options in the multiuser development option file.
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Table 3-2 Options in the Multiuser Development Option File

Option Description

BuildNumber When set to Yes, the build version of the Administration Tool is
displayed in the MUD history.

Admin Lists multiuser development administrators. Administrators

must be defined in the option file before they can delete MUD
history.

Administrators are defined by their computer/network login
names. When multiple administrators exist, administrator
names are separated by semicolons. For example:

Admin=jsmith;mramirez;plafleur

Mandatory Consistency

When set to Yes, the publish step performs a consistency check.

Check Publishing cannot proceed unless there are no errors in the
given repository.
Equalize During Merge When set to Yes, the multiuser development merge process

performs mandatory equalization during MUD merges. Note
that setting this option to Yes affects the performance of the
merge process.
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Importing Metadata and Working with Data
Sources

If you do not already have an Oracle Bl repository file, you must create one. Then, you
can import metadata from your data sources into the Physical layer of your repository.
The Physical layer of the Administration Tool defines the data sources to which the
Oracle BI Server submits queries, and the relationships between physical databases
and other data sources that are used to process multiple data source queries.

Metadata imports to an Oracle BI repository must occur through an ODBC or native
database connection to the underlying data source. Metadata can also be imported
from software such as Microsoft Excel through an ODBC connection.

Importing metadata directly from each data source saves you time and effort by
importing the structure for the Physical layer. Data from these sources can be
displayed on Oracle BI Interactive Dashboards and other clients. You can only import
metadata from supported data sources.

After you import metadata, properties in the associated database object and
connection pool are typically set automatically. However, you may want to adjust
database or connection pool settings. See Chapter 6, "Setting Up Database Objects and
Connection Pools" for more information.

Although you can create the Physical layer manually rather than importing metadata,
it is a labor-intensive and error-prone activity. It is strongly recommended that you
import metadata.

This chapter contains the following topics:

s Creating New Oracle Bl Repository Files

s Performing Data Source Preconfiguration Tasks

s Importing Metadata from Relational Data Sources

s Importing Metadata from Multidimensional Data Sources
s Importing Metadata from XML Data Sources

= Using a Standby Database with Oracle Business Intelligence

Creating New Oracle Bl Repository Files

You can use the Create New Repository Wizard in the Administration Tool to create
new Oracle Bl repository files (.rpds). You do not need to create a new repository file if
you already have an existing repository.
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If you have an existing repository file, you can use the existing data source settings in
that file as a template to connect to different data sources. To do this, use the existing
data source settings and just change the database type and connection pool
information. See "Setting Up Database Objects" and "Creating or Changing Connection
Pools" for details.

To create a new repository file:

1.

In the Administration Tool, select File, then select New Repository. The Create
New Repository Wizard appears.

If an existing repository is open, you are prompted to save your changes, and the
existing repository is closed.

Type a name for the repository. Keep the name to 156 characters or less to avoid
problems with the metadata dictionary URL. An RPD file extension is
automatically added if you do not explicitly specify it.

Select a location for the new repository. By default, new repositories are stored in
the repository subdirectory, located at ORACLE_
INSTANCE\Dbifoundation\OracleBIServerComponent\coreapplication_

obisn \repository.

If you want to import metadata into the repository now, select Yes (the default) for
Import Metadata. If you do not want to import metadata, select No.

Enter and confirm the password you want to use for this repository. The
repository password must be longer than five characters and cannot be empty.

You enter the repository password when you open the repository in online or
offline mode. It is used to encrypt the repository contents.

If you selected Yes for Import Metadata, click Next.

Refer to the following sections for information about the Import screens, according
to your data source type:

s Importing Metadata from Relational Data Sources

s Importing Metadata from Multidimensional Data Sources
s  Importing Metadata from XML Data Sources

= Working with ADF Business Component Data Sources

Note that you many need to set up your data sources before you import
information into the repository. See "Performing Data Source Preconfiguration
Tasks" for more information.

If you selected No for Import Metadata, click Finish to create an empty
repository.

Performing Data Source Preconfiguration Tasks

Before you can import physical objects from your data sources into your repository
file, or set up connection pools to your data sources, you may need to perform
configuration steps so that the data sources can be accessed by Oracle Business
Intelligence.
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Note: See also the following related topics:

»  If the Oracle BI Server is running on a non-Windows platform, see
Chapter 15, "Setting Up Data Sources on Linux and UNIX" for
additional instructions.

= See Chapter 5, "Working with ADF Business Component Data
Sources" for information about setting up ADF Business
Component data sources.

= See "System Requirements and Certification" for information
about the data sources supported by Oracle Business Intelligence.

This section contains the following topics:

= Setting Up ODBC Data Source Names (DSNs)

= Setting Up Oracle Database Data Sources

»  Setting Up Essbase Data Sources

= Setting Up Hyperion Financial Management Data Sources

s Setting Up Oracle RPAS Data Sources

Setting Up ODBC Data Source Names (DSNs)

Before you can import from a data source through an ODBC connection, or set up a
connection pool to an ODBC data source, you must first create an ODBC Data Source
Name (DSN) for that data source. You reference this DSN in the Import Metadata
Wizard when you import metadata from the data source.

You can only use ODBC DSNs for import on Windows systems.
To set up an ODBC DSN on Windows:

1. Open the Windows Control Panel by selecting Start > Settings > Control Panel,
double-click Administrative Tools, and then double-click Data Sources (ODBC).

2. In the ODBC Data Source Administrator dialog, click the System DSN tab, and
then click Add.

3. From the Create New Data Source dialog, select the driver appropriate for your
data source, and then click Finish.

The remaining configuration steps are specific to the data source you want to
configure. Refer to the documentation for your data source for more information.

ODBC DSNs on Windows systems are used for both initial import, and for access to
the data source during query execution. On UNIX systems, ODBC DSNs are only used
for data access. For information about setting up ODBC data sources on UNIX, see
Chapter 15, "Setting Up Data Sources on Linux and UNIX."

Note: For Teradata data sources, after you have installed the latest
Teradata ODBC driver and set up an ODBC DSN, you must add the
lib directory for your Teradata data source to your Windows system
Path environment variable. For example:

D:\Program Files\NCR\Common Files\Shared ICU Libraries for
Teradata\lib
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Setting Up Oracle Database Data Sources

You should always use OCI when importing metadata from or connecting to an Oracle
Database. Before you can import schemas or set up a connection pool, you must add a
TNS names entry to your tnsnames.ora file. See the Oracle Database documentation
for more information.

When you import metadata from an Oracle Database data source or set up a
connection pool, you can include the entire connect string for Data Source Name, or
you can use the net service name defined in the tnsnames.ora file. If you choose to
enter only the net service name, you must set up a tnsnames.ora file in the following
location within the Oracle Business Intelligence environment, so that the Oracle BI
Server can locate the entry:

ORACLE_HOME\network\admin

You might need to create the admin directory, if it does not exist.

Setting Up Essbase Data Sources

The Oracle BI Server uses the Essbase client libraries to connect to Essbase data
sources. You must ensure that the Essbase client libraries are installed on the computer
running the Oracle BI Server before you can set up a connection to or import metadata
from Essbase data sources. You also need to ensure that the Essbase client libraries are
installed on any computer where you want to run the Administration Tool or the
ngcmd utility. See "System Requirements and Certification" for information about
supported versions of the Essbase Client for use with Oracle Business Intelligence.

After you verify that the Essbase client libraries are installed on the appropriate
computers, you must ensure that the PATH environment variable on each computer
includes the location of the Essbase client driver (for example, EPM_ORACLE_
HOME /products/Essbase/EssbaseClient). See "Configuring Essbase Data Sources on
Linux" for information about setting the PATH variable on Linux.

In addition, you also need to ensure that an additional environment variable is set
appropriately for each computer (either ESSBASEPATH or ARBORPATH, depending on
your client version). For more information, see Oracle Hyperion Enterprise Performance
Management System Installation and Configuration Guide (or the equivalent title for your
client version).

Other system processes need the information contained in the environment variables
set for the Essbase client libraries. The following sections provide additional
information:

s Updating Essbase Information in opmn.xml

»  Adding Essbase Information to bi-init.cmmd

Updating Essbase Information in opmn.xmi

To enable connectivity, on each computer running the Oracle BI Server, you need to
verify that information in opmn.xml is correct for your Essbase client version and
installed location.

To include the location of the Essbase client libraries in opmn.xml:
1. Open opmn.xml for editing. You can find opmn.xml at:

ORACLE_INSTANCE/config/OPMN/opmn/opmn . xml

2. Locate the ias-component tag for the Oracle BI Server process. For example:
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<ias-component id="coreapplication_obisl" inherit-environment="true">

Under the Oracle Bl Server ias-component tag, locate the line that identifies the
variable ESSBASEPATH. For example:

<variable i1d="ESSBASEPATH" value="$ORACLE_HOME/products/Essbase/EssbaseServer"
/>

If necessary, update the value to point to the appropriate location for your
installed client libraries. Change the variable name to ARBORPATH if necessary,
depending on your client version.

Locate the line that identifies the variable PATH. For example:

<variable id="PATH" value="$ORACLE_HOME/bifoundation/server/bin$:SORACLE_
HOME/bifoundation/web/bin$: SORACLE_HOME/bifoundation/odbc/1ib$: SORACLE
INSTANCES : $ORACLE_HOME/11ib$ : $ESSBASEPATH/bing : SPATHS : $/bin" append="true"/>

Locate the portion of the entry that shows the location of the Essbase client
libraries (shown in bold in the preceding example), and update the location if
appropriate for your installation. Change the variable used in the path from
ESSBASEPATH to ARBORPATH if necessary, depending on your client version.

Save and close the file.
Restart OPMN.

Repeat these steps on each computer that runs the Oracle BI Server process. If you
are running multiple Oracle BI Server instances on the same computer, be sure to
update the ias-component tag appropriately for each instance in opmn.xml (for
example, ias-component id="coreapplication_obis1", ias-component
id="coreapplication_obis2", and so on).

Adding Essbase Information to bi-init.cmd

On Windows systems, to enable connectivity, you need to update bi-init.cmd on each
computer running the Administration Tool.

See "Configuring Essbase Data Sources on Linux" for information about setting up the
environment on Linux systems.

To add Essbase environment variables to bi-init.cmd:

1.

Open the bi-init.cmd file for editing. You can find bi-init.cmd at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup

Add a line setting the ESSBASEPATH or ARBORPATH environment variable, as
appropriate for your version and installed location of the Essbase client libraries.
For example:

set ORACLE_INSTANCE=C:\mw_home\instances\instancel

set ORACLE_BI_APPLICATION=coreapplication

set ESSBASEPATH=C:\products\Essbase\EssbaseClient

call $ORACLE_INSTANCE%\bifoundation\OracleBIApplication\%ORACLE_BI_
APPLICATION%\setup\user.cmd

Locate the line that sets the PATH environment variable, and add the location of
the Essbase client binaries. For example:

set PATH=%0RACLE_HOME%\bifoundation\server\bin;%ORACLE_
HOME$%\bifoundation\web\bin; $ORACLE_HOME$%\bin; %ESSSBASEPATH%\bin; $PATH%

Importing Metadata and Working with Data Sources 4-5



Performing Data Source Preconfiguration Tasks

4. Save and close the file.

Setting Up Hyperion Financial Management Data Sources

Before you can import from or set up a connection to Hyperion Financial Management
data sources, you must ensure that both the Hyperion Financial Management win32
client and the HFM Application Builder component are installed on the computer
running the Oracle BI JavaHost process.

When you install the Hyperion Financial Management client, make sure to perform
the following steps in the Server/Cluster Registration tab of the client configuration
utility:

s Provide the IP address or host name of the Hyperion Financial Management
server.

s Click Enable DCOM.

In addition, you must edit the file opmn.xml on each computer running the Oracle BI
JavaHost process to include environment variables required by Hyperion Financial
Management.

To add Hyperion Financial Management environment variables to opmn.xml:
1. Open opmn.xml for editing. You can find opmn.xml at:

ORACLE_INSTANCE/config/OPMN/opmn/opmn . xml

2. Locate the ias-component tag for the JavaHost process. For example:

<ias-component id="coreapplication_obijhl">

3. Within the environment tag, add new variables required for Hyperion Financial
Management, using the following example as a guide. Update the actual values as
appropriate for your installation.

<variable id="HYPERION_HOME" value="C:/Hyperion"/>

<variable id="ADM_HOME" value="$SHYPERION_HOME/common/ADM/9.3.1"/>

<variable id="HFM_HOME" value="$SHYPERION_HOME/FinancialManagement/Client"/>
<variable id="ADM_ESS_NATIVE_HOME" value="$SADM_HOME/Essbase/9.3.1"/>

4. Update the PATH variable to include ADM_ESS_NATIVE_HOME/bin and HFM_
HOME. For example:

<variable id="PATH" value="$ADM ESS_NATIVE_HOME/bin$:$HFM HOMES$:SORACLE_
HOME /bifoundation/server/bins:$ORACLE_HOME/bifoundation/web/bin$: SORACLE
HOME/bifoundation/odbc/1ib$: SORACLE_INSTANCES: SORACLE_HOME/lib" append="true"/>

5. Save and close the file.
6. Restart OPMN.

7. Repeat these steps on each computer that runs the Oracle Bl JavaHost process. If
you are running multiple JavaHost instances on the same computer, be sure to
update the ias-component tag appropriately for each instance in opmn.xml (for
example, ias-component id="coreapplication_obijh1", ias-component
id="coreapplication_obijh2", and so on).

You should run more than one JavaHost process to ensure that the JavaHost is not
a single point of failure for HFM access. To do this, scale out the JavaHost process
using Fusion Middleware Control. See "Extending and Scaling Your Deployment”
in Oracle Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information about scaling out processes.
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Setting Up Oracle RPAS Data Sources

Oracle BI Server can connect to Oracle RPAS (Retail Predictive Application Server)
data sources through ODBC DSNs. To set up Oracle RPAS data sources, you must first
install the Oracle RPAS ODBC driver. During set up of the ODBC DSN, you must
select the SQLExtendedFetch option, select DBMS from the Authentication Method
list, and select No from the Normalize Dimension Tables list. See "About Importing
Metadata from Oracle RPAS Data Sources" for more information.

On Windows systems, you can connect to Oracle RPAS data sources for both initial
import and for access to the data source during query execution. On UNIX systems,
you can only connect to Oracle RPAS data sources for data access.

See "Configuring Oracle RPAS ODBC Data Sources on AIX UNIX" for information
about how to enable ODBC access to Oracle RPAS data sources when the Oracle BI
Server is running on AIX UNIX.

Importing Metadata from Relational Data Sources

You can import metadata for supported relational data source types by selecting one of
the following import options and the appropriate connection type:

s Local Machine. Available in both offline and online modes. Use this option when
you have all database connections set up on your computer. Note the following:

- Most metadata imports are performed using an ODBC connection type.

- Native database gateways for metadata import are supported for Oracle
Database (using OCI), DB2 (using DB2 CLI Unicode), and XML connection
types. See "Importing Metadata from XML Data Sources" for information
about importing XML data using the Oracle BI Server XML gateway.

- You can use the Find button in the Select Metadata Objects screen of the
Import Metadata Wizard to find a specific table you want to import.

s Through the Oracle BI Server. Available in online mode. Use this option when
you want to use Oracle Bl Server connections to import metadata. This option lets
you use the Data Source Name (DSN) of the Oracle BI Server computer to import
metadata, rather than duplicating the DSNs and connectivity information on your
local computer. Available connection types are ODBC, OCI, DB2 CLI (Unicode),
and XML.

You must create a DSN for the Oracle BI Server before you can import metadata
through the Oracle Bl Server. In addition, the Oracle BI Server must be running.
For more information about the Oracle Bl Server DSN, see "Integrating Other
Clients with Oracle Business Intelligence" in Oracle Fusion Middleware Integrator’s
Guide for Oracle Business Intelligence Enterprise Edition.

Note: When it is running on a UNIX platform, the Oracle BI Server
does not support importing metadata using an ODBC connection

type.

See "Importing Metadata from Multidimensional Data Sources" and Chapter 5,
"Working with ADF Business Component Data Sources" for information about
importing from other data sources.

When you import physical tables, be careful to limit the import to only those tables
that contain data that are likely to be used in the business models you create. You can
use the Find feature to locate and select the tables that you want to import. Importing
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large numbers of extraneous tables and other objects adds unnecessary complexity
and increases the size of the repository.

When you import metadata for most data sources, the default is to import tables,
primary keys, and foreign keys. It is recommended that you import primary and
foreign keys along with your tables so that the keys are automatically created in the
Physical layer. If you do not import keys, you must create them manually, which can
be a time-consuming process.

You can also import database views, aliases, synonyms, and system tables. Import
these objects only if you want the Oracle BI Server to generate queries against them.

To import metadata from a relational data source:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing database and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled.

Figure 4-1 shows the Import Metadata Wizard.

Figure 4-1 Import Metadata Wizard: Relational Data Source

Import Metadata - Select Data Source i ] |
n Select Data Source Import Type: ILocaI Machine j
Conneckion Type: IODBC 3.5 j
2 | Select Metadata Tupes
DSt | Driver |
3 | Select Metadata Objects a8 coreapplication_OH1994621847  Oracle BI Server 110_0H1994621847
User Mame: | Adrmin
Password: I Aokkd
Help | Back: | Iest | Firistt | Cancel |
|F0r Help, press F1 4

2. In the Select Data Source screen, in the Connection Type field, select the type of
connection appropriate for your data source, such as ODBC 3.5.

Make sure to choose OCI 10g/11g if your data source is an Oracle Database. Using
OClI as your connection protocol to an Oracle Database ensures better performance
and provides access to native database features that are not available through
ODBC.
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Note: For non-Oracle databases, it is recommended that you use
ODBC 3.5 or DB2 CLI (Unicode) for importing schemas with
International characters, such as Japanese table and column names.

The remaining fields and options on the Select Data Source screen vary according
to the connection type you selected:

— For ODBC 2.0 and ODBC 3.5 data sources, in the DSN list, select a data
source from which to import the schema. Then, provide a valid user name and
password for the data source.

Note that when you import through the Oracle Bl Server, the DSN entries are
on the Oracle BI Server, not on the local computer.

- For OCI 10g/11g and DB2 CLI (Unicode) data sources, provide the name of
the data source in the Data Source Name field, then provide a valid user name
and password for the data source.

For Oracle Database data sources, the data source name is either a full connect
string or a net service name from the tnsnames.ora file. If you enter a net
service name, you must ensure that you have set up a tnsnames.ora file within
the Oracle Business Intelligence environment, in ORACLE _

HOME /network/admin.

Other data source types are described in other sections:

= See "Importing Metadata from Multidimensional Data Sources" for XMLA,
Hyperion ADM, and Essbase.

= See "Importing Metadata from XML Data Sources" for XML.

»  See Chapter 5, "Working with ADF Business Component Data Sources" for
OracleADF_HTTP.

When you have finished providing information in the Select Data Source screen,
click Next. The Select Metadata Types screen appears.

Select the options for the types of objects that you want to import (for example,
Tables, Keys, and Foreign Keys). Some options are automatically selected.
Different types of data sources have different default selections, based on what is
typical for that data source.

If you want to import joins, select both Keys and Foreign Keys. If you want to
import system tables, you must have the system privilege for your data source. To
import from Customer Relationship Management (CRM) tables, select Metadata
from CRM tables.

For Oracle RPAS ODBC data sources, select the Tables, Keys, and Foreign Keys
options. See "About Importing Metadata from Oracle RPAS Data Sources" for
more information.

Click Next. The Select Metadata Objects screen appears.

Select the objects you want to import in the Available list and move them to the
Selected list, using the > (Import selected) or >> (Import all) buttons. You can also
move objects from the Selected list back to the Available list, using the < (Remove
selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.
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Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out.

Click Finish.

If some objects could not be imported, a list of warning messages appears. In the
dialog displaying the messages, you can perform the following actions:

- To search for specific terms, click Find and then Find Again.

- To copy the contents of the window so that you can paste the messages in
another file, click Copy.

After you import metadata, you should check to ensure that your database and
connection pool settings are correct. In rare cases, the Oracle BI Server cannot
determine the exact database type during import and instead assigns an approximate
type to the database object. See "Setting Up Database Objects" and "Creating or
Changing Connection Pools" for more information about working with these objects.

It is also a good practice to visually inspect the imported data in the Physical layer,
such as physical columns and tables, to ensure that the import completed successfully.

About Importing Metadata from Oracle RPAS Data Sources

This section provides important information about using the Administration Tool to
import metadata from Oracle RPAS, as follows:

Oracle RPAS schemas can only be imported on Windows.

Before you import RPAS schemas, you must set the Normalize Dimension Tables
field value in the ODBC DSN Setup page to Yes for the following reasons:

- Setting this value to Yes uses an appropriate schema model (the snowflake
schema) that creates joins correctly and enables drill down in the data.

- Setting this value to No uses a less appropriate schema model (the star
schema) that creates joins between all of the tables, causing drill down to not
work correctly. Many of the joins created in this way are unwanted, and
would need to be removed manually.

See "Setting Up ODBC Data Source Names (DSNs)" for more information.

When you import RPAS schemas in the Administration Tool, you must import the
data with joins. To do this, select the metadata types Keys and Foreign Keys in the
Import Metadata Wizard.

After you have imported RPAS schemas, you must change the Normalize
Dimension Tables field value in the ODBC DSN Setup page back to No. You need
to revert this setting back to No after import to enable the Oracle BI Server to
correctly generate optimized SQL against the RPAS driver.

Note: If you do not change the Normalize Dimension Tables setting value to No,
most queries will fail with an error message similar to the following:

[nQSError: 16001] ODBC error state: S0022 code: 0 message:
[Oracle Retail] [RPAS ODBC]Column:YEAR_LABEL not
found. . [nQSError: 16014] SQL statement preparation failed.
Statement execute failed.

If Oracle RPAS is the only data source, you must set the value of NULL_VALUES_
SORT_FIRST to ON in the NQSConfig.INI file. See Oracle Fusion Middleware System
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Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information about setting values in NQSConfig.INL

Importing Metadata from Multidimensional Data Sources

You can use the Administration Tool to import metadata from a multidimensional data
source to the Physical layer of the Oracle Bl repository. The ability to use
multidimensional data sources enables the Oracle Bl Server to connect to sources such
as Essbase, Hyperion Financial Management, Microsoft Analysis Services, and
SAP/BW (SAP/Business Warehouse) to extract data. Data from these sources can be
displayed on dashboards.

The primary differences between setting up multidimensional data sources and
relational data sources are in the Physical layer. The setup in the Business Model and
Presentation layers for multidimensional data sources and relational data sources is
almost identical.

During the import process, each cube in a multidimensional data source is created as a
single physical cube table. The Oracle BI Server imports the cube, including its metrics,
dimensions and hierarchies. After importing the cubes, you need to ensure that the
physical cube columns have the correct aggregation rule and that the default member
type ALL is correctly imported for a hierarchy. See "Working with Physical Hierarchy
Objects" for more information.

Caution: Manually creating a physical schema from a
multidimensional data source is labor-intensive and error prone.
Therefore, it is strongly recommended that you use the import
method.

It is recommended that you remove hierarchies and columns from the Physical layer if
they will not be used in the business model. This eliminates maintaining unnecessary
objects in the Administration Tool and might result in better performance.

To import metadata from a multidimensional data source:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing database and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled. You can also use this method to perform incremental
imports.

Figure 4-2 shows the Import Metadata Wizard.
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Figure 4-2 Import Metadata Wizard: Multidimensional Data Source
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2. In the Select Data Source screen, in the Connection Type field, select the type of
connection appropriate for your data source.

The remaining fields and options on the Select Data Source screen vary according
to the connection type you selected:

— For Essbase data sources, provide the host name of the computer where the
Essbase server is running in the Essbase Server field, then provide a valid
user name and password for the data source. This information should be
obtained from your data source administrator.

Note: You must ensure that Essbase client libraries are installed on
the computer running the Oracle Bl Server before you can import
metadata from Essbase data sources. See "Setting Up Essbase Data
Sources" for more information.

See "Working with Essbase Data Sources" for information about how data
from Essbase data sources is modeled in the Physical layer.

— For XMLA data sources, such as Microsoft Analysis Services and SAP/BW,
enter the URL of a data source from which to import the schema. Then, enter
the target database, provider type, and a valid user name and password for
the data source. This information should be obtained from your data source
administrator.

— For Hyperion ADM data sources, provide the URL for the Hyperion Financial
Management server, including the driver and application name (cube name).
Provide the URL in the following format:

adm:native:HsvADMDriver:ip_or_host_name:application_name

For example:

adm:native:HsvADMDriver:130.35.40.80:UCFHFM
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You also need to enter a valid user name and password for your data source.

See "Working with Hyperion Financial Management Data Sources" for
information about how data from Hyperion Financial Management data
sources is modeled in the Physical layer.

— For ODBC 3.5 data sources (for Oracle RPAS data sources), select the DSN
entry and provide the username and password for the selected data source.
See "Setting Up ODBC Data Source Names (DSNs)" for more information.

Other data source types are described in other sections:
= See "Importing Metadata from XML Data Sources" for XML.

= See "Importing Metadata from Relational Data Sources" for ODBC 2.0, OCI
10g/11g, and DB2 CLI (Unicode).

= See Chapter 5, "Working with ADF Business Component Data Sources" for
OracleADF_HTTP.

When you have finished providing information in the Select Data Source screen,
click Next.

3. For Oracle RPAS data sources only, the Select Metadata Types screen is displayed.
For Oracle RPAS, select Tables, Keys, and Foreign Keys. Then, click Next.

See "About Importing Metadata from Oracle RPAS Data Sources" for more
information.

4. In the Select Metadata Objects screen, select the objects you want to import in the
Available list and move them to the Selected list, using the > (Import selected) or
>> (Import all) buttons. You can also move objects from the Selected list back to
the Available list, using the < (Remove selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out

For Essbase data sources, select Import UDAs if you want to import UDAs
(user-defined attributes).

5. Click Finish.

If some objects could not be imported, a list of warning messages appears. In the
dialog displaying the messages, you can perform the following actions:

— To search for specific terms, click Find and then Find Again.

— To copy the contents of the window so that you can paste the messages in
another file, click Copy.

After you import metadata, you should check to ensure that your database and
connection pool settings are correct. In rare cases, the Oracle Bl Server cannot
determine the exact database type during import and instead assigns an approximate
type to the database object. See "Setting Up Database Objects" and "Creating or
Changing Connection Pools" for more information about working with these objects.

It is also a good practice to visually inspect the imported data in the Physical layer,
such as physical columns and hierarchical levels, to ensure that the import completed
successfully.
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For Essbase data sources, all hierarchies are imported as Unbalanced by default.
Review the Hierarchy Type property for each physical hierarchy and change the value
if necessary. Supported hierarchy types for Essbase are Unbalanced, Fully balanced,
and Value.

Importing Metadata from XML Data Sources

This section describes the use of the Extensible Markup Language (XML) as a data
source. XML is the universal format for structured documents and data on the Web. It
can also be used as a database to store structured data.

The Oracle BI Server supports various XML access modes, including access through
the Oracle BI Server XML Gateway, as well as access through an XML ODBC driver.

This section contains the following topics:

About Using XML as a Data Source

Importing Metadata from XML Data Sources Using the XML Gateway
Importing Metadata from XML Data Sources Using XML ODBC
Examples of XML Documents

About Using XML as a Data Source

The Oracle BI Server supports the use of XML data as a data source for the Physical
layer in the repository. Depending on the method used to access XML data sources, a
data source may be represented by a URL pointing to one of the following sources:

A static XML file or HTML file that contains XML data islands on the Internet
(including intranet or extranet). For example:

tap://216.217.17.176 /[ DEOA48DE-1C3E-11D4-97C9-00105A A70303]. XML
Dynamic XML generated from a server site. For example:
tap:/ /www.aspserver.com/example.asp

An XML file or HTML file that contains XML data islands on a local or network
drive. For example:

d:/xmldir/example.xml
d:/htmldir/island.htm

You can also specify a directory path for local or network XML files, or you can
use the asterisk ( * ) as a wildcard with the filenames. If you specify a directory
path without a filename specification (like d:/xmldir), all files with the XML suffix
are imported. For example:

d:/xmldir/
d:/xmldir/exam*.xml
d:/htmldir/exam*.htm
d:/htmldir/exam*.html

An HTML file that contains tables, defined by a pair of <table> and </table> tags.
The HTML file may reside on the Internet (including intranet or extranet), or on a
local or network drive. See "Accessing HTML Tables" for more information.

URLSs can include repository or session variables, providing support for HTTP data
sources that accept user IDs and passwords embedded in the URL. For example:
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http://somewebserver/cgi.pl?userid=valueof (session_variablel) &password=
valueof (session_variable2)

This functionality also lets you create an XML data source with a location that is
dynamically determined by some run-time parameters. For more information about
variables, see Chapter 18.

If the Oracle BI Server needs to access any nonlocal files (network files or files on the
Internet, for example), you must run the Oracle BI Server using a valid user ID and
password with sufficient network privileges to access these remote files.

Importing Metadata from XML Data Sources Using the XML Gateway

Using the Oracle Bl Server XML Gateway, the metadata import process flattens the
XML document to a tabular form using the stem of the XML filename (that is, the
filename without the suffix) as the table name and the second level element in the
XML document as the row delimiter. All leaf nodes are imported as columns
belonging to the table. The hierarchical access path to leaf nodes is also imported.

The Oracle BI Server XML Gateway uses the metadata information contained in an
XML schema. The XML schema is contained within the XML document, or is
referenced within the root element of the XML document.

Where there is no schema available, all XML data is imported as text data. In building
the repository, you can alter the data types of the columns in the Physical layer,
overriding the data types for the corresponding columns defined in the schema. The
gateway converts the incoming data to the desired type as specified in the Physical
layer. You can also map the text data type to other data types in the Business Model
and Mapping layer of the Administration Tool, using the CAST operator.

The Oracle BI Server XML Gateway does not support:

= Resolution of external references contained in an XML document (other than a
reference to an external XML schema, as demonstrated in the example file in
"Examples of XML Documents Generated by the Oracle BI Server XML Gateway").

s Element and attribute inheritance contained within the Microsoft XML schema.

= Element types of a mixed content model (such as XML elements that contain a
mixture of elements and CDATA, such as <p> hello <b>Joe</b>, how are you
doing?</p>).

To import XML data using the Oracle BI Server XML Gateway:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing database and
connection pool, you can right-click the connection pool in the
Physical layer and select Import Metadata. The Import Metadata
Wizard appears with the information on the Select Data Source screen
pre-filled.

Figure 4-3 shows the Import Metadata Wizard.
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Figure 4-3 Import Metadata Wizard: XML Data Source
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2. In the Select Data Source screen, select XML for Connection Type. Then, provide
the following values:

»  For URL, specify the XML data source URL. The Oracle Bl Server XML
Gateway supports all data sources described in the previous section.

URLs can include repository or session variables. For more information about
variables, see Chapter 18.

If you click Browse, the Select XML File dialog appears, from which you can
select a single file. For XML documents, the file name in the URL that you
specify must have the suffix .xm1. Otherwise, the documents are treated as
HTML documents.

= Type an optional user name and password in the appropriate fields for
connections to HTTP sites that employ the HTTP Basic Authentication security
mode.

In addition to HTTP Basic Authentication security mode, the Oracle Bl
Server XML Gateway also supports Secure HTTP protocol and Integrated
Windows Authentication (for Windows 2000), formerly called NTLM or
Windows NT Challenge /Response authentication.

When you have finished providing information in the Select Data Source screen,
click Next. The Select Metadata Types screen appears.

3. Select the options for the types of objects that you want to import (for example,
Tables, Keys, and Foreign Keys). The most typical options are automatically
selected.

If you want to import joins, select both Keys and Foreign Keys. If you want to
import system tables, you must have the system privilege for your data source.

4. Click Next. The Select Metadata Objects screen appears.

5. Select the objects you want to import in the Available list and move them to the
Selected list, using the > (Import selected) or >> (Import all) buttons. You can also
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6.

move objects from the Selected list back to the Available list, using the < (Remove
selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out.

Click Finish.

After you import XML data, you must adjust connection pool settings. See "Creating
or Changing Connection Pools" for complete information. Minimally, you can do the
following:

In the Connection Pool dialog, type a name and optional description for the
connection on the General tab.

Click the XML tab to set additional connection properties, including the URL
refresh interval and the length of time to wait for a URL to load before timing out.

Because XML data sources are typically updated frequently and in real time, you
can specify a refresh interval for Oracle BI Server XML Gateway data sources. The
default timeout interval for queries (URL loading time-out) is 15 minutes. For
more information, see "About the Refresh Interval for XML Data Sources" in Oracle
Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition.

Examples of XML Documents Generated by the Oracle Bl Server XML Gateway

Example 4-1 and Example 4-2 show sample XML documents and the corresponding
columns that are generated by the Oracle Bl Server XML Gateway.

Example 4-1 XML Schema Contained in an External File

The following sample XML data document (mytest.xml) references an XML schema
contained in an external file. The schema file is shown following the data document.
The generated XML schema information available for import to the repository is
shown at the end.

<?xml version="1.0"?>
<test xmlns="x-schema:mytest_sch.xml">

<row>
<pl>0</pl>
<p2 width="5">

<p3>hi</p3>
<p4d>
<pb>xx0</pb>
<p7>yy0</p7>
</p4>
<p5>zz0</p5>

</p2>
</row>

<row>
<pl>1</pl>
<p2 width="6">

<p3>how are you</p3>
<péd>

Importing Metadata and Working with Data Sources 4-17



Importing Metadata from XML Data Sources

<pb>xx1</pb>
<p7>yyl</p7>
</pé>
<p5>zzl</p5>
</p2>
</row>

<row>
<pl>a</pl>
<p2 width="7">
<p3>hi</p3>
<p4d>
<p6>xXx2</pb>
<p7>yy2</p7>
</pd>
<p5>zz2</p5>
</p2>
</row>

<row>
<pl>b</pl>
<p2 width="8">
<p3>how are they</p3>
<p4d>
<p6>xx3</p6>
<p7>yy3</p7>
</pd>
<p5>zz2</p5>
</p2>
</row>
</test>

The corresponding schema file follows:

<Schema xmlns="urn:schemas-microsoft-com:xml-data"
xmlns:dt="urn:schemas-microsoft-com:datatypes">
<ElementType name="test" content="eltOnly" order="many">
<element type="row"/>
</ElementType>
<ElementType name="row" content="eltOnly" order="many">
<element type="pl"/>
<element type="p2"/>
</ElementType>
<ElementType name="p2" content="eltOnly" order="many">
<AttributeType name="width" dt:type="int" />
<attribute type="width" />
<element type="p3"/>
<element type="pd"/>
<element type="p5"/>
</ElementType>
<ElementType name="p4" content="eltOnly" order="many">
<element type="p6"/>
<element type="p7"/>
</ElementType>
<ElementType name="pl" content="textOnly" dt:type="string"/>
<ElementType name="p3" content="textOnly" dt:type="string"/>
<ElementType name="p5" content="textOnly" dt:type="string"/>
<ElementType name="p6" content="textOnly" dt:type="string"/>
<ElementType name="p7" content="textOnly" dt:type="string"/>
</Schema>
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The name of the table generated from the preceding XML data document (mytest.xml)
would be mytest and the column names would be p1, p3, p6, p7, p5, and width.

In addition, to preserve the context in which each column occurs in the document and
to distinguish between columns derived from XML elements with identical names but
appearing in different contexts, a list of fully qualified column names is generated,
based on the XPath proposal of the World Wide Web Consortium, as follows:

//test/row/pl
//test/row/p2/p3
//test/row/p2/pld/pb
//test/row/p2/pd/p7
//test/row/p2/p5
//test/row/p2@width

Example 4-2 Nested Table Structures in an XML Document

The following example is a more complex example that demonstrates the use of nested
table structures in an XML document. You can optionally omit references to an
external schema file, in which case all elements are treated as being of the Varchar
character type.

===Invoice.xml===
<INVOICE>
<CUSTOMER>
<CUST_ID>1</CUST_ID>
<FIRST_NAME>Nancy</FIRST NAME>
<LAST NAME>Fuller</LAST NAME>
<ADDRESS>
<ADD1>507 - 20th Ave. E.,</ADD1>
<ADD2>Apt. 2A</ADD2>
<CITY>Seattle</CITY>
<STATE>WA</STATE>
<ZIP>98122</7ZIP>
</ADDRESS>
<PRODUCTS>
<CATEGORY>
<CATEGORY_ID>CAT1</CATEGORY_ID>
<CATEGORY_NAME>NAME1</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>1</ITEM_ID>
<NAME>< /NAME>
<PRICE>0.50</PRICE>
<QTY>2000</QTY>
</ITEM>
<ITEM>
<ITEM_ID>2</ITEM_ID>
<NAME>SPRITE</NAME>
<PRICE>0.30</PRICE>
<QTY></QTY>
</ITEM>
</ITEMS>
</CATEGORY>
<CATEGORY>
<CATEGORY_ID>CAT2</CATEGORY_ID>
<CATEGORY_NAME>NAME2</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>11</ITEM_ID>
<NAME>ACOKE< /NAME>
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<PRICE>1.50</PRICE>
<QTY>3000</QTY>
</ITEM>
<ITEM>
<ITEM_ID>12</ITEM_ID>
<NAME>SOME SPRITE</NAME>
<PRICE>3.30</PRICE>
<QTY>2000</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
</PRODUCTS>
</CUSTOMER>
<CUSTOMER>
<CUST_ID>2</CUST_ID>
<FIRST_NAME>Andrew</FIRST_NAME>
<LAST NAME>Carnegie</LAST_NAME>
<ADDRESS>
<ADD1>2955 Campus Dr.</ADD1>
<ADD2>Ste. 300</ADD2>
<CITY>San Mateo</CITY>
<STATE>CA</STATE>
<ZIP>94403</ZIP>
</ADDRESS>
<PRODUCTS>
<CATEGORY>
<CATEGORY_ID>CAT22</CATEGORY_ID>
<CATEGORY_NAME>NAMEA1</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>122</ITEM_ID>
<NAME>DDDCOKE< /NAME>
<PRICE>11.50</PRICE>
<QTY>2</QTY>
</ITEM>
<ITEM>
<ITEM_ID>22</ITEM_ID>
<NAME>PSPRITE</NAME>
<PRICE>9.30</PRICE>
<QTY>1978</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
<CATEGORY>
<CATEGORY_ID>CAT24</CATEGORY_ID>
<CATEGORY_NAME>NAMEA2</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>19</ITEM_ID>
<NAME>SOME COKE</NAME>
<PRICE>1.58</PRICE>
<QTY>3</QTY>
</ITEM>
<ITEM>
<ITEM_ID>15</ITEM_ID>
<NAME>DIET SPRITE</NAME>
<PRICE>9.30</PRICE>
<QTY>12000</QTY>
</ITEM>
</ITEMS>
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</CATEGORY>
</PRODUCTS>
</CUSTOMER>
<CUSTOMER>
<CUST_ID>3</CUST_ID>
<FIRST NAME>Margaret</FIRST_NAME>
<LAST NAME>Leverling</LAST_ NAME>
<ADDRESS>
<ADD1>722 Moss Bay Blvd.</ADD1>
<ADD2> </ADD2>
<CITY>Kirkland</CITY>
<STATE>WA</STATE>
<ZIP>98033</ZIP>
</ADDRESS>
<PRODUCTS>
<CATEGORY>
<CATEGORY_ID>CAT31</CATEGORY_ID>
<CATEGORY_NAME>NAMEA3</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>13</ITEM_ID>
<NAME>COKE33</NAME>
<PRICE>30.50</PRICE>
<QTY>20033</QTY>
</ITEM>
<ITEM>
<ITEM_ID>23</ITEM_ID>
<NAME>SPRITE33</NAME>
<PRICE>0.38</PRICE>
<QTY>20099</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
<CATEGORY>
<CATEGORY_ID>CAT288</CATEGORY_ID>
<CATEGORY_NAME>NAME H</CATEGORY_NAME>
<ITEMS>
<ITEM>
<ITEM_ID>19</ITEM_ID>
<NAME>COLA< /NAME>
<PRICE>1.0</PRICE>
<QTY>3</QTY>
</ITEM>
<ITEM>
<ITEM_ID>18</ITEM_ID>
<NAME>MY SPRITE</NAME>
<PRICE>8.30</PRICE>
<QTY>123</QTY>
</ITEM>
</ITEMS>
</CATEGORY>
</PRODUCTS>
</CUSTOMER>
</INVOICE>

The generated XML schema consists of one table (INVOICE) with the following
column names and their corresponding fully qualified names.
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Column Fully Qualified Name

ADD1 / /INVOICE/CUSTOMER/ADDRESS/ADD1

ADD2 / /INVOICE /CUSTOMER/ADDRESS/ADD2

CITY / /INVOICE/CUSTOMER/ADDRESS/CITY

STATE //INVOICE/CUSTOMER/ ADDRESS/STATE

ZIP / /INVOICE/CUSTOMER/ ADDRESS/ ZIP

CUST_ID / /INVOICE/CUSTOMER/CUST_ID

FIRST_NAME //INVOICE/CUSTOMER /FIRST_NAME

LAST_NAME //INVOICE/CUSTOMER /LAST_NAME

CATEGORY_ID I/ D/ INVOICE/CUSTOMER/PRODUCTS/CATEGORY /CATEGORY _

CATEGORY_NAME | //INVOICE/CUSTOMER/PRODUCTS/CATEGORY /CATEGORY _
NAME

ITEM_ID / /INVOICE/CUSTOMER /PRODUCTS/CATEGORY /ITEMS/ITEM
/ITEM_ID

NAME / /INVOICE/CUSTOMER/PRODUCTS/CATEGORY /ITEMS/ITEM
/NAME

PRICE //INVOICE/CUSTOMER /PRODUCTS/CATEGORY /ITEMS/ITEM
/PRICE

QTY ; (/;%VOICE /CUSTOMER /PRODUCTS/CATEGORY /ITEMS/ITEM

Only tags with values are extracted as columns. An XML query generates fully

qualified tag names, to help ensure appropriate columns are retrieved.

The following shows the results of a sample query against the INVOICE table:

SELECT first_name, last_name, price, gty, name FROM invoice

FIRST _NAME LAST NAME PRICE QTY NAME

Andrew Carnegie 1.58 3 SOME COKE
Andrew Carnegie 11.50 2 DDDCOKE
Andrew Carnegie 9.30 12000 DIET SPRITE
Andrew Carnegie 9.30 1978 PSPRITE
Margar Leverling 0.38 20099 SPRITE33
Margar Leverling 1.0 3 COLA
Margar Leverling 30.50 20033 COKE33
Margar Leverling 8.30 123 MY SPRITE
Nancy Fuller 0.30 SPRITE
Nancy Fuller 0.50 2000

Nancy Fuller 1.50 3000 ACOKE
Nancy Fuller 3.30 2000 SOME SPRITE

Row count: 12

Accessing HTML Tables

The Oracle BI Server XML Gateway also supports the use of tables in HTML files as a
data source. The HTML file can be identified as a URL pointing to a file on the internet

(including intranet or extranet) or as a file on a local or network drive.
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Even though tables, defined by the <table> and </table> tag pair, are native
constructs of the HTML 4.0 specification, they are often used by Web designers as a
general formatting device to achieve specific visual effects rather than as a data
structure. The Oracle BI Server XML Gateway is currently the most effective in
extracting tables that include specific column headers, defined by <th> and </th> tag
pairs.

For tables that do not contain specific column headers, the Oracle BI Server XML
Gateway employs some simple heuristics to make a best effort to determine the
portions of an HTML file that appear to be genuine data tables.

The following is a sample HTML file with one table.

<html>
<body>
<table border=1 cellpadding=2 cellspacing=0>

<tr>
<th colspan=1>Transaction</th>
<th colspan=2>Measurements</th>

</tr>

<tr>
<th>Quality</th>
<th>Count</th>
<th>Percent</th>

</tr>

<tr>
<td>Failed</td>
<td>66,672</td>
<td>4.1%</td>

</tr>

<tr>
<td>Poor</td>
<td>126,304</td>
<td>7.7%</td>

</tr>

<tr>
<td>Warning</td>
<td>355,728</td>
<td>21.6%</td>

</tr>

<tr>
<td>O0K</td>
<td>1,095,056</td>
<td>66.6%</td>

</tr>

<tr>
<td colspan=1>Grand Total</td>
<td>1,643,760</td>
<td>100.0%</td>

</tr>

</table>
</body>
</html>

The table name is derived from the HTML filename, and the column names are
formed by concatenating the headings (defined by the <th> and </th> tag pairs) for
the corresponding columns, separated by an underscore.

Assuming that our sample file is named 18.htm, the table name would be 18_0
(because it is the first table in that HTML file), with the following column names and
their corresponding fully qualified names:
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Column Fully Qualified Name
Transaction_Quality \\18_0\Transaction_Quality
Measurements_Count \\18_0\Measurements_Count
Measurements_Percent \\18_0\Measurements_Percent

If the table column headings appear in more than one row, the column names are
formed by concatenating the corresponding field contents of those header rows.

For tables without any heading tag pairs, the Oracle BI Server XML Gateway assumes
the field values (as delimited by the <td> and </td> tag pairs) in the first row to be the
column names. The columns are named by the order in which they appear (c0, c1, and
SO on).

See "Importing Metadata from XML Data Sources Using XML ODBC" and "Examples
of XML Documents" for additional XML examples.

Importing Metadata from XML Data Sources Using XML ODBC

Using the XML ODBC database type, you can access XML data sources through an
ODBC interface. The data types of the XML elements representing physical columns in
physical tables are derived from the data types of the XML elements as defined in the
XML schema. In the absence of a proper XML schema, the default data type of string is
used. Data Type settings in the Physical layer do not override those defined in the
XML data sources. When accessing XML data without XML schema, use the CAST
operator to perform data type conversions in the Business Model and Mapping layer
of the Administration Tool.

To import XML data using ODBC:

1. To access XML data sources through ODBC, you first need to license and install an
XML ODBC driver.

2. Create ODBC DSNs that point to the XML data sources you want to access,
making sure you select the XML ODBC database type.

3. In the Administration Tool, select File, then select Import Metadata.

4. Follow the instructions in the dialogs to import the ODBC DSNs into the
repository. See "Importing Metadata from Relational Data Sources" for more
information.

Caution: Due to XML ODBC limitations, you must select the
Synonyms option in the Select Metadata Types screen, or no tables are
imported.

Example of an XML ODBC Data Source

Example 4-3 shows an example of an XML ODBC data source in the Microsoft ADO
persisted file format. Both the data and the schema could be contained inside the same
document.

Example 4-3 XML ODBC Example

<xml xmlns:s='uuid:BDC6E3F0-6DA3-11d1-A2A3-00AA00C14882"
xmlns:dt="uuid:C2F41010-65B3-11d1-A29F-00AA00C14882"
xmlns:rs='urn:schemas-microsoft-com:rowset'
xmlns:z="'#RowsetSchema'>
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<s:Schema id='RowsetSchema'>
<s:ElementType name='row' content='eltOnly' rs:CommandTimeout="'30"
rs:updatable="'true'>
<s:AttributeType name='ShipperID' rs:number='1l' rs:writeunknown='true'
rs:basecatalog='Paint' rs:basetable='Shippers'
rs:basecolumn="'ShipperID'>
<s:datatype dt:type='12' dt:maxLength='2' rs:precision='5"
rs:fixedlength="'true' rs:benull='false'/>
</s:AttributeType>
<s:AttributeType name='CompanyName' rs:number='2' rs:writeunknown='true'
rs:basecatalog='Paint' rs:basetable='Shippers'
rs:basecolumn="'CompanyName'>
<s:datatype dt:type='string' rs:dbtype='str' dt:maxLength='40"
rs:benull="'false'/>
</s:AttributeType>
<s:AttributeType name='Phone' rs:number='3"' rs:nullable='true'
rs:writeunknown='true' rs:basecatalog='Paint'
rs:basetable="'Shippers' rs:basecolumn='Phone'>
<s:datatype dt:type='string' rs:dbtype='str' dt:maxLength='24"
rs:fixedlength="true'/>
</s:AttributeType>
<s:extends type='rs:rowbase'/>
</s:ElementType>
</s:Schema>
<rs:data>
<z:row ShipperID='1l' CompanyName='Speedy Express' Phone="' (503)
555-9831 '/>
<z:row ShipperID='2' CompanyName='United Package' Phone="'(503)
555-3199 v/>
<z:row ShipperID='3' CompanyName='Federal Shipping' Phone="'(503)
555-9931 v/>
</rs:data>
</xml>

Examples of XML Documents

The following XML documents provide examples of several different situations and
explain how the Oracle BI Server XML access method handles those situations.

s The XML documents 83.xml and 8_sch.xml (shown in Example 4—4 and
Example 4-5) demonstrate the use of the same element declarations in different
scope. For example, <p3> could appear within <p2> as well as within <p4>.

Because the element <p3> in the preceding examples appears in two different
scopes, each element is given a distinct column name by appending an index
number to the second occurrence of the element during the import process. In this
case, the second occurrence becomes p3_1. If <p3> occurs in additional contexts,
they become p3_2, p3_3.

s The XML documents 83.xml and 84.xml (shown in Example 4—4 and Example 4-6)
demonstrate that multiple XML files can share the same schema (8_sch.xml).

= Internet Explorer version 5 and higher supports HTML documents containing
embedded XML fragments called XML islands. The XML document island2.htm
(shown in Example 4-7) demonstrates a simple situation where multiple XML
data islands, and therefore multiple tables, could be generated from one
document. One table is generated for each instance of an XML island. Tables are
distinguished by appending an appropriate index to the document name. For
island2.htm, the two XML tables generated would be island2_0 and island2_1.
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Example 4-4 83.xml

===83.xml===
<?xml version="1.0"?>
<test xmlns="x-schema:8_sch.xml">|
<row>
<pl>0</pl>
<p2 width="5" height="2">
<p3>hi</p3>
<p4d>
<p3>hi</p3>
<p6>xx0</p6>
<p7>yy0</p7>
</pd>
<p5>zz0</p5>
</p2>
</row>

<row>
<pl>1</pl>
<p2 width="6" height="3">
<p3>how are you</p3>
<p4d>
<p3>hi</p3>
<p6>xx1</pb>
<p7>yyl</p7>
</pd>
<p5>zzl1</p5>
</p2>
</row>
</test>

Example 4-5 8_sch.xml

===8_sch.xml===
<Schema xmlns="urn:schemas-microsoft-com:xml-data"
xmlns:dt="urn:schemas-microsoft-com:datatypes">
<AttributeType name="height" dt:type="int" />
<ElementType name="test" content="eltOnly" order="many">
<AttributeType name="height" dt:type="int" />
<element type="row"/>
</ElementType>
<ElementType name="row" content="eltOnly" order="many">
<element type="pl"/>
<element type="p2"/>
</ElementType>
<ElementType name="p2" content="eltOnly" order="many">
<AttributeType name="width" dt:type="int" />
<AttributeType name="height" dt:type="int" />
<attribute type="width" />
<attribute type="height" />
<element type="p3"/>
<element type="p4"/>
<element type="p5"/>
</ElementType>
<ElementType name="p4" content="eltOnly" order="many">
<element type="p3"/>
<element type="p6"/>
<element type="p7"/>
</ElementType>
<ElementType name="test0" content="eltOnly" order="many">
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<element type="row"/>
</ElementType>
<ElementType name="pl" content="textOnly" dt:type="string"/>
<ElementType name="p3" content="textOnly" dt:type="string"/>
<ElementType name="p5" content="textOnly" dt:type="string"/>
<ElementType name="p6" content="textOnly" dt:type="string"/>
<ElementType name="p7" content="textOnly" dt:type="string"/>
</Schema>

Example 4-6 84.xml

===84.xml===
<?xml version="1.0"?>
<test(0 xmlns="x-schema:8_sch.xml">
<row>
<pl>0</pl>
<p2 width="5" height="2">
<p3>hi</p3>
<pd>
<p3>hi</p3>
<p6>xx0</p6>
<p7>yy0</p7>
</pd>
<p5>zz0</p5>
</p2>
</row>

<row>
<pl>1</pl>
<p2 width="6" height="3">
<p3>how are you</p3>
<p4d>
<p3>hi</p3>
<p6>xx1</p6>
<p7>yyl</p7>
</pd>
<p5>zzl</p5>
</p2>
</row>
</test0>

Example 4-7 Island2.htm

===igland2.htm===
<HTML>
<HEAD>
<TITLE>HTML Document with Data Island</TITLE>
</HEAD>
<BODY>
<p>This is an example of an XML data island in I.E. 5</p>
<XML ID="12345">
test>
<row>
<fieldl1>00</fieldl>
<field2>01</field2>
</row>
<row>
<fieldl>10</fieldl>
<field2>11</field2>
</row>
<row>
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<fieldl1>20</fieldl>
<field2>21</field2>
</row>
</test>
</XML>
<p>End of first example.</p>
<XML ID="12346">
<test>
<row>
<fieldl11>00</fieldll>
<fieldl2>01</fieldl2>
</row>
<row>
<fieldl1>10</fieldll>
<fieldl2>11</field12>
</row>
<row>
<fieldl1>20</fieldll>
<fieldl2>21</field12>
</row>
</test>
</XML>
<p>End of second example.</p>
</BODY>
</HTML>

Using a Standby Database with Oracle Business Intelligence

A standby database is used mainly for its high availability and failover functions as a
backup for the primary database. In a standby database configuration, there is
regularly scheduled replication from the primary database to the secondary database.
The latency of this replication must be short enough that writing to the primary
database while reading from the secondary database does not cause any
synchronization or data integrity problems.

Because a standby database is essentially a read-only database, it can be used as a
business intelligence query server, relieving the workload of the primary database and
improving query performance.

The following sections explain how to use a standby database with Oracle Business
Intelligence:

= About Using a Standby Database with Oracle Business Intelligence

»  Creating the Database Object for the Standby Database Configuration
= Creating Connection Pools for the Standby Database Configuration

»  Updating Write-Back Scripts in a Standby Database Configuration

= Setting Up Usage Tracking in a Standby Database Configuration

= Setting Up Event Polling in a Standby Database Configuration

= Setting Up Oracle BI Scheduler in a Standby Database Configuration

About Using a Standby Database with Oracle Business Intelligence

In a standby database configuration, you have two databases: a primary database that
handles all write operations and is the source of truth for data integrity, and a
secondary database that is exposed as a read-only source. When you use a standby
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database configuration with Oracle Business Intelligence, all write operations are
offloaded to the primary database, and read operations are sent to the standby
database.

Write operations that need to be routed to the primary source may include the
following:

s Oracle BI Scheduler job and instance data

s Temporary tables for performance enhancements

= Writeback scripts for aggregate persistence

= Usage tracking data, if usage tracking has been enabled

= Event polling table data, if event polling tables are being used

The following list provides an overview of how to configure the Oracle BI Server to
use a standby database:

1. Create a single database object for the standby database configuration, with
temporary table creation disabled.

2. Configure two connection pools for the database object:
= A read-only connection pool that points to the standby database

= A second connection pool that points to the primary database for write
operations

3. Update any connection scripts that write to the database so that they explicitly
specify the primary database connection pool.

4. If usage tracking has been enabled, update the usage tracking configuration to use
the primary connection.

5. If event polling tables are being used, update the event polling database
configuration to use the primary connection.

6. Ensure that Oracle BI Scheduler is not configured to use any standby sources.

Even though there are two separate physical data sources for the standby database
configuration, you create only one database object in the Physical layer. Figure 4—4
shows the database object and connection pools for the standby database
configuration in the Physical layer.

Figure 4-4 Standby Database Configuration in the Physical Layer
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Creating the Database Object for the Standby Database Configuration

Use the Administration Tool to create a database object in the repository for the
standby database configuration. When you create the database object, make sure that
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the persist connection pool is not assigned, to prevent the Oracle BI Server from
creating temporary tables in the standby database.

To create a database object for the standby database configuration:
1. In the Administration Tool, right-click the Physical layer and select New Database.

2. Provide a name for the database, and then select the type of database in the
Database list.

3. Ensure that the Persist connection pool is "not assigned."

Figure 4-5 shows the Database dialog for a standby database configuration.

Figure 4-5 Database Dialog for Standby Database Configuration
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Creating Connection Pools for the Standby Database Configuration

After you have created a database object in the repository for the standby database
configuration, use the Administration Tool to create two connection pools: one that
points to the standby database, and another that points to the primary database.

Because the standby connection pool is used for the majority of connections, make
sure that the standby connection pool is listed first.

Note: Connection pools are used in the order listed, until the
maximum number of connections is achieved. Ensure that the
maximum number of connections is set in accordance with the
standby database tuning.

See "Creating or Changing Connection Pools" for more information
about setting the maximum number of connections.

To create a standby connection pool for the standby database configuration:

1. In the Administration Tool, in the Physical layer, right-click the database object for
the standby database configuration and select New Object, then select
Connection Pool.
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2. Provide a name for the connection pool, and ensure that the call interface is
appropriate for the standby database type.

3. Provide the Data source name for the standby database.
4. Enter a user name and password for the standby database.
5. Click OK.

Figure 4-6 shows the Connection Pool dialog for the standby connection pool.

Figure 4-6 Connection Pool Dialog for Standby Connection Pool
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To create the primary connection pool for the standby database configuration:

1. In the Administration Tool, in the Physical layer, right-click the database object for
the standby database configuration and select New Object, then select
Connection Pool.

2. Provide a name for the connection pool, and ensure that the call interface is
appropriate for the primary database type.

3. Provide the Data source name for the primary database.
4. Enter a user name and password for the primary database.
5. Click OK.

Figure 4-7 shows the Connection Pool dialog for the primary connection pool.
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Figure 4-7 Connection Pool Dialog for Primary Connection Pool
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Updating Write-Back Scripts in a Standby Database Configuration

If you use scripts that write to the database, such as scripts for aggregate persistence,
you must update the scripts to explicitly refer to the primary connection pool.
Information written through the primary connection will be automatically transferred
to the standby database (through the regularly scheduled replication between the
primary and secondary databases), and will become available through the standby
connection pool.

The following example shows a writeback script for aggregate persistence that
explicitly specifies the primary connection pool:

create aggregates sc_rev_gty_yr_cat for "DimSnowflakeSales"."SalesFacts"
("Revenue", "QtySold") at levels ("DimSnowflakeSales"."Time"."Year",
"DimSnowflakeSales"."Product"."Category") using connection pool
"StandbyDemo" . "Primary Connection" in "StandbyDemo"."My_Schema"

Setting Up Usage Tracking in a Standby Database Configuration

The Oracle BI Server supports the collection of usage tracking data. When usage
tracking is enabled, the Oracle BI Server collects usage tracking data for each query
and writes statistics to a usage tracking log file or inserts them directly to a database
table.

If you want to enable usage tracking on a standby database configuration using direct
insertion, you must create the table used to store the usage tracking data (typically S_
NQ_ACCT) on the primary database. Then, import the table into the physical layer of
the repository using the Administration Tool.

You must ensure that the database object for the usage tracking table is configured
with both the standby connection pool and the primary connection pool. Then, ensure
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that the CONNECTION_POOL parameter for usage tracking points to the primary
database. For example, in NQSConfig.ini:

CONNECTION_POOL = "StandbyDatabaseConfiguration"."Primary
Connection";

See "Managing Usage Tracking" in Oracle Fusion Middleware System Administrator’s
Guide for Oracle Business Intelligence Enterprise Edition for full information about usage
tracking, including how to create tables for usage tracking data and how to set
parameters for usage tracking.

Setting Up Event Polling in a Standby Database Configuration

You can use an Oracle Bl Server event polling table (event table) as a way to notify the
Oracle BI Server that one or more physical tables have been updated. The event table
is a physical table that resides on a database accessible to the Oracle BI Server. It is
normally exposed only in the Physical layer of the Administration Tool, where it is
identified in the Physical Table dialog as an Oracle BI Server event table.

The Oracle BI Server requires write access to the event polling table. Because of this, if
you are using event polling in a standby database configuration, you must ensure that
the database object for the event table only references the primary connection pool.

See "Cache Event Processing with an Event Polling Table" in Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for full
information about event polling, including how to set up, activate, and populate event
tables.

Setting Up Oracle Bl Scheduler in a Standby Database Configuration

Oracle BI Scheduler is an extensible application and server that manages and
schedules jobs, both scripted and unscripted. To use Oracle BI Scheduler in a standby
database configuration, you must ensure that the database object for Oracle BI
Scheduler only references the primary connection pool.

See "Configuration Tasks for Oracle BI Scheduler" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for full
information about setting up and using Oracle BI Scheduler.
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Working with ADF Business Component
Data Sources

Oracle Business Intelligence supports connecting to ADF Business Components as
data sources. This enables Oracle Business Intelligence users to query data from any
application that is built using the ADF Framework. For example, because Oracle CRM
applications are developed using the ADF Framework, Oracle Business Intelligence
users can report on CRM data using an ADF Business Component data source that
implements the required ADF Application Programming Interface (API).

By using the ADF components as a data source to the Oracle Bl Server, users can
quickly integrate operational reporting with any application that is built on top of the
ADF Framework.

This chapter contains the following topics:

s What Are ADF Business Components?

s What Happens During Import?

= About Specifying a SQL Bypass Database

»  Setting Up ADF Business Component Data Sources

»  Importing Metadata from ADF Business Component Data Sources

= Enabling the Ability to Pass Custom Parameters to the ADF Application

What Are ADF Business Components?

Oracle Application Development Framework (Oracle ADF) is an object-relational
framework that can be used to create J2EE business services and expose underlying
database objects. This framework provides an abstraction layer that enables
application developers to build applications quickly and efficiently.

When you use Oracle ADF to build service-oriented Java EE applications, you
implement your core business logic as one or more business services. These back-end
services provide clients with a way to query, insert, update, and delete business data
as required, while enforcing appropriate business rules. ADF Business Components
are prebuilt application objects that provide a ready-to-use implementation of Java EE
design patterns and best practices.

The ADF model is represented through the ADF Business Component constructs
called Entity Objects and View Objects, usually constructed and defined during design
time:

= Entity Objects: ADF framework components that represent a row in a database
table and simplify modifying its data. Importantly, it enables you to encapsulate
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domain business logic for those rows to ensure your business policies and rules
are consistently validated.

= View Objects: ADF framework components that encapsulate a SQL query and
simplify working with its results. In addition to read-only view objects, there are
entity-based view objects that support updatable rows. The view object queries just
the data needed for the client-facing task at hand, then cooperates with one or
more entity objects in your business domain layer to automatically validate and
save changes made to its view rows. Like the read-only view object, an
entity-based view object encapsulates a SQL query, can be linked into
master/detail hierarchies using view links, and can be used in the data model of
your application modules.

Applications built using ADF obtain their data by querying the defined View
Objects using the ADF APlIs.

The ADF model also includes an application module, which is the transactional
component that Ul clients use to work with application data. It defines an updatable
data model along with top-level procedures and functions (called service methods)
related to a logical unit of work related to an end-user task.

The application module serves as a container for multiple View Objects and Entity
Objects, and also contains configuration related to the JDBC data source.

About Operational Reporting with ADF Business Components

You can use Oracle Business Intelligence integration with ADF Business Components
to generate reports on data within your applications. For example, you can generate
reports based on expense report data entered into an Expense Application.

To do this, you would first import the Expense Application metadata into the Oracle
Bl repository using the Administration Tool, then map the data from the Physical layer
to the Business Model and Mapping layer and Presentation layer. After you restart the
Oracle BI Server and reload the metadata into Oracle BI Presentation Services, you can
log in to Oracle BI Answers and drag and drop the columns to generate a report on the
Expense Application data. For example, you can select columns to view a report of
your expenses grouped by category.

What Happens During Import?

On import, the required physical tables and complex joins are automatically created.
The instances (ViewObject and ViewLink) are imported into Oracle Business
Intelligence. During query execution, the definitions retrieved from these instances are
used to create the CompositeVO in ADF.

These complex joins are 'dummy joins' and are not executed in Oracle Business
Intelligence. Instead, they denote ViewLink instances that connect pairs of View
Objects in the ADF model. The physical table and complex join names correspond to
the fully qualified ViewObject and ViewLink instance names, respectively. This
convention allows arbitrary nesting of ApplicationModules in the ADF model.

Note that the External Expression field in the Complex Join dialog for ADF data
sources shows an arbitrary expression that has no meaning. This field is reserved for a
future release.

The name of the automatically generated joins follow a naming convention similar to
ViewObjectNamel_ViewObjectName2 (for example, AppModuleAM.AP_VO1_
AppModuleAM_BU_VO1). The ViewLink instance name appears in the ViewLink
Name field of the Complex Join dialog.
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The complex joins are only created automatically if a ViewLink instance is available.
They are not created for ViewLink definitions. Joins using ViewLink definitions must
be created manually. To do this, specify the ViewLink definition name in the ViewLink
Name field of the Complex Join dialog.

Alternatively, Oracle Business Intelligence joins between VOs in different
ApplicationModules are created upon import from ADF if custom properties are
defined on the ApplicationModule. Note the following;:

s The property name format is Bl VIEW_LINK_property_name

»  The property value format is source_VO_instance_name, ViewLink_definition_name,
destination_VO_instance_name

Be sure to use the fully qualified VO instance names for the source and destination
VOs, as well as the fully qualified package name for the ViewLink definition.

About Specifying a SQL Bypass Database

The Oracle BI Server can automatically create composite View Objects at run time, so
that an ad-hoc BI query can reference multiple View Objects in the ADF layer. For
improved performance, a SQL bypass query is generated that incorporates the
projection columns, filters, and joins required by the BI query.

The SQL Bypass feature directly queries the database so that aggregations and other
transformations are pushed down where possible, reducing the amount of data
streamed and worked on in Oracle Business Intelligence. When using a SQL Bypass
database, the Oracle BI Server gets the VO query from the ADF Business Component
data source and then wraps it with the aggregations in the Logical SQL query. The
query, including the aggregations, is then executed in the database. Because the
database computes the aggregation and less rows are streamed back to Oracle
Business Intelligence, using a SQL Bypass database can result in significant
performance gains.

Multiple View Objects are modeled as separate BI physical tables and are connected
with dummy complex joins. These joins only represent the ViewLinks in the ADF
model and are not executed by the Oracle BI Server.

You can specify the name of the SQL Bypass database in the connection pool for the
ADF Business Component data source. The SQL Bypass database must be a physical
database in the Physical layer of the repository. The database object for the SQL Bypass
database must have a valid connection pool, with connection information that points
to the same database that is being used by the JDBC Data source defined in the Oracle
WebLogic Server that runs the ADF application.

The SQL Bypass database does not need to have any tables under it. After a valid
database name is supplied, the SQL Bypass feature is enabled for all queries against
that ADF database.

Setting Up ADF Business Component Data Sources

This section explains how to configure your ADF Business Components for use with
Oracle Business Intelligence.

See "System Requirements and Certification" for information about supported
versions.

This section contains the following topics:

s Creating a WebLogic Domain
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= Deploying OBIEEBroker as a Shared Library in Oracle WebLogic Server

s Deploying the Application EAR File to Oracle WebLogic Server from JDeveloper

s Setting Up a JDBC Data Source in the WebLogic Server

s Setting the Logging Level for the Deployed Application in Oracle WebLogic Server

Creating a WebLogic Domain

Create a WebLogic Domain for your ADF Business Components that supports
WebLogic Server, Oracle Application Core (Webapp), and Oracle JRF.

To create a WebLogic domain that supports the required components:

1. Start the WebLogic Configuration Wizard. For example, on Windows, run MW_
HOME\wlserver_10.3\common\bin\config.cmd.

2. Select Create a new WebLogic domain and click Next.

3. On the Select Domain Source screen, ensure that Basic WebLogic Server Domain,
Oracle JRF, and Oracle Application Core (Webapp) are selected.

4. Follow the remaining steps in the wizard, providing values appropriate for your
environment.

5. Click Create on the Configuration Summary screen to create the domain.

You can start and stop the Oracle WebLogic Server for this domain using
command-line scripts in the domain directory. For example, on Windows, use the
following:

s  MW_HOME\user_projects\domains\domain_name\bin\startWebLogic.cmmd
s  MW_HOME\user_projects\domains\domain_name\bin\stopWebLogic.cmd

Deploying OBIEEBroker as a Shared Library in Oracle WebLogic Server

The OBIEEBroker shared library is installed as part of your Oracle Business
Intelligence installation. You need to deploy the OBIEEBroker library as a shared
library in Oracle WebLogic Server by installing it (making its physical file or directory
known to Oracle WebLogic Server) and starting it. After the library has been installed
and started, other deployed modules can reference the library.

To deploy OBIEEBroker as a shared library in Oracle WebLogic Server:

1. Ensure that Oracle WebLogic Server is running. If it is not running, start it. For
example, on Windows, run MW_HOME\user_projects\domains \your_
domain\bin\startWebLogic.cmd.

2. Open the WebLogic Server Administration Console. For example, if your Oracle
WebLogic Server is running locally on port 7001, go to
http://localhost:7001/console.

3. Login to the WebLogic Server Administration Console with the credentials you
created when you set up your WebLogic domain.

In the Change Center, click Lock & Edit.
On the Home Page, in the left pane, click Deployments.
In the right pane, click Install.

N o a &

Using the Install Application Assistant, locate the OBIEEBroker EAR file. You can
find this file at:
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10.

11.

12.

13.
14.

ORACLE_HOME\bifoundation\javahost\lib\obisintegration\adf\
oracle.bi.integration.adf.ear

Click Next.
Select Install this deployment as a library and click Next.

Select the servers and/or clusters to which you want to deploy the OBIEEBroker
library. Make sure to select all servers and clusters to which modules or
applications that reference the library are deployed.

Click Next.

You can optionally update settings about the deployment. Typically, the default
values are adequate. Click Help for more information.

Click Next, then click Finish to complete the installation.
In the Change Center, click Activate Changes.

Deploying the Application EAR File to Oracle WebLogic Server from JDeveloper

Follow the steps in this section to deploy the application EAR file to Oracle WebLogic
Server from JDeveloper. Before beginning this procedure, ensure that the following
conditions are true:

You have an ADF Model project that contains AMs and VOs that will be exposed
to Oracle Business Intelligence.

You have deployed OBIEEBroker as a shared library in Oracle WebLogic Server.
See "Deploying OBIEEBroker as a Shared Library in Oracle WebLogic Server" for
more information.

Oracle WebLogic Server is running.

To deploy the application EAR file to Oracle WebLogic Server from JDeveloper:

1.

4,

Start JDeveloper. For example, on Windows, run MW_
HOME\jdeveloper\jdev\bin\jdev.exe.

Select File, then select Open to open the project that contains your ADF Business
Components in JDeveloper. If prompted, allow JDeveloper to migrate the project
to the latest version.

Create a new Application Module configuration, as follows:

a. In the Model project, double click the application module, then click the
Configurations tab for that application module.

b. Create a new configuration with the following characteristics:
- Select JDBC DataSource for Connection Type.

- Keep the default DataSource Name (for example,
java:comp/env/jdbc/ApplicationDBDS).

When you set up the JDBC data source in Oracle WebLogic Server in a later
step, you use part of this DataSource Name as the JNDI name required by
Oracle WebLogic Server. The JNDI name is the DataSource Name without the
java:comp/env context prefix (for example, jdbc/ApplicationDBDS).

Create a Business Component Archive deployment provide, as follows:

a. In the Projects window, right-click the Model project and choose New.
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b. Select Deployment Profiles under General in the left pane, then choose
Business Components Archive in the right pane and click OK.

c. Provide a name for the deployment profile (for example, MyApplication_
Archive) and click OK.

d. On the Deployment page, click OK.

5. In the Projects window, right-click the Model project and select Deploy > your_
deployment_profile_name > Deploy, or use the deployment wizard by selecting
Deploy to File.

After the project has been deployed, two jar files are created in the deploy
directory for the Model project (for example, MyApplication_Archive_
Common.jar and MyApplication_Archive_MiddleTierjar).

6. Create a new Web Project for the application, as follows:
a. Right-click the global application and select New Project.
b. Select Projects from the left pane, then select Web Project from the right pane.

c. Provide a project name (for example, OBIEEBroker).

e

Click Next until you reach the Web Project Profile page.

e. Modify the Java EE Context Root to a name that better represents your
application (for example, MyApplication).

This value determines the URL that you use to connect to the application from
Oracle Business Intelligence (for example,
http:/ /localhost:7001/MyApplication/obieebroker).

7. Edit the Profile Dependencies of the WAR deployment, as follows:

a. Right-click the Web Project you just created (for example, OBIEEBroker) and
select Project Properties.

b. From the left pane, select Deployment. Then, open the WAR File deployment
profile on the right pane.

c. Select Profile Dependencies from the left pane. Then, on the right pane, select
the Common and MiddleTier deployment profiles of your Model project.

Following this step ensures that the Business Component Archives for the
Model project are included in the WAR file.

8. [Expand the Web Project and open web.xml. Then, go to the source view of the file.

9. In the web.xml source, replace the content within the <web-app> element with the
following:

<filter>
<filter-name>ServletADFFilter</filter-name>
<filter-class>oracle.adf.share.http.ServletADFFilter</filter-class>

</filter>

<filter-mapping>
<filter-name>ServletADFFilter</filter-name>
<servlet-name>0BIEEBroker</servlet-name>
<dispatcher>FORWARD</dispatcher>
<dispatcher>REQUEST</dispatcher>

</filter-mapping>

<servlet>
<servlet-name>0OBIEEBroker</servlet-name>
<servlet-class>oracle.bi.integration.adf.v1llg.obieebroker.0OBIEEBroker
</servlet-class>
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10.

11.

12.
13.

14.

15.

</servlet>

<servlet-mapping>
<servlet-name>OBIEEBroker</servlet-name>
<url-pattern>/obieebroker</url-pattern>

</servlet-mapping>

Following this step ensures that the OBIEEBroker servlet will be used to access
your application from Oracle Business Intelligence.

Create an EAR deployment profile for the application, as follows:

a. Right-click the global application and select Application Properties.

b. From the left pane, select Deployment, then click New on the right pane to
create a new deployment profile.

c. For Archive Type, select EAR File. Then, provide a name for the deployment
profile (for example, MyApplication).

The deployment profile name is used as the name displayed in the list of
deployments in Oracle WebLogic Server.

d. From the left pane, select Application Assembly. Then, on the right pane,
select the webapp deployment profile of your Web Project.

Following this step ensures that the WAR file from your Web Project is
included in the EAR file.

Under Application Resources, select Descriptors > META-INF >
weblogic-application.xml.

On the left, select the Libraries tab.
Create two new Shared Library References, as follows:
s Create the first Shared Library Reference with the following characteristics:
— Library Name: oracle.bi.integration.adf
— Implementation Version: 11.1.1.2.0
s Create the second Shared Library Reference with the following characteristics:
- Library Name: oracle.applcore.model
— Implementation Version: 11.1.1.0.0

These two Shared Library References create the following entries in the
weblogic-application.xml file for the application:

<library-ref>
<library-name>oracle.bi.integration.adf</library-name>
<implementation-version>11.1.1.2.0</implementation-version>

</library-ref>

<library-ref>
<library-name>oracle.applcore.model</library-name>
<implementation-version>11.1.1.0.0</implementation-version>

</library-ref>

Deploy the EAR file to Oracle WebLogic Server by right-clicking the global
application, then selecting Deploy > EAR_deployment_profile_name. From the
dialog that appears, select Deploy to Application Server and then follow the
instructions in the wizard.

To verify that the application has been deployed, log in to the WebLogic Server
Administration Console and click Deployments under Your Deployed Resources.
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Verify that your application appears in the list (for example, obieebroker_app_
name).

Setting Up a JDBC Data Source in the WebLogic Server
You must set up a JDBC data source in Oracle WebLogic Server for your application.
To set up a JDBC data source in Oracle WebLogic Server:

1. Ensure that Oracle WebLogic Server is running. If it is not running, start it. For
example, on Windows, run MW_HOME\user_projects\domains \your_
domain\bin\startWebLogic.cmd.

2. Open the WebLogic Server Administration Console. For example, if your Oracle
WebLogic Server is running locally on port 7001, go to
http://localhost:7001/console.

3. Login to the WebLogic Server Administration Console with the credentials you
created when you set up your WebLogic domain.

4. On the Home Page, select JDBC, then select Data Sources.
5. Click New.

6. Provide information for your data source. For Name and JNDI Name, provide the
DataSource Name you specified in the Application Module configuration for the
application, without the java:comp/env context prefix (for example,
jdbc/ApplicationDBDS). In addition, make sure to select the target on which you
want to deploy the data source before exiting the wizard.

7. Click Finish when you are done providing JDBC data source settings.

Setting the Logging Level for the Deployed Application in Oracle WebLogic Server

The log file for the server to which your application is deployed (server_
name-diagnostic.log) records information about your deployed application. You can
find this file in the server-specific directory within your domain. For example, on
Windows, the log file for the AdminServer is located in:

MW_HOME\user_projects\domains\your_domain\servers\AdminServer\logs

To set the logging level for your deployed application:

1. Open the Oracle WebLogic Server file logging.xml for editing. You can find this
file in:

MW_HOME\user_projects\domains\your_domain\config\fmwconfig\servers\server._name

2. Within the <loggers> element, add the following child elements:

<logger name="oracle.bi.integration.adf" level="LOG_LEVEL"/>
<logger name="oracle.bi.integration.adf.vllg.obieebroker" level="LOG_LEVEL"/>

Log levels include SEVERE, WARNING, INFO, CONFIG, FINE, FINER, and FINEST.
Refer to the Oracle WebLogic Server documentation for information about logger
levels.

3. Save and close the file.

4. Restart Oracle WebLogic Server.
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Importing Metadata from ADF Business Component Data Sources

You must complete the steps in "Setting Up ADF Business Component Data Sources"
before you can import metadata from ADF Business Component data sources.

To import metadata from an ADF Business Component data source:

1. In the Administration Tool, select File, then select Import Metadata. The Import
Metadata Wizard appears.

Note: If you have already defined an existing ADF Business
Component data source and connection pool, you can right-click the
connection pool in the Physical layer and select Import Metadata. The
Import Metadata Wizard appears with the information on the Select
Data Source screen pre-filled.

Figure 5-1 shows the Import Metadata Wizard.

Figure 5-1 Import Metadata Wizard: ADF Business Component Data Source

Import Metadata - Select Data Source o =]
Select Data Source MR I ILocaI Hadine j
Connection Type: IOracIeADF_HTTP j
2 | Select Metadata Types
Conneckion Pool:
3 | Select Metadata Objects i+ New Connection Existing Connection BrowWse, ., |
Daka Source: I jdbefrwindDS

AppModule Definition: | snowflakesales, snowflakesalesapp

AppMadule Config: I SnoviflakesalesMy Ofpplocal

LRL: | http:f{computer .corp.com: 7001 /Snowflakesalesty O obiesbroker
User Mame: I my_User
Password: I skttt

Help | Eack | Text I Fimish | Cancel |

[Far Help, press F1 4

2. In the Select Data Source screen, select OracleADF_HTTP for Connection Type.
Then, provide the following values:

Select New Connection, or select Existing Connection if you already have a
connection pool for this data source. Click Browse to locate and select an
existing connection pool. If you select Existing Connection, you do not
provide information for Data Source, AppModule Definition, AppModule
Config, or URL, and the User Name and Password fields are prefilled.

Keep the Data Source field blank to use the default JDBC data source
configured in the application module. You only need to provide data source
information (a JDBC data source name, such as jdbc/nWindORAO5) if you
want to use a different data source than the one set up in the application
module.
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- For AppModule Definition, provide the fully qualified Java package name of
the Root Application Module to which you want to connect, such as
oracle.apps.fii.receivables.model.RootAppModule, or
snowflakesales.SnowflakeSalesApp.

- For AppModule Config, provide the name of the configuration you want to
use in your connection, such as RootAppModuleShared or
SnowflakeSalesAppLocal. See step 3 of "Deploying the Application EAR
File to Oracle WebLogic Server from JDeveloper" for more information.

— For URL, provide the URL to the Oracle Business Intelligence broker servlet,
in the format:

http://host:port/APP_DEPLOYMENT NAME/obieebroker

For example:

http://localhost:7001/MyApp/obieebroker

The URL is case-sensitive.

— For User Name and Password, provide a valid user name and password for
the Oracle ADF application. The user name and password must be set up and
authenticated in the Oracle WebLogic Server security realm.

When you have finished providing information in the Select Data Source screen,
click Next. The Select Metadata Objects screen appears.

3. Select the objects you want to import in the Available list and move them to the
Selected list, using the > (Import selected) or >> (Import all) buttons. You can also
move objects from the Selected list back to the Available list, using the < (Remove
selected) and << (Remove all) buttons.

To search for a particular item, enter a keyword in the Find box and then click
Find Down or Find Up.

Select Show complete structure to view all objects, including those that have
already been imported. Deselecting this option shows only the objects that are
available for import. When this option is selected, objects that have already been
imported appear grayed out.

When you move the items from the Available list to the Selected list, the
Connection Pool dialog opens, showing the values that you provided in the Select
Data Source screen of the Import Metadata Wizard. Optionally, click the
Miscellaneous tab and provide the name of a SQL Bypass database in the SQL
Bypass Database field. Then, click OK. If you do not want to specify a SQL Bypass
database, click Cancel.

See "About Specifying a SQL Bypass Database" for more information.
4. Click Finish.

5. To validate that your import was successful, expand the database object for the
ADF Business Component data source in the Physical layer. Then, right-click a
physical table and click View Data. If the appropriate data is displayed, the import
completed successfully.

Enabling the Ability to Pass Custom Parameters to the ADF Application

Some ADF applications have custom properties defined on the ApplicationModule,
such as EFFECTIVE_DATE or TREE_VERSION. You can include these custom
properties in your application queries, and the Oracle BI Server will pass them to the
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ADF application. To enable this feature, you must register the custom properties as a
static repository variable using the Administration Tool.

You cannot use this feature to pass any custom property to your ADF application.
Only certain custom properties, like EFFECTIVE_DATE and TREE_VERSION, are
supported.

To register custom properties:

1. Open your repository in the Administration Tool.
2. Select Manage, then select Variables.

3. Select Action > New > Repository > Variable.

4

For Name, enter ADF_PARAM_LIST. Do not enter the name of the custom
property as the name of the variable.

o

Ensure that the Type is Static.

6. For Default Initializer, enter the name or names of the custom properties as a
character string. If you have multiple custom properties, include them as a
comma-delimited list. For example:

'PARAM_EFFECTIVE_DATE'

'PARAM_EFFECTIVE_DATE, ApplicationldBind, KeyFlexfieldCodeBind'
7. Click OK.
8. Save and close the repository.

After you register the custom properties as a repository variable, you can include these
variables in queries. For example:

set variable PARAM_EFFECTIVE_DATE=2001-01-01 : SELECT cl FROM tl1;

or

set variable ApplicationIdBind = '0', KeyFlexfieldCodeBind = 'KFF1' :
select_physical ApplicationID, KeyFlexfieldCode, DataSecurityObjectName,
SegmentLabelCode from adfdb..."AppModule.KFFHierFilterVol";

Note that when you are including a custom property of type PARAM_EFFECTIVE_
DATE, the date format for the property value must be in the format yyyy-mm-dd.
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Setting Up Database Objects and
Connection Pools

Properties for database objects and connection pools are typically set automatically
when you import metadata from your data sources. However, in some cases you may
want to adjust database or connection pool settings, or create a database object or
connection pool manually. This chapter describes the properties of the database and
connection pool objects in the Physical layer.

This chapter contains the following sections:
»  Setting Up Database Objects

= About Connection Pools

s Creating or Changing Connection Pools

s Setting Up Persist Connection Pools

Setting Up Database Objects

Importing metadata from a data source automatically creates a database object for the
schema, but you may need to adjust the database properties.

See "System Requirements and Certification" for information about supported data
sources.

The following sections provide information about how to create or edit database
objects in the Physical layer:

= About Database Types in the Physical Layer
»  Creating a Database Object Manually in the Physical Layer
= Specifying SQL Features Supported by a Data Source

About Database Types in the Physical Layer

If you import the physical schema into the Physical layer, the database type is usually
assigned automatically. The following list contains additional information about
automatic assignment of database types:

= Relational data sources. During the import process, some ODBC drivers provide
the Oracle BI Server with the database type. However, if the server cannot
determine the database type, an approximate ODBC type is assigned to the
database object. Replace the ODBC type with the closest matching entry from the
Database list.
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= Multidimensional data sources. Microsoft Analysis Services and SAP/BW are the
only supported XMLA-compliant data sources currently available. After you
import metadata from a multidimensional data source, check the database object
and update the appropriate database type and version if necessary.

Creating a Database Object Manually in the Physical Layer

If you create a database object manually, you need to manually set up all database
elements such as the connection pool, tables, and columns.

For multidimensional data sources, if you create the physical schema in the Physical
layer of the repository, you need to create one database in the physical layer for each
cube, or set of cubes, that belong to the same catalog (database) in the data source. A
physical database can have more than one cube. However, all of these cubes must be
in the same catalog in the data source.

Caution: It is strongly recommended that you import your physical
schema.

To create a database object:

1. In the Administration Tool, in the Physical layer, right-click and select New
Database.

Make sure that no object is selected when you right-click.

2. In the Database dialog, in the General tab, complete the fields using Table 6-1 as a
guide.

Table 6—1 Options in the General Tab of the Database Dialog

Option Description
Data source definition: The database type for your database.
Database

See "Specifying SQL Features Supported by a Data Source" for
more information about using the Features tab to examine the
SQL features supported by the specified database type.

Data source definition: This property is only available for relational data sources and is
CRM metadata tables for legacy Siebel Systems sources only.

When selected, indicates that the definition of physical tables
and columns for Siebel CRM tables was derived from the Siebel
metadata dictionary.

Data source definition: Identifies the physical database source as a virtual private
Virtual Private Database database (VPD). When a VPD is used, returned data results are
contingent on the user's authorization credentials. Therefore, it
is important to identify these sources. These data results affect
the validity of the query result set that is used with caching. See
"Managing Performance Tuning and Query Caching" in Oracle
Fusion Middleware System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition.

Note: If you select this option, you also should select the
Security Sensitive option in the Session Variable dialog. See
"Creating Session Variables" for more information.

Persist connection pool To use a persistent connection pool, you must set up a
temporary table first. See "Setting Up Persist Connection Pools"
for more information.
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Table 6-1 (Cont.) Options in the General Tab of the Database Dialog

Option

Description

Allow populate queries by
default

When selected, allows everyone to execute POPULATE SQL. If
you want most, but not all, users to be able to execute

POPULATE SQL, select this option and then limit queries for
specific users or groups. See "Setting Query Limits" for more

information.
Allow direct database When selected, allows all users to execute physical queries. The
requests by default Oracle BI Server sends unprocessed, user-entered, physical SQL

directly to an underlying database. The returned results set can
be rendered in Oracle BI Presentation Services, and then
charted, rendered in a dashboard, and treated as an Oracle BI
request.

If you want most, but not all, users to be able to execute
physical queries, select this option and then limit queries for
specific users or groups. See "Setting Query Limits" for more
information.

Caution: If configured incorrectly, this option can expose
sensitive data to an unintended audience. See "When to Allow
Direct Database Requests by Default" for more information.

For more information about executing physical SQL, see
"Working with Direct Database Requests" in Oracle Fusion
Middleware User’s Guide for Oracle Business Intelligence Enterprise
Edition.

When to Allow Direct Database Requests by Default

The property Allow direct database requests by default lets all users execute physical
queries. If configured incorrectly, it can expose sensitive data to an unintended
audience. Use the following recommended guidelines when setting this database
property:

The Oracle BI Server should be configured to accept connection requests only from
a computer on which the Oracle BI Server, Oracle BI Presentation Services, or
Oracle BI Scheduler are running. This restriction should be established at the
TCP/1IP level using the Oracle BI Presentation Services IP address. This allows
only a TCP/IP connection from the IP address of Oracle BI Presentation Services.

To prevent users from running nqemd (a utility that executes SQL scripts) by
logging in remotely to this computer, you should disallow access by the following
to the computer on which you installed Oracle BI Presentation Services:

- TELNET

— Remote shells

— Remote desktops

- Teleconferencing software (such as Windows NetMeeting)

If necessary, you might want to make an exception for users with administrator
permissions.

Only users with administrator permissions should be allowed to perform the
following tasks:

— TELNET into the Oracle Bl Server and Oracle BI Presentation Services
computers to perform tasks such as running nqcmd for cache seeding.
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- Access the advanced SQL page of Answers to create requests. For more
information, see Oracle Fusion Middleware User’s Guide for Oracle Business
Intelligence Enterprise Edition.

= Set up group/user-based permissions on Oracle BI Presentation Services to control
access to editing (preconfigured to allow access by Oracle BI Presentation Services
administrators) and executing (preconfigured to not allow access by anyone)
direct database requests. For more information, see Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence Enterprise Edition.

Specifying SQL Features Supported by a Data Source

When you import metadata or specify a database type in the General tab of the
Database dialog, the set of features for that database object is automatically populated
with default values appropriate for the database type. These are the SQL features that
the Oracle BI Server uses with this data source.

When a feature is marked as supported (checked) in the Features tab of the Database
dialog, the Oracle BI Server typically pushes the function or calculation down to the
data source for improved performance. When a function or feature is not supported in
the data source, the calculation or processing is performed in the Oracle BI Server.

The supported features list in the Features tab uses the feature defaults defined in the
DBFeatures.INI file, located in ORACLE_
INSTANCE\config\OracleBIServerComponent\coreapplication_obisn. Although you
should not moditfy this file directly, it can be useful to look at this file to compare the
features supported by different data source types.

You can tailor the query features for a data source. For example, a new version of a
data source may be released with updated feature support that is not reflected in the
Oracle BI Server defaults. In this case, you can update the settings in the Features tab
to reflect the actual features supported by the new version of the data source. Or, if a
data source supports a particular feature (such as left outer join queries) but you want
to prohibit the Oracle BI Server from sending such queries to a particular data source,
you can change this default setting in the Features tab. A third situation is when you
have federated data sources that execute functions differently. To ensure query results
are consistent, you can disable the appropriate functions so that the calculations are
performed in a consistent manner in the Oracle Bl Server.

Caution: Be very careful when modifying the set of supported
features in the Features tab. If you enable SQL features that the data
source does not support, your query may return errors and
unexpected results. If you disable supported SQL features, the server
could issue less efficient SQL to the data source.

In most cases, you should keep the default values. If you do change
the defaults to mark a feature as supported in the Features tab, make
sure that the feature is actually supported by the data source.

To specify SQL features supported by a data source:

1. In the Administration Tool, in the Physical layer, double-click the database for
which you want to specify SQL features.

2. In the Database dialog, click the Features tab.

3. In the Features tab, use the information in Table 6-2 to help you specify properties
for each SQL feature.
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Table 6—2 Options in the Features Tab of the Database Dialog

Option

Description

Feature

The name of the database feature, such as COUNT_DISTINCT_
SUPPORTED.

Value

Shows the current value for the given feature. Selected indicates
that the feature is supported in the data source, and that the
function or feature should be performed in the data source
rather than in the Oracle BI Server.

Some features show a default value in the Value column rather
than selected /not selected, such as 10 for MAX_ENTRIES_PER_
IN_LIST.

It is strongly recommended that you keep the default selections
and default values.

Default

Shows the default value for the given feature. The defaults
listed in this column are specified in the file DBFeatures.INIL.

Find

Lets you type a string to help you locate a feature in the list.

Find Again

This option becomes available after you click Find. It lets you
perform multiple searches for the same string.

Query DBMS

This button is only used if you are installing and querying a
data source that has no set of feature defaults in the Oracle BI
Server. It lets you query this type of data source for Feature
table entries so that you can find out which SQL features it
supports. You can then change the entries that appear in the
Features tab based on your query results.

This button is not available if you are using an XML or a
multidimensional data source.

Caution: Be very careful when using the Query DBMS feature.
The results of the features query are not always an accurate
reflection of the SQL features actually supported by the data
source. When using this feature, you should verify that the list
of supported features in the Features tab matches the actual
features supported by your data source. Refer to the
documentation for your data source for details.

Reset to defaults

This button restores the default values for this data source type
from the file DBFeatures.INI.

About Connection Pools

The connection pool is an object in the Physical layer that describes access to the data
source. It contains information about the connection between the Oracle BI Server and

that data source.

The Physical layer in the Administration Tool contains at least one connection pool for
each database. When you create the Physical layer by importing a schema for a data

source, the connection pool

is created automatically. You can configure multiple

connection pools for a database. Connection pools allow multiple concurrent data

source requests (queries) to
of connecting to a database.

share a single database connection, reducing the overhead

Note: Itis recommended that you create a dedicated connection pool
for initialization blocks. See "About Connection Pools for Initialization
Blocks" for more information.
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For each connection pool, you must specify the maximum number of concurrent
connections allowed. After this limit is reached, the connection request waits until a
connection becomes available.

Increasing the allowed number of concurrent connections can potentially increase the
load on the underlying database accessed by the connection pool. Test and consult
with your DBA to make sure the data source can handle the number of connections
specified in the connection pool. Also, if the data sources have a charge back system
based on the number of connections, you might want to limit the number of
concurrent connections to keep the charge-back costs down.

In addition to the potential load and costs associated with the database resources, the
Oracle BI Server allocates shared memory for each connection upon server startup.
This raises the number of connections and increases Oracle Bl Server memory usage.

About Connection Pools for Initialization Blocks

It is recommended that you create a dedicated connection pool for initialization
blocks. This connection pool should not be used for queries.

Additionally, it is recommended that you isolate the connections pools for different
types of initialization blocks. This also makes sure that authentication and
login-specific initialization blocks do not slow down the login process. The following
types should have separate connection pools:

=  All authentication and login-specific initialization blocks such as language,
externalized strings, and group assignments.

s All initialization blocks that set session variables.

= Allinitialization blocks that set repository variables. These initialization blocks
should always be run using credentials with administrator privileges.

Be aware of the number of these initialization blocks, their scheduled refresh rate,
and when they are scheduled to run. Typically, it would take an extreme case for
this scenario to affect resources. For example, refresh rates set in minutes, greater
than 15 initialization blocks that refresh concurrently, and a situation in which
either of these scenarios could occur during prime user access time frames.

Initialization blocks should be designed so that the maximum number of Oracle BI
Server variables may be assigned by each block. For example, if you have five
variables, it is more efficient and less resource intensive to construct a single
initialization block containing all five variables. When using one initialization block,
the values are resolved with one call to the back end tables using the initialization
string. Constructing five initialization blocks, one for each variable, would result in
five calls to the back end tables for assignment.

See "Working with Initialization Blocks" for more information about these objects.

Creating or Changing Connection Pools

Typically, database objects and connection pools are created automatically when you
import physical schemas, for both relational and multidimensional data sources. If you
did not import physical schemas, you must create a database object before you create a
connection pool. You create or change a connection pool in the Physical layer of the
Administration Tool.

If you have already defined an existing database and connection pool, you can
right-click the connection pool in the Physical layer and select Import Metadata to
import metadata for this data source. The Import Metadata Wizard appears with the
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information on the Select Data Source screen pre-filled. See Chapter 4, "Importing
Metadata and Working with Data Sources" for information about the Import Wizard.

To automate connection pool changes for use in a process such as production
migration, consider using the Oracle BI Server XML APL. See "About the Oracle BI
Server XML API" in Oracle Fusion Middleware Integrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information.

To create or change a connection pool:

1. In the Physical layer of the Administration Tool, right-click a database and select
New Object, then select Connection Pool. Or, double-click an existing connection
pool.

2. Specify or adjust the properties as needed, then click OK.

The following sections describe how to set properties in the various tabs of the
Connection Pool dialog:

= Setting Connection Pool Properties in the General Tab

»  Setting Connection Pool Properties in the Connection Scripts Tab
s Setting Connection Pool Properties in the XML Tab

= Setting Connection Pool Properties in the Write Back Tab

s Setting Connection Pool Properties in the Miscellaneous Tab

Setting Connection Pool Properties in the General Tab

This section describes the properties in the General tab of the Connection Pool dialog.
The General tab is available for all data sources.

To set general properties for connection pools:

s In the Connection Pool dialog, click the General tab, and then complete the fields
using the information in Table 6-3 and Table 6—4.

The properties listed in the General tab vary according to the data source type. For
example, XMLA data sources have a connection pool property for URL, while
relational and XML data sources have the option Require fully qualified table names.

The following two sections describe connection pool properties on the General tab that
appear for most data source types, and properties that are specific to multidimensional
data sources:

s Common Connection Pool Properties on the General Tab

»  Multidimensional Connection Pool Properties on the General Tab

Common Connection Pool Properties on the General Tab

This section describes connection pool properties on the General tab that are common
among most data source types.

Figure 6-1 shows the General tab of the Connection Pool dialog, for an OCI data
source.
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Figure 6—1 General Tab of the Connection Pool Dialog: OCI Data Source
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Table 6-3 describes the properties in the General tab of the Connection Pool dialog that
are common for different data source types.

Table 6-3 Connection Pool Properties in the General Tab: Common Properties

Property Description

Name The name for the connection pool. A name is assigned
automatically for connection pools created upon import.

Permissions Use this option to assign permissions for individual users or

application roles to access the connection pool. For example,
you can set up a privileged group of users to have its own
connection pool.

This feature is not intended to be used for data access security.
For example, connection pool permissions do not protect cache
entries.

Refer to Chapter 13 for complete information on data access
security in Oracle Business Intelligence.

Call interface

Identifies the application programming interface (API) with
which to access the data source. Some databases can be accessed
using native APIs, some use ODBC, and some work both ways.
If the call interface is XML, the XML tab is available but options
that do not apply to XML data sources are not available.
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Table 6-3 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property

Description

Maximum connections

The maximum number of connections allowed for this
connection pool. The default is 10. This value should be
determined by the database make and model and the
configuration of the hardware for the computer on which the
database runs, as well as the number of concurrent users who
require access.

Note: For deployments with Oracle BI Interactive Dashboards
pages, consider estimating this value at 10% to 20% of the
number of simultaneous users multiplied by the number of
requests on a dashboard. This number can be adjusted based on
usage. The total number of all connections in the repository
should be less than 800. To estimate the maximum connections
needed for a connection pool dedicated to an initialization
block, you might use the number of users concurrently logged
on during initialization block execution.

Require fully qualified table
names

Select this option if the database or database configuration
requires fully qualified table names. This option is not available
for some data source types.

When this option is selected, all requests sent from the
connection pool use fully qualified names to query the
underlying database. The fully qualified names are based on the
physical object names in the repository. If you are querying the
same tables from which the Physical layer metadata was
imported, you can safely select this option. If you have migrated
your repository from one physical database to another physical
database that has different database and schema names, the
fully qualified names would be invalid in the newly migrated
database. In this case, if you do not select this option, the
queries will succeed against the new database objects.

For some data sources, fully qualified names might be safer
because they guarantee that the queries are directed to the
desired tables in the desired database. For example, if the
RDBMS supports a master database concept, a query against a
table named Customer first looks for that table in the master
database, and then looks for it in the specified database. If the
table named Customer exists in the master database, that table
is queried, not the table named Customer in the specified
database.

It is sometimes necessary to select this option when you are
using an Oracle Database, and you are accessing the database
with a user that is not the owner of the schema containing the
tables. When the Oracle Database interprets table names in SQL,
it assumes that the user that made the query is the owner if the
table name is not fully qualified in the query. This can result in
an incorrect qualified name.

For example, if the user SAMPLE creates a table called
CUSTOMER, the fully qualified table name is
SAMPLE.CUSTOMER. When the SAMPLE user references the
CUSTOMER table in a query, the Oracle Database assumes the
fully qualified table name is SAMPLE.CUSTOMER, and the
access is successful. However, if the JANEDOE user references
the CUSTOMER table in a query, the Oracle Database assumes
the fully qualified table name is JANEDOE.CUSTOMER, and a
"Table or view not found" error can result. To enable access for
JANEDOE, you must select Require fully qualified table
names in the connection pool so that the Oracle BI Server
specifies SAMPLE.CUSTOMER in all queries.
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Table 6-3 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property

Description

Data source name

The name of the data source to which you want this connection
pool to connect and send physical queries. The value you enter
in this field depends on the selected call interface:

= If the call interface is OCI, enter a full connect string or a
net service name from the tnsnames.ora file you set up
within the Oracle Business Intelligence environment, in
ORACLE_HOME /network/admin.

= If you are using a native interface for a different database,
enter the name of the database for that system.

» If the call interface is ODBC, the data source name field
displays a drop-down list containing all the User and
System DSNs defined for ODBC on the local computer.
Select the correct one for the data source to which you want
connect.

Shared logon

Select this option if you want all users whose queries use the
connection pool to access the underlying database using the
same user name and password.

If this option is selected, then all connections to the database
that use the connection pool use the user name and password
specified in the connection pool, even if the user has specified a
database user name and password in the DSN (or in user
configuration).

If this option is not selected, connections through the connection
pool use the database user ID and password specified in the
DSN or in the user profile.

Enable connection pooling

When selected, allows a single database connection to remain
open for the specified time for use by future query requests.
Connection pooling saves the overhead of opening and closing
a new connection for every query. If you do not select this
option, each query sent to the database opens a new connection.

Timeout

Specify the amount of time and in what increment (such as
minutes) that a connection to the data source remains open after
a request completes. During this time, new requests use this
connection rather than open a new one (up to the number
specified for the maximum connections). The time is reset after
each completed connection request.

Use multithreaded
connections

When this option is selected, the Oracle BI Server terminates
idle physical queries (threads). When not selected, one thread is
tied to one database connection (number of threads = maximum
connections). Even if threads are idle, they consume memory.

The parameter DB_GATEWAY_THREAD_RANGE in the Server
section of NQSConfig.ini establishes when the Oracle BI Server
terminates idle threads. The lower number in the range is the
number of threads that are kept open before the Oracle BI
Server takes action. If the number of open threads exceeds the
low point in the range, the Oracle BI Server terminates idle
threads. For example, if DB_GATEWAY_THREAD_RANGE is set to
40-200 and 75 threads are open, the Oracle BI Server terminates
any idle threads.

Parameters supported

If this option is not selected, and the database features table
supports parameters, special code executes that allows the
Oracle BI Server to push filters (or calculations) with parameters
to the database. The Oracle BI Server does this by simulating
parameter support within the gateway/adapter layer by
sending extra SQLPrepare calls to the database.
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Table 6-3 (Cont.) Connection Pool Properties in the General Tab: Common Properties

Property

Description

Isolation level

For ODBC and DB2 gateways only. The value sets the
transaction isolation level on each connection to the back-end
database. The isolation level setting controls the default
transaction locking behavior for all statements issued by a
connection. Only one option can be set at a time. It remains set
for that connection until it is explicitly changed.

The following options are available:

Dirty read. Implements dirty read (isolation level 0 locking).
This is the least restrictive isolation level. When this option is
set, it is possible to read uncommitted or dirty data, change
values in the data, and have rows appear or disappear in the
data set before the end of the transaction.

Dirty data is data that needs to be cleaned before being queried
to obtain correct results (for example, duplicate records, records
with inconsistent naming conventions, or records with
incompatible data types).

Committed read. Specifies that shared locks are held while the
data is read to avoid dirty reads. However, the data can be
changed before the end of the transaction, resulting in non
repeatable reads or phantom data.

Repeatable read. Places locks on all data that is used in a query,
preventing other users from updating the data. However, new
phantom rows can be inserted into the data set by another user
and are included in later reads in the current transaction.

Serializable. Places a range lock on the data set, preventing
other users from updating or inserting rows into the data set
until the transaction is complete. This is the most restrictive of
the four isolation levels. Because concurrency is lower, use this
option only if necessary.

CSF Key

This field is not used.

Multidimensional Connection Pool Properties on the General Tab

This section describes connection pool properties on the General tab that are specific to
multidimensional data sources.

Figure 6-2 shows the General tab of the Connection Pool dialog, for an Essbase data

source.
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Figure 6—2 General Tab of the Connection Pool Dialog: Essbase Data Source
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Table 64 describes the properties in the General tab of the Connection Pool dialog that
are specific to multidimensional data sources. Note that some properties only appear
for certain types of multidimensional data sources.

Table 6-4 Connection Pool Properties in the General Tab: Multidimensional Data Source

Properties
Property Description
URL This property is only displayed for XMLA data sources. Specify

the URL to connect to the XMLA provider. This URL points to
the XMLA virtual directory of the computer hosting the cube.
This virtual directory must be associated with msxisapi.dll (part
of the Microsoft XML for Analysis SDK installation). For
example, the URL might look like the following:

http:/ /SDCDL360i101 /xmla/msxisap.dll

Essbase Server

This property is only displayed for Essbase data sources.
Specify the name of the Essbase server.

Data Source

Data Source Information:

Specify the vendor-specific information used to connect to the
multidimensional data source. Consult your multidimensional
data source administrator for setup instructions because
specifications can change. For example, if you use v1.0 of the
XML for Analysis SDK, then the value should be
Provider-MSOLAP;Data Source-local.lIf youusevl.l,
then it should be Local Analysis Server.

Catalog

Data Source Information:

Specify the list of catalogs available, if you imported data from
your data source. The cube tables correspond to the catalog you
use in the connection pool.
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Table 6—4 (Cont.) Connection Pool Properties in the General Tab: Multidimensional Data
Source Properties

Property Description

Use session An option that controls whether queries go through a common
session. Consult your multidimensional data source
administrator to determine whether this option should be
enabled. Default is Off (not selected).

Setting Connection Pool Properties in the Connection Scripts Tab

This section describes the properties in the Connection Scripts tab of the Connection
Pool dialog. The Connection Scripts tab is available for ODBC, OCI, ADEF, and DB2
data sources.

You can create connection scripts and set them to be run before the connection is
established, before a query is run, after a query is run, or after the connection is
disconnected. For example, you can create a connection script that, on connect, inserts
the name of the user and the connection time into a table.

Connection scripts can contain any commands accepted by the database, such as a
command to turn on quoted identifiers. In a mainframe environment, a script could be
used to set the secondary authorization ID when connecting to DB2 to force a security
exit to a mainframe security package such as RACFE. This enables mainframe
environments to maintain security in one central location.

Because the connection script is sent directly to the data source, the script should use
native SQL or another language understood by the data source, not Oracle BI Server
Logical SQL.

To create connection scripts for data sources:

= In the Connection Pool dialog, click the Connection Scripts tab, and then complete
the fields using the information in Table 6-5.

To enter a new connection script, click New next to the appropriate script type.
Then, enter or paste the SQL statements for the script and click OK.

You can edit existing scripts by clicking the ellipsis button to launch the Physical
SQL window. Use the Up Arrow and Down Arrow buttons to reorder existing
scripts.

Click Delete to remove a script.

Figure 6-3 shows the Connection Scripts tab of the Connection Pool dialog.
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Figure 6-3 Connection Scripts Tab of the Connection Pool Dialog
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Table 6-5 describes the properties in the Connection Scripts tab of the Connection Pool

dialog.

Table 6-5 Connection Pool Properties in the Connection Scripts Tab

Property

Description

Execute on connect

Contains SQL queries that are executed before the connection is
established.

Execute before query

Contains SQL queries that are executed before the query is run.

Execute after query

Contains SQL queries that are executed after the query is run.

Execute on disconnect

Contains SQL queries that are executed after the connection is
closed.

Setting Connection Pool Properties in the XML Tab

This section describes the properties in the XML tab of the Connection Pool dialog. See
Table 6-6 for details. The XML tab is only available for XML and XML Server data

sources.

Caution: The XML tab of the Connection Pool dialog provides the
same functionality as the XML tab of the Physical Table dialog.
However, the properties in the XML tab of the Physical Table dialog
override the corresponding settings in the Connection Pool dialog.

To set connection pool properties for XML data sources:
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= In the Connection Pool dialog, click the XML tab, and then complete the fields
using the information in Table 6-6.

Figure 64 shows the XML tab of the Connection Pool dialog.

Figure 6—4 XML Tab of the Connection Pool Dialog
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Table 6-6 describes the properties in the XML tab of the Connection Pool dialog.

Table 6-6 Connection Pool Properties in the XML Tab

Property Description

Connection method: This property is only displayed for XML Server data sources.

Search script Click Browse to locate the appropriate search script.

Connection properties: This property is used for XML data sources and is not available
URL refresh interval for XML Server data sources. The refresh interval is analogous

to setting cache persistence for database tables. The URL refresh
interval is the time interval after which the XML data source is
queried again directly rather than using results in cache. The
default setting is infinite, meaning the XML data source is never
refreshed.

If you specified a URL to access the data source, set the URL
refresh interval.

= Select a value from the list (Infinite, Days, Hours, Minutes
or Seconds).

= Specify a whole number as the numeric portion of the
interval.
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Table 6-6 (Cont.) Connection Pool Properties in the XML Tab

Property Description
Connection properties: The timeout interval for queries. The default is 15 minutes.
URL loading time-out If you specified a URL to access the data source, set the URL

loading time-out as follows:

= Select a value from the list (Infinite, Days, Hours, Minutes
or Seconds).

= Specify a whole number as the numeric portion of the
interval.

Connection properties: The maximum number of connections. The default is 10.

Maximum connections

Query input supplements: | This property is only displayed for XML Server data sources.
. g Click Browse to locate the header and trailer files.
Header file/Trailer file

Query output format For XML data sources, choose only XML.

Other output formats are available for XML Server data sources.

Setting Connection Pool Properties in the Write Back Tab

This section describes the properties in the Write Back tab of the Connection Pool
dialog. The Write Back tab is available for ODBC, OCI, ADF Business Component, and
DB2 data sources.

To set write-back properties for data sources:

s In the Connection Pool dialog, click the Write Back tab, and then complete the
fields using the information in Table 6-7.

Figure 6-3 shows the Write Back tab of the Connection Pool dialog.
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Figure 6-5 Write Back Tab of the Connection Pool Dialog
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Table 6-7 describes the properties in the Write Back tab of the Connection Pool dialog.

Table 6-7 Connection Pool Properties in the Write Back Tab

Property Description
Temporary table: When the Oracle BI Server creates a temporary table, these are
Prefix the first two characters in the temporary table name. The default
value is TT.
Temporary table: Table owner name used to qualify a temporary table name in a
Owner SQL statement, for example to create the table
owner . tablename. If left blank, the user name specified in the
writeable connection pool is used to qualify the table name and
the Shared logon field on the General tab should also be set.
Temporary table: Database where the temporary table will be created. This

property applies only to IBM OS/390 because IBM OS/390
requires database name qualifier to be part of the CREATE
TABLE statement. If left blank, OS/390 defaults the target
database to a system database for which the users may not have
Create Table privileges.

Database name

Temporary table: Tablespace where the temporary table will be created. This
property applies to OS/390 only as OS/390 requires tablespace
name qualifier to be part of the CREATE TABLE statement. If
left blank, OS/390 defaults the target database to a system
database for which the users may not have Create Table
privileges.

Tablespace name
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Table 6-7 (Cont.) Connection Pool Properties in the Write Back Tab

Property

Description

Bulk insert:
Buffer size (KB)

Used for limiting the number of bytes each time data is inserted
in a database table. For optimum performance, consider setting
this parameter to 128.

See "About Setting the Buffer Size and Transaction Boundary”
for additional information.

Bulk insert:

Transaction boundary

Controls the batch size for an insert in a database table. For
optimum performance, consider setting this parameter to 1000.

See "About Setting the Buffer Size and Transaction Boundary”
for additional information.

Unicode database type

Select this option when working with columns of an explicit
Unicode data type, such as NCHAR, in a Unicode database. This
makes sure that the binding is correct and that data is inserted
correctly. Different database vendors provide different
character data types and different levels of Unicode support.
Use the following general guidelines to determine when to set
this option:

= Onadatabase where CHAR data type supports Unicode and
there is no separate NCHAR data type, do not select this
option.

= On adatabase where NCHAR data type is available, it is
recommended to select this option.

= Onadatabase where CHAR and NCHAR data type are
configured to support Unicode, selecting this option is
optional.

Note: Unicode and non-Unicode data types cannot coexist in a
single non-Unicode database. For example, mixing the CHAR
and NCHAR data types in a single non-Unicode database
environment is not supported.

Setting Connection Pool Properties in the Miscellaneous Tab

This section describes the properties in the Miscellaneous tab of the Connection Pool
dialog. The Miscellaneous tab is only available for ADF Business Component data

sources.

To set application properties for ADF Business Component data sources:

= In the Connection Pool dialog, click the Miscellaneous tab, and then complete the
fields using the information in Table 6-8.

Figure 6-6 shows the Miscellaneous tab of the Connection Pool dialog.
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Figure 6-6 Miscellaneous Tab of the Connection Pool Dialog
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Table 6-8 describes the properties in the Miscellaneous tab of the Connection Pool
dialog.

Table 6—8 Connection Pool Properties in the Miscellaneous Tab

Property Description

AppModule Definition The fully qualified Java package name of the Root Application
Module to which you want to connect, such as
oracle.apps.fii.receivables.model.RootAppModule.

AppModule Config Determines which application configuration is used in the
connection, such as RootAppModuleShared.

URL The URL to the Oracle Business Intelligence broker servlet, in
the format:

http://host:port/APP_DEPLOYMENT NAME/obieebroker

For example:

http://localhost:7001/SnowflakeSalesApp/obieebroker

The URL is case-sensitive.
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Table 6-8 (Cont.) Connection Pool Properties in the Miscellaneous Tab

Property Description

SQL Bypass Database (Optional) The name of the SQL Bypass database. The SQL
Bypass database must be a physical database in the Physical
layer of the repository. The database object for the SQL Bypass
database must have a valid connection pool, with connection
information that points to the same database that is being used
by the JDBC Data source defined in the WebLogic Server.

The SQL Bypass database does not need to have any tables
under it. After a valid database name is supplied, the SQL
Bypass feature is enabled for all queries.

The SQL Bypass feature directly queries the database so that
aggregations and other transformations are pushed down
where possible, reducing the amount of data streamed and
worked on in Oracle Business Intelligence. See "About
Specifying a SQL Bypass Database" for more information.

Setting Up Persist Connection Pools

A persist connection pool is a database property that is used for specific types of
queries (typically used to support Marketing queries). In some queries, all of the
logical query cannot be sent to the transactional database because that database might
not support all of the functions in the query. This issue might be solved by temporarily
constructing a physical table in the database and rewriting the Oracle BI Server query
to reference the new temporary physical table.

You can use the persist connection pool in the following situations:

= Populate stored procedures. Use to rewrite the Logical SQL result set to a
managed table. Typically used by Oracle's Siebel Marketing Server to write
segmentation cache result sets.

s Perform a generalized subquery. Stores a nonfunction subquery in a temporary
table, and then rewrites the original subquery result against this table. Reduces
data movement between the Oracle BI Server and the database, supports
unlimited IN list values, and might result in improved performance.

In these situations, the user issuing the Logical SQL query must have been granted
the Populate privilege on the target database.

The persist connection pool functionality designates a connection pool with write-back
capabilities for processing this type of query. You can assign one connection pool in a
single database as a persist connection pool. If this functionality is enabled, the user
name specified in the connection pool must have the privileges to create DDL (Data
Definition Language) and DML (Data Manipulation Language) in the database.

To assign a persist connection pool:

1. In the Physical layer of the Administration Tool, double-click the database object
for which you want to assign a persist connection pool.

2. In the Database dialog, click the General tab.
3. In the Persist connection pool area, click Set.
If there is only one connection pool, it appears in the Persist connection pool field.

4. If there are multiple connection pools, in the Browse dialog, select the appropriate
connection pool, and then click OK.

The selected connection pool name appears in the Persist connection pool field.
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9.

(Optional) To set write-back properties, click the Connection Pools tab.
In the connection pool list, double-click the connection pool.
In the Connection Pool dialog, click the Write Back tab.

Complete the fields using Table 6-7 as a guide. See also "About Setting the Buffer
Size and Transaction Boundary" for additional information.

Click OK, then click OK again to save the persist connection pool.

To remove a persist connection pool:

1.

In the Physical layer of the Administration Tool, double-click the database object
that contains the persist connection pool you want to remove.

In the Database dialog, click the General tab.
In the Persist connection pool area, click Clear.

The database name is replaced by not assigned in the Persist connection pool
field.

Click OK.

About Setting the Buffer Size and Transaction Boundary

If each row size in a result set is 1 KB and the buffer size is 20 KB, then the maximum
array size is 20 KB. If there are 120 rows, there are 6 batches with each batch size
limited to 20 rows.

If you set Transaction boundary to 3, the server commits twice. The first time, the
server commits after row 60 (3 * 20). The second time, the server commits after row
120. If there is a failure when the server commits, the server only rolls back the current
transaction. For example, if there are two commits and the first commit succeeds but
the second commit fails, the server only rolls back the second commit.

For optimum performance, consider setting the buffer size to 128 and the transaction
boundary to 1000.
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Working with Physical Tables, Cubes, and
Joins

The Physical layer of the Oracle BI repository contains objects that represent physical
data constructs from back-end data sources. The Physical layer defines the objects and
relationships available for writing physical queries. This layer encapsulates data
source dependencies to enable portability and federation.

Physical tables, cubes, joins, and other objects in the Physical layer are typically
created automatically when you import metadata from your data sources. After these
objects have been imported, you can perform tasks like creating additional join paths
that are not in the data source, create alias tables for physical tables that need to serve
in different roles, and adjust properties of physical hierarchies from multidimensional
data sources.

This chapter contains the following topics:

»  Working with the Physical Diagram

»  Creating Physical Layer Folders

= Working with Physical Tables

= Working with Essbase Data Sources

s Working with Hyperion Financial Management Data Sources

= Working with Dimensions and Hierarchies in the Physical Layer
= Working with Physical Foreign Keys and Joins

s Deploying Opaque Views

»  Using Hints

= Displaying and Updating Row Counts for Physical Tables and Columns

Working with the Physical Diagram

In addition to working with Physical layer objects in the right pane of the
Administration Tool, you can open the Physical Diagram view to see a graphical
model of tables and joins.

To access the Physical Diagram, right-click an object in the Physical layer tree view
(such as a physical database or table) and select Physical Diagram. Then, select one of
the following options:

= Selected Object(s) Only. Displays only the selected objects. Joins appear only if
they exist between the objects that you select.
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= Object(s) and Direct Joins. Displays the selected objects and any tables that join to
the objects that you select.

= Object(s) and All Joins. Displays the selected objects, as well as each object that is
related directly or indirectly to the selected object through some join path. If all the
objects in a schema are related, then using this option diagrams every table, even if
you only select one table.

Note that the Physical Diagram displays only physical tables and joins. It does not
display other Physical layer objects, such as connection pools, physical hierarchies, or
levels.

You can also open the Physical Diagram by selecting one or more objects in the tree
view and then clicking the Physical Diagram button on the toolbar. Only the objects
you selected appear. Joins appear only if they exist between the selected objects.

You can view the physical objects that are associated with a particular logical object by
selecting one or more business models, logical tables, or logical table sources in the
Business Model and Mapping layer tree view and then clicking the Physical Diagram
button on the toolbar. Only physical objects that are related to the objects you selected
appear. You can view the same information by right-clicking a logical object and
selecting Objects and Direct Join(s) within Business Model from the Physical
Diagram submenu. You can also choose one of the other Physical Diagram display
options.

To add additional tables to the Physical Diagram, leave the Physical Diagram window
open and then right-click the table or tables you want to add. Then, select Physical
Diagram and choose one of the display options.

Additional options are available in the right-click menu for the graphical tables and
joins displayed in the Physical Diagram. For example, you can delete objects or view
their properties, or you can add additional related objects using the right-click options
Add Direct Joins, Add Tables Joined to Whole Selection, and Add All Joins. You can
also select Find in Tree View to locate a particular object in the Physical layer tree
view in the right pane, or check out objects in online mode.

You can also right-click an object in the Physical Diagram view and click Hide to hide
particular objects in the diagram. Note that this effect is temporary and does not
persist.

Creating Physical Layer Folders
This section contains the following topics:
»  Creating Physical Layer Catalogs and Schemas
= Using a Variable to Specify the Name of a Catalog or Schema
s Setting Up Display Folders in the Physical Layer

Creating Physical Layer Catalogs and Schemas

Catalogs are optional ways to group different schemas. A catalog contains all the
schemas (metadata) for a physical database object. A schema contains only the
metadata information for a particular user or application. Model the Physical layer
after the way your data source is structured.

Note the following:

= You must create a physical database object before you can create a physical catalog
object or a physical schema object.
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= After you implement a certain type of grouping, you cannot change it later. For
example, if you decide to implement database > schema > table, you cannot add a
catalog afterward.

Creating Catalogs

In the Physical layer of a large repository, administrators can create physical catalogs
that contain one or more physical schemas.

To create a catalog:

1. In the Physical layer of the Administration Tool, right-click a physical database
and select New Object, then select Physical Catalog.

2. In the Physical Catalog dialog, type a name for the catalog.
3. Type a description for the catalog, and then click OK.

Creating Schemas

The schema object contains tables and columns for a physical schema. Schema objects
are optional in the Physical layer of the Administration Tool.

To create a schema:

1. In the Physical layer of the Administration Tool, right-click a physical database or
physical catalog and select New Object, then select Physical Schema.

2. In the Physical Schema dialog, type a name.
3. Type a description for the schema, and then click OK.

Using a Variable to Specify the Name of a Catalog or Schema

You can use a variable to specify the names of catalog and schema objects. For
example, you have data for multiple clients and you structured the data source so that
data for each client was in a separate catalog. You would initialize a session variable
named Client, for example, that could be used to set the name for the catalog object
dynamically when a user signs on to the Oracle BI Server.

You specify the session variable to use in the Dynamic Name tab of the Physical
Catalog or Physical Schema dialog.

Note: The Dynamic Name tab is not active unless at least one session
variable is defined.

To specify the session variable to use in the Dynamic Name tab:

1. In the Name column of the Dynamic Name tab, click the name of the session
variable that you want to use. The initial value for the variable (if any) is shown in
the Default Initializer column.

2. To select the highlighted variable, click Select.

The name of the variable is displayed in the dynamic name field, and the Select
button toggles to the Clear button.

To remove assignment for a session variable in the Dynamic Name tab:

»  Click Clear to remove the assignment for the variable as the dynamic name.

Working with Physical Tables, Cubes, and Joins 7-3



Working with Physical Tables

The value not assigned is displayed in the dynamic name field, and the Clear
button toggles to the Select button.

To sort column entries in the Dynamic Name tab:

You can sort the entries in a column by clicking the Name or Default Initializer
column heading. Clicking a column heading toggles the order of the entries in that
column between ascending and descending order, according to the column type.

Setting Up Display Folders in the Physical Layer

You can create display folders to organize table objects in the Physical layer. They have
no effect on query processing. After you create a display folder, the selected tables
appear in the folder as a shortcut and in the Physical layer tree as an object. You can
hide the objects so that you only view the shortcuts in the display folder. See the
information about the Repository tab of the Options dialog in "Setting Preferences"” for
more information about hiding these objects.

Note: Deleting a table in a display folder deletes only the shortcut to
that object. When you delete a column in a display folder, however,
the column is actually deleted.

To set up a physical display folder:

1.

In the Physical layer of the Administration Tool, right-click a physical database
and select New Object, then select Physical Display Folder.

In the Physical Display Folder dialog, type a name for the folder.

To add tables to the display folder, click Add. Then, in the Browse dialog, select
the fact or physical tables you want to add to the folder and click Select.

Alternatively, you can drag one or more physical tables to the display folder after
you close the dialog.

Click OK.

Working with Physical Tables

For all data sources, you can define general properties, columns, a primary key, and
foreign keys.

This section contains the following topics:

About Physical Tables

About Physical Alias Tables

Creating and Managing Physical Tables

Creating and Managing Columns and Keys for Physical Tables
Setting Physical Table Properties for XML Data Sources
Working with Cube Variables for SAP/BW Data Sources

Viewing Data in Physical Tables or Columns
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About Physical Tables

A physical table is an object in the Physical layer of the Oracle Bl repository that
corresponds to a table in a data source. Metadata for physical tables is usually
imported from the data source. This metadata enables the Oracle BI Server to access
the data source tables with SQL requests.

When you delete a physical table, all dependent objects are deleted (for example,
columns, keys, and foreign keys). When you delete a physical cube table, hierarchies
are also deleted. The deletion fails if an alias exists on the physical table.

In addition to importing data source tables into the Physical layer, you can create
virtual physical tables in the Physical layer, using values in the Table Type field in the
Physical Table dialog. Creating virtual tables can provide the Oracle Bl Server and
the underlying data sources with the proper metadata to perform some advanced
query requests.

A virtual physical table can be a stored procedure, or a SELECT statement. A virtual
physical table created from a SELECT statement is also called an opaque view. You can
define an opaque view, and then deploy it in your data source to create a deployed
view. See "Deploying Opaque Views" for more information.

Use the Table Type list in the General tab of the Physical Table dialog to specify the
physical table object type. Table 7-1 describes the available object types.

Table 7-1 Table Types for Physical Tables

Table Type Description

Physical Table Specifies that the physical table object represents a data source
table.

Stored Proc Specifies that the physical table object is a stored procedure.

When you select this option, you type the stored procedure in
the text box. Requests for this table will call the stored
procedure.

For stored procedures that are data source-specific, select Use
database specific SQL. When you select this option, the
Database column displays supported data sources by brand,
with Default as the root. You can enter data source-specific
initialization strings by selecting the database type on the left
and entering the corresponding string on the right. The
initialization string for the Default option is run when the
queried database type does not have a corresponding
database-specific string defined.

Stored procedures within an Oracle Database do not typically
return result sets. Therefore, they cannot be initiated from
within Oracle Business Intelligence. You need to rewrite the
procedure as an Oracle function, use it in a SELECT statement in
the Administration Tool initialization block, and then associate
it with the appropriate Oracle BI Server session variables in the
Session Variables dialog.

The following example shows a SQL initialization string using
the GET_ROLES function that is associated with the USER,
GROUP, and DISPLAYNAME variables. The function takes a user
Id as a parameter and returns a semicolon-delimited list of
group names:

SELECT user_id, get_roles(user_id), first_name || ' '

|| last_name
FROM csx_security_table
WHERE user_id = ':USER' and password = ':PASSWORD'
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Table 7-1 (Cont.) Table Types for Physical Tables

Table Type Description

Select Specifies that the physical table object is a SELECT statement.
When you select this option, you type the SELECT statement in
the text field, and you also need to manually create the table
columns. The column names must match the ones specified in
the SELECT statement. Column aliases are required for
advanced SQL functions, such as aggregates and CASE
statements.

Requests for this table will execute the SELECT statement.

For SELECT statements that are data source-specific, select Use
database specific SQL. When you select this option, the
Database column displays supported data sources by brand,
with Default as the root. You can enter data source-specific
initialization strings by selecting the database type on the left
and entering the corresponding string on the right. The
initialization string for the Default option is run when the
queried database type does not have a corresponding
database-specific string defined.

This type of table is also called an opaque view. See "Deploying
Opaque Views" for more information.

About Physical Cube Tables

Each cube from a multidimensional data source is set up as a physical cube table, a
type of physical table. It has all the capabilities of a table, such as physical cube
columns and keys (optional) and foreign keys (optional). It also has cube-specific
metadata such as hierarchies and levels.

When you import the physical schema, the Oracle BI Server imports the metadata for
the cube, including its metrics, hierarchies, and levels. Expanding the hierarchy object
in the Physical layer reveals the levels in the hierarchy. In the Physical Cube Table
dialog, the Hierarchies tab lists the dimensional hierarchies in the cube.

Each multidimensional catalog in the data source can contain multiple physical cubes.
You can import the metadata for one or more of these cubes into your Oracle BI
repository. Although it is possible to create a cube table manually, it is recommended
that you import metadata for cube tables and their components.

If you do create cubes manually, be sure to build each cube one hierarchy at a time
and test each one before building another. For example, create the time hierarchy and
a measure, and then test it. When it is correct, create the geography hierarchy and test
it. This helps ensure that you have set up each cube correctly, and makes it easier to
identify any setup errors.

About Physical Alias Tables

An alias table (alias) is a physical table that references a different physical table as its
source (called the original table). Alias tables can be an important part of designing a
Physical layer because they enable you to reuse an existing table more than once,
without having to import it several times.

There are two main reasons to create an alias table:

= To set up multiple tables, each with different keys, names, or joins, when a single
data source table needs to serve in different semantic roles. Setting up alias tables
in this case is a way to avoid triangular or circular joins.
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For example, an order date and a shipping date in a fact table may both point to
the same column in the time dimension data source table, but you should alias the
dimension table so that each role is presented as a separately labeled alias table
with a single join. These separate roles carry over into the business model, so that
"Order Date" and "Ship Date" are part of two different logical dimensions. If a
single logical query contains both columns, the physical query uses aliases in the
SQL statement so that it can include both of them.

You can also use aliases to enable a data source table to play the role of both a fact
table, and a dimension table that joins to another fact table (often called a "fan

trap").

s Toinclude best practice naming conventions for physical table names. For
example, you can prefix the alias table name with the table type (such as fact,
dimension, or bridge), and leave the original physical table names as-is. Some
organizations alias all physical tables to enforce best practice naming conventions.
In this case, all mappings and joins are based on the alias tables rather than the
original tables.

Alias table names appear in physical SQL queries. Using alias tables to provide
meaningful table names can make SQL queries referencing those tables easier to read.
For example:

WITH
SAWITHO AS (select sum(T835.Dollars) as cl
from
FactsRevT835/*Al1lRevenue (Billed Time Join)*/)
select distinct 0 as cl,

Dl.cl as c2
from

SAWITHO D1
order by cl

In this query, the meaningful alias table name "A11 Revenue (Billed Time Join)" has
been applied to the terse original physical table name "FACTSREV." In this case, the
alias table name provides information about which role the table was playing each

time it appears in SQL queries.

Alias tables can have cache properties that differ from their original tables. To set
different cache properties for an alias table, select the option Override Source Table
Caching Properties in the Physical Table dialog for the alias table. In alias tables,
columns cannot be added, deleted, or modified. Because columns are automatically
synchronized, no manual intervention is required.

Synchronization ensures that the original tables and their related alias tables have the
same column definitions. For example, if you delete a column in the original table, the
column is automatically removed from the alias table.

You cannot delete an original table unless you delete all its alias tables first.
Alternatively, you can select the original table and all its alias tables and delete them at
the same time.

You can change the original table of an alias table, if the new original table is a
superset of the current original table. However, this could result in an inconsistent
repository if changing the original table deletes columns that are being used. If you
attempt to do this, a warning message appears to let you know that this could cause a
problem and lets you cancel the action. Running a consistency check identifies
orphaned aliases.

When you edit a physical table or column in online mode, all alias tables and columns
must be checked out. The behavior of online checkout uses the following conventions:

Working with Physical Tables, Cubes, and Joins 7-7



Working with Physical Tables

s If an original table or column is checked out, all its alias tables and columns are
checked out.

= If an alias table or column is checked out, its original table and column are
checked out.

s The checkout option is available for online repositories (if not read-only) and for
all original and alias tables and columns.

Alias tables inherit some properties from their original tables. A property that is
proxied is a value that is always the same as the original table, and cannot be changed.
(In other words, the proxied properties are the ones that are dimmed in the alias table
dialog.) If the original table changes its value for that particular property, the same
change is applied on the alias table.

The following is a list of the properties that are proxied:
s Cacheable (the inherited property can be overridden)

»s  Cache never expires and Cache persistence time (the inherited properties can be
overridden)

= Row Count

s Last Updated

= Table Type

= External Db Specifications

The following is list of the properties that are not proxied:
= Name

s Description

= Display Folder Containers

= Poreign Keys

s Columns

Note: Alias tables and original tables never share columns. Aliases
and original tables have distinctly different columns that alias each
other.

= Table Keys

s Complex Joins

= Source Connection Pool
= Polling Frequency

= All XML attributes

Creating and Managing Physical Tables

Use the General tab of the Physical Table dialog to create or edit a physical table in the
Physical layer of the Administration Tool.

This section contains the following topics:

s Creating or Editing Physical Tables
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Creating Alias Tables

Creating or Editing Physical Tables

This section describes how to create or edit the general properties for a table, including
both relational physical tables and physical cube tables.

To create a physical table or edit general properties for tables:

1.

2.

In the Physical layer of the Administration Tool, perform one of the following
steps:

To create a physical table, right-click the physical database or physical catalog
and select New Object, then select Physical Table.

If your database object has physical schemas defined, right-click the physical
schema and select New Physical Table.

To create a physical cube table for a multidimensional data source, right-click
the physical database and select New Object, then select Cube Table.

Caution: It is strongly recommended that you import cube tables,
not create them manually.

To edit an existing physical table, double-click the physical table object in the
Physical layer.

In the Physical Table dialog, complete the fields using Table 7-2 as a guide.

Table 7-2  General Properties for Physical Tables

Property Description

Name

The name of the physical table.

Table Type Physical Table values: Physical Table, Stored Proc (stored

procedure), or Select.
Physical Cube Table values: Physical Table or Select.

See Table 7-1 for more information.

Use Dynamic Name Select this option to use a session variable to specify the

physical table name, similar to catalog and schema objects. This
option is available for non-multidimensional data source tables
when you select a table type of Physical Table.

You might want to choose this option if you have a
multi-tenancy implementation and you want to define a
separate physical table name for each customer. Another
example would be to select between primary and shadow tables
that are valid at different times in your ETL cycle. In both cases,
you can assign session variables to dynamically select the
appropriate table.

Default Initialization String | For non-multidimensional data source tables (not alias tables),
/ Use database specific SQL | this option appears if you choose a Table Type of Stored Proc or

Select. For multidimensional data source tables, this appears if
you choose a Table Type of Select.

When you select this option, you can specify the data source
and type the SQL statements.

See Table 7-1 for more information.
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Table 7-2 (Cont.) General Properties for Physical Tables

Property

Description

Cacheable

Select this option to include the table in the Oracle BI Server
query cache. Typically, you should select this option for tables
that do not need to be accessed in real time.

When you select this option, the Cache persistence time settings
become active.

Note that there are additional configuration settings that affect
the behavior of the query cache. See "Configuring Query
Caching" in Oracle Fusion Middleware System Administrator’s
Guide for Oracle Business Intelligence Enterprise Edition for full
information.

Cache never expires

When you select this option, cache entries do not automatically
expire. This could be useful when a table is important to a large
number of queries users might run. For example, if most of your
queries have a reference to an account object, keeping it cached
indefinitely could actually improve performance rather than
compromise it.

Note that selecting this option does not mean that an entry
always remains in the cache. Other invalidation techniques,
such as manual purging, LRU (Least Recently Used)
replacement, metadata changes, or use of the cache polling table
can result in entries being removed from the cache.

Cache persistence time

How long table entries should persist in the query cache, or in
other words, the cache expiration time.

Setting a cache persistence time is useful for OLTP data sources
and other data sources that are updated frequently. For
example, you could set this option refresh the underlying
physical tables daily for a particular dashboard.

If a query references multiple physical tables with different
persistence times, the cache entry for the query exists for the
shortest persistence time set for any of the tables referenced in
the query. This makes sure that no subsequent query gets a
cache hit from an expired cache entry.

For more information, see "Troubleshooting Problems with
Event Polling Tables" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition.

External name

Applies to physical cube tables from multidimensional data
sources. The external name is the physical name that is used
when referencing the cube table in physical SQL queries. This
value must reflect the external name defined in the data source.

Display Column For Essbase data sources only. See "Working with Essbase Data
Sources" for more information.
Hint Available only for some data sources. See "Using Hints" for

more information.

Creating Alias Tables

To create an alias table, right-click an existing physical table and select New Object,
then select Alias. You can also create aliases on opaque views and stored procedures.

Table 7-3 describes properties that are specific to alias tables. Refer to Table 7-2 for
information about other table properties that are shared between physical tables and

alias tables.
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Table 7-3 Properties Specific to Physical Alias Tables

Property Description

Source Table Applies to alias tables. Click Select to choose the original
physical table from which to create an alias table.

Override Source Table Option available for alias tables. When selected, the cacheable

Caching Properties properties become available and you can clear or select the

appropriate options.

Creating and Managing Columns and Keys for Physical Tables

Each table in the Physical layer of the Administration Tool has one or more physical
columns. You can use the Columns, Keys, and Foreign Keys tabs in the Physical Table
dialog to view, create new, and edit existing columns, keys, and foreign keys that are
associated with the table.

The following list describes the buttons that appear in the tabs:

= New. Lets you create a new object by opening the dialog that corresponds to the
tab.

s Edit. When you select an object and then click Edit, the dialog that corresponds to
the tab appears. You can then edit the properties of the object.

»s  Delete. Deletes the selected object.

This section contains the following topics:

= About Measures in Multidimensional Data Sources
s Creating and Editing a Column in a Physical Table
= Specifying a Primary Key for a Physical Table

= Deleting Physical Columns for All Data Sources

About Measures in Multidimensional Data Sources

You need to select the aggregation rule for a physical cube column carefully to make
sure your measures are correct. Setting it correctly might improve performance.

Use the following guidelines to verify and assign the aggregation rule correctly:

= Verify aggregation rules after importing a cube. Typically, aggregation rules are
assigned correctly when you import the cube. However, if a measure is a
calculated measure, the aggregation rule is reported as None. Therefore, you
should examine the aggregation rule for all measures after importing a cube to
verify that the aggregation rule has been assigned correctly.

For all measures assigned an aggregation rule value of None, contact the
multidimensional data source administrator to verify that the value of the
aggregation rule is accurate. If you need to change the aggregation rule, you can
change it in the Physical Cube Column dialog.

»  Setting the aggregation rule when you build the measures manually. Set the
aggregation rule to match its definition in the multidimensional data source.

About Externally Aggregated Measures In a multidimensional data source, some cubes
contain very complex, multi-level based measures. If you assign an aggregation rule of
External Aggregation, the Oracle Bl Server bypasses its internal aggregation
mechanisms and uses the pre-aggregated measures. When imported, these measures
are assigned an aggregate value of None.
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The following are some guidelines for working with pre-aggregated measures:

= External aggregation only applies to multidimensional data sources (such as
Essbase, MS Analysis Services, and SAP/BW) that support these complex
calculations.

= You cannot assign external aggregation to measures from standard data sources
(relational). If the measure is supported and can be mapped to a relational data
source, then it is not complex and does not require external aggregation.

= You cannot mix noncomplex measures from standard data sources (relational)
with complex measures from multidimensional data sources. In other words, you
cannot map a logical column to both an externally aggregated physical cube
column and a standard physical column from a relational source.

= You can mix noncomplex measures from standard data sources (relational) with
noncomplex measures from multidimensional data sources if they are aggregated
through the Oracle BI Server.

Creating and Editing a Column in a Physical Table

If the column is imported, the properties of the column are set automatically. The
following list contains information about nullable and data type values for columns
imported into the Physical layer.

= Nullable. Indicates whether null values are allowed for the column. If null values
can exist in the underlying table, you need to select this option. This allows null
values to be returned to the user, which is expected with certain functions and
with outer joins. It is generally safe to change a non-nullable value to a nullable
value in a physical column.

s Type. Indicates the data type of the column. Use caution when changing the data
type. Setting the values to ones that are incorrect in the underlying data source
might cause unexpected results. If there are any data type mismatches, correct
them in the repository or reimport the columns that have mismatched data types.

If you reimport columns, you also need to remap any logical column sources that
reference the remapped columns. The data type of a logical column in the business
model must match the data type of its physical column source. The Oracle BI
Server passes these logical column data types to client applications.

Except when stated otherwise, the characteristics and behavior of a physical cube
column are the same as for other physical columns.

Note: Creating, modifying, or deleting a column in an original
physical table also creates, modifies, or deletes the same column on all
its alias tables.

To create or edit a physical column:

1. In the Physical layer of the Administration Tool, perform one of the following
steps:

- To create a physical column, right-click a physical table and select New
Object, then select Physical Column.

- To create a physical cube column for a multidimensional data source,
right-click a physical cube table and select New Object, then select Physical
Cube Column.
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- Toedit an existing physical column, double-click the physical column object in
the Physical layer.

In the Physical Column dialog, type a name for the physical column.

For XML data sources, this field stores and displays the unqualified name of a
column (attribute) in an XML document.

In the Type field, select a data type for the physical column.
If applicable, specify the length of the data type.

For multidimensional data sources, if you select VARCHAR, you need to type a
value in the Length field.

Select the Nullable option if the column is allowed to have null values.
In the External Name field, type an external name.
— Required if the same name (such as STATE) is used in multiple hierarchies.

- Optional for XML documents. The External Name field stores and displays
the fully qualified name of a column (attribute).

(Multidimensional data sources) When the physical cube column is a measure, in
the Aggregation role list, select the appropriate value.

A new physical cube column is created as a measure by default. See "Working with
Dimensions and Hierarchies in the Physical Layer" for information about changing
this behavior.

Click OK.

Specifying a Primary Key for a Physical Table

Use the Physical Key dialog to specify the column or columns that define the primary
key of the physical table.

To specify a primary key for a physical table:

1.

N o g & 0 Db

In the Physical layer of the Administration Tool, right-click a physical table and
select Properties.

In the Physical Table dialog, click the Keys tab.

In the Keys tab, click New.

In the Physical Key dialog, type a name for the key.

Select the column that defines the primary key of the physical table.
(Optional) Type a description for the key.

Click OK.

Deleting Physical Columns for All Data Sources
When you delete a physical column, the following occurs:

Multidimensional data sources. If you delete property or key columns from a
level, the association is deleted and the column changes to a measure under the
parent cube table.

Alias tables. Deleting a column in an original physical table deletes the same
column on all its alias tables.
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Setting Physical Table Properties for XML Data Sources

Use the XML tab to set or edit properties for an XML data source. The XML tab of the
Physical Table dialog provides the same functionality as the XML tab of the
Connection Pool dialog. However, setting properties in the Physical Table dialog
overrides the corresponding settings in the Connection Pool dialog. See "Setting
Connection Pool Properties in the XML Tab" for more information.

Working with Cube Variables for SAP/BW Data Sources

In SAP/BW data sources, cube variables are used as a means of parameterizing
queries. Cube variable objects are imported into the Physical layer when metadata is
imported from Querycubes/Bex Queries in SAP/BW data sources. Typically, you do
not edit these objects directly except to keep them synchronized with the Bex queries
in the data source, and except to specify overrides for key characteristics values.

The Cube Variables tab of the Cube Table dialog lists the cube variables for the given
cube table, along with the cube variable caption. Double-click a cube variable to see
more detailed information, or click the Add button to define a new cube variable.

Table 7—4 describes the properties of cube variables for SAP/BW data sources. See
your SAP/BW documentation for additional information.

Table 7-4 Cube Variable Properties

Property Description
Name Name of the cube variable.
Caption A description (label or caption) associated with the cube

variable, mainly used for display purposes.

Variable Type The type of cube variable. Variable types include:

= SAP_VAR_TYPE_MEMBER: A placeholder for a selection
for MEMBER_UNIQUE_NAMES.

= SAP_VAR_TYPE_HIERARCHY: A placeholder for a
HIERARCHY_UNIQUE_NAME.

= SAP_VAR_TYPE_NUMERIC: A placeholder for a numeric
value in formulas.

Selection Type The selection type of the cube variable, for cube variables of
type SAP_VAR_TYPE_MEMBER.

Selection types include:

s SAP_VAR_SEL_TYPE_VALUE: The variable is replaced by
a single value. Cube variables of type NUMERIC must
have this selection type.

= SAP_VAR_SEL_TYPE_INTERVAL: A placeholder for an
interval.

= SAP_VAR_SEL_TYPE_COMPLEX: A placeholder for a
complex selection.

Entry Type Indicates whether replacing variables is optional or mandatory.
Entry types include:

= SAP_VAR_INPUT_TYPE_OPTIONAL: Specifying a value
is optional for this variable.

= SAP_VAR_INPUT_TYPE_MANDATORY: You must
specify a value for this variable.

s SAP_VAR_INPUT_TYPE_MANDATORY_NOT_INITIAL:
You must specify a value for this variable. An initial field is
not a valid entry.
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Table 7-4 (Cont.) Cube Variable Properties

Property Description

Reference Dimension This column contains a DIMENSION_UNIQUE_NAME for the
parameter type SAP_VAR_TYPE_HIERARCHY.

Reference Hierarchy This column contains a HIERARCHY_UNIQUE_NAME for the
variable type SAP_VAR_TYPE_MEMBER.

Default Low This property contains a default value for the variable or is zero.

Default High This property contains a default value for the variable or is zero.

This property is only important for variables with the selection
type SAP_VAR_SEL_TYPE_INTERVAL and SAP_VAR_SEL _
TYPE_SELECTION.

Override Default Low Provide a default value for the cube variable in this field if the
Default Low is zero.

You must specify a value for this property for mandatory
variables that do not specify a default value.

Override Default High Provide a default value for the cube variable in this field if the
Default High is zero.

You must specify a value for this property for mandatory
variables that do not specify a default value.

Viewing Data in Physical Tables or Columns

You can view the data in a physical table or an individual physical column by
right-clicking the object and choosing View Data. In online editing mode, you must
check in changes before you can use this option.

View Data is not available for physical cube tables or columns. See "Viewing Members
in Physical Cube Tables" for more information.

Because the View Data feature issues a row count, it is not available for data sources
that do not support row counts. See "Displaying and Updating Row Counts for
Physical Tables and Columns" for more information.

Caution: View Data does not work in online mode if you set the user
name and password for connection pools to : USER and : PASSWORD.
In offline mode, the Set values for variables dialog appears so that you
can populate : USER and : PASSWORD as part of the viewing process.

Working with Essbase Data Sources

This section describes how Essbase data is modeled by default in the Physical layer of
the Oracle BI repository, and describes the tasks you can perform to model the data in
different ways.

This section contains the following topics:

= About Using Essbase Data Sources with Oracle Business Intelligence
= Working with Essbase Alias Tables

= Associating Member Attributes to Dimensions and Levels

= Modeling Alternate Hierarchies

= Modeling Measure Hierarchies

= Improving Performance by Using Unqualified Member Names
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About Using Essbase Data Sources with Oracle Business Intelligence

When you import metadata from Essbase data sources, the cube metadata is mapped

to the Physical layer in a way that supports the Oracle Business Intelligence logical
model. Metadata that applies to all members of the dimension, such as aliases, are

modeled as dimension properties by default. Level-based properties, such as outline

sort/memnor information, are mapped as separate physical cube columns in the
dimension.

The following physical column types are used for Essbase metadata:
= Member Alias: Indicates an Alias column.

s UDA: Indicates the column is a User Defined Attribute (UDA).

s Outline Sort: Indicates the column is of memnor type, used for outline sorts in the

logical layer. Imported at the lowest level of each dimension.
= Attribute: Indicates the column is of attribute type, for attribute dimensions.
s Other: The type is different than those listed, or unknown.
= Ancestor Reference: References the ancestor of a dimension.
= Member Key: Indicates the column is a member key.
s Leaf: Indicates that the column is the lowest member of the hierarchy.
= Root: Indicates that the column is the root member of the hierarchy.
»  Parent Reference: References the parent of a dimension.

The column types Outline Sort, Ancestor Reference, Member Key, Leaf, Root, and
Parent Reference are used internally by the system and should not be changed.

Figure 7-1 shows Essbase data that has been imported into the Physical layer.

Figure 7-1 Essbase Data Modeled in the Physical Layer
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There are different options in the Physical layer that let you control how you want to
model certain types of metadata. Choose the option that best meets the needs of your
user base. For example, many types of Essbase metadata are modeled as dimension
properties by default in the Physical layer. This multidimensional structure works best
with the new hierarchical reporting style introduced in the current release.

Alternatively, you can choose to flatten the Essbase metadata in the Physical layer for
ease of use with the attribute-style reporting supported in previous releases of Oracle
Business Intelligence.

The following list summarizes some of these modeling options:

= Aliases. Aliases are modeled as dimension properties by default, but you can also
choose to flatten them using the Create Columns for Alias Table feature. See
"Working with Essbase Alias Tables" for more information.

s UDAs. UDAs are modeled as dimension properties by default, but you can also
choose to flatten them using the Create Columns for UDA feature. See "Modeling
User-Defined Attributes" for more information.

»  Alternate Hierarchies. Alternate hierarchies are modeled as separate hierarchies
by default, but you can choose to view them in as a single hierarchy using the
Convert to single hierarchy view feature. See "Modeling Alternate Hierarchies"
for more information.

= Measure Hierarchies. By default, measures are imported as a single measure
column that represents all the measures, but you can also choose to view each
measure as an individual column using the Convert measure dimension to flat
measures feature. See "Modeling Measure Hierarchies" for more information.

Note the following additional information about using Essbase data sources with
Oracle Business Intelligence:

= Substitution variables. Essbase substitution variables are automatically retrieved
and populated into corresponding Oracle BI Server session variables. Depending
on the scope of the Essbase variable, the naming convention for the Oracle BI
Server variable is as follows:

Server instance scope: server_name:var_name
Application scope: server name:app_name:var_name
Cube scope: server name:app_name: cube_name: var_name

A single initialization block is also created in the repository for the Essbase
variables. Set the appropriate refresh interval in the initialization block to reflect
anticipated update cycles for Essbase variables.

»  Essbase Generations. Essbase Generations are mapped to physical level objects.

s Time series functions. The Oracle BI Server time series functions AGO, TODATE,
and PERTODROLLING are pushed down to Essbase to take advantage of the native
capabilities of the Essbase server.

s Database functions. You can use the database SQL functions EVALUATE and
EVALUATE_AGGREGATE to leverage functions specific to Essbase data sources. See
"Examples Using EVALUATE_AGGREGATE and EVALUATE to Leverage Unique
Essbase Functions" for more information.

Note that EVALUATE_PREDICATE is not supported for use with Essbase data
sources.

= Gen1levels. By default, Gen 1 levels are included when you drag and drop an
Essbase cube or dimension from the Physical layer to the Business Model and
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Mapping layer. However, because Gen 1 levels are not usually needed for
analysis, you can choose to exclude Gen 1 levels when you drag and drop Essbase
objects to your business model. To do this, select Skip Gen 1 levels in Essbase
drag and drop actions in the General tab of the Options dialog. See "Setting
Preferences" for more information.

= Hierarchy types. For Essbase data sources, all hierarchies are imported as
Unbalanced by default. Review the Hierarchy Type property for each physical
hierarchy and change the value if necessary. Supported hierarchy types for
Essbase are Unbalanced, Fully balanced, and Value.

About Incremental Import

You can choose to incrementally import Essbase metadata. In other words, you can
perform an initial import, and then import again. You might want to import
incrementally when information in the data source has changed, or when your first
import only included a subset of the metadata. Note the following about incremental
import:

= When you re-import metadata that already exists in the Physical layer, a message
appears, warning you that your Physical objects will be overwritten.

s If you delete data in the source, re-importing the metadata does not automatically
perform the deletion in the Physical layer. Instead, you must manually delete the
corresponding Physical objects.

s If you rename an object in the source, the renamed object is imported as a new
object. In this case, both the old object and the new (renamed) object are displayed
in the Physical layer.

s In general, customizations that you have performed on the Physical layer data,
such as determining the alias column to use for display, are retained after an
incremental import. If you want to revert to the default imported view, you must
delete the existing Physical layer objects and then re-import the metadata.

Working with Essbase Alias Tables

Essbase cubes support the concept of aliases, which are alternate names for members
or shared members. For example, the member name might be a product code (100),
with a default alias for the product name (Cola) and an additional alias for the long
name (Cherry Cola). Often, members have separate aliases for each user language to
enable users to view member names in their own language.

In the Essbase cube, aliases are stored in alias tables that map a specific set of alias
names to member names. Typically, a Default alias table exists for each cube.

This section contains the following topics:
s Determining the Value to Use for Display
= Explicitly Defining Columns for Each Alias

Determining the Value to Use for Display

When you import metadata from Essbase into the Oracle BI repository, the Essbase
cube table object in the Physical layer has a property that determines which value to
display for members: the member name, the default alias name, or some other alias
name. By default, the columns display the default alias name.

To change the value to display for members:
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1. In the Physical layer of the Administration Tool, double-click an Essbase cube
table.

2. In the General tab of the Cube Table dialog, choose the appropriate value for
Display Column. You can select Member Name, or you can select Alias and then
choose an alias table name from the drop-down list.

3. Click OK.

Explicitly Defining Columns for Each Alias

Aliases are modeled as dimension properties in the Physical layer after import. If you
want to work with more than one alias, such as when you want to flatten attributes for
reporting purposes or externalize strings for translation, you can explicitly define
columns for each alias. You can define alias columns at the cube, dimension, or
hierarchy level.

To explicitly define columns for each alias:

1. In the Administration Tool, in the Physical layer, right-click the cube table,
physical dimension, or physical hierarchy for which you want to define alias
columns.

2. Select Create Columns for Alias Table. Then, from the sub-list, select the alias
table for which you want to create columns.

Note that the Fetch button is not used.
3. C(lick Create.

4. Drag the new alias columns to the appropriate location in the Business Model and
Mapping layer.

If you want to externalize strings for translation based on the alias columns, see
"Localizing Oracle Business Intelligence Deployments" in Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information.

Modeling User-Defined Attributes

Essbase supports the concept of user-defined attributes (UDAs). A UDA is essentially
any arbitrary textual string that can be associated with any member from a dimension.
A member can have multiple strings associated to it.

You can choose whether to import UDAs in the Import Metadata Wizard. If you
choose to import UDAs, then by default, each UDA is modeled as a dimension
property in the Physical layer of the repository.

You can also choose to model each UDA as a separate physical column. To do this,
perform one of the following tasks:

s Tomodel all UDAs in a cube as separate physical columns, right-click the cube
table and select Create columns for UDA. All UDAs in the cube are modeled as
separate physical columns.

= Tomodel all UDAs in a dimension as separate physical columns, right-click the
dimension object and select Create columns for UDA, then select All UDAs. All
UDAs in the dimension are modeled as separate physical columns.

s Tomodel a particular UDA in a dimension as a separate physical column in each
level, right-click the dimension object and select Create columns for UDA, then
select the specific UDA you want to model. The selected UDA is modeled as a
separate physical column for each level.
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Associating Member Attributes to Dimensions and Levels

Member attributes are not automatically associated to corresponding dimensions and
levels during the import process. To manually create the association, map the member
attribute to the appropriate logical table. In other words, drag and drop the columns
from the attribute dimension in the Physical layer to the appropriate logical tables in
the Business Model and Mapping layer.

Modeling Alternate Hierarchies

By default, alternate hierarchies are modeled as separate hierarchies in the Physical
layer. You can choose to view them as separate hierarchies (called the multi-hierarchy
view), or as a single hierarchy.

To view alternate hierarchies as a single hierarchy, right-click the dimension object
containing the alternate hierarchies and select Convert to single hierarchy view. To
return to the multi-hierarchy view, right-click the dimension object again and select
Convert to multi-hierarchy view.

For example, Figure 7-2 shows the multi-hierarchy view for an alternate hierarchy.

Figure 7-2 Essbase Alternate Hierarchy Displayed in Multi-Hierarchy View
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Figure 7-3 shows the single-hierarchy view for the same alternate hierarchy.
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Figure 7-3 Essbase Alternate Hierarchy Displayed in Single-Hierarchy View
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Modeling Measure Hierarchies

By default, measures are imported as measure hierarchies. In other words, the cube
contains a single measure column that represents all the measures.

Alternatively, you can choose to flatten the measure hierarchy to view each measure
as an individual column. To do this, right-click the cube object and select Convert
measure dimension to flat measures.

Improving Performance by Using Unqualified Member Names

When member names (including aliases) are unique in a given hierarchy, the Oracle BI
Server can take advantage of specific MDX syntax to optimize performance. To enable
this capability, select Use unqualified member name for better performance in the
Hierarchy dialog.

The import process cannot identify that member names are unique for a given
hierarchy, so it is the responsibility of the administrator to confirm uniqueness. Note
that query errors may result if a hierarchy is specified as having unique members
when it does not.
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Note: If you find that the Oracle BI Server is generating incorrect
queries for Essbase, check to see whether there are duplicate member
names in a given hierarchy. If there are, ensure that the option Use
unqualified member name for better performance is not selected for
that hierarchy, or perform the following steps:

1. From the Essbase outline, update each offending member variable by
adding a prefix or suffix to make the member name unique.

2. Update SQL queries as necessary, if references are made to data within
SQL.

3. Reload the data and members in the Essbase outline.

Working with Hyperion Financial Management Data Sources

When you import data from Hyperion Financial Management data sources, both
measures and dimensions are imported into the Physical layer. The Hyperion
Financial Management hypercube model is exposed in the Physical layer in the
following ways:

s There is only one measure in Hyperion Financial Management, called Value. This
measure is modeled as a single fact column in the Physical layer, also called Value.

s The Value measure has three base properties: CellText, CurrencyType, and
Attribute. These properties are all represented as additional fact columns.

s The Attribute property has additional sub-properties, such as IsReadOnly. These
properties are also exposed as additional columns.

Figure 7-4 shows how Hyperion Financial Management data is modeled in the
Physical layer.
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Figure 7-4 Hyperion Financial Management Metadata in the Physical Layer
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All Hyperion Financial Management dimensions are modeled as parent-child
hierarchies in the Physical layer. Shared members, alternate hierarchies, and
unbalanced hierarchies are supported.

Dimension member properties are exposed as columns (such as Name, Description,
ShortName, and so on). An additional column called Sort Order is also displayed for
each dimension. This column contains custom sort information retrieved from the
Hyperion Financial Management data source.

Each Hyperion Financial Management dimension has a corresponding Point of View
(POV) value that provides customized information for different users. This POV value
is exposed as the Default Member in the Hierarchies tab of the Dimension dialog.
Although the Default Member field is populated upon import, note that the default
values may need to be updated according to the needs of the user base.

Note: Because the default member represents a POV value, do not
select the Default member type ALL option for Hyperion Financial
Management hierarchies. The default member should either be set to
one of the values in the dimension, or it should be set to None.
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About Query Support for Hyperion Financial Management Data Sources

Both member queries (dimensional browsing) and data queries (measure analysis) are
supported for Hyperion Financial Management data sources.

Most Logical SQL functions are performed in the Oracle BI Server. However, you
should use EVALUATE_PREDICATE to access the following functions specific to
Hyperion Financial Management:

» PeriodOffset (used to access prior or future periods through an offset)

= NA Suppression functions specific to Hyperion Financial Management
(SuppressDerived, SuppressInvalidIntersection, SuppressMissing,
SuppressNoOAccess, SuppresszZero, SuppressError)

= Base function (returns the leaf members below a given ancestor member)

s CommonChildren

»  User-defined functions

See "EVALUATE_PREDICATE" for detailed information about syntax and usage.

Note that there is no native support for time series functions. Time series functions are
only supported through data modeling.

Working with Dimensions and Hierarchies in the Physical Layer

Most dimensions and hierarchies are imported into the Physical layer from
multidimensional data sources, rather than created manually. If a particular hierarchy
is not imported, any columns associated with that hierarchy are also not imported. If
users need access to columns that are not imported, first add these columns to the
Physical layer by manually creating them, and then associate them with a level in a
hierarchy.

Each level in a hierarchy has a level key. The first cube column associated with (added
to) the level of a hierarchy is the level key. This must match with the data source
definition of the cube. The icon for the column that you select first changes to the key
icon after it is associated with the level of a hierarchy.

Oracle Business Intelligence supports unbalanced hierarchies for all multidimensional
data sources. In general, you can configure unbalanced hierarchies in the Physical
layer by changing the hierarchy type.

You can view and edit properties for physical dimensions and hierarchies by
double-clicking physical dimension and physical hierarchy objects in the Physical
layer of the Administration Tool. You can also view and edit these objects from the
Dimensions and Hierarchies tabs of the Cube Table dialog.

This section contains the following topics:

=  Working with Physical Dimension Objects
= Working with Physical Hierarchy Objects
= Viewing Members in Physical Cube Tables

= Adding or Removing Cube Columns in a Hierarchy
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Working with Physical Dimension Objects

In the Physical Dimension dialog, you can view and edit the name and description of
the dimension. You can also add, remove, or edit hierarchies for that dimension, as
well as add, remove, or edit columns that represent dimension properties.

Working with Physical Hierarchy Objects

When you select columns to add to a hierarchy, it is recommended that you select
them in hierarchical order, starting with the highest level. If you select multiple
columns and bring them into the hierarchy at the same time, the order of the selected
group of columns remains the same. After adding columns to the hierarchy, you can
change the order of the columns in the Browse dialog.

If a query does not explicitly refer to a member of a hierarchy, a default member must
be used. Therefore, every hierarchy must be associated with a default member,
typically the ALL member. The Hierarchy dialog contains an option (Default member
type ALL) that you use when you want to designate the ALL member as the default.
Typically, this item is automatically selected when you import the hierarchy. Note that
the ALL member is not an appropriate default for some hierarchies. For example, for
the Year level, 1997 might be designated as the default member.

In the Physical Hierarchy dialog, you can view and edit the name and description of
the hierarchy, along with the properties described in Table 7-5. For level-based
hierarchies, you can add, remove, edit, or reorder levels. For value-based hierarchies,
click the Column tab to add, remove, or edit columns. To specify a key column,
double-click a column name.

In the Physical Level dialog, you can view and edit the name, external name, and
description of the level. You can also add, remove, or edit columns for that level. To
designate a column as a level key, double-click a column name.

Table 7-5 Options in the Physical Hierarchy Dialog

Property Description

External Name The physical name that is used when referencing the hierarchy
in physical SQL queries. This value must reflect the external
name defined in the data source.

Dimension Name (Dimension Unique Name) Dimension to which the hierarchy
belongs.
Dimension Type Identifies whether this hierarchy belongs to a time dimension,

measure dimension, or other type of dimension.

Hierarchy Type Identifies whether the hierarchy is Fully Balanced, Unbalanced,
Ragged Balanced, Network, or Value.

Default member type ALL | Select this option to designate the ALL member as the default.
Do not select this option for non-ALL default members.

Use unqualified member Select this option when member names (including aliases) are
name for better unique in a given hierarchy so that the Oracle BI Server can take
performance advantage of specific MDX syntax to optimize performance.

Viewing Members in Physical Cube Tables

You can view members of hierarchies or levels in the Physical layer of repositories. To
view members, the repository must be open in online mode. The list of members by
level in the hierarchy can help you determine if the connection pool is set up properly.
You might want to reduce the time it takes to return data or the size of the returned
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data by specifying a starting point (Starting from option) and the number of rows you
want returned (Show option).

To view members:

1. Open the Administration Tool in online mode.

2. In the Physical layer, right-click a hierarchy or level.
3. Select View Members.

A window opens showing the number of members in the hierarchy and a list of
the levels. You might need to enlarge the window and the columns to view all the
returned data.

4. Click Query to display results.
5. When finished, click Close.

Adding or Removing Cube Columns in a Hierarchy

After importing a hierarchy, you may need to add or remove a column. If you remove
a cube column from a hierarchy, it is deleted from the hierarchy but remains in the
cube table and is available for selection to add to other levels.

To add or remove a cube column in an existing hierarchy:

1. In the Physical layer of the Administration Tool, double-click the physical
hierarchy that you want to change. The Physical Hierarchy dialog appears.

2. For level-based hierarchies, double-click the level for which you want to add or
remove columns. Then, in the Physical Level dialog, you can add, remove, or edit
columns. When you are finished, click OK in the Physical Level dialog.

3. For value-based hierarchies, click the Columns tab. You can add, remove, or edit
columns, as well as designate member key and parent key columns.

4. Click OK in the Hierarchy dialog.

Working with Physical Foreign Keys and Joins

You can create physical foreign keys and complex joins using either the Physical
Diagram, or the Joins Manager. Note that you do not create joins for multidimensional
data sources.

This section contains the following topics:

= About Physical Joins

s Defining Physical Joins with the Physical Diagram
s Defining Physical Joins with the Joins Manager

About Physical Joins

All valid physical joins need to be configured in the Physical layer of the
Administration Tool.

When you import keys in a physical schema, the primary key-foreign key joins are
automatically defined. Any other joins within each data source or between data
sources have to be explicitly defined to express relationships between tables in the
Physical layer.
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Imported key and foreign key joins do not have to be used in metadata. Joins that are
defined to enforce referential integrity constraints can result in incorrect joins being
specified in queries. For example, joins between a multipurpose lookup table and
several other tables can result in unnecessary or invalid circular joins in the SQL
queries issued by the Oracle BI Server.

This section contains the following topics:

= About Primary Key and Foreign Key Relationships
= About Complex Joins

s About Multi-Database Joins

= About Fragmented Data

About Primary Key and Foreign Key Relationships

A primary key and foreign key relationship defines a one-to-many relationship
between two tables. A foreign key is a column or a set of columns in one table that
references the primary key columns in another table. The primary key is defined as a
column or set of columns where each value is unique and identifies a single row of the
table.

Note that there are two cases where multiple foreign key columns in a table point to
the same table:

= When the primary key of the foreign table is "concatenated," meaning that it
consists of a set of columns. This is a single join between two tables that happens
to use multiple columns.

= When you have created an alias to the foreign table, because the foreign table
needs to serve in different roles. In this case, each foreign key joins to a primary
key in one role-playing alias or the other. See"About Physical Alias Tables" for
more information.

You can specify primary key and foreign keys in the Physical Diagram, or by using the
Keys and Foreign Keys tabs of the Physical Table dialog. Also refer to "Defining
Physical Joins with the Physical Diagram" and "Creating and Managing Columns and
Keys for Physical Tables" for more information.

About Complex Joins

In the Physical layer of the repository, complex joins are joins over nonforeign key and
primary key columns. In other words, physical complex joins are joins that use an
expression rather than key column relationships. When you create a complex join in
the Physical layer, you specify the expression for the join.

For most data sources, foreign key joins are preferred for performance reasons.
Complex joins are usually not as performant because they do not use key column
relationships to form the join. The exception is ADF business component data sources,
which use physical complex joins exclusively to denote ViewLink instances that
connect pairs of View Objects in the ADF model.

About Multi-Database Joins

A multi-database join is defined as a table under one metadata database object that
joins to a table under a different metadata database object. You need to specify
multi-database joins to combine the data from different databases. Use the Physical
Diagram to specify multi-database joins. See "Defining Physical Joins with the Physical
Diagram" for more information.
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Multi-database joins can be created between tables in most types of databases and are
performed within the Oracle BI Server.

While the Oracle BI Server has several strategies for optimizing the performance of
multi-database joins, these joins are significantly slower than joins between tables
within the same database. For this reason, you should avoid them whenever possible.

About Fragmented Data

Fragmented data is data from a single domain that is split between multiple tables. For
example, a data source might store sales data for customers with last names beginning
with the letter A through M in one table and last names from N through Z in another
table. With fragmented tables, you need to define all of the join conditions between
each fragment and all the tables to which it relates. Figure 7-5 shows the physical joins
with a fragmented sales table and a fragmented customer table where they are
fragmented the same way (A through M and N through Z).

Figure 7-5 Fragmented Tables Example

Sales A to M >— Customer & to M

Sales Mto £ Customer Mio £

In some cases, you might have a fragmented fact table and a fragmented dimension
table, but the fragments might be across different values. In this case, in addition to the
joins created in Figure 7-5, you need to define a one-to-many join from Customer A to
F and from Customer G to Z to Sales A to M, as shown in Figure 7-6.

Figure 7-6 Joins for Fragmented Tables Example

Customer Ato F
Sales A to M

ZalezMto £ Customer Gto £

Note: Avoid adding join conditions where they are not necessary (for
example, between Sales A to M and Customer N to Z in Figure 7-5).
Extra join conditions can cause performance degradations.
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Defining Physical Joins with the Physical Diagram

You can define foreign keys and complex joins between tables, whether or not the
tables are in the same data source. When you use the Physical Diagram to create joins,
the Administration Tool determines what type of join to create based on the selected
object types and the join expression.

If you do not want the Administration Tool to automatically determine what type of
join to create, use the Joins manager to explicitly create the join. See "Defining Physical
Joins with the Joins Manager" for more information.

To define a physical foreign key join or a complex join with the Physical Diagram:

1. In the Physical layer of the Administration Tool, select one or more tables and
choose one of the Physical Diagram commands from the right-click menu.

2. Click the New Join button on the Administration Tool toolbar.

3. In the Physical Diagram, left-click the first table in the join (the table representing
one in the one-to-many join) to select it.

4. Move the cursor to the table to which you want to join (the table representing
many in the one-to-many join), and then left-click the second table to select it.

The Physical Foreign Key dialog appears. Although physical foreign key joins are
the default join type, the object type might change to a complex join after you
define the join and click OK, depending on the join information.

5. Select the joining columns from the left and the right tables.
The SQL join conditions appear in the expression pane of the window.

The driving table is shown on this window, but it is not available for selection
because the Oracle BI Server implements driving tables only in the Business Model
and Mapping layer. See "Specifying a Driving Table" for more information about
driving tables.

6. For complex joins, you can optionally set the cardinality for each side of the join
(for example, N, 1, 0,1, or unknown).

To set the cardinality to unknown, you only need to select unknown for one side
of the join. For example, choosing unknown-to-1 is equivalent to
unknown-to-unknown and appears as such the next time you open the dialog for
this join.

7. If appropriate, specify a database hint. See "Using Hints" for more information.

8. If you are creating a complex join for ADF Business Component ViewObject or
ViewLink instances, specify the ViewLink instance name or the ViewLink
definition name in the ViewLink Name field.

9. To open Expression Builder, click the button to the right of the Expression pane.
The expression displays in the Expression pane.

The default join expression for ViewObject or ViewLink instances is arbitrary and
has no meaning.

10. Click OK to apply the selections.

Defining Physical Joins with the Joins Manager

You can use the Joins Manager to view join relationships and to create physical foreign
key joins and complex joins.

To define a physical foreign key join or complex join with the Joins Manager:
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10.

11.

In the Administration Tool toolbar, select Manage, then select Joins.
In the Joins Manager dialog, perform one of the following tasks:
—  Select Action > New > Complex Join.

The Complex Join dialog appears.

- Select Action > New > Physical Foreign Key. Then, in the Browse dialog,
double-click a table.

In the Complex Join or Physical Foreign Key dialog, type a name for the join.

Click the Browse button for the Table field on the left side of the dialog, and then
locate the table that the foreign key references.

Select the columns in the left table that the key references.
Select the columns in the right table that make up the foreign key columns.

For complex joins, you can optionally set the cardinality for each side of the join
(for example, N, 1, 0,1, or unknown).

To set the cardinality to unknown, you only need to select unknown for one side
of the join. For example, choosing unknown-to-1 is equivalent to
unknown-to-unknown and appears as such the next time you open the dialog for
this join.

If appropriate, specify a database hint. See "Using Hints" for more information.

If you are creating a complex join for ADF Business Component ViewObject or
ViewLink instances, specify the ViewLink instance name or the ViewLink
definition name in the ViewLink Name field.

To open Expression Builder, click the button to the right of the Expression pane.
The expression displays in the Expression pane.

The default join expression for ViewObject or ViewLink instances is arbitrary and
has no meaning,.

Click OK to save your work.

Deploying Opaque Views

An opaque view is a Physical layer table that consists of a SELECT statement. When
you need a new table, you should create a physical table or a materialized view. An
opaque view should be used only if there is no other solution. See "Exchanging
Metadata with Databases" in Oracle Fusion Middleware System Administrator's Guide for
Oracle Business Intelligence Enterprise Edition for more information about materialized
views.

This section contains the following topics:

About Deploying Opaque Views

Deploying Opaque View Objects

Undeploying a Deployed View

When to Delete Opaque Views or Deployed Views
When to Redeploy Opaque Views
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About Deploying Opaque Views

In the repository, opaque views appear as view tables in the data source, but the view
does not actually exist until you deploy it. You deploy an opaque view in the data
source using the Deploy Views utility. After deploying an opaque view, it is called a
deployed view. Opaque views can be used without deploying them, but the Oracle BI
Server has to generate a more complex query when an opaque view is encountered.

Note: Data sources such as XLS and nonrelational data sources do
not support opaque views and cannot run the view deployment
utility.

To verify that opaque views are supported by a data source, check whether the
CREATE_VIEW_SUPPORTED SQL feature is selected in the Database dialog, in the
Features tab. See "Specifying SQL Features Supported by a Data Source" for
instructions.

Deploying Opaque View Objects

In offline mode, the Deploy Views utility is available when importing from data
sources with ODBC and DB2 CLI data sources. Oracle Native (client) drivers are also
supported in the offline mode for deploying views. In online mode, view deployment
is available for supported data sources using Import through server (the settings on
the client are ignored).

Using the Create View SELECT Statement

The SQL statement for deploying opaque views in the Physical layer of the repository
is available for supported data sources. To determine which of your data sources
support opaque views, contact your system administrator or consult your data source
documentation.

Only repository variables can be used in the definition. An error is generated if a
session variable is used in the view definition.

Syntax
CREATE VIEW view_name AS select_statement,

Where:

» select_statement is the user-entered SQL in the opaque view object. If SQL is
invalid, the create view statement fails during view deployment.

s view_name is one of the two following formats: schema . viewname, or
viewname. The connection pool settings determine if the schema name is added.

For opaque view objects, the right-click menu contains the Deploy View(s) option.
When you select Deploy View(s), the Create View SQL statement executes and
attempts to create the deployed view objects. The following list describes the ways you
can initiate view deployment and the results of each method:

= Right-click a single opaque view object. When you select Deploy View(s), the
Create View SQL statement executes and attempts to create a deployed view for
the object.

= Right-click several objects. If at least one of the selected objects is an opaque view
object, the right-click menu contains the Deploy View(s) option. When you select
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Deploy View(s), the Create View SQL statement executes and attempts to create
the deployed views for any qualifying objects.

= Right-click a physical schema or physical catalog. If any opaque view object exists
in the schema or catalog, the right-click menu contains the Deploy View(s) option.
When you select Deploy View(s), the Create View SQL statements for all
qualifying objects execute and attempt to create deployed views for the qualifying
objects contained in the selected schema or catalog.

During deployment, names are assigned to the views. If you change the preassigned
name, the new name must be alphanumeric and no more than 18 characters. If these
guidelines are not followed, the object name is automatically transformed to a valid

name using the following Name Transform algorithm:

1. All non-alphanumeric characters are removed.
2, If there are 16 or more characters after Step 1, the first 16 characters are kept.

3. Two digits starting from 00 to 99 are appended to the name to make the name
unique in the corresponding context.

After the deployment process completes, the following occurs:
= Views that have been successfully and unsuccessfully deployed appear in a list.
s For unsuccessful deployments, a brief reason appears in the list.

s If deployment is successful, the object type of the opaque view changes from
Select to None and the deployed view is treated as a regular table.

If you change the type back to Select, the associated opaque views are dropped
from the data source, or an error message appears. See "When to Delete Opaque
Views or Deployed Views" for information about deleting deployed views.

s Inthe Administration Tool, the view icon changes to the deployed view icon for
successfully deployed views.

To deploy an opaque view:

1. In the Physical layer of the Administration Tool, right-click the opaque view that
you want to deploy.

2. In the right-click menu, select Deploy View(s).
3. In the View Deployment - Deploy View(s) dialog, perform the following steps:

a. Inthe New Table Name column, you can optionally change the new deployed
view names.

If the change does not conform to the naming rules, a new name is assigned
and the dialog appears again so that you can accept or change it. This action
repeats until all names pass validation.

b. If you do not want to deploy one or more of the views, clear the appropriate
rows.

4, If there are multiple connection pools defined for the physical database, in the
Select Connection Pool dialog, choose a connection pool and click Select.

The SQL statement (CREATE VIEW) executes, and the View Deployment Messages
dialog appears.

5. Inthe View Deployment Messages dialog, you can search for views using Find
and Find Again, or copy the contents.

6. When you are finished, click OK.
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Undeploying a Deployed View

Running the Undeploy Views utility against a deployed view deletes the views and
converts the table back to an opaque view with its original SELECT statement.

To undeploy a deployed view:

1. In the Physical layer of the Administration Tool, right-click a physical database,
catalog, schema, or table.

If a deployed view exists that is related to the selected object, the right-click menu
contains the Undeploy View(s) option.

2. Select Undeploy View(s).
A list of views to be undeployed appears.

3. If you do not want to undeploy one or more of the views, clear the appropriate
rOws.

4. Inthe View Deployment - Undeploy View(s) dialog, click OK to remove the
views.

A message appears if the undeployment was successful.

5. Inthe View Deployment Messages dialog, you can search for undeployed views
using Find and Find Again, or you can copy the contents.

6. When you are finished, click OK.

When to Delete Opaque Views or Deployed Views

Use the following guidelines to remove opaque or deployed view objects in the
repository:

= Removing an undeployed opaque view in the repository. If the opaque view has
not been deployed, you can delete it from the repository.

= Removing a deployed view. When you deploy an opaque view, a view table is
created physically in both the data source and the repository. Therefore, you must
undeploy the view before deleting it. You use the Undeploy Views utility in the
Administration Tool. This removes the opaque view from the back-end data
source, changes the Table Type from None to Select, and restores the SELECT
statement of the object in the Physical layer of repository.

Caution: Do not manually delete the view table in the data source. If
deleted, the Oracle BI Server cannot query the view object. When you
undeploy the view, it is removed automatically from the data source.

When to Redeploy Opaque Views

After removing an opaque view, you can choose to redeploy it. The Administration
Tool does not distinguish between a first-time deployment and a redeployment. Make
sure that you remove a deployed view before deploying the opaque view again.
Failure to do this causes the deploy operation to fail, and an error message is returned
from the data source.

Using Hints

Hints are instructions placed within a SQL statement that tell the data source query
optimizer the most efficient way to execute the statement. Hints override the
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optimizer's execution plan, so you can use hints to improve performance by forcing
the optimizer to use a more efficient plan. Hints are only supported for Oracle
Database data sources.

Using the Administration Tool, you can add hints to a repository, in both online and
offline modes, to optimize the performance of queries. When you add a hint to the
repository, you associate it with Physical layer objects. When the object associated
with the hint is queried, the Oracle BI Server inserts the hint into the SQL statement.

Table 7-6 shows the physical objects with which you can associate hints. It also shows
the Administration Tool dialog that corresponds to the physical object. Each of these
dialogs contains a Hint field, into which you can type a hint to add it to the repository.

Table 7-6 Physical Layer Objects That Accept Hints

Database Object Dialog

Complex join Complex Join

Physical foreign key Physical Foreign Key
Physical table Physical Table - General tab

Hints are only supported when the Table Type is set to Physical Table. For other
table types, the hint text is ignored. For physical tables with a table type of Select, you
can provide the hint text as part of the SQL statement entered in the Default
Initialization String field.

How to Use Oracle Hints

This section provides a few examples of how to use Oracle hints with the Oracle BI
Server. For more information about Oracle hints, see Oracle Database SQL Language
Reference for the version of the Oracle Database that you use.

About the Index Hint

The Index hint instructs the optimizer to scan a specified index rather than a table.
Example 7-1 explains how you would use the Index hint.

Example 7-1 Index Hint

You find queries against the ORDER_ITEMS table to be slow. You review the execution
plan of the query optimizer and find the FAST_INDEX index is not being used. You
create an Index hint to force the optimizer to scan the FAST_INDEX index rather than
the ORDER_ITEMS table. The syntax for the Index hint is index (table_name,
index_name). To add this hint to the repository, go to the Physical Table dialog in the
Administration Tool and type the following text in the Hint field:

index (ORDER_ITEMS, FAST_INDEX)

About the Leading Hint

The Leading hint forces the optimizer to build the join order of a query with a
specified table. The syntax for the Leading hint is leading ( table_name).If you
were creating a foreign key join between the Products table and the Sales Fact table
and wanted to force the optimizer to begin the join with the Products table, you would
go to the Physical Foreign Key dialog in the Administration Tool and type the
following text in the Hint field:

leading (Products)
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About Performance Considerations for Hints

Hints that are well researched and planned can result in significantly better query
performance. However, hints can also negatively affect performance if they result in a
suboptimal execution plan. Follow these guidelines to create hints to optimize query
performance:

= You should only add hints to a repository after you have tried to improve
performance in the following ways:

- Added physical indexes (or other physical changes) to the Oracle Database.
- Made modeling changes within the server.

= Avoid creating hints for physical table and join objects that are queried often. If
you drop or rename a physical object that is associated with a hint, you must also
alter the hints accordingly.

Creating Hints

The following procedure explains how to add hints to the repository using the
Administration Tool.

To create a hint:

1. In the Administration Tool, go to one of the following dialogs:
— Physical Table—General tab
— Physical Foreign Key
- Complex Join

2. Type the text of the hint in the Hint field and click OK.

For a description of available Oracle hints and hint syntax, see Oracle Database SQL
Language Reference for the version of the Oracle Database that you use.

Note: Although hints are identified using SQL comment markers (/*
or --), do not type SQL comment markers when you type the text of
the hint. The Oracle BI Server inserts the comment markers when the
hint is executed.

Displaying and Updating Row Counts for Physical Tables and Columns

When you request row counts, the Administration Tool retrieves the number of rows
from the data source for all or selected tables and columns (distinct values are
retrieved for columns) and stores those values in the repository. The time this process
takes depends upon the number of row counts retrieved.

When updating all row counts, the Updating Row Counts window appears while row
counts are retrieved and stored. If you click Cancel, the retrieve process stops after the
in-process table (and its columns) have been retrieved. Row counts include all tables
and columns for which values were retrieved before the cancel operation.

Updating all row counts for a large repository might take a long time to complete.
Therefore, you sometimes might want to update only selected table and column
counts.

Row counts are not available for the following;:

= Stored Procedure object types
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s XML data sources and XML Server data sources
s Multidimensional data sources

= Data sources that do not support the COUNTDISTINCT function, such as Microsoft
Access and Microsoft Excel, or data sources for which COUNT_STAR_SUPPORTED
has been disabled in the database features table

= Inonline mode, Update Row Count does not work with connection pools in which
the session variables : USER and : PASSWORD are set as the user name and
password.

In offline mode, the Set values for variables dialog appears so that you can
populate the session variables :USER and : PASSWORD.

= Inonline mode, after importing or manually creating a physical table or column,
the Oracle BI Server does not recognize the new objects until you check them in.
Therefore, Update Row Count is not available in the menu until you check in
these objects.

To display row counts in the Physical layer:
1. In the Administration Tool, select Tools, then select Options.

2. In the General tab of the Options dialog, select Show row count in physical view,
and then click OK.

To update selected row counts in the Physical layer:

1. In the Physical layer of the Administration Tool, right-click a single table or
column. You can select multiple objects and then right-click.

2, In the shortcut menu, select Update Row Count.
To update all row counts in the Physical layer:

1. Inthe Administration Tool, select Tools, then select Update All Row Counts. If the
repository is open in online mode, the Check Out Objects window might open.

2. Click Yes to check out the objects.

Any row counts that have changed since the last update are refreshed.
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Working with Logical Tables, Joins, and
Columns

The Business Model and Mapping layer of the Oracle Bl repository defines the
business, or logical, model of the data and specifies the mapping between the business
model and the Physical layer schemas. Business models are always dimensional,
unlike objects in the Physical layer, which reflect the organization of the data sources.
The Business Model and Mapping layer can contain one or more business models.
Each business model contains logical tables, columns, and joins.

Even though similar terminology is used for logical table and physical table objects,
such as the concept of keys, logical tables and joins in the Business Model and
Mapping layer have their own set of rules that differ from those of relational models.
For example, logical fact tables are not required to have keys, and logical joins can
represent many possible physical joins.

Logical tables, joins, mappings, and other objects in the Business Model and Mapping
layer are typically created automatically when you drag and drop objects from the
Physical layer to a particular business model. After these objects have been created,
you can perform tasks like creating additional logical joins, performing calculations
and transformations on columns, and adding and removing keys from dimension and
fact tables.

This chapter contains the following sections:

s Creating the Business Model and Mapping Layer

= Working with the Business Model Diagram

s Creating and Managing Logical Tables

s Defining Logical Joins

s Creating and Managing Logical Columns

= Enabling Write Back On Columns

s Setting Up Display Folders in the Business Model and Mapping Layer
= Modeling Bridge Tables

Creating the Business Model and Mapping Layer

After creating all of the elements of the Physical layer, you can drag tables or columns
from the Physical layer to a business model in the Business Model and Mapping layer
to create logical objects in the metadata.

This section contains the following topics:
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s Creating Business Models
= Automatically Creating Business Model Objects
= Duplicating a Business Model and Subject Area

Creating Business Models

The Business Model and Mapping layer of the Administration Tool can contain one or
more business models. A business model contains the business model definitions and
the mappings from logical to physical tables for the business model.

When you work in a repository in offline mode, remember to save your repository
from time to time. You can save a repository in offline mode even though the business
models may be inconsistent.

To create a business model:

1. In the Administration Tool, right-click in the Business Model and Mapping layer
below any existing objects.

2. Select the option New Business Model from the shortcut menu.
3. Specify a name for the business model.

4. New business models are disabled by default. If you want to make the
corresponding Presentation layer available for queries, deselect Disabled.

Note: The business model should be consistent before you deselect
this option.

5. Optionally, type a description of the business model.
6. Click OK.

After you create a business model, you can create business model objects by dragging
and dropping objects from the Physical layer. See the next section for more
information.

Automatically Creating Business Model Objects

To automatically map objects in the Business Model and Mapping layer to sources in
the Physical layer, you can drag and drop Physical layer objects to a particular
business model in the logical layer. When you drag a physical table to the Business
Model and Mapping layer, a corresponding logical table is created. For each physical
column in the table, a corresponding logical column is created. If you drag multiple
tables at once, a logical join is created for each physical join, but only the first time the
tables are dragged onto a new business model.

Automatically Creating Business Model Objects for Multidimensional Data Sources

Setting up objects in the Business Model and Mapping layer for multidimensional data
sources is similar to setting up logical layer objects for a relational data source. To
create the business model layer, you can drag and drop the Physical layer cube to the
logical layer. Oracle Business Intelligence automatically creates a fully configured and
consistent business model that retains metrics, attributes and dimensions.
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Note: For Essbase data sources, it is recommended that you create a
separate business model for each Essbase cube. To do this, drag each
cube individually to the Business Model and Mapping layer.

Duplicating a Business Model and Subject Area

This feature lets you select a business model and its corresponding subject area (or a
subject area and its corresponding business model), make a copy, and assign new
names to the duplicates. Note that aliases are not copied.

To copy a business model and subject area:
1. Perform one of the following steps:

= In the Business Model and Mapping layer of the Administration Tool,
right-click a business model and select Duplicate with Subject Area.

= In the Presentation layer of the Administration Tool, right-click a subject area
and select Duplicate with Business Model.

2. In the Copy Business Model and Subject Area dialog, select the business model
and corresponding subject area you want to copy.

3. Specify new names for the business model and subject area in the appropriate
name fields, and then click OK.

The copied business model appears in the Business Model and Mapping layer,
and the copied subject area appears in the Presentation layer.

Working with the Business Model Diagram

In addition to working with Business Model and Mapping layer objects in the middle
pane of the Administration Tool, you can open the Business Model Diagram to see a
graphical model of logical tables and joins.

To access the Business Model Diagram, right-click an object in the Business Model and
Mapping layer (such as a dimension or fact table) and select Business Model
Diagram. Then, select one of the following options:

= Whole Diagram. Displays all logical tables and joins in the business model.

= Selected Tables Only. Displays only the selected logical tables. Logical joins
appear only if they exist between the objects that you selected. This option is only
available when you select one or more logical tables.

= Selected Tables and Direct Joins. Displays the selected logical tables and any
logical tables that join to the tables that you selected. This option is only available
when you select one or more logical tables.

= Selected Fact Tables and Dimensions. Displays the selected logical tables and their
associated logical dimensions. This option is only available when your selection
includes at least one fact table.

To add additional tables to the Business Model Diagram, leave the Business Model
Diagram window open and then right-click the table or tables you want to add. Then,
select Business Model Diagram and choose one of the display options.

Additional options are available in the right-click menu for the graphical tables and
joins displayed in the Business Model Diagram. For example, you can right-click an
object and choose Hide to hide particular objects in the diagram, you can delete objects
or view their properties, or you can add additional related objects using the right-click
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options Add Direct Joins, Add Tables Joined to Whole Selection, and Add All Joins.
You can also select Find in Tree View to locate a particular object in the Business
Model and Mapping layer view in the middle pane, or check out objects in online
mode.

Creating and Managing Logical Tables

Logical tables exist in the Business Model and Mapping layer. The logical schema
defined in each business model must contain at least two logical tables, and you must
define relationships between them.

Each logical table has one or more logical columns and one or more logical table
sources associated with it. You can change the logical table name, reorder the logical
table sources, and configure the logical keys, both primary and foreign.

This section contains the following topics:
»  Creating Logical Tables
= Specifying a Primary Key in a Logical Table

= Reviewing Foreign Keys for a Logical Table

Creating Logical Tables

Typically, you create logical tables by dragging and dropping a physical table from the
Physical layer to a business model in the Business Model and Mapping layer. If a table
does not exist in your physical schema, you need to create the logical table manually.

Drag and drop operations are usually the fastest method for creating objects in the
Business Model and Mapping layer. If you drag and drop physical tables from the
Physical layer to the Business Model and Mapping layer, the columns belonging to the
table are also copied. After you drag and drop objects into the Business Model and
Mapping layer, you can modify them in any way necessary without affecting the
objects in the Physical layer.

When you drag physical tables (with key and foreign key relationships defined) to a
business model, logical keys and joins are created that mirror the keys and joins in the
Physical layer. This occurs only if the tables that you drag include the table with the
foreign keys. Additionally, if you create new tables or subsequently drag additional
tables from the Physical layer to the Business Model and Mapping layer, the logical
mappings between the new or newly dragged tables and the previously dragged
tables must be created manually.

See "Defining Logical Joins with the Joins Manager" and "Defining Logical Joins with
the Business Model Diagram" for more information about joins.

To create a logical table by dragging and dropping:
1. In the Administration Tool, select one or more table objects in the Physical layer.

You must include the table with the foreign keys if you want to preserve the keys
and joins from the Physical layer.

2. Drag and drop the table objects to a business model in the Business Model and
Mapping layer.

When you drop them, the table objects, including the physical source mappings,
are created automatically in the Business Model and Mapping layer.

To create a logical table manually:
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1. In the Business Model and Mapping layer of the Administration Tool, right-click
the business model in which you want to create the table and select New Object >
Logical Table.

The Logical Table dialog appears.
2. In the General tab, type a name for the logical table.

3. If this is a lookup table, select the option Lookup table. A lookup table stores
multilingual data corresponding to rows in the base tables. See "Localizing Oracle
Business Intelligence Deployments" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information about localization and lookup tables.

4. Optionally, type a description of the table.
5. Click OK.

After creating a logical table manually, you must create all keys and joins manually.

Creating and Managing Logical Table Sources

You can add a new logical table source, edit or delete an existing table source, create or
change mappings to the table source, and define when to use logical tables sources
and how content is aggregated. See Chapter 10, "Managing Logical Table Sources
(Mappings)" for instructions about how to perform these tasks.

Specifying a Primary Key in a Logical Table

After creating tables in the Business Model and Mapping layer, you specify a primary
key for each dimension table. Logical dimension tables must have a logical primary
key. Logical keys can be composed of one or more logical columns.

Note: Itis recommended that you do not specify logical keys for
logical fact tables.

To specify a primary key in a logical table:

1. In the Business Model and Mapping layer of the Administration Tool, double-click
a table.

2. In the Logical Table dialog, select the Keys tab and then click New.

3. Inthe Logical Key dialog, type a name for the key and select the column that
defines the key of the logical table.

4. C(lick OK.

Reviewing Foreign Keys for a Logical Table

It is recommended that you do not use foreign key joins in logical tables. If you must
create these joins, you must first enable the option Allow logical foreign key join
creation in the Options dialog. See "Creating Logical Foreign Key Joins with the Joins
Manager" for more information.

The Foreign Keys tab of the Logical Table dialog exists so that you can view logical
foreign keys you might have had in a previous release of Oracle Business Intelligence.
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Defining Logical Joins

Relationships between logical tables are expressed by logical joins. Logical joins are
conceptual, rather than physical, joins. In other words, they do not join to particular
keys or columns. A single logical join can correspond to many possible physical joins.

A key property of a logical join is cardinality. Cardinality expresses how rows in one
table are related to rows in the table to which it is joined. A one-to-many cardinality
means that for every row in the first logical dimension table, there are 0, 1, or many
rows in the second logical table. The Administration Tool considers a table to be a
logical fact table if it is at the Many end of all logical joins that connect it to other
logical tables.

Specifying the logical table joins is required so that the Oracle Bl Server can have the
necessary metadata to translate a logical request against the business model to SQL
queries against the physical data sources. The logical join information provides the
Oracle BI Server with the many-to-one relationships between the logical tables. This
logical join information is used when the Oracle BI Server generates queries against
the underlying databases.

You do not need to create logical joins in the Business Model and Mapping layer if
both of the following statements are true:

= You create the logical tables by simultaneously dragging and dropping all
required physical tables to the Business Model and Mapping layer.

s The logical joins are the same as the joins in the Physical layer.

However, you will probably have to create some logical joins in the Business Model
and Mapping layer, because you will rarely drag and drop all physical tables
simultaneously except in very simple models.

You can create logical joins using either the Joins Manager or the Business Model
Diagram. When you create a complex join in the Physical layer, you can specify
expressions and the specific columns on which to create the join. When you create a
logical join in the Business Model and Mapping layer, you cannot specify expressions
or columns on which to create the join. The existence of a join in the Physical layer
does not require a matching join in the Business Model and Mapping layer.

Note: It is recommended that you do not have foreign keys for
logical tables. However, for backward compatibility, you can create
logical foreign key joins using the Joins Manager if you select Allow
logical foreign key join creation in the Options dialog.

A logical key for a fact table must be made up of the key columns that
join to the attribute tables. Logical foreign key joins may be needed if
the Oracle BI Server is to be used as an ODBC data source for certain
third-party query and reporting tools.

This section contains the following topics:

= Defining Logical Joins with the Business Model Diagram
s Defining Logical Joins with the Joins Manager

s Specifying a Driving Table

= Identifying Physical Tables That Map to Logical Objects
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Defining Logical Joins with the Business Model Diagram

The Business Model Diagram shows logical tables and any defined joins between
them. You can use the Business Model Diagram to define logical joins between tables.

To define a logical join with the Business Model Diagram:

1. Inthe Administration Tool, right-click a business model and select Business
Model Diagram, then select Whole Diagram.

2. Click the New Join button in the toolbar.

3. In the business model diagram, move the cursor to the first table in the join (the
one of the one-to-many join).

4. Left-click and move the cursor to the table to which you want to make the join (the
many of the one-to-many join), and then left-click the second table. The Logical
Join dialog appears.

5. (Optional) To specify a driving table for the key, select a table from the Driving
list, and an applicable cardinality.

This option is useful for optimizing the manner in which the Oracle BI Server
processes multi-database inner joins when one table is very small and the other
table is very large. Do not select a driving table unless multi-database joins are
going to occur. See "Specifying a Driving Table" for more information about
driving tables.

Caution: Use extreme caution in deciding whether to specify a
driving table. Driving tables are used for query optimization only
under rare circumstances and when the driving table is extremely
small (fewer than 1000 rows). Choosing a driving table incorrectly can
lead to severe performance degradation.

6. Select the join type from the Type list, or keep the default value.
7. Set the Cardinality for each side of the join, or keep the default values.
8. Click OK to save your work.

Defining Logical Joins with the Joins Manager

You can use the Joins Manager to view logical join relationships and to create logical
joins. You can also use the Joins Manager to create logical foreign key joins if you select
Allow logical foreign key join creation in the Options dialog, although this is not
recommended.

This section contains the following topics:
s Creating Logical Joins with the Joins Manager

s Creating Logical Foreign Key Joins with the Joins Manager

Creating Logical Joins with the Joins Manager

Logical joins are recommended over logical foreign key joins in the Business Model
and Mapping layer.

To create a logical join with the Joins Manager:

1. In the Administration Tool, select Manage, then select Joins.
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The Joins Manager dialog appears.
2. Select Action > New > Logical Join.
The Logical Join dialog appears.
3. Type a name for the logical join.

4. In the Table lists on the left and right side of the dialog, select the tables that the
logical join references.

5. (Optional) To specify a driving table for the key, select a table from the Driving
list, and an applicable cardinality.

This option is useful for optimizing the manner in which the Oracle BI Server
processes multi-database inner joins when one table is very small and the other
table is very large. Do not select a driving table unless multi-database joins are
going to occur. See "Specifying a Driving Table" for more information about
driving tables.

Caution: Use extreme caution in deciding whether to specify a
driving table. Driving tables are used for query optimization only
under rare circumstances and when the driving table is extremely
small, that is, less than 1000 rows. Choosing a driving table incorrectly
can lead to severe performance degradation.

6. Select the join type from the Type list, or keep the default value.
7. Set the Cardinality for each side of the join, or keep the default values.
8. Click OK.

Creating Logical Foreign Key Joins with the Joins Manager

Logical foreign key joins might be needed if the Oracle BI Server is to be used as an
ODBC data source for certain third-party query and reporting tools. Typically, you
should not create logical foreign keys. This capability is in the Administration Tool to
provide compatibility with previous releases.

To create a logical foreign key join with the Joins Manager:
1. In the Administration Tool, select Tools, then select Options.

2. In the General tab of the Options dialog, select Allow logical foreign key join
creation.

Click OK.
Select Manage, then select Joins to display the Joins Manager.
Select Action > New > Logical Foreign Key.

o o & W

In the Browse dialog, double-click a table to display the Logical Foreign Key
dialog.

N

Type a name for the foreign key.

8. In the Table list on the left side of the dialog, select the table that the foreign key
references.

9. Select the columns in the left table that the foreign key references.

10. Select the columns in the right table that make up the foreign key columns.
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11. (Optional) To specify a driving table for the key, select a table from the Driving
list, and an applicable cardinality.

This option is useful for optimizing the manner in which the Oracle BI Server
processes multi-database inner joins when one table is very small and the other
table is very large. Do not select a driving table unless multi-database joins are
going to occur. See "Specifying a Driving Table" for more information about
driving tables.

Caution: Use extreme caution in deciding whether to specify a
driving table. Driving tables are used for query optimization only
under rare circumstances and when the driving table is extremely
small, that is, less than 1000 rows. Choosing a driving table incorrectly
can lead to severe performance degradation.

12. Select the join type from the Type list, or keep the default value.
13. Set the Cardinality for each side of the join, or keep the default values.

14. Enter an expression for the join, or click the Expression Builder button to define
the expression in Expression Builder.

15. Click OK to save your work.

Specifying a Driving Table

You can specify a driving table for logical joins from the Logical Joins window.
Driving tables are useful for optimizing the manner in which the Oracle BI Server
processes cross-database joins when one table is very small and the other table is very
large. Specifying driving tables leads to query optimization only when the number of
rows being selected from the driving table is much smaller than the number of rows in
the table to which it is being joined.

Caution: To avoid problems, only specify driving tables when the
driving table is extremely small - less than 1000 rows.

When you specify a driving table, the Oracle BI Server uses it if the query plan
determines that its use will optimize query processing. The small table (the driving
table) is scanned, and parameterized queries are issued to the large table to select
matching rows. The other tables, including other driving tables, are then joined
together.

Caution: If large numbers of rows are being selected from the
driving table, specifying a driving table could lead to significant
performance degradation or, if the MAX_QUERIES_PER_DRIVE_JOIN
limit is exceeded, the query terminates.

In general, driving tables can be used with inner joins, and for outer joins when the
driving table is the left table for a left outer join, or the right table for a right outer join.
Driving tables are not used for full outer joins. See "Defining Logical Joins" for
instructions on specifying a driving table.

There are two entries in the database features table that control and tune driving table
performance.
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s MAX PARAMETERS_PER_DRIVE_JOIN

This is a performance tuning parameter. In general, the larger its value, the fewer
parameterized queries need to be generated. Values that are too large can result in
parameterized queries that fail due to back-end database limitations. Setting the
value to 0 (zero) turns off drive table joins.

s MAX QUERIES_PER_DRIVE_JOIN

This is used to prevent runaway drive table joins. If the number of parameterized
queries exceeds its value, the query is terminated and an error message is returned
to the user.

Identifying Physical Tables That Map to Logical Objects

The Physical Diagram shows the physical tables that map to the selected logical object
and the physical joins between each table.

One of the joins options, Object(s) and Direct Joins within Business Model, is unique
to the logical layer. It creates a physical diagram of the tables that meet both of the
following conditions:

= Tables in the selected objects and tables that join directly

= Tables that are mapped (exist in logical table sources in the business model) in the
business model

To open the Physical Diagram for a logical object:

1. In the Business Model and Mapping layer of the Administration Tool, right-click a
business model, logical table, or logical table source.

2. Select Physical Diagram and then one of the joins options.

3. (Click and drag any object to more clearly view the relationship lines, such as
one-to-many:.

Creating and Managing Logical Columns

Many logical columns are automatically created by dragging tables from the Physical
layer to the Business Model and Mapping layer. Other logical columns, especially ones
that involve calculations based on other logical columns, can be created later.

Logical columns are displayed in a tree structure expanded out from the logical table
to which they belong. If the column is a primary key column or participates in a
primary key, the column is displayed with a key icon. If the column has an
aggregation rule, it is displayed with a ruler icon. You can also reorder logical columns
in the Business Model and Mapping layer.

This section contains the following topics:

s Creating Logical Columns

= Basing the Sort for a Logical Column on a Different Column

= Assigning a Descriptor ID Column to a Logical Column

m  Creating Derived Columns

»  Setting Default Levels of Aggregation for Measure Columns

= Associating an Attribute with a Logical Level in Dimension Tables

= Moving or Copying Logical Columns
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Creating Logical Columns

The following procedure explains how to create logical columns in the Business Model
and Mapping layer.

To create a logical column:

1. In the Business Model and Mapping layer, right-click a logical table.

2. From the shortcut menu, select New Object, then select Logical Column.
3. In the General tab, type a name for the logical column.

The name of the business model and the associated logical table appear in the
Belongs to Table field.

4. Select Writeable to enable write back for this column. See "Enabling Write Back On
Columns" for more information.

5. Optionally, you can assign a different column on which to base the sort order for a
column. See "Basing the Sort for a Logical Column on a Different Column" for
details.

6. Optionally, you can assign a descriptor ID column for this column. See "Assigning
a Descriptor ID Column to a Logical Column" for details.

7. Optionally, on the Column Source tab, you can specify that this logical column is
derived from other logical columns. See "Creating Derived Columns" for details.

8. Optionally, on the Aggregation tab, you can set column aggregation. See "Setting
Default Levels of Aggregation for Measure Columns" for details.

9. Optionally, on the Levels tab, you can associate attributes with a logical level.
Measures can be associated with levels from multiple dimensions and always
aggregate to the levels specified. See "Associating an Attribute with a Logical
Level in Dimension Tables" for details.

10. Click OK.

Basing the Sort for a Logical Column on a Different Column

For a logical column, you can specify a different column on which to base the sort.
This changes the sort order of a column when you do not want to order the values
lexicographically. Lexicographical sort arranges the results in alphabetic order such as
in a dictionary. In this type of sort, numbers are ordered by their alphabetic spelling
and not divided into a separate group.

For example, if you sorted on month (using a column such as MONTH_NAME), the
results would be returned as February, January, March, and so on, in lexicographical
sort order. However, you might want months to be sorted in chronological order.
Therefore, your table should have a month key (such as MONTH_KEY) with values of 1
(January), 2 (February), 3 (March), and so on. To achieve the desired sort, you set the
Sort order column field for the MONTH_NAME column to be MONTH_KEY. Then, a
request to order by MONTH_NAME would return January, February, March, and so on.

To assign a different column on which to base the sort order for a column:

1. In the Logical Column dialog, in the General tab, click Set next to the Sort order
column field.

2. In the Browse dialog, select a column.

3. To view the column details, click View to open the Logical Column dialog for that
column, and then click Cancel.
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You can make some changes in this dialog. If you make changes, click OK to
accept the changes instead of Cancel.

4. Inthe Browse dialog, click OK.

Assigning a Descriptor ID Column to a Logical Column

When multilingual columns are based on a lookup function, it is common to specify
the non-translated lookup key column as the descriptor ID column of the translated
column. Assigning a descriptor ID column enables Double Column Support, a feature
which helps in defining language-independent filters. For example, in Answers, users
see the display column, but the query filters on the hidden descriptor ID column.

For more information, see "Supporting Multilingual Data" in Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence Enterprise Edition.

To assign a Descriptor ID column to a display column:

1. In the Logical Column dialog, in the General tab, click Set next to the Descriptor
ID column field.

2. Inthe Browse dialog, select a key column.

3. To view the column details, click View to open the Logical Column dialog for that
column, and then click Cancel.

You can make some changes in this dialog. If you make changes, click OK to
accept the changes instead of Cancel.

4. Inthe Browse dialog, click OK.

Creating Derived Columns

Some columns are derived from other logical columns as a way to apply
post-aggregation calculations to measures. To do this, you specify the derived column
expression in the Column Source tab of the Logical Column dialog.

You can also create a set of derived columns using the Calculation Wizard. See "Using
the Calculation Wizard" for more information.

Note that if the parameter PREVENT_DIVIDE_BY_ZERO is set to YES in
NQSConfig.INI, the Oracle BI Server prevents errors in divide-by-zero situations, even
for Answers column calculations. The Oracle Bl Server creates a divide-by-zero
prevention expression using nullif () or a similar function when it writes the
physical SQL. Because of this, you do not have to use CASE statements to avoid
divide-by-zero errors, as long as PREVENT_DIVIDE_BY_ZERO is set to YES (the
default value).

See Oracle Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition for more information about NQSConfig.INI settings.

You can also apply calculations pre-aggregation. See "Defining Physical to Logical
Table Source Mappings and Creating Calculated Items" for more information.

To specify a derived column:

1. In the Logical Column dialog, select the Column Source tab.

2. Select the option Derived from existing columns using an expression.
3. Click the Expression Builder button to open Expression Builder.
4

In the Expression Builder - Derived logical column dialog, specify the expression
from which the logical column should be derived.
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Note: To optimize performance, do not define aggregations in
Expression Builder. Instead, use the Aggregation tab of the Logical
Column dialog. See "Setting Default Levels of Aggregation for
Measure Columns" for more information.

5. Click OK.

Note that you can display data from multilingual database schemas by using
Expression Builder to create a lookup function. For more information, see "Supporting
Multilingual Data" in Oracle Fusion Middleware System Administrator's Guide for Oracle
Business Intelligence Enterprise Edition.

Configuring Logical Columns for Multicurrency Support

You can configure logical columns so that Oracle Business Intelligence users can select
the currency in which they prefer to view currency columns in analyses and
dashboards. You can set up this feature so that all users see the same static list of
currency options, or you can provide a dynamic list of currency options that changes
based on a Logical SQL statement you specify.

To configure logical columns for multicurrency support:

1. Create a session variable named PREFERRED_CURRENCY, along with an
initialization block to use in the variable. Make sure to select Enable any user to
set the value when you create the session variable. Note that when you use
session variables in an expression for Oracle BI Presentation Services, you must
preface their names with NQ_SESSION.

See "Creating Session Variables" and "Creating Initialization Blocks" for detailed
information about setting up session variables and initialization blocks.

2. Edit any logical columns that display currency values to use the appropriate
conversion factor using the PREFERRED_CURRENCY session variable. To do this,
double-click the appropriate logical column in the Business Model and Mapping
layer, select the Column Source tab, and create a derived expression that uses the
PREFERRED_CURRENCY variable.

For example, the following logical column expression uses the value of the NQ_
SESSION.PREFERRED_CURRENCY variable to switch between different currency
columns. Note that the currency columns are expected to have the appropriate
converted values.

INDEXCOL ( CASE VALUEOF (NQ_SESSION.PREFERRED_CURRENCY) WHEN 'gcl' THEN 0
WHEN 'gc2' THEN 1 WHEN 'orgc' THEN 2 WHEN 'lcl' THEN 3 ELSE 4 END,
"Paint"."Sales Facts"."USDCurrency",

"Paint"."Sales Facts"."DEMCurrency" ,

"Paint"."Sales Facts"."EuroCurrency" ,

"Paint"."Sales Facts"."JapCurrency" ,

"Paint"."Sales Facts"."USDCurrency" )

3. If you want to provide a dynamic list of currency options, create a table in your
data source that provides the entries you want to display for the user-preferred
currency. This table must include the following columns:

s The first column contains the values used to set the session variable
PREFERRED_CURRENCY. Each value in this column is a string that uniquely
identifies the currency (for example, gc2).

Working with Logical Tables, Joins, and Columns 8-13



Creating and Managing Logical Columns

s The second column contains currency tags from the file currencies.xml. The
displayMessage values for each tag are used to populate the Currency box and
currency prompts (for example, int:euro-1). The currencies.xml file is located
in ORACLE_HOME\bifoundation\web\display.

= You can optionally provide a third column that contains the values used to set
the presentation variable currency.userPreference. Each value in this
column is a string that identifies the currency (for example, Global Currency
2). If you omit this column, then the values for the displayMessage attributes
for the corresponding currency tags in the currencies.xml file are used.

Table 8-1 shows a sample table with user-preferred currency entries.

Table 8-1 Sample Table for Dynamically Displaying the Preferred Currency

UserPreference CurrencyTag UserPreferenceName
char char char

orgcl loc:en-BZ Org currency

gc2 int:euro-1 Global currency 2

Ic1 int:DEM Ledger currency

gcl int:USD Global Currency 1

Additional configuration is required in Oracle BI Presentation Services to enable this
feature. For full information about the Oracle BI Presentation Services configuration,
see "Defining User-Preferred Currency Options" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition.

Setting Default Levels of Aggregation for Measure Columns

You need to specify aggregation rules for mapped logical columns that are measures.
Aggregation should only be performed on measure columns, with the possible
exception of the aggregation COUNT and COUNTDISTINCT. Measure columns should
exist only in logical fact tables.

You can optionally select different aggregation rules for different dimensions that are
associated with this logical column. For example, if someone queries the aggregate
column along with one dimension, you may want to use one type of aggregation rule,
whereas with another dimension, you may want to use a different aggregation rule.

When the default aggregation rule is Count Distinct, you can optionally specify an
override aggregation expression for specific logical table sources. For example, you
may want to specify override aggregation expressions when you are querying
different aggregate table sources that already contain some level of aggregation. If you
do not specify any override, then the default rule prevails.

You can choose the aggregation rule Evaluate_Aggr to enable queries to call custom
functions in the data source. For information about this function and other aggregation
rules, see Appendix C. See also "Defining Aggregation Rules for Essbase and Other
Multidimensional Data Sources” for additional information about setting aggregation
for multidimensional sources.

By default, data is considered sparse. However, on rare occasions you might have a
logical table source with dense data. A logical table source is considered to have dense
data if it has a row for every combination of its associated dimension levels. When
setting up aggregate rules for a measure column, you can specify that data is dense
only if all the logical table sources to which it is mapped are dense.
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To specify a default aggregation rule for a measure column:

1.
2.
3.

4,

In the Business Model and Mapping layer, double-click a logical column.

In the Logical Column dialog, click the Aggregation tab.

In the Aggregation tab, choose one of the following options:

For measures in which the additivity is the same in all dimensions (in other
words, for fully-additive or non-additive measures), select one of the
aggregate functions from the Default Aggregation Rule list.

The function you select is always applied when a user or an application
requests the column in a query, unless an override aggregation expression has
been specified.

When you select Count Distinct as the default aggregation rule, you can
specify an override aggregation expression for specific logical table sources.
Choose this option when you have more than one logical table source mapped
to a logical column and you want to apply a different aggregation rule to each
source.

Click the Add button to select logical table sources for which you want to
specify individual aggregation rules. In the Browse dialog, select the logical
table source you want to add, and click OK. Then, in the Formula list for that
logical table source, select the aggregation rule you want to use.

Select Based on dimensions if your measure has different additivity for
different dimensions (in other words, for semi-additive measures). For
example, select this option for inventory units that sum in all dimensions
except time. See "Setting Up Dimension-Specific Aggregate Rules for Logical
Columns" for more information about this feature.

Click the Add button to select additional dimensions for which you want to
specify aggregation rules. In the Browse dialog, select the dimension you want
to add, and then click OK. Then, in the Formula list for that dimension, select
the aggregation rule you want to use, or click the Expression Builder button
to build the aggregation rule using Expression Builder.

The Data is dense option appears when you select Based on dimensions.
Select this option only if all the logical table sources to which this column is
mapped are dense.

Caution: Selecting Data is dense indicates that all sources to which
this column is mapped have a row for every combination of
dimension levels that they represent. Selecting this option when any
table source that is used by this column does not contain dense data
will return incorrect results.

Click OK.

Setting Up Dimension-Specific Aggregate Rules for Logical Columns

The majority of measures have the same aggregation rule for each dimension.
However, some measures can have different aggregation rules for different
dimensions. For example, bank balances might be averaged over time but summed
over the individual accounts. The Oracle Bl Server lets you configure
dimension-specific aggregation rules. You can specify one aggregation rule for a given
dimension and specify other rules to apply to other dimensions.
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You need to configure dimensions in the Business Model and Mapping layer to set up
dimension-specific aggregation. For more information about setting up aggregate
navigation, see Chapter 10.

To specify dimension-specific aggregation rules for a single logical column:

1.

2
3.
4

8.

In the Business Model and Mapping layer, double-click a logical column.
In the Logical Column dialog, click the Aggregation tab.
In the Aggregation tab, select Based on dimensions.

In the Browse dialog, select a dimension over which you want to aggregate, and
then click OK.

In the Aggregation tab, from the Formula list, select a rule.

After selecting rules for specified dimensions, set the aggregation rule for any
remaining dimensions by using the dimension labeled Other.

If you need to create more complex formulas, click the Expression Builder button
to the right of the Formula column to open Expression Builder.

If you have multiple dimensions, you can click Up or Down to change the order in
which the dimension-specific rules are performed.

When calculating the measure, aggregation rules are applied in the order (top to
bottom) established in the dialog.

Click OK.

To specify dimension-specific aggregation rules for multiple logical fact columns:

1.
2.

In the Business Model and Mapping layer, select multiple logical fact columns.
Right-click and select Set Aggregation.

You must select more than one column to see the Set Aggregation menu item.
Also note that Set Aggregation does not appear if one or more of the columns you
select is a derived column.

In the Aggregation dialog, select or clear All columns the same.

This option is selected by default. When selected, you can set aggregation rules
that apply to all selected columns. If you clear this option, you can set aggregation
rules separately for each selected column.

In the Aggregation tab, select Based on dimensions.

In the Browse dialog, select a dimension over which you want to perform
aggregation, and then click OK.

After setting up the rule for a dimension, specify aggregation rules for any other
dimensions in the entry labeled Other.

Click the Expression Builder button to the right of the Formula column.

In the Expression Builder - Aggregate dialog, from the Formula list, select the
aggregation to perform over the dimension.

To change the order in which the dimension-specific rules are performed, click Up
or Down, and then click OK.

When calculating the measure, aggregation rules are applied in the order (top to
bottom) established in the dialog.
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Defining Aggregation Rules for Essbase and Other Multidimensional Data Sources

This section describes best practices for defining aggregation rules for logical measures
sourced from Essbase and other multidimensional data sources, like MSAS and
SAP/BW.

By default, when you import Essbase and some other multidimensional cubes into the
Physical layer, Oracle Business Intelligence cannot read the aggregation rules set
within the data source. Because of this, the measures are imported automatically with
the default aggregation rule of External Aggregation. Note that this rule is only
available for multidimensional data sources.

External Aggregation means that the Oracle BI Server is not aware of the underlying
aggregation rule for the specific measure and will not compute it internally. Instead,
the Oracle BI Server will always ship the query to the underlying multidimensional
data source for aggregation.

Because the underlying data sources are extremely efficient, pushing the aggregation
rules down to the data source ensures that the Oracle BI Server returns the results
without adding any additional overhead in processing. However, it is recommended
that you update the aggregation rule for each measure in Oracle Business Intelligence
with the corresponding aggregation rule defined in the data source. Doing so ensures
that the Oracle BI Server can do additional computations when needed. There is no
query performance impact, since the Oracle Bl Server still pushes down optimized
queries wherever possible.

Note: If the Oracle Bl Server needs to do additional aggregation for a
particular query, and the aggregation rule is set to the default of
External Aggregation, the server returns the following error:

An external aggregate is found in an outer query block.

This error occurs because the Oracle Bl Server cannot read the
aggregation rule in the underlying data source. To ensure that correct
results are returned for these queries, you should change the
aggregation rules set in the Oracle BI repository to match the
aggregation rules set in the underlying data source.

You must ensure that the aggregation rule defined in Oracle Business Intelligence
matches the rule in the underlying data source. Also, you must set the appropriate
aggregation rule in both the Physical layer and Business Model and Mapping layer, as
shown in Figure 8-1.
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Figure 8-1 Setting Aggregation Rules in the Physical and Business Model and Mapping
Layers for Multidimensional Sources
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For custom aggregations or aggregations which do not have a corresponding function
within the Oracle BI Server, it is recommended to leave the aggregation as External

Aggregation for both the physical measure column and its corresponding logical
measure column.

Associating an Attribute with a Logical Level in Dimension Tables

Attributes can be associated with a logical level by selecting the dimensional level on
the Levels tab. Measures can be associated with levels from multiple dimensions and
always aggregate to the levels specified.

Dimensions appear in the Dimensions list. If this attribute is associated with a logical
level, the level appears in the Levels list.

Another way to associate a measure with a level in a dimension is to expand the
dimension tree in the Business Model and Mapping layer, and then use drag-and-drop

to drop the column on the target level. For more information about level-based
measures, see Example 9-1.

To associate a measure with a logical level in a dimension:

1. In the Business Model and Mapping layer of the Administration Tool, double-click
a logical column.

2. In the Logical Column dialog, click the Levels tab.

3. Inthe Levels tab, click the Logical Level field for the dimension from which you
want to select a logical level.

In the Levels tab, in the levels list, you can sort the rows (toggle between
ascending order and descending order) by clicking a column heading.
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4, In the Logical Level list, select the level.

5. Repeat this process to associate this measure with other logical levels in other
dimensions.

To remove the association between a dimension and a measure:

1. In the Business Model and Mapping layer of the Administration Tool, double-click
a logical column.

2. In the Logical Column dialog, click the Levels tab.

3. Inthe Levels tab, select the row for the association you want to remove and click
Delete.

4. Click OK.

Moving or Copying Logical Columns

By default, dragging and dropping a logical column from one table to another moves
the logical column. If a column with the same name already exists, the new column is
renamed (for example, mycolumn#1).

You can also choose the option Prompt when moving logical columns in the Options
dialog to cause the Sources for moved columns dialog to be displayed when you drag
and drop a logical column. This dialog gives you options about the drag and drop
behavior.

See "Setting Preferences" for more information about selecting the Prompt when
moving logical columns option.

To move or copy logical columns using the Sources for moved columns dialog:

1. In the Business Model and Mapping layer, drag and drop a logical column to a
different logical table. You can select multiple columns to move.

2. In the Sources for moved columns dialog, in the Action area, select an action.

3. If you select Ignore, no logical source is added in the Sources folder of the
destination table.

4. If you select Create new, a copy of the logical source associated with the logical
column is created in the Sources folder of the destination table.

5. If you select Use existing, in the Use existing list, you must select a logical source
from the Sources folder of the destination table.

The column that you moved or copied is associated with this logical source.

Enabling Write Back On Columns

You can configure individual logical columns so that users in Oracle BI Presentation
Services can update column data and write the changes back to the data source. To
enable write back on a particular column, you must select the Writeable option for the
logical column, and enable the Read/Write permission for the corresponding
presentation column. You must also disable caching on the corresponding physical
table.

Additional tasks to enable write back need to be performed in Oracle BI Presentation
Services. See "Configuring for Write Back in Dashboards and Analyses" in Oracle
Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for full information.
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To enable write back for a particular column:

1. In the Administration Tool, in the Physical layer, double-click the physical table
that contains the column for which you want to enable write back.

2. On the General tab of the Physical Table dialog, ensure that Cacheable is not
selected. Deselecting this option ensures that Oracle Bl Presentation Services users
can see updates immediately.

3. In the Business Model and Mapping layer, double-click the corresponding logical
column. The Logical Column dialog opens.

Figure 8-2 shows the Logical Column dialog.

Figure 8-2 Logical Column Dialog with Writeable Option Selected
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4. Select Writeable, then click OK.

5. In the Presentation layer, double-click the column that corresponds to the logical
column for which you enabled write back. The Presentation Column dialog opens.

6. Click Permissions.
7. Select the Read/Write permission for the appropriate users and application roles.

Figure 8-3 shows the Permissions dialog.
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Figure 8-3 Permissions Dialog for Presentation Layer Column with Read/Write Option
Selected
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8. Click OK in the Permissions dialog.
9. Click OK in the Presentation Column dialog.

Setting Up Display Folders in the Business Model and Mapping Layer

You can create display folders to organize objects in the Business Model and Mapping
layer. They have no effect on query processing. After you create a display folder, the
selected tables and dimensions appear in the folder as a shortcut and in the business
model tree as the object. You can hide the objects so that you only view the shortcuts in
the display folder. See the information about the Repository tab of the Options dialog
in "Setting Preferences" for more information about hiding these objects.

Note: Deleting a table in a display folder deletes only the shortcut to
that object. When you delete a column in a display folder, however,
the column is actually deleted.

To set up a logical display folder:

1. In the Business Model and Mapping layer of the Administration Tool, right-click a
business model and select New Object, then select Logical Display Folder.

2. Inthe Logical Display Folder dialog, in the Tables tab, type a name for the folder.

3. To add tables to the display folder, click Add. In the Browse dialog, select the fact
or dimension tables you want to add to the folder and click Select.

Alternatively, you can drag one or more logical tables to the display folder after
you close the dialog.

4. To add dimensions to the display folder, click the Dimensions tab and click Add.
In the Browse dialog, select the dimensions that you want to add to the folder and
click Select.

Alternatively, you can drag one or more dimensions to the display folder after you
close the dialog.

5. Click OK.
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Modeling Bridge Tables

A bridge table enables you to resolve many-to-many relationships between tables. For
example, you might hold information about employees in an Employees table, and
information about the jobs they do in a Jobs table. However, an organization's
employees can have multiple jobs, and the same job can be performed by multiple
employees. This situation would result in a many-to-many relationship between the
Employees table and the Jobs table.

To resolve the many-to-many relationship, you can create a bridge table (or
intermediate table) called Assignments. Each row in the Assignments table is unique,
representing one employee doing one job. If an employee has several jobs, there are
several rows in the Assignments table for that employee. If a job is done by several
employees, there are several rows in the Assignments table for that job. The primary
key of the Assignments table is a composite key, made up of a column containing the
employee ID and a column containing the job ID.

By acting as a bridge table between the Job and Employee tables, the Assignments
table enables you to resolve the many-to-many relationship between Employees and
Jobs into:

= A one-to-many relationship between Employees and Assignments
= A one-to-many relationship between Assignments and Jobs

Figure 8-4 shows a Physical layer view of the example bridge and associated
dimension tables described in the preceding paragraphs.

Figure 8—4 Example Bridge and Associated Tables in the Physical Layer
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Note that "Weight Factor" should be included as an additional column in the bridge
table and calculated during ETL for efficient query processing.

The following sections explain how to model bridge tables in the Physical and
Business Model and Mapping layers:

»  Creating Joins in the Physical Layer for Bridge and Associated Dimension Tables
= Modeling the Associated Dimension Tables in a Single Dimension

= Modeling the Associated Dimension Tables in Separate Dimensions

Creating Joins in the Physical Layer for Bridge and Associated Dimension Tables

To model bridge tables in the Physical layer, create joins between the bridge table and
the associated dimension tables.

To create physical joins for a bridge table and its associated tables:
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In the Administration Tool, in the Physical layer, select the fact, bridge, and
associated dimension tables. Then, right-click the objects and select Physical
Diagram, and then choose Selected Object(s) Only.

With the Physical Diagram displayed, click New Join on the toolbar. Then, select
one of the dimension tables, and then select the bridge table.

Click OK in the Physical Foreign Key dialog.
Repeat steps 2 and 3 for the other associated dimension table.
Ensure that one of the associated dimension tables is joined to the fact table.

Figure 8-5 shows joins between the example Physical tables in the Physical
Diagram.

Figure 8-5 Joins Between the Example Tables in the Physical Diagram
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Modeling the Associated Dimension Tables in a Single Dimension

In the Business Model and Mapping layer, you can choose to model the two
dimension tables associated with a bridge table in a single dimension, or in two
separate dimensions. To model the associated dimension tables in one dimension,
create a second logical table source that maps to the bridge table and the other
dimension table, and then add columns from the other dimension table.

Providing two separate logical table sources makes queries more efficient, because it
ensures that queries against a single dimension table do not involve the bridge table.

To model the dimension tables associated with a bridge table in a single dimension:

1.

Drag objects from the Physical layer to the Business Model and Mapping layer,
except the bridge table and the associated dimension table that is not joined to the
fact table. For the example described in the previous sections, you would drag all
objects except for the Assignment and Employee tables.

In the Business Model and Mapping layer, right-click the dimension table that is
joined to the fact table (Jobs in our example) and select New Object, then select
Logical Table Source.

In the Logical Table Source dialog, provide a name for the new bridge table
source. It is a good practice to use the bridge table name as the name of the source
(for example, Assignment).
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4. Click the Add button in the upper right corner of the Logical Table Source dialog.
Then, select the bridge table from the Name list (Assignment in our example) and
then click Select.

5. Click the Add button again and select the associated dimension table that is not
joined to the fact table (Employee in our example) and then click Select.

6. Click OK in the Logical Table Source diaog.
Figure 8-6 shows the Logical Table Source dialog for the bridge table source.

Figure 8-6 Logical Table Source Dialog for Bridge Table Source
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7. Drag columns from the dimension table that is not joined to the fact table
(Employees in our example) from the Physical layer to the logical table source that
you just created.

You can now create dimensions based on your logical tables, including the logical
table with the bridge table source.

Modeling the Associated Dimension Tables in Separate Dimensions

As an alternative to modeling the two dimension tables associated with a bridge table
in a single dimension, you can choose to model them in separate dimensions. To do
this, create a logical join between the fact table and the dimension table that is not
physically joined to the fact table, and then modify the logical table source for that
same dimension table to add the other table mappings.

To model the dimension tables associated with a bridge table in separate
dimensions:

1. Drag objects from the Physical layer to the Business Model and Mapping layer.
Because you want to model the dimension tables in separate dimensions, drag
both of the dimension tables associated with the bridge table. You do not need to
drag and drop the bridge table object.
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2.

In the Business Model and Mapping layer, select the fact table and the two
dimension tables that are associated with the bridge table (Facts, Employee, and
Jobs in our example). Then, right-click the objects and select Business Model
Diagram, and then choose Selected Tables Only.

With the Business Model Diagram displayed, click New Join on the toolbar. Then,
select the dimension table not currently joined to the fact table, and then select the
fact table.

Click OK in the Logical Join dialog.

Figure 8-7 shows joins between the example logical tables in the Business Model
Diagram.

Figure 8-7 Joins Between the Example Tables in the Business Model Diagram

=

Empluyee

Double-click the logical table source for the logical table for which you created the
logical join (Employee in our example).

Click the Add button in the upper right corner of the Logical Table Source dialog.
Then, select the bridge table from the Name list (Assignment in our example) and
then click Select.

Click the Add button again and select the other associated dimension table (Jobs
in our example) and then click Select.

Click OK in the Logical Table Source diaog.

Figure 8-8 shows the Logical Table Source dialog for the modified dimension table
source.
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Figure 8-8 Logical Table Source Dialog for Dimension Table Source
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You can now create dimensions based on your logical tables, including both logical
tables associated with the bridge table.
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Working with Logical Dimensions

In the Business Model and Mapping layer, a dimension object represents a hierarchical
organization of logical columns (attributes). One or more logical dimension tables can
be associated with at most one dimension object. Common dimensions might be time
periods, products, markets, customers, suppliers, promotion conditions, raw materials,
manufacturing plants, transportation methods, media types, and time of day. Note
that dimensions exist in the Business Model and Mapping (logical) layer and in the
Presentation layer.

In each dimension, you organize logical columns into the structure of the hierarchy.
This structure represents the organization rules and reporting needs required by your
business. It also provide the metadata that the Oracle BI Server uses to drill into and
across dimensions to get more detailed views of the data.

There are two types of logical dimensions: dimensions with level-based hierarchies
(structure hierarchies), and dimensions with parent-child hierarchies (value
hierarchies). Level-based hierarchies are those in which members are of several types,
and members of the same type occur only at a single level. In parent-child hierarchies,
members all have the same type. Oracle Business Intelligence also supports a special
type of level-based dimension, called a time dimension, that provides special
functionality for modeling time series data.

Because dimensions for multidimensional data sources are defined in the source, they
do not require as much work compared with dimensions in other data sources. For
example, you do not create dimension level keys. A dimension is specific to a
particular multidimensional data source (it cannot be used by more than one) and
cannot be created and manipulated individually. Additionally, each cube in the data
source should have at least one dimension and one measure in the Business Model
and Mapping layer.

You can expose logical dimensions to Oracle BI Answers users by creating
presentation hierarchy objects that are based on particular logical dimensions.
Creating hierarchies in the Presentation layer enables users to create hierarchy-based
queries. See "Working with Presentation Hierarchies and Levels" for more information.

Note that you can also expose dimension hierarchies by adding one or more columns
from each hierarchy level to a subject area in the Presentation layer. Oracle BI Answers
supports drill-down on these hierarchical columns.

This chapter contains the following topics:
»  Creating and Managing Dimensions with Level-Based Hierarchies
s Creating and Managing Dimensions with Parent-Child Hierarchies

= Modeling Time Series Data

Working with Logical Dimensions  9-1



Creating and Managing Dimensions with Level-Based Hierarchies

Creating and Managing Dimensions with Level-Based Hierarchies

Each business model can have one or more dimensions, each dimension can have one
or more logical levels, and each logical level has one or more attributes (columns)
associated with it.

The following sections explain how to create dimensions:

About Level-Based Hierarchies
Manually Creating Dimensions, Levels, and Keys with Level-Based Hierarchies
Automatically Creating Dimensions with Level-Based Hierarchies

Populating Logical Level Counts Automatically

About Level-Based Hierarchies

A dimension contains two or more logical levels. The recommended sequence for
creating logical levels is to create a Grand Total level and then create child levels,
working down to the lowest level. The following are the parts of a dimension:

Grand Total level. A special level representing the grand total for a dimension.
Each dimension can have just one Grand Total level. A Grand Total level does not
contain dimensional attributes and does not have a level key. However, you can
associate measures with a Grand Total level. The aggregation level for those
measures will always be the grand total for the dimension.

Level. All levels, except the Grand Total level, need to have at least one column.
However, it is not necessary to explicitly associate all of the columns from a table
with logical levels. Any column that you do not associate with a logical level is
automatically associated with the lowest level in the dimension that corresponds
to that dimension table. All logical columns in the same dimension table have to
be associated with the same dimension.

Hierarchy. Each dimension contains one or more hierarchies. All hierarchies must
have a common leaf level and a common root (all) level.

For example, a time dimension might contain a fiscal hierarchy and a calendar
hierarchy, with a common leaf level of Day. Day has two named parent levels
called Fiscal Year and Calendar Year, which are both children of the All root level.

In the Business Model and Mapping layer, logical hierarchies are not defined as
independent metadata objects, unlike hierarchies in the Presentation layer. Rather,
logical hierarchies exist implicitly through the relationships between levels.

Level keys. Each logical level (except the topmost level defined as a Grand Total
level) must have one or more attributes that compose a level key. The level key
defines the unique elements in each logical level. The dimension table logical key
has to be associated with the lowest level of a dimension and has to be the level
key for that level.

A logical level can have multiple level keys. When that is the case, specify the key
that is the primary key of that level. All dimension sources which have an
aggregate content at a specified level need to contain the column that is the
primary key of that level. Each logical level should have one level key that is
displayed when an Oracle BI Presentation Services user clicks to drill down. This
may or may not be the primary key of the level. To set the level key to display,
select the Use for display option in the Level Key dialog.

Be careful using level keys such as Month whose domain includes the values
January, February, and so on (or in other words, values that are not unique to a
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particular month, repeating every year). To define Month as a level key, you also
need to include an attribute from a higher level (for example, Year). To add Year,
click Add in this dialog and select the logical column from the dialog that is
presented.

Level keys should be meaningful business keys (like Month_name="2010 July")
rather than generated surrogate keys (like time_key='1023793'), because surrogate
keys are physical artifacts that only apply to a single instance of a source table. The
business name, in contrast, can map to any physical instance for that logical
column. For example, month_name might map to a detailed table, an aggregate
table from an aggregate star, and a column in a federated spreadsheet. Note that
the Physical layer still uses the surrogate keys in the joins, so there is no
performance or flexibility penalty for using business keys in the business model.

Time dimensions and chronological keys. You can identify a dimension as a time
dimension. At least one level of a time dimension must have a chronological key.
The following is a list of some guidelines you should use when setting up and
using time dimensions:

— Atleast one level of a time dimension must have a chronological key. See
"Selecting and Sorting Chronological Keys in a Time Dimension" for more
information.

- All time series measures using the AGO, TODATE, and PERIODROLLING
functions must be on time levels. AGO, TODATE, and PERIODROLLING
aggregates are created as derived logical columns. See "About Time Series
Functions" for more information.

- AGO, TODATE, and PERIODROLLING functionality is not supported either on
fragmented dimensional logical table sources, or on fact sources fragmented
on the same time dimension. Fact sources may be fragmented on other
dimensions.See "About Time Series Functions" for more information.

Unbalanced (or ragged) hierarchy. An unbalanced (or ragged) hierarchy is a
hierarchy where the leaves (members with no children) do not necessarily have
the same depth. For example, a site can choose to have data for the current month
at the day level, previous months data at the month level, and the previous 5 years
data at the quarter level.

User applications can use the ISLEAF function to determine whether to allow
drilldown from any particular member. See "ISLEAF" for more information.

A missing member is implemented in the data source with a null value for the
member value. All computations treat the null value as a unique child within its
parent. Level-based measures and aggregate-by calculations group all missing
nodes together.

Note that unbalanced hierarchies are not necessarily the same as parent-child
hierarchies. Parent-child hierarchies are unbalanced by nature, but level-based
hierarchies can be unbalanced also.

Skip-level hierarchy. A skip-level hierarchy is a hierarchy where there are
members that do not have a value for a particular ancestor level. For example, in a
Country-State-City-District hierarchy, the city 'Washington, D.C.' does not belong
to a State. In this case, you can drill down from the Country level (USA) to the City
level (Washington, D.C.) and below.

In a query, skipped levels are not displayed, and do not affect computations.
When sorted hierarchically, members appear under their nearest ancestors.
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A missing member at a particular level is implemented in the data source with a
null value for the member value. All computations treat the null value as a unique
child within its parent. Level-based measures and aggregate-by calculations group
all skip-level nodes together.

Figure 9-1 shows a hierarchy with both unbalanced and skip-level characteristics. For
example, A-Brand 4, B-LOB 3, and Type 5 are unbalanced branches, while skips are
present between A-Brand 2 and Type 3, B-LOB 2 and Product 6, and others.

Figure 9—1 Hierarchy with Unbalanced and Skip-Level Characteristics
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Using Dimension Hierarchy Levels in Level-Based Hierarchies
Dimension hierarchical levels can be used to perform the following actions:

= Setup aggregate navigation
= Configure level-based measure calculations (refer to Example 9-1).

s Determine what attributes appear when Oracle Bl Presentation Services users drill
down in their data requests

Manually Creating Dimensions, Levels, and Keys with Level-Based Hierarchies

To create and manage dimension hierarchy levels in level-based hierarchies, perform
the tasks described in the following sections:

s Creating Dimensions in Level-Based Hierarchies
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s Creating Logical Levels in a Dimension

= Associating a Logical Column and Its Table with a Dimension Level
s Identifying the Primary Key for a Dimension Level

= Selecting and Sorting Chronological Keys in a Time Dimension

= Adding a Dimension Level to the Preferred Drill Path

Creating Dimensions in Level-Based Hierarchies

After creating a dimension, each dimension can be associated with attributes
(columns) from one or more logical dimension tables and level-based measures from
logical fact tables. After you associate logical columns with a dimension level, the
tables in which these columns exist appear in the Tables tab of the Dimension dialog.

To create a dimension with a level-based hierarchy:

1. In the Business Model and Mapping layer of the Administration Tool, right-click a
business model and select New Object > Logical Dimension > Dimension with
Level-Based Hierarchy.

Note that this option is only available when there is at least one dimension table
that has no dimension associated with it.

2. In the Logical Dimension dialog, in the General tab, type a name for the
dimension.

The Default root level field is automatically populated after you associate logical
columns with a dimension level.

If the dimension is a time dimension, select Time.

If the dimension is an unbalanced dimension, select Ragged.

If the dimension is a skip-level dimension, select Skipped Levels.
(Optional) Type a description of the dimension.

Click OK.

N o g k0

Creating Logical Levels in a Dimension

When creating logical levels in a dimension, you also create the hierarchy by
identifying the type of level and defining child levels. See "Automatically Creating
Business Model Objects for Multidimensional Data Sources" for more information
about creating hierarchies for a multidimensional data source.

To define general properties for a logical level in a dimension:

1. In the Business Model and Mapping layer of the Administration Tool, right-click a
dimension and select New Object, then select Logical Level.

2. In the Logical Level dialog, in the General tab, specify a name for the logical level.

3. For Number of elements at this level, specify the number of elements that exist at
this logical level. If this level will be the Grand Total level, leave this field blank.
The system will set to a value of 1 by default.

The number does not have to be exact, but ratios of numbers from one logical level
to another should be accurate. For relational sources, you can retrieve the row
count for the level key and use that number as the number of elements. For
multidimensional sources, you can use the number of members at that level.
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The Oracle BI Server uses this number when selecting which aggregate source to
use. For example, when aggregate navigation is used, multiple fact sources exist at
different grains. The Oracle BI Server multiplies the number of elements at each
level for each qualified source as a way to estimate the total number of rows for
that source. Then, the Oracle BI Server compares the result for each source and
selects the source with the lowest number of total elements to answer the query.
The source with the lowest number of total elements is assumed to be the fastest.

4. Choose one of the following options, if appropriate:

- If the logical level is the Grand Total level, select Grand total level. There
should be only one Grand Total level for a dimension.

- If measure values at a particular level fully constitute aggregated measures at
its parent level, select Supports rollup to higher level of aggregation.

5. To define child logical levels, click Add.
6. Inthe Browse dialog, select the child logical levels and click OK.
The child levels appear in the Child Levels pane.

7. Toremove a previously defined child level, select the level in the Child Levels
pane and click Remove.

The child level and all of its child levels are deleted from the Child Levels pane.
8. (Optional) Type a description of the logical level.
9. Click OK.

Associating a Logical Column and Its Table with a Dimension Level

After you create all logical levels within a dimension, you need to drag and drop one
or more columns from the dimension table to each logical level except the Grand Total
level. The first time you drag a column to a dimension it associates the logical table to
the dimension. It also associates the logical column with that level of the dimension.
To change the logical level to be associated with that logical column, you can drag a
column from one logical level to another.

The logical column or columns that comprise the logical key of a dimension table must
be associated with the lowest level of the dimension.

After you associate a logical column with a dimension level, the tables in which these
columns exist appear in the Tables tab of the Dimensions dialog.

For time dimensions, ensure that all time-related logical columns in the source table
are defined in the time dimension. For example, if a time-related logical table contains
the columns Month Name and Month Code, you must ensure that both columns are
dragged to the appropriate level within the dimension. Figure 9-2 shows how to
associate logical columns with a logical level.
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Figure 9-2 Associating Logical Columns with a Logical Level
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To verify tables that are associated with a dimension:

1. In the Business Model and Mapping layer of the Administration Tool, double-click
a dimension.

2. In the Dimensions dialog, click the Tables tab.

The tables list contains tables that you associated with that dimension. This list of
tables includes only one logical dimension table and one or more logical fact tables
(if you created level-based measures).

3. Click OK or Cancel to close the Dimensions dialog.

Example 9-1 and Example 9-2 show how to associate measures to different levels of
level-based dimension hierarchies.

Example 9—1 Level-Based Measure Calculations

A level-based measure is a column whose values are always calculated to a specific
level of aggregation. For example, a company might want to measure its revenue
based on the country, based on the region, and based on the city. You can set up
columns to measure CountryRevenue, RegionRevenue, and CityRevenue.

When a query includes a level-based measure column, and the query grain is higher
than the level of aggregation specific to the column, the query results return null. Note
that in previous releases, results were returned for this situation, but they were not
deterministic.

The measure AllProductRevenue is an example of a level-based measure at the Grand
Total level. Level-based measures allow a single query to return data at multiple levels
of aggregation. They are also useful in creating share measures, that are calculated by
taking some measure and dividing it by a level-based measure to calculate a
percentage. For example, you can divide salesperson revenue by regional revenue to
calculate the share of the regional revenue each salesperson generates.
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To set up these calculations, you need to build a dimensional hierarchy in your
repository that contains the levels Grandtotal, Country, Region, and City. This
hierarchy contains the metadata that defines a one-to-many relationship between
Country and Region and a one-to-many relationship between Region and City. For
each country, there are many regions, but each region is in only one country. Similarly,
for each region, there are many cities, but each city is in only one region.

Next, you need to create three logical columns (CountryRevenue, RegionRevenue, and
CityRevenue). Each of these columns uses the logical column Revenue as its source.
The Revenue column has a default aggregation rule of SUM and has sources in the
underlying databases.

You then drag the CountryRevenue, RegionRevenue, and CityRevenue columns into
the Country, Region, and City levels, respectively. Each query that requests one of
these columns returns the revenue aggregated to its associated level.

Figure 9-3 shows what the business model in the Business Model and Mapping layer
looks like for this example.

Figure 9-3 Example of Business Model in the Business Model and Mapping Layer
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In the Geography Dimension, the CountryRevenue and RegionRevenue columns are
attributes of the Country and Region levels. In the Sales Facts table, the Revenue
column has a default aggregation rule of SUM and is mapped to physical detail data or
physical aggregate data. CountryRevenue and RegionRevenue columns use the
Revenue column as their source.

Example 9-2 Grand Total Dimension Hierarchy

You might have a product dimensional hierarchy with levels TotalProducts (Grand
Total level), Brands, and Products. Additionally, there might be a column called
Revenue that is defined with a default aggregation rule of Sum. You can then create a
logical column, AllProductRevenue, that uses Revenue as its source (as specified in the
General tab of the Logical Column dialog). Now, drag AllProductRevenue to the
Grand Total level. Each query that includes this column returns the total revenue for
all products. The value is returned regardless of any constraints on Brands or
Products. If you have constraints on columns in other tables, the grand total is limited
to the scope of the query. For example, if the scope of the query asks for data from
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1999 and 2000, the grand total product revenue is for all products sold in 1999 and
2000.

If you have three products, A, B, and C with total revenues of 100, 200, and 300
respectively, then the grand total product revenue is 600 (the sum of each product's
revenue). If you have set up a repository as described in this example, the following
query produces the results listed:

SELECT product, productrevenue, allproductrevenue
FROM sales_subject_area
WHERE product IN 'A' or 'B'

The results are as follows:

PRODUCT PRODUCTREVENUE ALLPRODUCTREVENUE
A 100 600
B 200 600

In this example, the AllProductRevenue column always returns a value of 600,
regardless of the products on which the query constrains.

Identifying the Primary Key for a Dimension Level
Use the Keys tab in the Logical Level dialog to identify the primary key for a level.

To specify a primary key for a dimension level:

1. In the Business Model and Mapping layer of the Administration Tool, expand a
dimension and then expand the highest level (Grand Total level) of the dimension.

2. Double-click a logical level below the Grand Total level.
3. Inthe Logical Level dialog, click the Keys tab.
4. In the Keys tab, from the Primary key list, select a level key.
If only one level key exists, it is the primary key by default.
5. Toadd a column to the list, perform the following steps:
a. In the Logical Level dialog, click New.
b. Inthe Logical Level Key dialog, type a name for the key.
c. Inthe Logical Level Key dialog, select a column or click Add.
d. If you click Add, in the Browse dialog, select the column, and then click OK.

The column you selected appears in the Columns list of the Logical Level Key
dialog and is automatically selected.

Note: You cannot use a derived logical column that is the result of a
LOOKUP function as part of a primary logical level key. This limitation
exists because the LOOKUP operation is applied after aggregates are
computed, but level key columns must be available before the
aggregates are computed because they define the granularity at which
the aggregates are calculated.

You can use a derived logical column that is the result of a LOOKUP
function as a secondary logical level key.

6. If the level is in a time dimension, you can select chronological keys and sort the
keys by name.
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7. (Optional) Type a description for the key and then click OK.
8. Repeat Step 2 through Step 7 to add primary keys to other logical levels.
9. In the Logical Level dialog, click OK.

Selecting and Sorting Chronological Keys in a Time Dimension

At least one level of a time dimension must have a chronological key. Although you
can select one or more chronological keys for any level and then sort keys in the level,
only the first chronological key is used.

To select and sort chronological keys for a time dimension:

1. In the Business Model and Mapping layer of the Administration Tool, expand a
time dimension and then expand the highest level (Grand Total level) of the
dimension.

Note: For a dimension to be recognized as a time dimension, you
must select Time on the General tab of the Dimension dialog.

2. Double-click a logical level below the Grand Total level.
3. Inthe Logical Level dialog, click the Keys tab.

4. To select a chronological key, in the Keys tab, select the Chronological Key option.
You may need to scroll to the right to see this option.

5. To sort chronological keys, in the Keys tab, double-click a chronological key.

6. In the Chronological Key dialog, select a chronological key column, click Up or
Down to reorder the column, and then click OK.

Adding a Dimension Level to the Preferred Drill Path

You can use the Preferred Drill Path tab to identify the drill path to use when Oracle BI
Presentation Services users drill down in their data requests. You should use this only

to specify a drill path that is outside the normal drill path defined by the dimensional

level hierarchy. It is most commonly used to drill from one dimension to another. You

can delete a logical level from a drill path or reorder a logical level in the drill path.

To add a dimension level to the preferred drill path:

1. Click Add to open the Browse dialog, then select the logical levels to include in the
drill path. You can select logical levels from the current dimension, or from other
dimensions.

2. Click OK to return to the Level dialog.

The names of the levels are added to the Names pane.

Automatically Creating Dimensions with Level-Based Hierarchies

You can set up a dimension automatically from a logical dimension table if a
dimension for that table does not exist. To create a dimension automatically, the
Administration Tool examines the logical table sources and the column mappings in
those sources and uses the joins between physical tables in the logical table sources to
determine logical levels and level keys. Therefore, it is best to create a dimension in
this way after all the logical table sources have been defined for a dimension table.

The following rules apply:
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Create Dimensions is only available if the selected logical table is a dimension
table (defined by 1:N logical joins) and no dimension has been associated with this
table.

An automatically created dimension uses the same name as the logical table,
adding Dim as a suffix. For example, if a table is named Periods, the dimension is
named Periods Dim.

A Grand Total level is automatically named logical_table_name Total. For example,
the Grand Total level of the Periods Dim table is Periods Total.

When there are multiple tables in a source, the join relationships between tables in
the source determine the physical table containing the lowest-level attributes. The
lowest level in the hierarchy is named logical_table_name Detail. For example, the
lowest level of the periods table is Periods Detail.

The logical key of the dimension table is mapped to the lowest level of the
hierarchy and specified as the level key. This logical column should map to the
key column of the lowest level table in the dimension source.

—  If there are two or more physical tables in a source, the columns that map to
the keys of those tables become additional logical levels. These additional
level names use the logical column names of these key columns.

— The order of joins determines the hierarchical arrangement of the logical
levels. The level keys of these new logical levels are set to the logical columns
that map to the keys of the tables in the source.

If there are multiple logical table sources, the tool uses attribute mappings and
physical joins to determine the hierarchical order of the tables in the physical
sources. For example, you might have three sources (A, B, C) each containing a
single physical table and attribute mappings for 10, 15, and 3 attributes,
respectively (not counting columns that are constructed from other logical
columns). The following is a list of the results of creating a dimension for this table
automatically:

— The Administration Tool creates a dimension containing four logical levels,
counting the Grand Total and detail levels.

— The key of the table in source B (that has the greatest number of columns
mapped and contains the column mapping for the logical table key) should be
the level key for the detail level.

—  The parent of the detail level should be the logical level named for the logical
column that maps to the key of the physical table in source A.

- Any attributes that are mapped to both A and B should be associated with
level A.

- The parent of level A should be the logical level named for the logical column
that maps to the key of the physical table in source C.

- Any columns that are mapped to both A and C should be associated with level
C.

Table joins in a physical source might represent a pattern that results in a split
hierarchy. For example, the Product table can join to the Flavor table and a
Subtype table. This would result in two parents of the product detail level, one
flavor level and one subtype level.

You cannot create a dimension automatically in the following situations:
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- If a dimension with joins and levels has already been created, Create
Dimension does not appear on the right-click menu.

— If the table is not yet joined to any other table, the option is not available
because it is considered a fact table.

= Inasnowflake schema, if you use a table with only one source and create the
dimension automatically, the child tables are automatically incorporated into a
hierarchy. The child tables form intermediate levels between the Grand Total level
and detail level. If more then one child table exists for a dimension table, the
hierarchy is a split hierarchy.

To create a dimension automatically:
1. In the Administration Tool, open a repository.

2. In the Business Model and Mapping layer, right-click a logical dimension table
that is not associated with any dimension .

3. From the right-click menu, select Create Logical Dimension, then select either
Dimension with Level-Based Hierarchy or Dimension with Parent-Child
Hierarchy.

The new dimension is displayed in the Business Model and Mapping layer.

Populating Logical Level Counts Automatically

Estimate Levels enables administrators to automatically populate level counts for one
or more dimension hierarchies. Level counts are utilized by the query engine to
determine the most optimal query plan and optimizes overall system performance.

The repository must be opened in online mode and the business model must be
available for queries. Then, in the Business Model and Mapping layer, you can select
any of the following logical layer elements, and then execute the Estimate Levels
command:

= Business model. Must be available for queries. If you select this object, the
Administration Tool attempts to check out all objects in the business model.

= Dimension. You should run a consistency check on dimensions to ensure that the
dimension is logically sound.

= A combination of business models and dimensions. You can select multiple
dimensions and multiple business models individually.

When run, the Estimate Levels command also launches a consistency check on the
level counts as described in the following list:

s Checks that a level key is valid. Columns in levels have referential integrity.

»  Checks the parent-child relationship. If the parent level count is greater that the
child level count, an error is returned.

= Generates a run report that lists all the counts that were estimated and any errors
or consistency warnings.

s The queries and errors are logged to nqquery.log on the Oracle BI Server.

Set the log level at 4 or higher to write this information to the log file. For more
information about logging, see "Diagnosing and Resolving Issues in Oracle
Business" in Oracle Fusion Middleware System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition.

To populate logical level counts automatically:
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1. In the Administration Tool, open a repository in online mode.

2. Right-click one or more business models and dimension objects, and select
Estimate Levels.

3. In the Check Out Objects dialog, click Yes to check out the objects that appear in
the list.

If you click No, the action terminates because you must check out items to run
Estimate Levels.

In the Administration Tool dialog, a list of the dimension level counts and any
eITors Or warning messages appear.

When you check in the objects, you can check the global consistency of your
repository.

Creating and Managing Dimensions with Parent-Child Hierarchies

A parent-child hierarchy is a hierarchy of members that all have the same type. This
contrasts with level-based hierarchies, where members of the same type occur only at
a single level of the hierarchy.

This section contains the following topics:
= About Parent-Child Hierarchies
s Creating Dimensions with Parent-Child Hierarchies

s Defining Parent-Child Relationship Tables

About Parent-Child Hierarchies

The most common real-life occurrence of a parent-child hierarchy is an organizational
reporting hierarchy chart, where the following all apply:

s Each individual in the organization is an employee.
= Each employee, apart from the top-level managers, reports to a single manager.
s The reporting hierarchy has many levels.

These conditions illustrate the basic features that define a parent-child hierarchy,
namely:

= A parent-child hierarchy is based on a single logical table (for example, the
"Employees" table)

= Each row in the table contains two identifying keys, one to identify the member
itself, the other to identify the "parent" of the member (for example, Emp_ID and
Mgr_ID)

Figure 9—4 shows an example of a multi-level parent-child hierarchy.
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Figure 9-4 Multi-Level Parent-Child Hierarchy
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The following table shows how this parent-child hierarchy could be represented by the
rows and key values in an Employees table.

Emp_ID Mgr_ID
Andrew null

Barbara Andrew
Carlos Andrew
Dawn Barbara
Emre Barbara

You can expose logical dimensions with parent-child hierarchies to Oracle BI Answers
users by creating presentation hierarchies that are based on particular logical
dimensions. Creating hierarchies in the Presentation layer enables users to create
hierarchy-based queries. See "Working with Presentation Hierarchies and Levels" for
more information.

About Levels and Distances in Parent-Child Hierarchies

Unlike the situation with level-based hierarchies, all the dimension members of a
parent-child hierarchy occur in a single logical column. In a parent-child hierarchy, the
parent of a member is in another row in the same logical column, pointed to by the
parent key. This is unlike a level-based hierarchy, where the parent of a member is in a
different logical column in the same row. In other words, navigation in a parent-child
hierarchy follows data values, while navigation in a level-based hierarchy follows the
metadata structure.

In level-based hierarchies, each level is named, and occupies a position in the
hierarchy that corresponds to a real-word attribute or category that is deemed useful
for analysis. Unlike level-based hierarchies, where the number of levels is fixed at
design time, there is no limit to the depth of a parent-child hierarchy, and the depth
can change at run time due to new data."

Every Oracle Bl Server parent-child hierarchy has two system-generated entities,
"Total" and "Detail," that are automatically defined for each parent-child hierarchy
when the logical dimension is created. The "Detail" entity contains all the hierarchy
members.

These two system-generated entities are different from the implicit, inter-member
levels between ancestors and descendants in a parent-child hierarchy. These implicit
levels are referred to as parent-child hierarchical levels in this section.
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Closely associated with levels is the concept of distance in parent-child hierarchies.
The distance of one member from another is the number of parent-child hierarchical
levels from the member to an ancestor or to a descendant. For example, the distance
from a member to its parent is always 1, and the distance from Andrew to Emre in
Figure 94 is 2.

About Parent-Child Relationship Tables

In relational tables, the relationships between different members in a parent-child
hierarchy are implicitly defined by the identifier key values in the associated base
table.

However, for each Oracle BI Server parent-child hierarchy defined on a relational
table, you must also explicitly define the inter-member relationships in a separate
parent-child relationship table.

The parent-child relationship table must include four columns, as follows:
= A column that identifies the member

s A column that identifies an ancestor of the member

Note: The ancestor may be the parent of the member, or a
higher-level ancestor.

= A'distance" column that specifies the number of parent-child hierarchical levels
from the member to the ancestor

» A 'leaf" column that indicates if the member is a leaf member (1=Yes, 0=No)

The column names can be user defined. The data types of the columns must satisfy the
following conditions:

=  The member and ancestor identifier columns have the same data type as the
associated columns in the logical table that contains the hierarchy members.

Note that the example shown in Table 9-1 uses text strings for readability, but you
normally use integer surrogate keys for member_key and ancestor_key;, if they
exist in the source dimension table.

»  The "distance" and "leaf" columns are INTEGER columns.
Note the following about the rows in a parent-child relationship table:
s Each member must have a row pointing at itself, with distance zero.

= Each member must have a row pointing at each of its ancestors. For a root
member, this is a termination row with null for the parent and distance values.

Table 9-1 shows an example of a parent-child relationship table with rows that
represent the inter-member relationships for the employees shown in Figure 9-4.

Table 9-1 Example Parent-Child Relationship Table

Member_Key Ancestor_Key Distance Isleaf
Andrew Andrew 0 0
Barbara Barbara 0 0
Carlos Carlos 0 0
Dawn Dawn 0 0
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Table 9-1 (Cont.) Example Parent-Child Relationship Table

Member_Key Ancestor_Key Distance Isleaf
Emre Emre 0 0
Andrew null null 0
Barbara Andrew 1 0
Carlos Andrew 1 1
Dawn Barbara 1 1
Dawn Andrew 2 1
Emre Barbara 1 1
Emre Andrew 2 1

Typically, you generate scripts to create and populate the parent-child relationship
table through a wizard that you can invoke when you define the parent-child
hierarchy. Note the following about the create and load scripts:

= You run the create script only once, to create the parent-child relationship table in
the data source.

= You must run the load script after each time the data changes in the dimension
table. Because of this, you typically call the load script in your ETL processing. The
load script reloads the entire parent-child relationship table; it is not incremental.

If you do not choose to use the wizard, then you must create the parent-child
relationship table manually and then import it into the Physical layer before
associating it with the parent-child hierarchy. In this latter case, it is also your
responsibility to populate the table with the data required to describe the
inter-member relationships in the parent-child hierarchy.

Creating Dimensions with Parent-Child Hierarchies

The key elements that you must define for a parent-child hierarchy are the identifier
columns for the member and the parent of the member. This basic principle applies to
all parent-child hierarchies, regardless of the data source from which the hierarchy is
derived.

Parent-child hierarchies that are based on relational tables must have an
accompanying parent-child relationship table. See "About Parent-Child Relationship
Tables" for more information.

To create dimensions with a parent-child hierarchy:

1. In the Business Model and Mapping layer of the Administration Tool, perform one
of the following steps:

= Right-click a business model and select New Object > Logical Dimension >
Dimension with Parent-Child Hierarchy. Note that this option is only
available if there is at least one logical dimension table in the business model
that has no dimension associated with it.

= Right-click a dimension table that is not associated with any dimension and
select Create Logical Dimension, then select Dimension with Parent-Child
Hierarchy.

2. In the Logical Dimension dialog, in the General tab, type a name for the
dimension.
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Click Browse beside the Member Key field.

The Browse window shows the logical dimension tables in the business model,
each with their primary keys.

Select a Member Key for the parent-child hierarchy and click OK.
Click Browse beside the Parent Key field.

The Browse window shows the columns, other than the primary key, in the logical
table that you selected in step 4.

Select a column that will be the Parent Key for the parent-child hierarchy and click
OK.

If the logical table that you selected in step 4 is not from a relational table source,
click OK to finish the process of creating the dimension.

If the logical table you selected in step 4 is from a relational table source, you must
continue the dimension definition process by setting up the parent-child
relationship table for the hierarchy. See "Defining Parent-Child Relationship
Tables" for details.

Defining Parent-Child Relationship Tables

For parent-child hierarchies based on relational tables, you must define a parent-child
relationship table. See "About Parent-Child Relationship Tables" for more information.

When you create the parent-child relationship table, you must choose one of the
following options:

Select a previously-created parent-child relationship table

Use a wizard that will generate scripts to create and populate the parent-child
relationship table

To define parent-child relationship tables:

1.

In the Logical Dimension dialog, click Parent-Child Settings.

The Parent-Child Relationship Table Settings windows appears, with the Logical
Table and Logical Table Source values filled in.

Figure 9-5 shows the Parent-Child Relationship Table Settings dialog.
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Figure 9-5 Parent-Child Relationship Table Settings Dialog
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2. You can either manually define the parent-child relationship table for the
hierarchy, or you can start a wizard that will perform the definition for you
(recommended).

= To start the manual process, continue at step 3.
s To start the wizard, continue at step 7.

3. Click the Select Parent-Child Relationship Table button to start the manual
process of defining the parent-child relationship table for the parent-child
hierarchy.

4. Select the physical table that acts as the parent-child relationship table for your
parent-child hierarchy. The table must already exist in the Physical layer.

The parent-child relationship table must have at least four columns that describe
how the inter-member relationships are derived in the logical table selected for the
hierarchy. See "About Parent-Child Relationship Tables" for more information.

5. Map the four columns from the physical parent-child relationship table to the
fields in the Parent-Child Table Column Details area, as follows:

= Select the Member Key column

= Select the Parent Key column

= Select the Relationship Distance column
= Select the Leaf Node Identifier column

6. Click OK, then click OK again to finish the manual process of defining the
parent-child relationship table.

7. Click the Create Parent-Child Relationship Table button to start the wizard.

The Generate Parent-Child Relationship Table Wizard generates SQL scripts for
creating and populating the parent-child relationship table. At the end of the
wizard, the Oracle BI Server stores the scripts into directories chosen during the
wizard session. The scripts, when executed, will make the parent-child
relationship table available to the metadata repository.

The wizard contains the following three main windows:
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10.
11.

12.

13.
14.
15.
16.
17.
18.

»  Script Location
s Parent-Child Relationship Table Details
s Preview Script

In the Generate Parent-Child Relationship Table - Script Location screen, enter the
Name for the DDL Script to Generate the Parent-Child Table, and select the
Location where the Generate script will be placed.

Enter the Name for the DDL Script to Populate the Parent-Child Table, and
select the Location where the Populate script will be placed.

Click Next.

In the Parent-Child Relationship Table Details screen, enter the Name for the
parent-child relationship table.

Click Browse beside the Catalog/Schema field to select the catalog or schema for
the parent-child relationship table.

Click Next.

In the Preview Script window, you can view either or both of the scripts.
Click Finish.

In the Parent-Child Relationship Table Settings window, click OK.

In the Logical Dimension window, click OK.

If you used the Generate Parent-Child Relationship Table Wizard to generate
create and load scripts, run the scripts to create and load the parent-child
relationship table in your data source.

Adding the Parent-Child Relationship Table to the Model

After you have created a parent-child relationship table and imported it into the
Physical layer (either manually or using the Generate Parent-Child Relationship Table
Wizard), you must edit Physical layer joins to include the parent-child relationship
table. You also need to add the parent-child relationship table to the appropriate
logical table source.

To add the parent-child relationship table to the model:

1.

In the Administration Tool, in the Physical layer of the repository, open the
Physical Diagram so that it shows the parent-child relationship table and
associated dimension table and fact tables. To do this, right-click the appropriate
physical tables and select Physical Diagram > Selected Object(s) Only.

Delete the direct joins from the dimension table to each of the fact tables.

Create joins from the dimension table to each of the fact tables through the
parent-child closure table, as follows:

a. Create a join from the dimension table to the parent-child relationship table
using the ancestor key.

b. Create joins from the parent-child relationship table to the fact tables using the
member key.

Figure 9-6 shows joins from a dimension table to fact tables that go through a
parent-child relationship table.
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Figure 9-6 Physical Layer Joins Through a Parent-Child Relationship Table
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4. In the Business Model and Mapping layer, double-click the logical table source for
the logical dimension table that is used in your parent-child hierarchy.

[

5. In the General tab of the Logical Table Source dialog, click the Add button.

6. Browse to locate the parent-child relationship table in the Physical layer and click
Select.

7. Click OK in the Logical Table Source dialog.

Maintaining Parent-Child Hierarchies Based on Relational Tables

For parent-child hierarchies based on relational tables, you must ensure that the data
in the parent-child relationship table accurately reflects the inter-member relationships
in the dimension.

You may have created scripts manually to create and populate the parent-child
relationship table, or you may have used the Generate Parent-Child Relationship Table
Wizard to create the scripts. You must run these scripts, adapting them if necessary, as
often as required to guarantee the integrity of the parent-child relationships in the
hierarchy. You typically want to add the Populate script to your ETL process so that it
runs after the dimension table is updated.

Modeling Time Series Data

Time series functions provide the ability to compare business performance with
previous time periods, allowing you to analyze data that spans multiple time periods.
For example, time series functions enable comparisons between current sales and sales
a year ago, a month ago, and so on.

Because SQL does not provide a direct way to make time comparisons, you must
model time series data in the Oracle BI repository. First, set up time dimensions based
on the period table in your data warehouse. Then, you can define measures that take
advantage of this time dimension to use the AGO, TODATE, and PERIODROLLING
functions. At query time, the Oracle BI Server then generates highly optimized SQL
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that pushes the time offset processing down to the database whenever possible,
resulting in the best performance and functionality.

This section contains the following topics:
= About Time Series Functions
s Creating Logical Time Dimensions

s Creating AGO, TODATE, and PERIODROLLING Measures

About Time Series Functions

Time series functions operate on time-oriented dimensions. To use these functions on
a particular dimension, you must designate the dimension as a Time dimension and
set one or more keys at one or more levels as chronological keys. These keys identify
the chronological order of the members within a dimension level.

Time series functions include AGO, TODATE, and PERIODROLLING. These functions let
you use Expression Builder to call a logical function to perform time series calculations
instead of aliasing physical tables and modeling logically. The time series functions
calculate AGO, TODATE, and PERIODROLLING functions based on the calendar tables
in your data warehouse, not on standard SQL date manipulation functions.

Figure 9-7 shows a sample report that includes several measures derived using time
series functions.

Figure 9—-7 Example Measures Derived Using Time Series Functions

2008 Q1 2008 Q2 2008 Q3 2008 Q4

2008 /01| 2008 /02 | 2008 /03 | 2008 /04 | 2008 /05 | 2008 / 06 | 2008 /07 | 2008 / 08 | 2008 /09 | 2008 10 | 2008 / 11 | 2008 / 12
Dollars 100 200 300 101 202 203 110 220 330 444 555 666
Dollars Qago 100 200 300 101 202 303 110 220 330
Dollars QTD 100 300 500 101 303 606 110 330 650 444 999 1,665
Dollars 3-Period Roling Sum 100 300 500 601 603 606 615 633 660 994 1,329 1,665
Dollars 3-Period Raling Avg 33.3 100.0 200.0|  200.3 2010 2020 2050 211.0| 2200 331.3| 4430 555.0

Several different grains may be used in the time query, such as:

= Query grain. The lowest time grain of the request. In the report example shown in
Figure 9-7, the query grain is Month.

= Time Series grain. The grain at which the aggregation or offset is requested, for
both AGO and TODATE functions. In the report example shown in Figure 9-7, the
time series grain is Quarter. Time series queries are valid only if the time series
grain is at the query grain or longer. Note that the PERIODROLLING function does
not have a time series grain; instead, you specify a start and end period in the
function.

= Storage grain. The report example shown in Figure 9-7 can be computed from
daily sales or monthly sales. The grain of the source is called the storage grain. A
chronological key must be defined at this level for the query to work, but
performance is generally much better if a chronological key is also defined at the
query grain.

Note that queries against time series data must be an exact match to hit the query
cache. See Oracle Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information about the Oracle BI Server query
cache.

The following sections describe the time series conversion functions:
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s About the AGO Function
s About the TODATE Function
s About the PERIODROLLING Function

About the AGO Function

The AGO function offsets the time dimension to display data from a past period. This
function is useful for comparisons, such as Dollars compared to Dollars a Quarter Ago.
Note that the value of "Dollars Qago" for month 2008/08 equals the value of "Dollars"
for month 2008/05.

Figure 9-8 shows example values for the Dollars and Dollars Qago measures.

Figure 9-8 Example Dollars and Dollars Qago Measures

2008 Q1 2008 Q2 2008 Q3 2008 Q4
2008 /01| 2008 /02 | 2008 /03 | 2008 / 04 | 2008 /05 | 2008 / 06 | 2008 /07 | 2008 / 08 | 2008 / 09 | 2008 / 10 | 2008 / 11 | 2008 / 12

Dollars 100 200 300 101 202 303 110 220 330 444 555 566
Dollars Qago 100 200 300 101 202 303 110 220 330

In the example shown in Figure 9-8, the Dollars Qago measure is derived from the
Dollars measure.

In Expression Builder, the AGO function has the following template:
Ago (<<Measure>>, <<Level>>, <<Number of Periods>>)
<<Measure>> represents the logical measure column from which you want to derive.

In this example, you would select the measure "Dollars" from your existing logical fact
tables.

<<Level>> is the optional time series grain you want to use. In this example, you
would select "Quarter” from your time dimension.

<<Number of Periods>> is the size of the offset, measured in the grain you
provided in the <<Level>> argument. For example, if the <<Level>> is Quarter and
the <<Number of Periods>> is2, the function displays dollars from two quarters
ago.

Using this function template, you can create an expression for a One Quarter Ago
measure, as follows:

Ago("Sales"."Base Measures"."Dollars" , "Sales"."Time MonthDim"."Quarter" , 1)
The <<Level>> parameter is optional. If you do not want to specify a time series
grain in the AGO function, the function uses the query grain as the time series grain.

For example, you could define Dollars_Ago as Ago (Dollars, 1).Then, you could
perform the following logical query:

SELECT Month, Dollars, Dollars_Ago

The result is the same as if you defined Dollars_Ago as Ago (Dollars, Month, 1).
Alternatively, you could perform the following logical query:

SELECT Quarter, Dollars, Dollars_Ago

The result is the same as if you defined Dollars_Ago as Ago (Dollars, Quarter,
1.

See "AGQ" for additional information about the AGO function syntax.
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About the TODATE Function

The TODATE function accumulates the measure from the beginning of the time series
grain period to the current displayed query grain period. For example, Figure 9-9
shows a report with the measure "Dollars QTD," which is the Quarter To Date version
of the "Dollars" measure.

Figure 9-9 Example Dollars and Dollars QTD Measures

2008 Q1 2008 Q2 2008 Q3 2008 Q4
2008 /01 | 2008 /02 | 2008 / 03 | 2008 /04 | 2008 / 05 | 2008 /05 | 2008 /07 | 2008 / 08 | 2008 /03 | 2008 / 10 | 2008 / 11 | 2008 f 12
Dollars 100 200 300 101 202 303 110 220 330 244 555 666
Dollars QTD 100 300 &00 101 303 806 110 330 860 244 298 | 1,685

In the example shown in Figure 9-9, Dollars QTD for Month 2008/05 is the sum of
Dollars for 2008 /04 and 2008/05. In other words, Dollars QTD is the sum of the values
for all the query grain periods (month) for the current time series grain period
(quarter). The accumulation starts over for the next quarter.

In the example shown in Figure 9-9, the Dollars QTD measure is derived from the
Dollars measure.

In Expression Builder, the TODATE function has the following template:
ToDate (<<Measure>>, <<Level>>)
<<Measure>> represents the logical measure column from which you want to derive.

In this example, you would select the measure "Dollars" from your existing logical fact
tables.

<<Level>> is the time series grain you want to use. In this example, you would select
"Quarter” from your time dimension.

Using this function template, you can create the following expression for the measure:

ToDate("Sales"."Base Measures"."Dollars" , "Sales"."Time MonthDim"."Quarter" )

Note that the query grain is specified in the query itself at run time. For example, this
measure can display Quarter To Date at the Day grain, but still accumulates up to the
end of the Quarter.

See "TODATE" for additional information about TODATE function syntax.

About the PERIODROLLING Function

The PERIODROLLING function lets you perform an aggregation across a specified set
of query grain periods, rather than within a fixed time series grain. The most common
use is to create rolling averages, such as "13-week Rolling Average."

Note that because this function has no time series grain, the length of the rolling
sequence is determined by the query grain. For example, "Dollars 3-Period Rolling
Average" averages the last 3 months if the query grain is Month, but averages the last
3 years if the query grain is Year.

This section describes how to build two measures using the PERIODROLLING
function: "Dollars 3-Period Rolling Sum," and "Dollars 3-Period Rolling Average."
Figure 9-10 shows a report with these two measures.
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Figure 9-10 Example Dollars, Dollars 3-Period Rolling Sum, and Dollars 3-Period Rolling
Avg Measures

2008 Q1 2008 Q2 2008 Q3 2008 Q4

2008 /01 | 2008 /02 | 2008 /03 | 2008 /04 | 2008 / 05 | 2008 /05 | 2008 /07 | 2008 / 08 | 2008 j09 | 2008 / 10 | 2008 / 11| 2008 / 12
Dollars 100 200 00 101 202 303 110 220 330 444 555 666
Dollars 3-Period Roling Sum 100 300 00 601 603 606 615 33 660 g94| 1,328 1,665
Dollars 3-Period Roling Avg 33.3| 100.0 2000 200.3| 201.0| 2020| 2050 211.0| 220.0| 330L3| 4430 5550

In the example shown in Figure 9-10, the Dollars 3-Period Rolling Sum and Dollars
3-Period Rolling Avg measures are derived from the Dollars measure.

In Expression Builder, the PERIODROLLING function has the following template:

PeriodRolling (<<Measure>>, <<Starting Period Offset>>, <<Ending Period Offset>>)

<<Measure>> represents the logical measure column from which you want to derive.
To create the measure Dollars 3-Period Rolling Sum, you would select the measure
"Dollars" from your existing logical fact tables.

<<Starting Period Offset>>and <<Ending Period Offset>> identify the
first period and last period used in the rolling aggregation, respectively. The integer is
the relative number of periods from the displayed period. In the example shown in
Figure 9-10, the query grain is month, and the 3-month rolling sum starts 2 periods in
the past and includes the current period. That is, for month 2008/07, the rolling sum
includes 2008/05, 2008 /06 and 2008 /07. Therefore, to create the measure Dollars
3-Period Rolling Sum, the integers to indicate these offsets are -2 and 0.

Using this function template, you can create the following expression for the measure:

PeriodRolling("Sales"."Base Measures"."Dollars" , -2, 0)

The example shown in Figure 9-10 also shows a 3-month rolling average. To compute
this measure, you can divide the rolling sum that you previously created by 3 to get a
3-period rolling average. We know to divide the rolling sum by 3 because the
<<Starting Period Offset>>and <<Ending Period Offset>> fields for the
rolling sum are -2 and 0.

The expression for the 3-month rolling average is:

PeriodRolling ("Sales"."Base Measures"."Dollars" , -2, 0) /3

It is usually a mistake to use the AVG function to create a rolling average. AVG
computes the average of the database rows accessed at the storage grain, but you need
an average where the denominator is the number of rolling periods at the query grain.

Note that the PERIODROLLING function includes a fourth optional hierarchy
argument that lets you specify the name of a hierarchy in a time dimension, such as
yr, mon, day, that you want to use to compute the time window. This option is
useful when there are multiple hierarchies in a time dimension, or when you want to
distinguish between multiple time dimensions. See "PERIODROLLING" for more
information about the hierarchy argument and for details on the function syntax.

Creating Logical Time Dimensions

Compared to modeling an ordinary dimension, the time dimension requires just two
additional steps: selecting the Time option in the Logical Dimension dialog, and
designating a chronological key for every level of every dimension hierarchy.

Follow these additional guidelines when modeling time series data:
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= It only makes sense to use a time series function when the data source contains
history. Usually, a relational database that contains history uses a star or
snowflake schema with an explicit time dimension table. A normalized, historical
database is much rarer, but would still include a time hierarchy with levels in a
schema similar to a snowflake. A simple date field is not adequate.

s Oracle Business Intelligence requires the time dimension physical table (or set of
normalized tables) to be separate from the physical fact table to which it is related.

However, a somewhat common source schema pattern is a fully denormalized
relational table or flat file, where the time dimension columns are in the same table
as the facts and other dimensions. This cannot qualify as a time dimension,
because the time dimension table is combined with the fact table.

In this case, if you cannot change the model in the source, the best practice is to
create an Opaque View of the physical table containing the time columns, which
acts as the distinct physical time dimension table. This Opaque View time
dimension must then be joined to the physical table that contains the facts.

= In the Physical layer, the time dimension table (or lowest-level table in the
normalized /snowflake case) must join directly to the fact table without
intervening tables. This join must be a foreign key join.

s The tables in the physical model containing the time dimension cannot join to
other data sources, except at the most detailed level.

= A member value (for example, a row in relational sources) must be physically
present for every period at every hierarchy level. There cannot be any skips in the
sequence. Note that it does not matter whether there is fact data for every period;
only the dimension data must be complete.

s  Each unit of distance between members, such as "month," "half," or "year," must be
modeled in a separate hierarchy level.

Selecting the Time Option in the Logical Dimension Dialog

Select the Time option in the General tab of the Logical Dimension dialog to enable
time series functions on this dimension. Only logical dimensions with the Time option
selected can be used as the time dimension for the time series functions AGO, TODATE,
and PERTODROLLING.

Figure 9-11 shows the Time option in the Logical Dimension dialog.

Working with Logical Dimensions 9-25



Modeling Time Series Data

Figure 9-11 Time Option in Logical Dimension Dialog

Logical Dimension - HO Time o =]

General | Tables |

Iame: |HD Time
Default root level: ITotaI j
r— Stucturs
v Time
I~ Bagged
[~ | Skipped Lewels
Description:
ak. I Cancel | Help |
For Help, press F1 |

Setting Chronological Keys for Each Level

Designate a chronological key for every level of each dimension hierarchy. This key
must meet the requirements of being sequential (the members have a natural order),
cardinal (all members are spaced the same distance apart at a given level, such as day
or month), and complete (no members missing).

The Oracle BI Server uses the chronological key to create mathematically correct time
series predictions, such as Jan + 2 months = Mar. You should set a chronological key
for every level (except for the Grand Total level) so that you can perform time series
operations on all levels with good performance. This enables you to use an AGO,
TODATE, or PERIODROLLING function for any level of any time dimension hierarchy,
such as fiscal month ago, calendar year ago, and day ago.

Theoretically, time series functions operate correctly if only the bottom level key in the
Logical Dimension is chronological. In practice, however, this causes performance
problems because it forces the physical query to use the lowest grain, causing joins of
orders of magnitude more rows (for example, 365 times more rows for a "year ago"
joining at the "day" grain). It also means higher-level aggregate tables are never
selected by the query planner when using the time series functions, which again
significantly slows the query.

As with any level key, be sure the key is unique at its level. For example, a column
containing simple month names such as "January" is not unique unless it is
concatenated to a column containing year names.

Figure 9-12 shows how to designate a chronological key in the Logical Level dialog.
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Figure 9-12 Designating a Chronological Key in the Logical Level Dialog

Logical Level - Month _ Ol x|

General  Keps |F'refened Drrill Path

Prirnary key:
Y 4
Key Name Columns Description | Use for Display Chronological Key
Per_Mame_Month  TO2 Per Mame Month

Creating AGO, TODATE, and PERIODROLLING Measures

You can build time series measures by creating derived expressions from base
measures. To do this, create a new logical column and select Derived from existing
columns using an expression, then open Expression Builder to build the appropriate
time series function.

Follow these guidelines when modeling time series functions:

= Time series functions cannot be derived from measures that use the fragmentation
form of federation. This rule prevents some complex boundary conditions and
cross-source assumptions in the query generation and result merging, such as the
need to join some time dimension rows from one source to some of the fact rows
in a different source.

= To reduce maintenance and increase accuracy, it is best to create a single base
measure, and then derive a family of time series measures from it. For example,
start with a base measure, then define variations for month-ago, year-ago,
month-to-date, and so on. To do this, select Derived from existing columns using
an expression and refer to the base measure in the expression.

Example 9-3 shows how to build the AGO measure. See Appendix C, "Logical SQL
Reference" for detailed syntax for the other time series functions, TODATE and
PERIODROLLING.

Example 9-3 Creating the AGO Measure

This example explains how to create one of the derived AGO measures in the
Sampleapp demonstration repository.

1. In the Business Model and Mapping layer, create a new logical column. Name the
column 2-04 Billed Qty (Mago).

2. In the Column Source tab, select Derived from existing columns using an
expression and click the Expression Builder button.

3. In Expression Builder, select the Ago function to create a template for the
arguments. To do this, select Functions in the Category pane, Time Series
Functions in the Functions pane, and Ago in the Time Series Functions pane.

Figure 9-13 shows the AGO function in Expression Builder.
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Figure 9-13 AGO Function in Expression Builder
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4. Select the first argument, Measure, then use the selection panes to select the base
measure from which to derive this column. In this example, select "Sample
Sales"."FO Rev Base Measures"."2-01 Billed Qty (Sum All)."

5. Select the second argument, Level, then use the selection panes to select the unit of
the ago offset. It must be defined as a level of the time dimension, so that it can
take advantage of the chronological keys built in the time dimension. In this
example, select Time Dimensions in the Category pane, HO Time in the Time
Dimensions pane, and Month in the HO Time pane.

Figure 9-14 shows the Month level in Expression Builder.

Figure 9—-14 Selecting the Level Argument in Expression Builder
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6. Select the third argument, Number of Periods, and enter the size of the offset you
want to use for this measure. In this example, type 1.
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7. Click OK in the Expression Builder dialog, then click OK in the Logical Column
dialog.
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Managing Logical Table Sources (Mappings)

Logical table sources define the mappings from a single logical table to one or more
physical tables. The physical to logical mapping can also be used to specify
transformations that occur between the Physical layer and the Business Model and
Mapping layer, as well as to enable aggregate navigation and fragmentation.

One logical table source folder exists for each logical table. The folder contains one or
more logical table sources. You can also view logical table sources from the Sources
tab of the Logical Table dialog.

Logical tables can have many physical table sources. A single logical column might
map to many physical columns from multiple physical tables, including aggregate
tables that map to the column if a query asks for the appropriate level of aggregation
on that column.

This chapter contains the following topics:
s Creating Logical Table Sources

s Defining Physical to Logical Table Source Mappings and Creating Calculated
Items

= Defining Content of Logical Table Sources

= Working with Parent-Child Settings in the Logical Table Source

»  Setting Up Aggregate Navigation by Creating Sources for Aggregated Fact Data
s Setting Up Fragmentation Content for Aggregate Navigation

Creating Logical Table Sources

When you create logical tables and columns by dragging and dropping from the
Physical layer, the logical table sources are generated automatically. If you create the
logical tables manually, you need to also create the sources manually.

You also add new logical table sources when multiple physical tables can be the source
of information. For example, many tables could hold information for revenue. You
might have three different business units (each with its own order system) where you
get revenue information. In another example, you might periodically summarize
revenue from an orders system or a financial system and use this table for high-level
reporting.

Use the General tab of the Logical Table Source dialog to define general properties for
the logical table source.

To create a logical table source:
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1. In the Business Model and Mapping layer of the Administration Tool, right-click a
logical table and select New Object, then select Logical Table Source.

2. In the Logical Table Source dialog, in the General tab, type a name for the logical
table source.

3. (Click the Add button. In the Browse dialog, you can view joins and select tables
for the logical table source. When there are two or more tables in a logical table
source, all of the participating tables must have joins defined between them.

4. To view the joins, in the Browse dialog, select a table and click View. After
reviewing the joins in the Physical Table dialog, click Cancel.

5. To add tables to the table source, select the desired tables in the Name list and
click Select.

6. Optionally, in the Priority Group field, enter a priority group number for this
logical table source. See "Setting Priority Group Numbers for Logical Table
Sources" for more information.

7. In the Logical Table Source dialog, click the Column Mapping tab and complete
the fields. See "Defining Physical to Logical Table Source Mappings and Creating
Calculated Items" for instructions.

8. In the Logical Table dialog, click the Content tab and complete the fields. See
"Defining Content of Logical Table Sources" for instructions.

9. Click OK.

Setting Priority Group Numbers for Logical Table Sources

You can set priority group numbers to determine which logical table source should be
used for queries for which there is more than one logical table source that can satisfy
the requested set of columns.

For example, you might have user queries that can be fulfilled by both a data
warehouse and an OLTP source. Often, access to an operational system is "expensive,"
while access to a data warehouse is "cheap." In this situation, you can assign a higher
priority to the data warehouse to ensure that all queries are fulfilled by the data
warehouse if possible.

Note that the priority group of a given logical table source does not always ensure that
a particular query will be fulfilled by that source. Priority group assignments are only
one of many factors used by the Oracle BI Server to determine which logical table
source to select for a given query. However, the logical table source priority is the most
significant metric and is considered before any other cost metric.

To assign priority group numbers, rank your logical table sources in numeric order,
with 0 being the highest-priority source. You can assign the same number to multiple
sources. For example, you can have two logical table sources in priority group 0, two
logical table sources in priority group 1, and so on. Often, only two priority groups are
necessary (0 and 1).

Assigning priority groups is optional. All logical table sources are set to priority 0 by
default.

In some situations, you might want to allow users to reverse the normal logical table
source priority ranking at query time. To accomplish this, you can use a combination
of session variables and request variables with logical table source priority groups.
This feature provides a way to dynamically select a source at run time, depending on
user preference.
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To enable this dynamic selection, you must first create the REVERSIBLE_LTS_
PRIORITY_SA_VEC session variable in the repository. Create this variable as a string
vector session variable that uses a row-wise session initialization block. REVERSIBLE_
LTS_PRIORITY_SA_VEC should list the subject areas for which you want to allow
users to reverse the logical table source priority ranking. You must define this variable
to enable priority ranking reversal.

After you have defined the set of subject areas for which you want to allow priority
ranking reversal, users can include the request variable REVERSE_LTS_PRIORITY
with their queries to reverse the logical table source priority ranking. This request
variable can be set to 1 to reverse the logical table source priority, or 0 to keep the
normal logical table source priority.

As an alternative to using a request variable at query time, you can also define a
predetermined set of subject areas for which the logical table source priority should be
permanently reversed. To do this, create the session variable REVERSED_LTS_
PRIORITY_SA_VEC in the repository. Create this variable as a string vector session
variable that uses a row-wise session initialization block. REVERSED_LTS_
PRIORITY_SA_VEC should list the subject areas for which you want the logical table
source priority to be permanently reversed.

See "Creating Session Variables" for more information about how to define session
variables in the Administration Tool.

Example of REVERSIBLE_LTS_PRIORITY_SA_VEC

You could create a table called SA_TABLE that contains two columns: SUBJECT_
AREA_NAME and REVERSIBLE. This table could contain rows mapping subject area
names to their reversible values (1 or 0), as follows:

SUBJECT_AREA_NAME REVERSIBLE

my_sa_l 1

my_sa_2 0

Then, you would create a string vector session variable called REVERSIBLE_LTS_
PRIORITY_SA_VEC with a row-wise session initialization block. The initialization
string for this initialization block could be similar to the following:

SELECT 'REVERSIBLE_LTS_PRIORITY_SA VEC', SUBJECT_AREA_NAME FROM SA_TABLE
WHERE REVERSIBLE=1

Figure 10-1 shows the Session Variable Initialization Block dialog for this example.
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Figure 10-1 Session Variable Initialization Block Dialog for REVERSIBLE_LTS _
PRIORITY_SA_VEC Example
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Defining Physical to Logical Table Source Mappings and Creating
Calculated ltems

Use the Column Mapping tab of the Logical Table Source dialog to map logical
columns to physical columns. The physical to logical mapping can also be used to
specify transformations that occur between the Physical layer and the Business Model
and Mapping layer. The transformations can be simple, such as changing an integer
data type to a character, or more complex, such as applying a formula to find a
percentage of sales per unit of population. Applying these transformations is typically
referred to as creating calculated items.

The data type of a logical column is determined by its logical table source mappings.
For example, if a logical column has one physical source with a data type of
VARCHAR(50) not-nullable, and another physical source with a data type of
VARCHAR(20), nullable, then the data type of the logical column is VARCHAR(50)
nullable. This final type is called a promoted type. Because of the rules governing
logical table source mappings, you cannot map physical sources with data types that
cannot be promoted (such as an INT with a VARCHAR).

To map logical columns to physical columns:
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In the Business Model and Mapping layer of the Administration Tool, double-click
a logical table source.

In the Logical Table Source dialog, click the Column Mapping tab.

In the Column Mapping tab, maximize or enlarge the dialog to show all the
contents, as shown in Figure 10-2.

In the Column Mapping tab, in the Logical column to physical column mapping
area, you can sort the rows (toggle among ascending order, descending order, and
then restore original order) by clicking a column heading.

Figure 10-2 Column Mapping Tab of Logical Table Source Dialog
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In the Physical Table column, select the table that contains the column you want
to map.

When you select a cell in the Physical Table column, a list appears. It contains a list
of tables currently included in this logical table source.

In the Expression column, select the physical column corresponding to each
logical column.

When you select a cell in the Expression column, a list appears. It contains a list of
physical columns currently included in this logical table source.

To open Expression Builder, click the Expression Builder button.

All columns used in creating physical expressions must be in tables included in
the logical table source. You cannot create expressions involving columns in tables
outside the source.

You can use Expression Builder to create calculated items, in which formulas are
applied pre-aggregation. For example, to create the measure "tons sold" using the
columns units_sold and unit_weight, you apply a pre-aggregation formula
(fact.units_sold*product.unit_weight), and then apply the aggregation rule SUM in
the measure object. Another example is using CAST to transform a column of type
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TIMESTAMP to type DATE for faster display in Answers and other clients (for
example, CAST ("DB"."."TABLE"."COL" AS DATE)).

You can also conform sources by creating expressions that perform
transformations on physical data. For example, you can use the CAST function to
transform a column with a character data type to an integer data type, to match
data coming from a second logical table source. Other examples include using
CONCATENATE or math functions to make similar transformations on physical
data.

See "Creating Derived Columns" for calculations that need to occur
post-aggregation.

7. Toremove a column mapping, click the Delete button. You might need to scroll to
the right to locate the Delete button.

8. After you map the appropriate columns, click OK.

Unmapping a Logical Column from Its Source

In the Logical Column dialog, the Column Source tab contains information about the
logical column. You can edit the logical table sources from which the column derives
its data, or unmap it from its sources.

To unmap a logical column from its source:

1. In the Business Model and Mapping layer of the Administration Tool, double-click
a logical column.

2. In the Logical Column dialog, click the Column Source tab.
3. In the Logical Table Source list, select a source and click Unmap.

4. Click OK.

Defining Content of Logical Table Sources

To use a source correctly, the Oracle BI Server has to know what each source contains
in terms of the business model. Therefore, you need to define aggregation content for
each logical table source of a fact table. The aggregation content rule defines at what
level of granularity the data is stored in this fact table. For each dimension that relates
to this fact logical table, define the level of granularity, making sure that every related
dimension is defined. See "Setting Up Aggregate Navigation by Creating Sources for
Aggregated Fact Data" for more information.

If a logical table is sourced from a set of fragments, it is not required that every
individual fragment maps the same set of columns. However, the server returns
different answers depending on how columns are mapped.

» If all the fragments of a logical table map the same set of columns, than the set of
fragmented sources is considered to be the whole universe of logical table sources
for the logical table. This means that measure aggregations can be calculated based
on the set of fragments.

»  If the set of mapped columns differ across the fragments, than the Oracle BI Server
assumes that it does not have the whole universe of fragments, and therefore it
would be incorrect to calculate aggregate rollups (since some fragments are
missing). In this case, the server returns NULL as measure aggregates.
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Note: Itis recommended that all the fragments map the same set of
columns.

Use the Content tab of the Logical Table Source dialog to define any aggregate table
content definitions, fragmented table definitions for the source, and WHERE clauses (if
you want to limit the number of rows returned). See "Setting Up Fragmentation
Content for Aggregate Navigation" for additional information.

Verifying that Joins Exist from Dimension Tables to Fact Table

This source content information tells the Oracle BI Server what it needs to know to
send queries to the appropriate physical aggregate fact tables, joined to and
constrained by values in the appropriate physical aggregate dimension tables. Be sure
that joins exist between the aggregate fact tables and the aggregate dimension tables in
the Physical layer.

One recommended way to verify joins is to select a fact logical table and open a
Business Model Diagram (Selected Tables and Direct Joins). Only the dimension
logical tables that are directly joined to this fact logical table appear in the diagram. It
does not show dimension tables if the same physical table is used in logical fact and
dimension sources.

Figure 10-3 shows an example of how the Fact - Assess fact logical table appears in a
Business Model Diagram (Selected Tables and Direct Joins) view.

Figure 10-3 Diagram of Direct Joins for a Fact Table
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Table 10-1 contains a list of the logical level for each dimension table that is directly
joined the Fact - Assess fact table shown in Figure 10-3.

Table 10-1 Dimension and Logical Level as Shown in Content Tab

Dimension Logical Level
Account Geography Postal Code Detail
Person Geography Postal Code Detail
Time Day Detail
Account Organization Account Detail
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Table 10-1 (Cont.) Dimension and Logical Level as Shown in Content Tab

Dimension Logical Level
Opportunity Opty Detail
Primary Visibility Detail
Organization

Employee Detail
Assessment Detail
Contact (W_PERSON_D) Detail

FINS Time Day

Positions Details

To create logical table source content definitions:

1.

In the Business Model and Mapping layer of the Administration Tool, double-click
a logical table source.

In the Logical Table Source dialog, click the Content tab and perform the following
steps using Table 10-2 as a guide.

If a logical source is an aggregate table and you have defined logical dimensions,
select Logical Level from the Aggregation content, group-by list. Then, in the
Logical Level list, select the appropriate level for each logical dimension table to
which the logical fact table is joined.

You should specify a logical level for each dimension, unless you are specifying
the Grand Total level. Dimensions with no level specified are interpreted as being
at the most detailed level.

Caution: Although you have the option to specify aggregate content
by logical level or column, it is recommended that you use logical
levels exclusively. If you must define content by columns, do the
following:

1. Select Column from the Aggregation content, group-by list.

2. Inthe Table pane, select each logical dimension table that defines the
aggregation level of the source.

3. In the Column pane, select the logical column for each dimension that
defines how the aggregations were grouped.
When there are multiple logical columns that could be used, select
the one that maps to the key of the source physical table. For
example, if data has been aggregated to the Region logical level,
pick the logical column that maps to the key of the Region table.

Do not mix aggregation by logical level and column in the same
business model.

To specify fragmented table definitions for the source, use the Fragmentation
content box to describe the range of values included in the source when a source
represents a portion of the data at a given level of aggregation.

You can type the formula directly into the box, or click the Expression Builder
button to the right of the box. In the Expression Builder for Fragmentation
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7.

Content, you can specify content in terms of existing logical columns. See "Setting
Up Fragmentation Content for Aggregate Navigation" for additional information.

Select This source should be combined with other sources at this level.

This option is only for multiple sources that are at the same level of aggregation.
For example, one logical table source might point to records for people with last
names A-M, while a second logical table source might point to records for people
with last names N-Z.

(Optional) To limit the number of rows the source uses in the resultant table,
specify WHERE clause filters in the box labeled Use this "WHERE clause" filter to
limit rows returned (exclude the "WHERE"). You can enter the WHERE clause
directly, or you can click the Expression Builder button to open the Expression
Builder, create the WHERE clause, and click OK.

See "About WHERE Clause Filters" for more information.

If the values for the source are unique, select the option Select distinct values.

Table 10-2 Content Tab Options for Logical Table Source

Options Description

Aggregation content, group | How the content is aggregated.

More button When you click More, the following options appear:

= Copy. (Available only for fact tables) Copies aggregation
content to the Windows clipboard. You can paste the
Dimension.Level info into a text editor and use it for
searching or for adding to documentation.

Note that Copy is not available if the expression is empty.

= Copy from. (Available for fact tables and dimension tables)
Copies aggregation content from another logical table
source in the same business model. You need to specify the
source from which to copy the aggregation content.
(Multiple business models appear but only the logical table
sources from the current business model are selectable.)

= Get Levels. (Available only for fact tables) Changes
aggregation content. If joins do not exist between fact table
sources and dimension table sources (for example, if the
same physical table is in both sources), the aggregation
content determined by the Administration Tool does not
include the aggregation content of this dimension.

s Check Levels. (Available only for fact tables) Checks the
aggregation content of logical fact table sources (not
dimension table sources). The information returned
depends on the existence of dimensions and hierarchies
with logical levels and level keys, and physical joins
between tables in dimension table sources and the tables in
the fact table source. (If the same tables exist in the fact and
dimension sources and there are no physical joins between
tables in the sources, Check Levels does not include the
aggregation content of this dimension.)

Fragmentation content A description of the contents of a data source in business model

terms. Data is fragmented when information at the same level of
aggregation is split into multiple tables depending on the values
of the data. A common situation would be to have data
fragmented by time period. See "Setting Up Fragmentation
Content for Aggregate Navigation" for additional information.
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Table 10-2 (Cont) Content Tab Options for Logical Table Source

Options Description

This source should be Select this option when data sources at the same level of
combined with other aggregation do not contain overlapping information. In this
sources at this level situation, all sources must be combined to get a complete

picture of information at this level of aggregation.

Select distinct values Used if the values for the source are unique.

About WHERE Clause Filters

The WHERE clause filter is used to constrain the physical tables referenced in the logical
table source. If there are no constraints on the aggregate source, leave the WHERE
clause filter blank.

Each logical table source should contain data at a single intersection of aggregation
levels. You would not want to create a source, for example, that had sales data at both
the Brand and Manufacturer levels. If the physical tables include data at multiple
levels, add an appropriate WHERE clause constraint to filter values to a single level.

Any constraints in the WHERE clause filter are made on the physical tables in the
source.

Working with Parent-Child Settings in the Logical Table Source

Sometimes, a logical table is part of a dimension with a parent-child hierarchy that is
based on relational tables. When this is the case, the logical table includes both a
physical source and a source for the parent-child relationship table required for the
parent-child hierarchy. Parent-child relationship tables explicitly define the
inter-member relationships for parent-child hierarchies.

Typically, logical table sources for parent-child relationship tables are created
automatically when you run the scripts created by the Generate Parent-Child Table
Wizard. You access this wizard from the Parent-Child Table Settings dialog, available
in the dimension object.

Note: The Generate Parent-Child Table Wizard feature is not
available from the Logical Table Source dialog. You must go to the
dimension object to create scripts to generate the parent-child
relationship table.

You can view details for the parent-child relationship table source in the Parent-Child
Settings tab of the Logical Table Source dialog. The following information appears in
the tab:

»  Parent-Child Table: Shows the name of the parent-child relationship table on
which this source is based.

= Member Key: The name of the column in the parent-child relationship table that
identifies the member.

»  Parent Key: The name of the column in the parent-child relationship table that
identifies an ancestor of the member.

= Relationship Distance: The name of the column in the parent-child relationship
table that specifies the number of parent-child hierarchical levels from the member
to the ancestor.
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s Leaf Node Identifier: The name of the column in the parent-child relationship
table that indicates if the member is a leaf member (1=Yes, 0=No).

See "Creating Dimensions with Parent-Child Hierarchies" for more information about
parent-child relationship tables.

Setting Up Aggregate Navigation by Creating Sources for Aggregated

Fact Data

Aggregate tables store precomputed results from measures that have been aggregated
over a set of dimensional attributes. Each aggregate table column contains data at a
given set of levels. For example, a monthly sales table might contain a precomputed
sum of the revenue for each product in each store during each month. You configure
this metadata in the Content tab of the Logical Table Source dialog.

When you create a logical table source for an aggregate fact table, you should create
corresponding logical dimension table sources at the same levels of aggregation.

You need to have at least one logical dimension table source for each level of
aggregation. If the sources at each level already exist, you do not need to create new
ones.

For example, you might have a monthly sales fact table containing a precomputed
sum of the revenue for each product in each store during each month. You need to
have the following three other dimension sources, one for each of the logical
dimension tables referenced in the example:

= A source for the Product logical table with one of the following content
specifications:

- By logical level: ProductDimension.ProductLevel
- By column: Product.Product_Name

= A source for the Store logical table with one of the following content specifications:
- By logical level: StoreDimension.StoreLevel
- By column: Store.Store_Name

= A source for the Time logical table with one of the following content specifications:
- By logical level: TimeDimension.MonthLevel
- By column: Time.Month

At query time, the Oracle BI Server first determines which sources have enough detail
to answer the query. Out of these sources, the Oracle BI Server chooses the most
aggregated source to answer the query, because it is assumed to be the fastest. The
most aggregated source is the one with the lowest multiplied number of elements. See
"Creating Logical Levels in a Dimension" for more information about specifying the
number of elements at each level.

Setting Up Fragmentation Content for Aggregate Navigation

When a logical table source does not contain the entire set of data at a given level, you
need to specify the portion, or fragment, of the set that it does contain. You describe
the content in terms of logical columns in the Fragmentation content box in the
Content tab of the Logical Table Source dialog.

The examples in this section illustrate techniques and rules for specifying the
fragmentation content of sources.
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This section contains the following topics:
s Specifying Fragmentation Content for Single Column, Value-Based Predicates
= Specifying Fragmentation Content for Single Column, Range-Based Predicates

= Specifying Fragmentation Content for Aggregate Table Fragments

Specifying Fragmentation Content for Single Column, Value-Based Predicates

The IN predicates can be replaced with either an equality predicate or multiple
equality predicates separated by the OR connective.

Fragment 1:

logicalColumn IN <valueList,>

Fragment n:

logicalColumn IN <valueListy>

Specifying Fragmentation Content for Single Column, Range-Based Predicates
Fragment 1:

logicalColumn >= valueof (START VALUE) AND logicalColumn < valueof (MID_VALUE,)

Fragment 2:

logicalColumn >= valueof (MID_VALUE;) AND logicalColumn < valueof (MID_VALUE,)

Fragment n:

logicalColumn >= valueof (MID_VALUE, ;) AND logicalColumn < valueof (END_VALUE)

Pick your start point, midpoints, and endpoint carefully.

Note: Use >= and < predicates to make sure the fragment content
descriptions do not overlap. For each fragment, the upper value must
be expressed as <. You will get an error if you use <=. Likewise, you
cannot use the BETWEEN predicate to describe fragment range content.

The valueof referenced here is the value of a repository variable. If you use
repository values in your expression, note that the following construct does not work
for Fragment 2:

logicalColumn >= valueof (MID_VALUE,)+1 AND logicalColumn < valueof (MID_VALUE,)

Use another repository variable instead of valueof (MID_VALUEL) +1.

The same variables, for example, valueof (MID_VALUEL), do not have to appear in
the content of both fragments. You could set another variable, and create statements of
the following form:

Fragment 1:

logicalColumn >= valueof (START VALUE) AND logicalColumn < valueof (MID_VALUE,)

Fragment 2:

logicalColumn >= valueof (MID_VALUE,) AND logicalColumn < valueof (MID_VALUE;)
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For more information about variables, see Chapter 18.

Specifying Multicolumn Content Descriptions

An arbitrary number of predicates on different columns can be included in each
content filter. Each column predicate can be value-based or range-based.

Fragment 1:

<logicalColumnl predicate> AND <logicalColumn2 predicate > ... AND <logicalColumnM
predicate>

Fragment n:

<logicalColumnl predicate> AND <logicalColumn2 predicate > ... AND <logicalColumnM
predicate>

Ideally, all fragments will have predicates on the same M columns. If there is no
predicate constraint on a logical column, the Oracle BI Server assumes that the
fragment contains data for all values in that logical column. See "Specifying Parallel
Content Descriptions" for exceptions using the OR predicate.

Specifying Parallel Content Descriptions

Unfortunately, the preceding techniques are still not sufficient to handle dates because
of the multiple hierarchical relationships across logical columns, such as year > year
month > date; month > year month > date. For example, consider fragments
delineated by different points in time, such as year and month. Constraining
sufficiently far back on year should be enough to drive the selection of just the
historical fragment. The parallel OR technique supports this, as shown in the next
example. This example assumes that the snapshot month was April 1, 12:00 a.m. in the
year 1999.

Fragment 1 (Historical):

EnterpriseModel.Period. "Day" < VALUEOF ("Snapshot Date") OR
EnterpriseModel.Period.MonthCode < VALUEOF ("Snapshot Year Month") OR
EnterpriseModel.Period. "Year" < VALUEOF ("Snapshot Year") OR
EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Month in Year" < VALUEOF ("Snapshot Month") OR
EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Monthname" IN ('Mar', 'Feb', 'Jan')

Fragment 2 (Current):

EnterpriseModel.Period."Day" >= VALUEOF ("Snapshot Date") OR

EnterpriseModel.Period.MonthCode >= VALUEOF ("Snapshot Year Month") OR

EnterpriseModel.Period. "Year" > VALUEOF ("Snapshot Year") OR

EnterpriseModel.Period."Year" = VALUEOCF ("Snapshot Year") AND
EnterpriseModel.Period. "Month in Year" >= VALUEOF ("Snapshot Month") OR

EnterpriseModel.Period. "Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Monthname" IN ('Dec', 'Nov', 'Oct', 'Sep', 'Aug', 'Jul',
‘Jun', '', 'Apr')

If the logical model does not go down to the date level of detail, then omit the
predicate on EnterpriseModel.Period. "Day" in the preceding example.
Notice the use of the OR connective to support parallel content description tracks.
Examples of Parallel Content Descriptions In this section, the Track # labels in the

examples are shown to help relate the examples to the discussion that follows. You
would not include these labels in the actual fragmentation content statement.
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Example 10-1 Fragment 1 (Historical)

Track 1 EnterpriseModel.Period."Day" < VALUEOF ("Snapshot Date") OR

Track 2 EnterpriseModel.Period.MonthCode < VALUEOF ("Snapshot Year Month") OR

Track 3 EnterpriseModel.Period."Year" < VALUEOF ("Snapshot Year") OR

Track 4 EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel .Period. "Month in Year" < VALUEOF ("Snapshot Month") OR

Track 5 EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Monthname" IN ('Mar', 'Feb', 'Jan')

For example, consider the first track on EnterpriseModel . Period. "Day." In the
historical fragment, the < predicate tells the Oracle BI Server that any queries that
constrain on Day before the Snapshot Date fall within the historical fragment.
Conversely, the >= predicate in the current fragment on Day indicates that the current
fragment does not contain data before the Snapshot Date.

The second track on MonthCode (for example, 199912) is similar to Day. It uses the <
and >= predicates, as there is a nonoverlapping delineation on month (because the
snapshot date is April 1). The key rule to remember is that each additional parallel
track must reference a different column set. Common columns can be used, but the
overall column set must be unique. The Oracle BI Server uses the column set to select
the most appropriate track.

The third track on Year (< in the historical fragment and > in the current fragment)
tells the Oracle BI Server that optimal (single) fragment selections can be made on
queries that just constrain on year. For example, a logical query on Year IN (1997, 1998)
should only hit the historical fragment. Likewise, a query on Year = 2000 should only
hit the current fragment. However, a query that hits the year 1999 cannot be answered
by the content described in this track, and therefore hits both fragments, unless
additional information can be found in subsequent tracks.

The fourth track describes the fragment set for Year and Month in Year (month
integer). Notice the use of the multicolumn content description technique, described
previously. Notice the use of < and >= predicates, as there is no ambiguity or overlap
for these two columns.

The fifth track describes fragment content in terms of Year and Monthname. It uses the
value-based IN predicate technique.

As an embellishment, suppose the snapshot date fell on a specific day within a month:
therefore, multicolumn content descriptions on just year and month would overlap on
the specific snapshot month. To specify this ambiguity, <= and >= predicates are used.

Fragment 1 (Historical):

EnterpriseModel.Period. "Day" < VALUEOF ("Snapshot Date") OR
EnterpriseModel.Period.MonthCode <= VALUEOF ("Snapshot Year Month") OR
EnterpriseModel.Period. "Year" < VALUEOF ("Snapshot Year") OR
EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Month in Year" <= VALUEOF ("Snapshot Month") OR
EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Monthname" IN ('Apr', 'Mar', 'Feb', 'Jan')

Fragment 2 (Current):

EnterpriseModel.Period. "Day" >= VALUEOF ("Snapshot Date") OR
EnterpriseModel.Period.MonthCode >= VALUEOF ("Snapshot Year Month") OR
EnterpriseModel.Period. "Year" > VALUEOF ("Snapshot Year") OR
EnterpriseModel.Period."Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Month in Year" >= VALUEOF ("Snapshot Month") OR
EnterpriseModel.Period. "Year" = VALUEOF ("Snapshot Year") AND
EnterpriseModel.Period. "Monthname" IN ('Dec', 'Nov', 'Oct', 'Sep', 'Aug', 'Jul',
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"Jun', '', ‘Apr‘)

Specifying Unbalanced Parallel Content Descriptions

In an order entry application, time-based fragmentation between historical and current
fragments is typically insufficient. For example, records might still be volatile, even
though they are historical records entered into the database before the snapshot date.

Assume, in the following example, that open orders can be directly updated by the
application until the order is shipped or canceled. After the order has shipped,
however, the only change that can be made to the order is to type a separate
compensating return order transaction.

There are two parallel tracks in the following content descriptions. The first track uses
the multicolumn, parallel track techniques described in the preceding section. Notice
the parentheses nesting the parallel calendar descriptions within the
Shipped-or-Canceled order status multicolumn content description.

The second parallel track is present only in the Current fragment and specifies that all
Open records are in the Current fragment only.

Fragment 1 (Historical):

Marketing."Order Status"."Order Status" IN ('Shipped', 'Canceled') AND
Marketing.Calendar. "Calendar Date" <= VALUEOF ("Snapshot Date") OR

Marketing.Calendar."Year" <= VALUEOF ("Snapshot Year") OR

Marketing.Calendar. "Year Month" <= VALUEOF ("Snapshot Year Month")

Fragment 2 (Current):

Marketing."Order Status"."Order Status" IN ('Shipped', 'Canceled') AND

Marketing.Calendar."Calendar Date" > VALUEOF ("Snapshot Date") OR
Marketing.Calendar."Year" >= VALUEOF ("Snapshot Year") OR
Marketing.Calendar."Year Month" >= VALUEOF ("Snapshot Year Month") OR
Marketing."Order Status"."Order Status" = 'Open'

The overlapping Year and Month descriptions in the two fragments do not cause a
problem, as overlap is permissible when there are parallel tracks. The rule is that at
least one of the tracks has to be nonoverlapping. The other tracks can have overlap.

Specifying Fragmentation Content for Aggregate Table Fragments

Information at a given level of aggregation is sometimes stored in multiple physical
tables. When individual sources at a given level contain information for a portion or
fragment of the domain, the Oracle BI Server needs to know the content of the sources
in order to pick the appropriate source for the query.

For example, suppose you have a database that tracks the sales of soft drinks in all
stores. The detail level of data is at the store level. Aggregate information, as described
in Figure 104, is stored at the city level for the sales of Coke and Pepsi, but there is no
aggregate information for the sales of 7-Up or any other of the sodas.
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Figure 10-4 Aggregating Information
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The goal of this type of configuration is to maximize the use of the aggregate table. If a
query asks for sales figures for Coke and Pepsi, the data should be returned from the
aggregate table. If a query asks for sales figures for all soft drinks, the aggregate table
should be used for Coke and Pepsi and the detail data for the other brands.

The Oracle BI Server handles this type of partial aggregate navigation. To configure a
repository to use aggregate fragments for queries whose domain spans multiple
fragments, you need to define the entire domain for each level of aggregate data, even
if you must configure an aggregate fragment as being based on a less summarized
physical source.

This section contains the following topics:

= Specifying the Aggregate Table Content

s Defining a Physical Layer Table with a Select Statement to Complete the Domain
= Specifying the SQL Virtual Table Content

s Creating Physical Joins for the Virtual Table

Specifying the Aggregate Table Content

You configure the aggregate table navigation in the logical table source mappings. In
the soft drink example, the aggregate table contains data for Coke and Pepsi sales at
the city level. Its Aggregate content specification (in the Content tab of the Logical
Table Source window) is similar to the following;:

Group by logical level:

GeographyDim. CityLevel, ProductDim.ProductLevel

Its Fragmentation content specification (also in the Content tab of the Logical Table
Source dialog) is similar to the following:

SoftDrinks.Products.Product IN ('Coke', 'Pepsi')

This content specification tells the Oracle BI Server that the source table has data at the

city and product level for two of the products. Additionally, because this source is a
fragment of the data at this level, you must select This source should be combined
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with other sources at this level, in the Content tab of the Logical Table Source dialog,
to indicate that the source combines with other sources at the same level.

Defining a Physical Layer Table with a Select Statement to Complete the Domain

The data for the rest of the domain (the other types of sodas) is all stored at the store
level. To define the entire domain at the aggregate level (city and product, in this
example), you need to have a source that contains the rest of the domain at this level.
Because the data at the store level is at a lower (that is, more detailed) level than at the
city level, it is possible to calculate the city and product level detail from the store and
product detail by adding up the product sales data of all of the stores in a city. This
can be done in a query involving the store and product level table.

One way to do this is to define a table in the Physical layer with a Select statement that
returns the store level calculations. To define the table, create a table in the Physical
layer by right-clicking the physical schema object that the SELECT statement will be
querying and selecting New Physical Table. Choose Select from the Table Type list,
and type the SQL statement in the Default Initialization String box.

The SQL statement must define a virtual table that completes the domain at the level
of the other aggregate tables. In this case, there is one existing aggregate table, and it
contains data for Coke and Pepsi by city. Therefore, the SQL statement has to return all
of the data at the city level, except for the Coke and Pepsi data.

Specifying the SQL Virtual Table Content

Next, create a new logical table source for the Sales column that covers the remainder
of the domain at the city and product level. This source contains the virtual table
created in the previous section. Map the Dollars logical column to the USDollars
physical column in this virtual table.

The Aggregate content specification (in the Content tab of the Logical Table Source
dialog) for this source is:

Group by logical level:

GeographyDim.CityLevel, ProductDim.ProductLevel

This tells the Oracle Bl Server this source has data at the city and product level.

The Fragmentation content specification might be:

SoftDrinks.Products.Product = '7-Up'

Additionally, because it combines with the aggregate table containing the Coke and
Pepsi data at the city and product level to complete the domain, you need to select the

option in the Content tab of the Logical Table Source dialog indicating that the source
is combined with other sources at the same level.

Creating Physical Joins for the Virtual Table

Construct the correct physical joins for the virtual table. Notice that CityProductSales2
joins to the Cities and Products tables in Figure 10-5.
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Figure 10-5 Example Physical Joins

CityProductSales

4
[owe_

CityProductSales?2

l StoreProductSales

In this example, the two sources comprise the whole domain for soda sales. A domain
can have many sources. The sources have to all follow the rule that each level must
contain sources that, when combined, comprise the whole domain of values at that
level. Setting up the entire domain for each level helps ensure that queries asking for
Coke, Pepsi, and 7-Up do not leave out 7-Up. It also helps ensure that queries
requesting information that has been precomputed and stored in aggregate tables can
retrieve that information from the aggregate tables, even if the query requests other
information that is not stored in the aggregate tables.
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Creating and Maintaining the Presentation
Layer

The Presentation layer provides a way to present customized, secure, role-based views
of a business model to users. Role-based views provide object security and also
provide a way to hide some of the complexity of the business model. The Presentation
layer also provides some of the functionality of the metadata model, such as the ability
to set an implicit fact column.

Presentation layer views are called subject areas (formerly called presentation
catalogs). You can have a subject area that is identical to your business model, or you
can provide smaller, role-based subject areas that show a single subject, or that
support a particular business role. Create subject areas that help you organize your
content in a way that makes sense for your users.

After you have created the Business Model and Mapping layer, you can drag and drop
entire business models to the Presentation layer in the Administration Tool.
Alternatively, you can create subject areas and other Presentation layer objects
manually.

This chapter explains how to use the Administration Tool to create and edit objects in
the Presentation layer of a repository.

This chapter contains the following topics:

s Creating and Customizing the Presentation Layer
= Working with Subject Areas

= Working with Presentation Tables and Columns

= Working with Presentation Hierarchies and Levels
m  Setting Permissions for Presentation Layer Objects

»  Creating Aliases (Synonyms) for Presentation Layer Objects

Creating and Customizing the Presentation Layer

The Presentation layer provides a way to present customized views of a business
model to users. Subject areas in the Presentation layer appear as catalogs to client tools
that use the Oracle BI Server as an ODBC data source. Subject areas contain
presentation tables, columns, hierarchies, and levels.

Even though the Logical SQL requests from Answers and other clients query the
presentation tables and columns, the real logic for entities, relationships, joins, and so
on is in the Business Model and Mapping layer. The primary function of the
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Presentation layer is to provide custom names, dictionary entries, organization, and
security for different groups of users.

This section contains the following topics:

s Creating Subject Areas

= Removing Any Unneeded or Unwanted Columns

= Renaming Presentation Columns to User-Friendly Names
= Exporting Logical Keys in the Subject Area

s Setting an Implicit Fact Column in the Subject Area

= Maintaining the Presentation Layer

Creating Subject Areas

There are several ways to create subject areas in the Presentation layer. The
recommended method is to drag and drop a business model from the Business Model
and Mapping layer to the Presentation layer, and then modify the Presentation layer
based on what you want users to see. You can move columns between presentation
tables, remove columns that do not need to be seen by the users, or even present all of
the data in a single presentation table. You can create presentation tables to organize
and categorize measures in a way that makes sense to your users.

You can also duplicate an existing subject area and its corresponding business model.
See "Duplicating a Business Model and Subject Area" for more information.

Although each subject area must be populated with contents from a single business
model, you can create multiple subject areas for one business model. For very large
business models, you may want to do this to help users work with the content. Users
in Oracle BI Answers can create queries that span multiple subject areas, as long as the
subject areas correspond to the same business model.

There are many ways to create multiple subject areas from a single business model.
One method is to drag a particular business model to the Presentation layer multiple
times, then edit the properties or objects of the resulting subject areas as needed.

For example, if you have a business model called ABC that contains the Geography
and Products dimensions, you can drag it to the Presentation layer twice. Two
subject areas are created, with the default names ABC and ABC#1. You can then edit
the subject areas as follows:

= Rename the ABC subject area to DEF, then delete the Geography presentation
hierarchy

= Rename the ABC#1 subject area to XYZ, then delete the Products presentation
hierarchy

Users in Oracle BI Answers can then run queries that span both the DEF subject area
(containing the Products hierarchy), and the XYZ subject area (containing the
Geography hierarchy).

Automatically Creating Subject Areas Based on Logical Stars and Snowflakes

You can automatically create one subject area for each logical star or logical snowflake
in your business model. Logical stars and logical snowflakes are both composed of a
centralized fact table connected to multiple dimension tables. This feature provides
another way to create multiple subject areas from a single business model.
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To create a subject area for each fact table that is part of a logical star or snowflake,
right-click the business model and select Create Subject Areas for Logical Stars and
Snowflakes. The new subject areas are automatically created, each containing a fact
table and only the dimension tables with which it is associated. This option is available
for any business model that contains logical stars or logical snowflakes.

For example, if you choose this option for the Sample App business model with nine
fact tables, nine corresponding subject areas are created, each with one fact table and
its associated dimension tables. Subject areas are also created for lookup tables.
Figure 11-1 shows exactly how the logical fact tables and dimension tables are
modeled in the Presentation layer.

Figure 11-1 Creating Subject Areas for Logical Stars and Snowflakes in Sample App
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Removing Any Unneeded or Unwanted Columns

One important reason to use a custom Presentation layer is to make the schema as easy
to use and understand as possible. Therefore, users should not be able to view
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columns that have no meaning to them. The following columns are examples of
columns that you might want to remove from the Presentation layer:

s Key columns that have no business meaning

s Columns that users do not need to view (for example, codes, when text
descriptions exist)

s Columns that users are not authorized to see

Renaming Presentation Columns to User-Friendly Names

By default, presentation columns have the same name as the corresponding logical
column in the Business Model and Mapping layer. It is recommended to keep
presentation column names and their source logical column names synchronized to
reduce maintenance. To do this, ensure that Use Logical Column Name is selected in
the Presentation Column dialog.

In some cases, however, you may want a different presentation column name to be
shown to users. To do this, change the name of the presentation column in the
Presentation Column dialog.

When you change the name of a presentation column, an alias is automatically created
for the old name, so compatibility to the old name remains. See "Creating Aliases
(Synonyms) for Presentation Layer Objects" for more information about aliases.

Note that you cannot rename a Presentation layer object to a name that is already in
use as an alias for an object of the same type.

Exporting Logical Keys in the Subject Area

For each subject area in the Presentation layer, you can decide whether to export any
logical keys as key columns to tools that access it. Exporting logical keys is irrelevant
to users of Oracle BI Presentation Services, but it may be advantageous for some query
and reporting tools. If you decide to export logical keys, make sure that the logical key
columns exist in the table folders. In this situation, your business model should use
logical key /foreign key joins.

When you select the option Export logical keys in the Subject Area dialog, any
columns in the Presentation layer that are key columns in the Business Model and
Mapping layer are listed as key columns to any ODBC client. This is the default
selection. In most situations, this option should be selected.

Note: If you are using a tool that issues parameterized SQL queries,
such as Microsoft Access, do not select the option Export logical keys.
This stops the tool from issuing parameterized queries.

Setting an Implicit Fact Column in the Subject Area

For each subject area in the Presentation layer, you can set an implicit fact column. The
implicit fact column is added to a query when it contains columns from two or more
dimension tables and no measures. The column is not visible in the results. It is used
to specify a default join path between dimension tables when there are several possible
alternatives or contexts.
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Maintaining the Presentation Layer

There is no automatic way to synchronize all changes between the Business Model and
Mapping layer and the Presentation layer. For example, if you add logical columns to
an existing logical table, or edit existing columns, you must manually update the
corresponding Presentation layer objects.

However, the Administration Tool can automatically synchronize the name of
presentation columns with their corresponding logical column names. To take
advantage of this feature, ensure that Use Logical Column Name is selected in the
Presentation Column dialog.

In some cases, if there are many changes to a logical table or even to an entire business
model, it is easiest to delete the corresponding presentation table or subject area, and
then and drag and drop the updated logical objects to the Presentation layer. For this
reason, it is best to wait until the Business Model and Mapping layer is relatively
stable before adding customizations in the Presentation layer.

Working with Subject Areas

In the Presentation layer, subject areas enable you to show different views of a
business model to different sets of users. Subject areas have to be populated with
contents from a single business model. They cannot span business models.

Typically, subject areas are created automatically by dragging and dropping business
models from the logical layer.

To edit the properties of a subject area:

1. In the Presentation layer, double-click a subject area. The Subject Area dialog is
displayed.

2. In the General tab, you can change the name for the subject area. Note that aliases
are created automatically whenever presentation objects are renamed, so that any
queries using the original name do not break.

Also, a subject area cannot have the same name as any of its child presentation
tables. For example, you cannot have a subject area called Customer that has a
Customer table within it.

3. To set permissions for this subject area, click Permissions. See "Setting Permissions
for Presentation Layer Objects" for more information.

4. Select Custom display name or Custom description to dynamically display a
custom name or custom description based on a session variable, typically for
localization purposes. See "Localizing Oracle Business Intelligence Deployments"”
in Oracle Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information about localization.

5. The Business model list displays the business model for this subject area.

6. To expose the logical keys to other applications, select the option Export logical
keys.

In most situations, this option should be selected. Many client tools differentiate
between key and nonkey columns, and the option Export logical keys provides
client tools access to the key column metadata. Any join conditions the client tool
adds to the query, however, are ignored, because the Oracle BI Server uses the
joins defined in the repository.
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Note: If you are using a tool that issues parameterized SQL queries,
such as Microsoft Access, do not select the Export logical keys option.
Not exporting logical keys stops the tool from issuing parameterized
queries.

7. Optionally, you can set an Implicit Fact Column. This column is added to a query
when it contains columns from two or more dimension tables and no measures.
The column is not visible in the results. It is used to specify a default join path
between dimension tables when there are several possible alternatives or contexts.

8. Optionally, type a description. This description appears in a mouse-over tooltip
for the subject area in Oracle BI Answers.

9. In the Presentation Tables tab, you can add, remove, edit, or reorder the
presentation tables for this subject area.

10. Use the Aliases tab to specify or delete aliases for this subject area. See "Creating
Aliases (Synonyms) for Presentation Layer Objects" for more information about
aliases.

11. Click OK.

Working with Presentation Tables and Columns

Presentation tables and presentation columns appear as folders and columns in Oracle
BI Answers. You can customize presentation tables and presentation columns to help
users craft queries based on their business needs.

This section contains the following topics:
s Creating and Managing Presentation Tables

s Creating and Managing Presentation Columns

Creating and Managing Presentation Tables

You can use presentation tables to organize columns into categories that make sense to
the user community. A presentation table can contain columns from one or more
logical tables. The names and object properties of the presentation tables are
independent of the logical table properties.

Typically, presentation tables are created automatically by dragging and dropping
logical tables from the logical layer.

To edit the properties of a presentation table:

1. In the Presentation layer, double-click a presentation table. The Presentation Table
dialog appears.

2. In the General tab, you can change the name for the presentation table. Note that
aliases are created automatically whenever presentation objects are renamed, so
that any queries using the original name do not break.

Also, a presentation table cannot have the same name as its parent subject area.
For example, you cannot have a subject area called Customer that has a Customer
table within it.

3. To set permissions for this presentation table, click Permissions. See "Setting
Permissions for Presentation Layer Objects" for more information.
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4. Select Custom display name or Custom description to dynamically display a
custom name or custom description based on a session variable, typically for
localization purposes. See "Localizing Oracle Business Intelligence Deployments"”
in Oracle Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information about localization.

5. In the Columns tab, you can add, remove, edit, or reorder the presentation
columns for this presentation table.

6. In the Hierarchies tab, you can add, remove, edit, or reorder the presentation
hierarchies for this presentation table.

7. Use the Aliases tab to specify or delete aliases for this presentation table. See
"Creating Aliases (Synonyms) for Presentation Layer Objects" for more
information about aliases.

8. Click OK.

To reorder a table or sort all tables in a subject area:

1. In the Presentation layer, double-click a subject area.

2. In the Subject Area dialog, click the Presentation Tables tab.

3. Tomove a table, in the Name list, select the table you want to reorder. Then, use
drag-and-drop to reposition the table, or click the Up and Down buttons.

4. To sort all tables in alphanumeric order, click the Name column heading. This
toggles the sort between ascending and descending alphanumeric order.

Nesting Folders in Answers

You can use the Administration Tool to update Presentation layer metadata to give the
appearance of nested folders in Answers. To do this, open the Properties dialog for the
presentation table that corresponds to the folder you want to nest and add -> to the
beginning of the Description field.

For example, to nest the Sales Facts folder in the Facts folder in Answers, place the
Sales Facts presentation table directly after the Facts presentation table in the metadata
and add -> to the Description field in the Presentation Table - Sales Facts dialog. To
nest a second folder called Marketing Facts in the Facts folder, add -> to the
Description field for the Marketing Facts presentation table and place it directly after
Sales Facts. Only two levels of nesting are supported.

Alternatively, you can prefix the name of the presentation table to be nested with a
hyphen and a space and then place the table after the presentation table in which it
nests. For example, to nest Sales Facts within Facts, place Sales Facts directly after
Facts and change its name to - Sales Facts. When Answers displays the folder name in
the left pane, it omits the hyphen and space from the folder name. However, the
hyphen and space are visible to ODBC clients.

Note that these techniques do not provide true folder nesting. If you move the parent
presentation table, the "child" presentation tables do not move with it. These
techniques only provide the appearance of nesting in Answers.

Creating and Managing Presentation Columns

The presentation column names are, by default, identical to the logical column names
in the Business Model and Mapping layer. However, you can present a different name
by clearing both the Use Logical Column Name and the Custom display name
options in the Presentation Column dialog.
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To provide a convenient organization for your users, you can drag and drop a column
from a single logical table in the Business Model and Mapping layer onto multiple
presentation tables. This lets you create categories that make sense to the users. For
example, you can create several presentation tables that contain different classes of
measures: one containing volume measures, one containing share measures, one
containing measures from a year ago, and so on.

Caution: When you drag columns to presentation tables, make sure
that columns with the same name or an alias of the same name do not
already exist.

Typically, presentation columns are created automatically by dragging and dropping
logical columns from the logical layer.

To edit the properties of a presentation column:

1. In the Presentation layer, double-click a presentation column to display the
Presentation Column dialog.

2. In the General tab, to specify a name that is different from the Logical Column
name, clear Use Logical Column Name, and then type a name for the column.
Note that aliases are created automatically whenever presentation objects are
renamed, so that any queries using the original name do not break.

3. To set permissions for this presentation column, click Permissions. See "Setting
Permissions for Presentation Layer Objects" for more information.

4. Select Custom display name or Custom description to dynamically display a
custom name or custom description based on a session variable, typically for
localization purposes. See "Localizing Oracle Business Intelligence Deployments"”
in Oracle Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition for more information about localization.

Note: You can also use the Custom display name and Custom
description fields to propagate Ul hints (labels and tooltips) from an
ADF data source to display in Oracle BI Answers. See "Propagating
Labels and Tooltips from an Oracle Application Development
Framework Data Source to Display When Working with Analyses" in
Oracle Fusion Middleware System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition for more information about how
to set up ADF data source Ul hints.

5. The Logical Column field displays the name of the logical column for this
presentation column. Click Edit to make any changes to the logical column object.

6. Use the Aliases tab to specify or delete aliases for this presentation column. See
"Creating Aliases (Synonyms) for Presentation Layer Objects" for more
information about aliases.

To reorder a presentation column:

1. In the Presentation layer, right-click a presentation table and select Properties.
2. Click the Columns tab.

3. Select the column you want to reorder.

4

Use drag-and-drop to reposition the column, or click the Up and Down buttons.
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5. Click OK.

Working with Presentation Hierarchies and Levels

Presentation hierarchies and presentation levels provide an explicit way to expose the
multidimensional model in Oracle BI Answers. When presentation hierarchies and
levels are defined in the Presentation layer, roll-up information is displayed in the
Oracle BI Answers navigation pane, providing users with important contextual
information.

Be aware that members in a presentation hierarchy are not visible in the Presentation
layer. Instead, you can see hierarchy members in Answers.

Most importantly, users can create hierarchy-based queries using these objects.
Presentation hierarchies expose analytic functionality such as member selection,
custom member groups, and asymmetric queries.

As with other Presentation layer objects, you can also provide localization information
and apply fine-grained access control to presentation hierarchies and levels.

If you have a repository from a previous release, note that presentation hierarchies do
not appear in the Presentation layer automatically as part of the RPD upgrade process.
You must manually create these objects by dragging logical dimensions from the
Business Model and Mapping layer to the appropriate presentation tables.

This section contains the following topics:
»  Creating and Managing Presentation Hierarchies

»  Creating and Managing Presentation Levels

Creating and Managing Presentation Hierarchies

To create a presentation hierarchy, you can drag a logical dimension hierarchy from
the Business Model and Mapping layer to a table in the Presentation layer. The
presentation hierarchy object must be located within a presentation table, unlike in the
Business Model and Mapping layer, where logical dimensions are peer objects of
tables. Presentation hierarchies are also displayed within their associated tables in
Oracle BI Answers, providing a conceptually simpler model.

If a logical dimension spans multiple logical tables in the Business Model and
Mapping layer, it is a best practice to model the separate logical tables as a single
presentation table in the Presentation layer.

There are several ways to create presentation hierarchies:

= When you drag an entire business model to the Presentation layer, the
presentation hierarchies and constituent levels appear automatically, along with
other presentation objects.

= When you drag a logical dimension table to the Presentation layer, presentation
hierarchies and levels based on those dimensions are created automatically.

= You can also drag individual logical dimensions to the appropriate presentation
tables to create corresponding presentation hierarchies within those tables.

= As with most other objects in the Administration Tool, you can right-click a
presentation table and select New Object > Presentation Hierarchy to manually
define the object.
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You can also drag an individual logical level from the Business Model and Mapping
layer to a presentation table to create a presentation hierarchy that is a subset of the
logical dimension hierarchy.

For example, suppose a logical dimension has the levels All Markets, Total US, Region,
District, Market, and Market Key. Dragging and dropping the entire logical dimension
to the corresponding presentation table appears as follows:

- Markets

E-%, MarketDim

© Bl AllMarkets
: E-lo TotalUS

-4 Region
B4 District
B0 Market
Ll Market Key

However, dragging and dropping the Region level to the same presentation table
appears as follows:

- Markets
E-%, MarketDim
. Bl Region
: B4 District
-4 Market
Lol Market Key

Modeling Dimensions with Multiple Hierarchies in the Presentation Layer

For logical dimensions that contain multiple logical hierarchies, multiple separate
presentation hierarchies are created. For example, the following logical dimension
called Product contains the two hierarchies Category and Country:

=
-3 Category
™ CategorylD
[ CategoryName
: E Description
E-40 Product

P ProductiD
<P ProductN ame
QuantityPerlInit

&
&8 UnitPrice
-3 UnitsInStock
& UnitsOnOrder
& ReorderLevel
------ & Discontinued
=43 Country
Courtry

E CountryRevernue

=13 Reqion

Address
PostalCode

-@@ ProductName

E QuantityPerlnit
& UritPrice

E UnitzsinStock
& UnitsOnOrder
E ReorderLevel

------ E Diszontinued
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In the Business Model and Mapping layer, this logical dimension is modeled as a
single dimension object that contains multiple hierarchies. In contrast, the Presentation
layer models this dimension as two separate objects: one that displays the drill path
through the Category level, and another that shows the drill path through the Country
level, as follows:

= Product

B, Product - Category
. E-lg Category
-lg Product
E-%, Product - Counlry
. E-lg County
=1 Region
B0 City
E-lg Supplisr
el Praduct

Editing Presentation Hierarchy Objects

You can edit presentation hierarchy properties, including setting permissions to apply
role-based access control, setting a custom display name for localization purposes, and
changing the levels in a hierarchy.

To edit the properties of a presentation hierarchy:

1.

In the Presentation layer, double-click a presentation hierarchy to display the
Presentation Hierarchy dialog.

In the General tab, you can change the following:

= Name. Note that aliases are created automatically whenever presentation
objects are renamed, so that any queries using the original name do not break.

= Permissions. See "Setting Permissions for Presentation Layer Objects" for
more information.

s Custom display name and Custom description. Select Custom display name
or Custom description to dynamically display a custom name or custom
description based on a session variable, typically for localization purposes. See
"Localizing Oracle Business Intelligence Deployments" in Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition for more information about localization.

s Logical Dimension. This field displays the name of the logical dimension for
this presentation hierarchy. Click Browse to select a different logical
dimension.

The Levels tab lists the levels within the hierarchy and their order. This tab is not
available for parent-child hierarchies. You can add, delete, or reorder levels. You
can also click the Edit button to edit properties for a particular level. See "Creating
and Managing Presentation Levels" for information about level properties.

The Display Columns tab is only available for parent-child hierarchies. Because
parent-child hierarchies do not contain levels, display columns are defined for the
presentation hierarchy object as a whole. Use the Display Columns tab to define
which columns should be used for display for this parent-child hierarchy.

You can add, delete, or reorder display columns. You can also click the Edit button
to edit properties for a particular column.

Use the Aliases tab to specify or delete aliases for this presentation hierarchy. See
"Creating Aliases (Synonyms) for Presentation Layer Objects" for more
information about aliases.
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Creating and Managing Presentation Levels

Presentation levels are displayed within hierarchical columns in Oracle BI Answers.
Presentation levels are typically created automatically when presentation hierarchies
are created.

To edit the properties of a presentation level:

1.

In the Presentation layer, double-click a presentation level to display the
Presentation level dialog.

In the General tab, you can change the following;:

= Name. Note that aliases are created automatically whenever presentation
objects are renamed, so that any queries using the original name do not break.

= Permissions. See "Setting Permissions for Presentation Layer Objects" for
more information.

s Custom display name and Custom description. Select Custom display name
or Custom description to dynamically display a custom name or custom
description based on a session variable, typically for localization purposes. See
"Localizing Oracle Business Intelligence Deployments" in Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition for more information about localization.

= Logical Level. This field displays the name of the logical level for this
presentation level. Click Browse to select a different logical level.

The Drill To Levels and Drill From Levels tabs are reserved for a future release
and are not currently used. An additional option called Generate Drill Graph,
available as a right-click option for any Presentation layer object, is also reserved
for a future release.

Use the Display Columns tab to define which columns should be used for display
for that level (on drill-down). For example, if two columns called "Name" and "ID"
exist at the same level, you can choose to display "Name" because it is the more
user-friendly option.

You can add, delete, or reorder display columns. You can also click the Edit button
to edit properties for a particular column.

As an alternative to defining display columns in this tab, you can drag a
presentation column directly onto the presentation level in the Presentation layer
of the Administration Tool. Doing this automatically adds the column as a display
column for the presentation level.

Note that the display columns that appear by default when a presentation level is
created are based on which key columns for the corresponding logical level have
the Use for display option selected.

Use the Aliases tab to specify or delete aliases for a presentation level. See
"Creating Aliases (Synonyms) for Presentation Layer Objects" for more
information about aliases.

Setting Permissions for Presentation Layer Objects

You can apply access control to restrict which individual users or application roles
(groups) can access particular presentation layer objects. For example, you can provide
read-only access to a set of presentation tables for a particular application role,
read-write access for a second application role, and no access for a third application
role.
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You can also use the Security Manager to set up privileges and permissions. The
Security Manager is useful for setting permissions for individual application roles to
many objects at once, unlike permissions in the Presentation layer, which you can only
set for one object at a time. See "Setting Up Object Permissions" for information about
setting up object permissions in the Security Manager. For a full description of data
access security in Oracle Business Intelligence, see Chapter 13.

To set permissions for presentation layer objects:

1. In the Presentation layer, double-click a presentation object, such as a subject area,
table, column, or hierarchy.

2. In the General tab, click Permissions.

3. In the Permissions dialog, any users or application roles with the Default
permission do not appear in the User/Application Roles list. Select Show all
users/application roles to see all users and application roles.

4. For each user and application role, you can allow or disallow access privileges for
this presentation object by selecting one of the following options:

= Read. Only allows read access to this object.
= Read/Write. Provides both read and write access to this object.
= No access. Explicitly denies all access to this object.

s Default. No object-specific access rules apply. The default access control for
this user or application role, as defined in the Security Manager, controls what
the user or application role can do with this object.

Note that any permissions applied to a presentation object also apply to its child
objects. For example, permissions applied to a presentation table also apply to any
presentation columns, hierarchies, and levels in that table.

5. Click OK.
6. Click OK in the Properties dialog for this presentation object.

Generating a Permission Report for Presentation Layer Objects

You can generate a permission report for individual presentation layer objects to see a
summary of how permissions have been applied for that object. To do this, right-click
any presentation object and select Permission Report. The Permission Report dialog
displays the name and a description of the presentation object, along with a list of
users/application roles and their permissions.

Sorting Columns in the Permissions Dialog

There are six ways that you can sort the types and User/Application Role names in the
Permissions dialog. To change the sort, click the heading of the first or second column.
The first column has no heading and contains an icon that represents the type of user
or application role. The second column contains the name of the User/Application
Role object. Note that you cannot sort on the columns for individual object
permissions (like Read, Read /Write, and so on).

There are three ways to sort by type, and two ways to sort the list of user and
application role names. This results in a total of six possible sort results (3 x 2 = 6). The
following list shows the sort results available by clicking the type column:

= Everyone, Application Roles, Users (ascending by name of type)

= Users, Application Roles, Everyone (descending by name of type)
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= Type column is in no particular order (Type value is ignored, as all names in
User/Application Role column are sorted in ascending order by value in
User/Application Role column)

The following list shows the sort results available by clicking the User/Application
Role column:

= Ascending within the type
= Descending within the type

Creating Aliases (Synonyms) for Presentation Layer Objects

Each presentation object can have a list of aliases (synonyms) for its name that can be
used in Logical SQL queries. To create the list of aliases, use the Alias tab in the
Properties dialog for the appropriate presentation object (subject area, presentation
table, presentation hierarchy, presentation level, or presentation column).

Because Presentation layer objects are often deleted and then re-created during the
repository development process, it is best to wait until your logical business model is
relatively stable before creating aliases for presentation objects.

You can use this feature to rename presentation objects without breaking references
that any existing requests have to the old names, including requests from Answers,
Oracle BI Publisher, or other Logical SQL clients. If you are still developing a new
repository, you might want to wait until the repository is stable before renaming
objects.

For example, consider a subject area called "Sample Sales Reduced" that contains a
presentation table called "Facts Other." If you rename the presentation column called
"# of Customers" to "Number of Customers," any requests that use "# of Customers"
fail. However, if you add "# of Customers" to the list of synonyms in the Alias tab for
the "Number of Customers" column, then queries containing both "# of Customers"
and "Number of Customers" succeed and return the same results.

Note the following:

= Aliases for presentation objects do not appear in Answers or other query clients
when creating new queries. Only the primary names of subject areas, hierarchies,
levels, tables, and columns appear.

»  This feature works in a different way from SQL aliases or the alias feature in the
Physical layer. It simply provides synonyms for object names, much like
"synonyms" in SQL.

= Aliases are created automatically when you rename presentation objects. For
example, if you change Catalog to Catalogl, the original name Catalog is added to
the Aliases list.

= You cannot rename a Presentation layer object to a name that is already in use as
an alias for an object of the same type.

To add or delete an alias for a presentation object:

1. In the Presentation layer, double-click a presentation object, such as a subject area,
table, column, or hierarchy.

2. Click the Aliases tab.

3. Toadd an alias, click the New button, and then type the text string to use for the
alias.
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4. To delete an alias, select the alias you want to delete from the Aliases list, then
click the Delete button.

5. Click OK.
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Creating and Persisting Aggregates for
Oracle Bl Server Queries

Most data warehouse practitioners create aggregated data tables to dramatically
improve the performance of highly summarized queries. These aggregate tables store
precomputed results that are aggregated measures (typically summed) over a set of
dimensional attributes. Using aggregate tables is a typical technique used to improve
query response times in decision support systems.

If you write SQL queries or use a tool that only understands what physical tables exist
and not their meaning, then using aggregate tables becomes more complex as the
number of aggregate tables increases. The aggregate navigation capability of the
Oracle BI Server allows queries to use the information stored in aggregate tables
automatically. The Oracle BI Server lets you concentrate on asking the right business
question, and then the server decides which tables provide the fastest answers.

Oracle Business Intelligence has an aggregate navigation feature to take advantage of
those aggregates in source databases (for more information, see Chapter 10). However,
it can be time consuming to create and maintain the data aggregation, as well as load
database scripts and the corresponding metadata mappings. For that reason, Oracle
Business Intelligence provides an aggregate persistence feature that automates the
creation and loading of the aggregate tables and their corresponding Oracle Business
Intelligence metadata mappings.

This chapter explains how to set up and use aggregate persistence in Oracle Business
Intelligence.

This chapter contains the following topics:

= About Aggregate Persistence in Oracle Business Intelligence

s Identifying Query Candidates for Aggregation

s Using the Aggregate Persistence Wizard to Generate the Aggregate Specification
s Writing the Create Aggregates Specification Manually

= Running the Aggregate Specification Against the Oracle BI Server

= Troubleshooting Aggregate Persistence

About Aggregate Persistence in Oracle Business Intelligence

Use the Aggregate Persistence feature to create aggregates for Oracle BI Server queries.
The Aggregate Persistence Wizard lets you automate the creation of the aggregate
specification script. When you run this script against a live Oracle Bl Server, aggregate
tables are created and are mapped into the metadata for navigation. When aggregates
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are persisted, indexes and statistics are created on relational tables for greater
performance.

The Aggregate Persistence Wizard creates a SQL script that you can run on a
scheduled basis against the Oracle Bl Server. In the Aggregate Persistence Wizard, you
specify the measures, dimensionality, and other parameters of each star or cube based
on your performance design. The script should run after each load of the base-level
tables, so that the aggregates are always synchronized with the detail-level data when
the load window completes and users begin to run queries.

Aggregate creation runs against the master server in a cluster. It takes some time for
the metadata changes to propagate to the slaves. The cluster refresh time is a
user-controlled option and results might be incorrect if a query hits a slave server
before it is refreshed. It is the administrator's responsibility to set an appropriate
cluster refresh interval.

Aggregate persistence requires a dedicated connection pool to create tables or cubes in
the target database that will hold the aggregates. Because the Oracle BI repository
enables federation, the aggregated target can be on the same database as the detailed
source, or in a completely different database. This dedicated connection pool must be
created before you run the Aggregate Persistence Wizard, so it can be selected during
the appropriate step of the wizard.

The default prefix SA_ is automatically added to dimension (level) aggregates. You can
change this default prefix by updating the AGGREGATE_PREFIX parameter in the
AGGREGATE_PERSISTENCE section of the NQSConfig.INI file:

AGGREGATE_PREFIX = "prefix name" ;

The target schema used to store aggregates must be appropriately secured and should
not allow public access. The schema should have privileges to connect, create, and
drop tables and indexes. By default, only users who belong to the BIAdministrators
group can manage aggregates.

Do not use aggregate persistence against tables with active Virtual Private Database
(VPD) security filters. There is a possibility that the aggregate information might be
persisted without the VPD filter, posing a security risk.

Identifying Query Candidates for Aggregation

When creating aggregates, you must identify which queries would benefit
substantially from aggregated data. You will achieve the best results by aggregating to
the highest level possible. To identify slow-running queries, perform the following
tasks:

= Enable usage tracking in the Oracle BI Server. Usage tracking statistics can be
used in a variety of ways, such as database optimization, aggregation strategies,
and billing users or departments based on the resources they consume. The Oracle
BI Server tracks usage at the detailed query level. When you enable usage
tracking, statistics for every query are written to a usage tracking log file or
inserted into a database table.

Note: It is strongly recommended that you use the direct insertion
into a database method for usage tracking. See "Managing Usage
Tracking" in Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition for full information about
usage tracking.
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Analyze the query run times and identify the slowest running queries as
candidates for aggregation. The run time for creating aggregates is dependent on
the type of aggregates selected by the user. Creating aggregates from large fact
tables is slower than from smaller tables. You should carefully select the
aggregates to be created.

Using the Aggregate Persistence Wizard to Generate the Aggregate

Specification

You can use the Aggregate Persistence Wizard to create the SQL file that will be used
to create and load aggregate tables and map them into the metadata. The resulting
SQL file must be executed against a running Oracle BI Server.

Note: It is strongly recommended that you use the Aggregate
Persistence Wizard because it automatically enforces many of the
constraints necessary when generating the aggregate specification.
However, you can manually write the aggregate Logical SQL as an
alternative to using the wizard. Make sure to follow the guidelines
described in "Writing the Create Aggregates Specification Manually" if
you choose to write your own aggregates specification.

To use the Aggregate Persistence Wizard:

1.

In the Administration Tool, select Tools > Utilities > Aggregate Persistence, and
then click Execute.

On the Select File Location screen, specify the complete path and file name of the
aggregate creation script. You can specify a new or an existing file name.

Typically, when you run the SQL script against the Oracle BI Server, it creates DDL
and runs it against the target database schema to create the aggregate tables, then
loads them from the source, and finally creates the Oracle BI Server metadata so
the aggregate navigation feature can use the new tables.

Alternatively, you can select Generate target DDL in a separate file if you want
the DDL to be stored in a separate file from the Oracle BI Server SQL script. When
you select this option, two SQL scripts are generated:

s The create aggregates script (script_name)

s The prepare aggregates script (script_name_DDL)

Both files are stored in the following location:
ORACLE_INSTANCE\bifoundation\OracleBIServerComponent\coreapplication_obisn\

aggr

Selecting Generate target DDL in a separate file gives you the flexibility to alter
the auto-generated DDL and run it independently of the Oracle BI Server. For
example, you may want to alter the storage parameter or index settings. When you
select this option, you first make manual updates to the DDL file, then you run the
DDL file (prepare aggregates), then you run the create aggregates script.

Click Next after you have finished specifying options on the Select File Location
screen.

In the Select Business Measures screen, select the measures on which you want to
aggregate. To do this, select a business model in the upper pane, then select a
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single fact table or a set of measures in the lower pane. You cannot select measures
that span multiple fact tables. Use Ctrl-click to select multiple measures, or use
Shift-click to select a range of consecutive measures.

Note that the View Script button is not available during the creation of the first
aggregate table block.

Figure 12-1 shows the Select Business Measures screen.

Figure 12-1 Aggregate Persistence Wizard: Select Business Measures Screen

Aggregate Persistence - Select Business Measures it |I:||5|
Select the measures on which you want bo aggregate. ; . |
1 | Select File Location iz Serigh
Select a business model:
Select Business Measures 3 7
- Sample App
@ 2 - Essbase Sample
3| Select Levels g1 3 - Sample Federated
{3 4 - Olap Sample
4 | Select Connection Pool w 5 - Fusion Order Dema
W 9 - Uzage Tracking
5 | Finizh
b6 | Finizh Script
Select measures or a fact table:
v-ffa) F1 Targets Base Measures -
W F2 Quntas Baze Measunes
& F3Headcount Base Measures
& F4 Time Series and Level Based Examples
& F5 Logical Calculations Examples
& F90 Time Facts
Ei F91 SalesRep Facts
el F92 Actions Entries
L1 Lackups Translation
(-4 L2 Lockups Fx &
Help | Back. | Texk Fimish Cancel
|L0gical Table : "1 - Sample App"."L1 Lookups Translation” A

Click Next after you have selected the appropriate measures.

4. In the Select Levels screen, specify the level of aggregation by selecting a logical
level for one or more dimensions. You can specify a surrogate key to be used for
the fact-dimension join.

The default join option between the aggregated fact and dimension tables is the
primary key defined in the logical level you selected. If the primary key of the
level is large and complex, the join to the fact table is expensive, so using a
surrogate key is recommended in this case. A surrogate key is an artificially
generated key, usually a number. For example, a surrogate key in the level
aggregate table would simplify this join, removing unnecessary (level primary
key) columns from the fact table and resulting in a leaner fact table.

Using a surrogate key only changes the query response time, not the logical results
of the queries. However, generating the surrogate keys can have the side effect of
increasing the aggregate table load time. Therefore, the recommended setting is as
follows:

- If the primary key for the logical level you have selected is already a single,
numeric column, you typically should not select the Use Surrogate Key
option since it may add to load processing time without producing a
performance benefit.

— If the primary key for the logical level you have selected is a text string, or
consists of multiple logical columns, you typically should use a surrogate key

12-4 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



Using the Aggregate Persistence Wizard to Generate the Aggregate Specification

to improve the performance of the queries that join to that aggregate
dimension. However, keep in mind that generating the surrogate key can
increase the load time for that aggregate dimension table.

See "Adding Surrogate Keys to Dimension Aggregate Tables" for additional
information about surrogate keys.

Figure 12-2 shows the Select Levels screen.

Figure 12-2 Aggregate Persistence Wizard: Select Levels Screen
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Click Next after you have selected the appropriate level of aggregation.

5. In the Select Connection Pool screen, select the appropriate items to specify a
location for the aggregate table.

A default aggregate table name is provided, and a prefix is added to the table
name. The default prefix for the generated fact table is ag. For tables created for
dimension (level) aggregates, the default prefix is SA_ and can be changed by
updating the AGGREGATE_PREFIX property in NQSConfig.INI. See Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition for more information about changing configuration settings.

Figure 12-3 shows the Select Connection Pool screen.
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Figure 12-3 Aggregate Persistence Wizard: Select Connection Pool Screen
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Click Next after you have provided connection pool information.

6. In the Finish screen, the View Script button becomes available for use, and the
Logical SQL script appears for your review. Choose whether to define another
aggregate (default) or end the wizard, and then click Next.

7. In the Finish Script screen, the complete path and file name appears. Click Finish.

See "Running the Aggregate Specification Against the Oracle BI Server" for
information about using the SQL file to create aggregate tables.

Writing the Create Aggregates Specification Manually

If you choose not to use the Aggregate Persistence Wizard to create the script file, you
can write the file manually. It is recommended that you use the Aggregate Persistence
Wizard.

If you do not want the Oracle BI Server to modify your databases during aggregate
creation, then you can specify this in the Aggregate Persistence Wizard by selecting the
option Generate target DDL in a separate file. The Aggregate Persistence Wizard will
create a DDL file (the "prepare aggregates" script) that you can use to create the empty
aggregate tables. After this, you need to run the "create aggregates" script to populate
the aggregate tables. This option provides some flexibility in case the database access
to create tables is restricted. Note that you must run the prepare aggregates script
before you run the create aggregates script.

This section contains the following topics:

= What Constraints Are Imposed During the Create Process?
s How to Write the Create Aggregates Specification

= Adding Surrogate Keys to Dimension Aggregate Tables
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What Constraints Are Imposed During the Create Process?

The following constraints are imposed during the create process:

Valid measures. A valid measure must have a valid aggregation rule. The
following constraints apply to level-based measures:

— If the level is grand total alias, then that dimension must not be present in the
list of levels for that aggregate specification.

— Any other level defined for this measure must be present in the list of levels
for that aggregate specification.

If the above constraints are not met, then the entire aggregate specification is
discarded. In addition, a measure is ignored by the create process if any of the
following conditions are true:

- Measure is mapped to a session or repository variable.
— Measure is a derived measure.
- Measure has a default aggregation rule of None.

Measures that are ignored do not necessarily affect the aggregate specification. The
remaining measures are used to create the aggregate.

Valid levels. A valid level must have a valid primary key. If a level is invalid, the
aggregate specification is be discarded. Also, attributes of a level or its primary
key are ignored if any of the following conditions are true:

- Attribute is mapped to session or repository variables.
— Attributes are not from the same logical table.

Valid aggregate specification. A valid aggregate specification has the following
properties:

- Name length is between 1 and 18 characters (inclusive).

— Atleast one valid level must be specified.

— Atleast one valid measure must be specified.

— Must have a valid connection pool.

— Must have a valid output container (database/catalog/schema).

— Connection pool and container must belong to the same database.

—  Only one level per dimension can be specified.

— Measures can only be from the same fact table.

- Alllogical components of the specification must be from the same subject area.

An aggregate specification is ignored if the name already exists in the output
container because level aggregates are scoped by the entire database. However, if
different catalogs or schemas are specified for the same fact aggregate name, it is
allowed to have multiple facts with the same name but different scope in the same
database.

Note that the aggregate specification is discarded if any dimension is not joined to
a fact.
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How to Write the Create Aggregates Specification

All metadata names (except for logical fact columns) are fully qualified. There are two
modes of operation: Create and Delete. It is strongly recommended that you place all
aggregate specifications under a single Create Aggregates statement.

Follow these guidelines when writing the aggregate specification:

= Begin the script file with a Delete statement. It is essential to delete
system-generated aggregates before creating new ones. This ensures that data is
consistent and removes invalid or incomplete aggregates before you run the
Create operation. The following statement is the syntax for deleting aggregates:

Delete aggregates;

= The next statement should be a Create statement. The following is the syntax for
creating aggregates:

Create|Prepare aggregates

aggr_name_1

for logical_fact_table_1 [(logical_fact_column_1, logical_fact_column_2,..)]
at levels (level 1, level 2, ..)

using connection pool connection pool_name_1

in schema_name 1

[ ,aggr_name 2

for logical_fact_table_3 [(logical_fact_column_5, logical_fact_column_2,..)]
at levels (level 3, level 2, ..)

using connection pool connection_pool_name 2

in schema_name 2] ;

»  To specify multiple aggregates in a single Create Aggregates statement, follow
these guidelines:

- Ensure that each of the multiple aggregate specifications are separated by a
comma, and the entire aggregate creation script is terminated with a
semicolon.

- In this file, only one Delete Aggregates statement should be specified at the
beginning. Make sure that only one delete is issued per ETL run (unless a reset
is called for).

Caution: Any aggregate scripts that are run after the first one should
not have a Delete Aggregates statement, or all previously created
aggregates are removed.

For information about creating aggregates with surrogate keys, see the following
section.

Adding Surrogate Keys to Dimension Aggregate Tables

The join option default between fact and level aggregate tables uses primary keys from
the level aggregate. If the primary key of the level is large and complex (composite of
many columns), then the join to the fact table is expensive. A surrogate key is an
artificially generated key, usually a number. A surrogate key, in the level aggregate
table, simplifies this join and removes unnecessary columns (level primary key) from
the fact table, resulting in a smaller-sized fact table. Adding surrogate keys to the
dimension (level) aggregate tables can simplify joins to the fact tables and might
improve query performance. Additionally, a surrogate key makes sure that each
aggregate table has a unique identifier.
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There might be cases in which a level is shared among multiple fact tables. One fact
might use surrogate keys, and another might use primary keys from the dimension
aggregate. The following are some options for resolving this issue:

= Set a metadata property for levels that indicates whether to use surrogate keys or
primary keys.

= Always create a surrogate key for a level aggregate (relatively low cost operation).
Then, decide later if the fact aggregate should join to it using a surrogate or
primary key.

An alternative to specifying the join type for each dimension is to specify if surrogate
keys should be used for the entire star. This would result in simpler syntax, but would
also restrict the available user options and slow the aggregate creation process.

About the Create/Prepare Aggregates Syntax

The following syntax for create/prepare aggregates contains the change for [Using_
Surrogate_Key]. The surrogate key option can be specified for each level. If
unspecified, the fact and dimension tables are joined using the primary key from the
level aggregate.

Create|Prepare aggregates

aggr_name_1

[file output_file name]

for logical_fact_table_1 [(logical_fact_column_1, logical_fact_column_2,..)]
at levels (level_1 [Using_Surrogate_Key], level_2, ..)

using connection pool connection_pool_name 1

in schema_name_1

[ ,aggr_name_2

for logical_fact_table 3 [(logical_fact_column_5, logical_fact_column_2,..)]
at levels (level 3, level 2, ..)

using connection pool connection_pool_name 2

in schema_name 2] ;

About Surrogate Key Output from Create/Prepare Aggregates

The changes to the current process are restricted to the physical metadata layer in the
repository and the database.

When you use the Using_Surrogate_Key join option, the following describes the
results:

= For a level aggregate, the following occurs:
- Inthe physical metadata, the following occurs:

*  The level aggregate table has a new column called IevelName_

upgradeIDSK (check for collisions). This is the surrogate key column for
the dimension aggregate. Note that 1evelName is truncated if the total
number of characters exceeds 18.

*  The type of this column is SMALLUINT.
— In the database, the following occurs:

*  The level aggregate table also has a corresponding column called
levelName_upgradeIDSK. Again, levelName is truncated if the total
number of characters exceeds 18.

* It can be populated using RCOUNT ().

= For a fact aggregate, the following occurs:
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— In the physical metadata, the following occurs:

*  The fact aggregate table no longer contains columns from the level's
primary keys.

* Instead, a new column that corresponds to the level aggregate's surrogate
key is added to the table.

*  The type of this column is identical to the level's surrogate key.

*  The column has the same name as that in the level aggregate (check for
collisions).

*  The fact table and the level table are joined using this surrogate key only.
- Inthe database, the following occurs:
*  The fact aggregate table also has the corresponding surrogate key.

*  Itis populated using new capabilities to be available through Populate.

Running the Aggregate Specification Against the Oracle Bl Server

Before you run the aggregate specification against the Oracle BI Server, you should set
an appropriate logging level. Trace logs are be logged to nqquery.log if the logging
level is at least 2. The logging events include the aggregate execution plan and the
order in which the aggregates are created and deleted. Higher logging levels provide
more details about the query and execution plans. Error logs are logged to nqquery.log
if the logging level is at least 1, and to nqserver.log regardless of the logging level.

After generating the SQL script file and setting the logging levels, you can run the SQL
script using nqemd. The SQL file must be executed against a running Oracle BI Server.
See "Using nqemd to Run Sample Queries” for more information about running
ngcmd.

After executing the SQL script, aggregates are created and persisted in the Oracle BI
Server metadata, as well as in the back-end databases.

Troubleshooting Aggregate Persistence
The following is a list of some reasons errors can occur:
= Network failure.
= No disk space on the database.
= Bad aggregate request.

If there is an error in the creation of any aggregate, then the entire aggregate request is
terminated and subsequent aggregates are not created. Aggregates that are already
created and checked in remain checked in. If there are errors, you must remove them
at the time of the error or at the next ETL run in one of the following ways:

= Manually remove the aggregates from the metadata and the database.

= Automatically remove all the aggregates using the Delete Aggregates
specification.

12-10 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



13

Applying Data Access Security to
Repository Objects

Data access security controls rights to view and modify data. You can use several
different methods of data access security with Oracle Business Intelligence: row-level
security (implemented either in the repository or in the database), object permissions,
and query limits. This chapter provides information about the different types of data
access security and explains how to set them up.

Other security tasks, including setting up SSL connections, managing users, groups,
and application roles, setting up custom LDAP servers, and managing custom
authenticators, are covered in Oracle Fusion Middleware Security Guide for Oracle
Business Intelligence Enterprise Edition. Note that you must create users and application
roles before you can implement data access security.

You should plan to implement data access security in the Administration Tool in
online mode. If you must perform data access security tasks in offline mode, be sure to
read "About Applying Data Access Security in Offline Mode" first.

Data access security auditing is covered by the Oracle Business Intelligence usage
tracking feature. See "Managing Usage Tracking" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for more
information.

This chapter contains the following topics:

= About Data Access Security

n  Setting Up Row-Level Security

s Setting Up Object Permissions

s Setting Query Limits

= About Applying Data Access Security in Offline Mode

About Data Access Security

After developing your metadata repository, you need to set up your data security
architecture to control access to source data. Data access security accomplishes the
following goals:

s To protect business data queried from databases
= To protect your repository metadata (such as measure definitions)

s To prevent individual users from hurting overall system performance
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Oracle Business Intelligence supports three types of data security: row-level security,
object permissions, and query limits (governors). Object permissions and query limits
are set up in the repository and are enforced only by the Oracle BI Server. Row-level
data security, however, can be implemented and enforced in both the repository, and in

the database.

Even if you choose to implement row-level security in the database, you should still
set up object permissions and query limits in the repository. Although it is possible to
provide database-level object restrictions on individual tables or columns, objects to
which users do not have access are still visible in all clients, even though queries
against them will fail. It is better to set up object permissions in the repository, so that
objects to which users do not have access are hidden in all clients.

Because a variety of clients can connect to the Oracle BI Server, you cannot implement
or enforce data security in Oracle BI Presentation Services. Oracle BI Presentation
Services provides an extensive set of security controls that let you set up privileges to
access functionality in the Oracle Business Intelligence user interface, as well as
dashboards and analyses objects. However, Oracle BI Presentation Services does not
provide data access security. If you only implement security controls in Oracle BI
Presentation Services, you will be exposed to SQL injection hacker attacks and other
security vulnerabilities. You must provide object-level security in the repository to
create rules that apply to all incoming clients.

See Oracle Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition for more information about the security controls available in Oracle

BI Presentation Services.

Where Do | Find Information About Security Tasks?

Oracle Business Intelligence security tasks are covered in this guide, in Oracle Fusion
Middleware Security Guide for Oracle Business Intelligence Enterprise Edition, and in other
sources. Table 13-1 summarizes the Oracle Business Intelligence security tasks and
where to go for more information.

Table 13-1

Security Tasks in Oracle Business Intelligence

Task

Location

Setting up user
authentication with the
default identity store or an
alternative identity store

"Managing Authentication" in Oracle Fusion Middleware Security
Guide for Oracle Business Intelligence Enterprise Edition

Creating and managing
users and groups in the
default identity store

"Managing Users and Groups in the Default Identity Store" in
Oracle Fusion Middleware Security Guide for Oracle Business
Intelligence Enterprise Edition

Managing additional user
attributes in the
Administration Tool

"Working with Users in the Repository File" in Oracle Fusion
Middleware Security Guide for Oracle Business Intelligence
Enterprise Edition

Creating application roles
and managing policies in
the default policy store

"Managing the Domain Policy Store" in Oracle Fusion Middleware
Application Security Guide

Managing system
credentials in the credential
store

"Managing System Credentials" in Oracle Fusion Middleware
Security Guide for Oracle Business Intelligence Enterprise Edition

Applying data access
security in offline mode and
setting up placeholder
application roles

"About Applying Data Access Security in Offline Mode"
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Table 13-1 (Cont.) Security Tasks in Oracle Business Intelligence

Task

Location

Setting up row-level data
security

"Setting Up Row-Level Security"

Setting repository object
permissions

"Setting Up Object Permissions"

Setting query limits
(governors)

"Setting Query Limits"

Setting up single sign-on

(SSO)

"Enabling SSO Authentication" in Oracle Fusion Middleware
Security Guide for Oracle Business Intelligence Enterprise Edition

Enabling SSL
communication

"SSL Configuration in Oracle Business Intelligence" in Oracle
Fusion Middleware Security Guide for Oracle Business Intelligence
Enterprise Edition

Managing custom

"Authenticating by Using a Custom Authenticator Plug-In" in

authenticators Oracle Fusion Middleware Security Guide for Oracle Business

Intelligence Enterprise Edition

Setting Up Row-Level Security

You can choose to set up row-level security in the repository, or in the database.
Implementing row-level security in the repository provides many benefits, including
the following:

= All users share the same database connection pool for better performance
= All users share cache for better performance

= You can define and maintain security rules that apply across many federated data
sources

Implementing row-level security in the database, in contrast, is good for situations
where multiple applications share the same database. Note that even when you design
and implement row-level security in the database, you should still define and apply
object permissions in the repository.

Although it is possible to set up row-level security in both the repository and in the
database, you typically do not enforce row-level security in both places unless you
have a particular need to do so.

This section contains the following topics:
= Setting Up Row-Level Security (Data Filters) in the Repository
= Setting Up Row-Level Security in the Database

Setting Up Row-Level Security (Data Filters) in the Repository

Data filters are a security feature that provide a way to enforce row-level security rules
in the repository. Data filters are set up in the repository using the Administration Tool
and are applied for a particular application role. You typically do not set up data filters
if you have implemented row-level security in the database, because in this case, your
row-level security policies are being enforced by the database rather than the Oracle BI
Server.

Data filters can be set for objects in both the Business Model and Mapping layer and
the Presentation layer. Applying a filter on a logical object impacts all Presentation
layer objects that use the object. If you set a filter on a Presentation layer object, it is
applied in addition to any filters that might be set on the underlying logical objects.

Applying Data Access Security to Repository Objects 13-3



Setting Up Row-Level Security

Figure 13-1 illustrates how data filter rules are enforced in the Oracle BI Server. The
security rules are applied to all incoming clients and cannot be breached, even when
the Logical SQL query is modified.

In this example, a filter has been applied to an application role. When Anne Green,
who is a member of that role, sends a request, the return results are limited based on
the filter. Because no filters have been applied to the application roles for the
Administrator user, all results are returned. The Oracle BI Server-generated SQL takes
into account any data filters that have been defined.

Figure 13-1 Row-Level Security Enforcement in the Oracle Bl Server
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You should always set up data filters for particular application roles rather than for
individual users.

To set up data filters to apply row-level authorization rules for queries:

1. Open your repository in the Administration Tool.

2. Select Manage, then select Identity.

3. In the Security Manager dialog, in the tree pane, select BI Repository.

4

In the right pane, select the Application Roles tab, then double-click the
application role for which you want to set data filters.

Note that if you are in offline mode, no application roles appear in the list unless
you have first modified them in online mode. See "About Applying Data Access
Security in Offline Mode" for more information.

5. In the Application Role dialog, click Permissions.
6. In the User/Application Role Permissions dialog, click the Data Filters tab.

To create filters, you first add objects on which you want to apply the filters. Then,
you provide the filter expression information for the individual objects.

7. To add objects on which you want to apply filters, perform one of the following
steps:
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10.

s Click the Add button. Then, browse to locate the object you want, select it, and
then click Select.

s Click the Name field for an empty row. Then, browse to locate the object you
want, select it, and then click Select.

To enter the filter expression for individual objects, perform one of the following
steps:

»  Select the data filter, then click the Expression Builder button. Create the filter
expression in Expression Builder, then click OK.

»  Click the Data Filter field for the appropriate filter, then type the filter
expression.

For example, you might want to define a filter like "Sample Sales"."D2
Market"."MOO Mkt Key" > 5 to restrict results based on a range of values for
another column in the table.

You can also use repository and session variables in filter definitions. Use
Expression Builder to include these variables to ensure the correct syntax.

Optionally, select a status for each filter from the Status list. You can choose one of
the following options:

s Enabled: The filter is applied to any query that accesses the object.

s Disabled: The filter is not used and no other filters applied to the object at
higher levels of precedence (for example, through an application role) are
used.

s Ignored: The filter is not in use, but any other filters applied to the object (for
example, through a different application role) are used. If no other filters are
enabled, no filtering occurs.

In addition to defining new filters, you can perform other operations in the Data
Filters tab. Table 13-2 lists and describes the other buttons and options.

Table 13-2 Data Filters Tab: Buttons and Options

Option Name Description

Subject Area Select a subject area to only view data filters for that individual
subject area, or select All to view all filters.

Total Filters Lists the total number of data filters that have been defined for
this particular user or application role.

Add Click Add to open the Browse dialog to add objects on which
you want to apply data filters.

Delete Select a row and click Delete to remove a filter.

Browse Select a row and click Browse to change the object on which the

filter is applied.

Edit Expression (Expression
Builder)

Select a row and click Edit Expression to add or change a filter
expression for a particular object. You must first add an object
before you can apply a filter expression to the row.
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Table 13-2 (Cont.) Data Filters Tab: Buttons and Options

Option Name Description

Find Enter text in the Find field and click Find Down or Find Up to

find a particular string.
Ifac:ts & f}

11. Click OK, then click OK again to return to the Security Manager.

Setting Up Row-Level Security in the Database

To set up Oracle Business Intelligence for row-level security that has been
implemented in the database, you can configure your connection pools so that the
Oracle BI Server passes the credentials for each user to the database. The database then
uses the credentials to apply its own row-level security rules to user queries.

Note that the row-level database security described in this section is different from
database authentication, a topic discussed in Oracle Fusion Middleware Security Guide for
Oracle Business Intelligence Enterprise Edition. Rather, row-level database security
provides database authorization. In other words, it applies access security to particular
rows in the database.

Figure 13-2 illustrates how row-level security is enforced in the database for Oracle
Business Intelligence queries. The security rules are applied to all incoming clients and
cannot be breached, even when the Logical SQL query is modified. In this example,
the results returned are different depending on which user generated the query, even
though the SQL query generated by the Oracle Bl Server is the same. The returned
results are based on rules created and enforced in the database.

Figure 13-2 Row-Level Security Enforcement in the Database

Dashboard Requestto Oracle Bl Server-Generated Result
Oracle Bl Server SQL to Data Source
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In addition to setting up Oracle Business Intelligence for row-level security in the
database, you must define your set of users, permissions, and security policies in the
database itself. Refer to your database documentation for more information.

13-6 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition




Setting Up Object Permissions

To set up Oracle Business Intelligence for row-level access security in the database:
1. Open your repository in the Administration Tool.

2. Double-click the connection pool associated with the database for which you want
to set up database-level security.

3. In the General tab of the Connection Pool dialog, select Shared logon, and then
enter : USER and : PASSWORD in the User name and Password fields. The :USER
and :PASSWORD syntax automatically passes the value of user credentials upon
login to the database. Note that the : USER and : PASSWORD syntax does not refer
to session variables.

Figure 13-3 shows the General tab of the Connection Pool dialog.

Figure 13-3 Entering Credentials for Database-Level Security in the Connection Pool
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Data source name: |DHEL
[¥ Shared logon
Llzer name: I:USEH FPazsword: I *********

[ Enable conmection poaling

Timeout: | IInfinite j

Note: Alternatively, you can use the database session context to pass
end user identity to the database. Use a connection pool script to set
up session context. Note that this approach does not rely on database
authentication.

4. Click OK in the Connection Pool dialog.

5. Double-click the database object for which you want to set up database-level
security.

6. In the Database dialog, select Virtual Private Database. Selecting this option
ensures that the Oracle BI Server protects cache entries for each user.

7. Click OK in the Database dialog.

After you have set up row-level security in the database, you still need to set up object
permissions in the repository for Presentation layer or other objects. You can also set
query limits (governors). See "Setting Up Object Permissions” and "Setting Query
Limits" for more information.

Setting Up Object Permissions

You can set up object permissions in your repository to control access to Presentation
layer and Business Model and Mapping layer objects. You set object permissions using
the Administration Tool. There are two approaches to setting object permissions: you
can set permissions for particular application roles in the Security Manager, or you can
set permissions for individual objects in the Presentation layer.
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This section explains how to set up object permissions for application roles in the
Security Manager. See "Setting Permissions for Presentation Layer Objects" for
information about setting object permissions for individual Presentation layer objects.

Setting up object permissions for particular application roles is useful when you want
to define permissions for a large set of objects at one time. You should always set up
object permissions for particular application roles rather than for individual users.

Figure 13-4 shows how object permissions restrict what users can see. The security
rules are applied to all incoming clients and cannot be breached, even when the
Logical SQL query is modified. In this example, an application role to which the
Administrator belongs has been granted access to the Booked Amount column, so the
Administrator can view the returned results. The user Anne Green is not a member of
an application role with access to this object and cannot see the column in the Subject
Area pane in Answers. Even if the request SQL is modified, results are not returned
for this column because of the application role-based object permissions that have
been set.

Figure 13-4 Object Permission Enforcement in the Oracle Bl Server

RequestCreation Answers Requestto Oracle Bl Server Result

User = ‘Administrator’

E/Subject Areas @ W
SELECT
= @ sample Sales Reduced Facte . "Tnt - ; Total” saw O
= [QFacts ;ac:_ — Lvontory & O__:E: saw_Y. Inventory Total Booked Amount
M- Inventory Total I:ac ts."Booked BEmount I saw_1 41627445 24,903,044
. n . . n
3 Booked Amount FRCM “Sample Sales Reduced

User= ‘Anne Green’

ElSubject Areas @ W~ SELECT
E @ Samgle Sales Reduced Facts."”Inventory Total” saw 0 D nernioey Toi?%
= - 41
2 [OFacts FROM "Sample Sales Reduced"
! Inventory Total

Issue SQL © Error
SELECT ) e
Enter a SQL statement to issue ¢ Facta “Ipventory Total” saw O, Odbe driver retumed an error (SQLExecDirectiy),
. = B Error Detais
I?ac:s . "Booked Zmount "I saw_1 ...,e..._ELr_wL%_hggr

FROM “Sample Sales Reduced"

Note the following:

= If an application role is granted or disallowed permissions on an object from
multiple sources (for example, explicitly and through one or more additional
application roles), the permissions are applied based on the order of precedence.

= If you explicitly deny access to an object that has child objects, users who are
members of the individual application role are denied access to the child objects.
For example, if you explicitly deny access to a particular logical table, you are
implicitly denying access to all of the logical columns associated with that table.

= Object permissions do not apply to repository and session variables, so values in
these variables are not secure. Anybody who knows or can guess the name of the
variable can use it in an expression in Answers or in a Logical SQL query. Because
of this, do not put sensitive data like passwords in session or repository variables.

To set up object permissions for individual application roles:
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1. Open your repository in the Administration Tool.
Select Manage, then select Identity.
In the Security Manager dialog, in the tree pane, select BI Repository.

P w N

In the right pane, select the Application Roles tab, then double-click the
application role for which you want to set object permissions.

Note that if you are in offline mode, no application roles appear in the list unless
you have first modified them in online mode. See "About Applying Data Access
Security in Offline Mode" for more information.

5. In the Application Role dialog, click Permissions.

6. In the User/Application Role Permissions dialog, in the Object Permissions tab,
select an object by performing one of the following steps:

s Click the Add button. Then, browse to locate the object you want, select it, and
then click Select.

s Click the Name field for an empty row. Then, browse to locate the object you
want, select it, and then click Select.

7. Assign the appropriate permission for each object. You can choose one of the
following options:

= Read: Only allows read access to this object.
= Read/Write: Provides both read and write access to this object.
= No Access: Explicitly denies all access to this object.

8. (Click OK, then click OK again to return to the Security Manager.

About Permission Inheritance for Users and Application Roles

Users can have explicitly granted permissions. They can also have permissions
granted through membership in application roles, that in turn can have permissions
granted through membership in other application roles, and so on. Permissions
granted explicitly to a user have precedence over permissions granted through
application roles, and permissions granted explicitly to the application role take
precedence over any permissions granted through other application roles.

If there are multiple application roles acting on a user or application role at the same
level with conflicting security attributes, the user or application role is granted the
least restrictive security attribute. Any explicit permissions acting on a user take
precedence over any permissions on the same objects granted to that user through
application roles.

Filter definitions, however, are always inherited. For example, if User1 is a member of
Rolel and Role2, and Rolel includes a filter definition but Role2 does not, the user
inherits the filter definition defined in Rolel.

Note that you should always define object permissions for application roles rather
than for individual users.

Example 13—-1 Permission Inheritance 1

You might have a user (Userl) who is explicitly granted permission to read a given
table (TableA). Suppose also that User1 is a member of Rolel, and Rolel explicitly
denies access to TableA. The resultant permission for User1 is to read TableA, as
shown in Figure 13-5.
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Because permissions granted directly to the user take precedence over those granted
through application roles, User] has the permission to read TableA.

Figure 13-5 User Permissions and Application Role Permissions

User1

READ for TableA
Member of Role1

Role1

NO ACCESS for
TableA

Example 13-2 Permission Inheritance 2

Consider the situation shown in Figure 13-6.

Figure 13-6 Permissions Example

User1

Member of Role
Member of Role2

Role1 Role2
NO ACCESS for TableA READ for TableA
Member of Role3 Member of RoleS
Member of Roled

Role3 Roled Roleb

READ for TableB READ for TableC NO ACCESS for TableA

These are the resulting permissions:

s Userl is a direct member of Rolel and Role2, and is an indirect member of Role3,
Role4, and Roleb.

= Because Role5 is at a lower level of precedence than Role2, its denial of access to
TableA is overridden by the READ permission granted through Role2. The result is
that Role2 provides READ permission on TableA.

s The resultant permissions from Rolel are NO ACCESS for TableA, READ for
TableB, and READ for TableC.

= Because Rolel and Role2 have the same level of precedence and because the
permissions in each cancel the other out (Rolel denies access to TableA, Role2
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allows access to TableA), the less restrictive level is inherited by User1. In other
words, Userl has READ access to TableA.

= The total permissions granted to Userl are READ access for TableA, TableB, and
TableC.

Setting Query Limits

You can manage the query environment by setting query limits (governors) in the
repository for particular application roles. You can limit queries by the number of rows
received, by maximum run time, and by restricting to particular time periods. You can
also allow or disallow direct database requests or the Populate privilege.

You should always set query limits for particular application roles rather than for
individual users.

This section contains the following topics:
= Accessing the Query Limits Functionality in the Administration Tool
» Limiting Queries By the Number of Rows Received

» Limiting Queries By Maximum Run Time and Restricting to Particular Time
Periods

=  Allowing or Disallowing Direct Database Requests

= Allowing or Disallowing the Populate Privilege

Accessing the Query Limits Functionality in the Administration Tool

Follow the steps in this section to access the Query Limits tab of the User/Application
Role Permissions dialog.

To access the query limits functionality in the Administration Tool for a particular
application role:

1. Open your repository in the Administration Tool.

2. Select Manage, then select Identity.

3. In the Security Manager dialog, in the tree pane, select BI Repository.
4

In the right pane, select the Application Roles tab, then double-click the
application role for which you want to set query limits.

Note that if you are in offline mode, no application roles appear in the list unless
you have first modified them in online mode. See "About Applying Data Access
Security in Offline Mode" for more information.

5. In the Application Role dialog, click Permissions.

6. In the User/Application Role Permissions dialog, click the Query Limits tab.

Limiting Queries By the Number of Rows Received

You can control runaway queries by limiting queries to a specific number of rows.
To limit queries by the number of rows received:

1. Follow the steps in "Accessing the Query Limits Functionality in the
Administration Tool" to access the Query Limits tab.
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In the Max Rows column, type the maximum number of rows for users to retrieve
from each source database object.

In the Status Max Rows field, select one of the following options for each
database:

s Enable: This limits the number of rows to the value specified. If the number of
rows exceeds the Max Rows value, the query is terminated.

= Disable: Disables any limits set in the Max Rows field.

= Warn: Does not enforce limits, but logs queries that exceed the set limit in the
Query log.

s Ignore: Limits are inherited from the parent application role. If there is no row
limit to inherit, no limit is enforced.

Click OK, then click OK again to return to the Security Manager.

Limiting Queries By Maximum Run Time and Restricting to Particular Time Periods

You can forbid queries during certain time periods, or you can specify the maximum
time a query can run on a database.

If you do not select a particular time period, access rights remain unchanged. If you
allow or disallow access explicitly in one or more application roles, users are granted
the least restrictive access for the defined time periods. For example, if a user is a
member of an application role that is explicitly allowed access all day on Mondays, but
that user also belongs to another application role that is disallowed access during all
hours of every day, then the user has access on Mondays only.

To limit queries by maximum run time, or restrict queries to particular time periods:

1.

Follow the steps in "Accessing the Query Limits Functionality in the
Administration Tool" to access the Query Limits tab.

To specify the maximum time a query can run on a database, in the Max Time
(Minutes) column, enter the maximum number of minutes you want queries to
run on each database object. Then, in the Status Max Time field, select one of the
following options for each database:

= Enable: This limits the time to the value specified.
= Disable: Disables any limits set in the Max Time field.

= Warn: Does not enforce limits, but logs queries that exceed the set time limit in
the Query log.

s Ignore: Limits are inherited from the parent application role. If there is no
time limit to inherit, no limit is enforced.

To restrict access to a database during particular time periods, in the Restrict
column, click the Ellipsis button. Then, in the Restrictions dialog, perform the
following steps:

a. To select a time period, click the start time and drag to the end time.
b. To explicitly grant access, click Allow.

c. To explicitly deny access, click Disallow.

d. Click OK.

Click OK, then click OK again to return to the Security Manager.
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Allowing or Disallowing Direct Database Requests

You can allow or disallow the ability to execute direct database requests for a
particular application role. For the selected role, this privilege overrides the property
Allow direct database requests by default for the database object in the Physical
layer.

To set the ability to execute direct database requests:

1. Follow the steps in "Accessing the Query Limits Functionality in the
Administration Tool" to access the Query Limits tab.

2. For each database object, in the Execute Direct Database Requests field, select one
of the following options:

= Allow: Explicitly grants the ability to execute direct database requests for this
database.

= Disallow: Explicitly denies the ability to execute direct database requests for
this database.

= Ignore: Limits are inherited from the parent application role. If there is no
limit to inherit, then direct database requests are allowed or disallowed based
on the property Allow direct database requests by default for the database
object.

3. (Click OK, then click OK again to return to the Security Manager.

Allowing or Disallowing the Populate Privilege

When a criteria block is cached, the Populate stored procedure writes the
Cache/Saved Result Set value to the database. You can grant or deny this privilege to
particular application roles. For the selected application role, this privilege overrides
the property Allow populate queries by default for the database object in the Physical
layer.

Any Oracle Marketing Segmentation user who writes a cache entry or saves a result
set must be a member of an application role that has been assigned the POPULATE
privilege for the target database. For more information about marketing cache, see the
topic about setting up cache for target levels in the documentation for the Oracle
Marketing Segmentation application.

To allow or disallow the Populate privilege:

1. Follow the steps in "Accessing the Query Limits Functionality in the
Administration Tool" to access the Query Limits tab.

2. For each database object, in the Populate Privilege field, select one of the
following options:

= Allow: Explicitly grants the Populate privilege for this database. For all
Marketing data warehouses, select Allow.

= Disallow: Explicitly denies the Populate privilege for this database.

s Ignore: Limits are inherited from the parent application role. If there is no
limit to inherit, then the Populate privilege is allowed or disallowed based on
the property Allow populate queries by default for the database object.

3. (Click OK, then click OK again to return to the Security Manager.
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About Applying Data Access Security in Offline Mode

It is strongly recommended that you perform data access security tasks in the
Administration Tool in online mode. If you must apply data access security in offline
mode, be aware that users and application roles do not appear in the Administration
Tool in offline mode unless you have first modified them in the Administration Tool in

online mode.

For example, if you open the Administration Tool in offline mode without first making
any changes in online mode, you will see zero users and application roles defined.
However, if you first modify the users and application roles in online mode (for
example, applying object permissions or setting query limits), they will subsequently

be available in the Administration Tool in offline mode.

Setting Up Placeholder Application Roles for Offline Repository Development

Application roles are created and managed in the policy store using the Oracle
WebLogic Administration Console and Fusion Middleware Control. These application
roles are displayed in the Administration Tool in online mode so that you can use
them to set data filters, object permissions, and query limits for particular roles. The
application roles in the policy store are retrieved by the Oracle BI Server when it starts.

In some cases, you may want to proceed with setting up data access security in your
repository for application roles that have not yet been defined in the policy store. You
can do this by creating placeholder application roles in the Administration Tool, then

proceeding with setting up data access security in the repository.

If you create placeholder application roles in the Administration Tool, you must
eventually add them to the policy store. Run the Consistency Checker to identify
application roles that have been defined in the Administration Tool, but that have not
yet been added to the policy store. Be sure to use the same name in the policy store

that you used for the placeholder role in the Administration Tool.

Note: Use caution when defining and using placeholder roles. If
make changes to a role in offline mode that also exists in the policy
store, the changes will be overwritten the next time you connect to the

Oracle BI Server.

To create placeholder application roles in the Administration Tool:
1. Open your repository in the Administration Tool.

2. Select Manage, then select Identity.

3. In the Security Manager dialog, select Action > New > Application Role.
4, In the Application Role dialog, provide the following information:

s Name: Provide a name for the role.

s Description: Optionally, provide a description of this application role.

s Members: Use the Add and Remove buttons to add or remove users and

other application roles as appropriate.

s Permissions: Set object permissions, data filters, and query limits for this
application role as appropriate. Refer to the other sections in this chapter for

detailed information.

5. Click OK to return to the Security Manager.
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To check for application roles that need to be added to the policy store:
1. Open your repository in online mode in the Administration Tool.
2. Select File, then select Check Global Consistency.

3. Note any entries related to application roles, then add the appropriate roles to the
policy store as appropriate. See Oracle Fusion Middleware Security Guide for Oracle
Business Intelligence Enterprise Edition for information about adding application
roles to the policy store.

4. Optionally, select individual rows and click Copy to copy the entries to a text file.

Alternatively, you can check an individual application role by right-clicking the
application role in the Security Manager dialog and then selecting Check Consistency.
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Completing Oracle Bl Repository Setup

After you have created the repository file, the Physical layer, Business Model and
Mapping layer, and Presentation layer, you need to perform several tasks to complete
the initial repository setup. These tasks include saving the repository and checking
consistency, adding an entry in NQSConfig.INI, and creating data source connections
to the Oracle BI Server for client applications. This chapter provides information about
these final setup tasks.

This chapter contains the following topics:

= Saving the Repository and Checking Consistency

s Testing and Refining the Repository

= Making the Repository Available for Queries

»  Creating Data Source Connections to the Oracle Bl Server for Client Applications

»  Publishing to the User Community

Saving the Repository and Checking Consistency

In offline editing, remember to save your repository from time to time. You can save a
repository in offline mode even though the business models may be inconsistent.

To determine if business models are consistent, use the Check Consistency command
to check for compilation errors. You can check for errors in the whole repository by
choosing File > Check Global Consistency, or in a particular logical business model
by selecting a business model and then selecting Check Consistency from the
right-click menu.

The consistency check analyzes the repository for certain kinds of errors and
inconsistencies. For example, the consistency check finds any logical tables that do not
have logical sources configured or any logical columns that are not mapped to
physical sources, checks for undefined logical join conditions, determines whether any
physical tables referenced in a business model are not joined to the other tables
referenced in the business model, and checks for existence of a subject area for each
business model.

Note: Passing a consistency check does not guarantee that a business
model is constructed correctly, but it does rule out many common
problems.

When you check for consistency, any errors or warnings that occur are displayed in a
dialog. Correct any errors and check for consistency again, repeating this process until
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there are no more errors. An error message indicates a problem that must be corrected.
A warning message identifies a possible problem. Refer to "Checking the Consistency
of a Repository or a Business Model" for more information.

After upgrading from a previous software version and checking the consistency of
your repository, you might observe messages that you had not received in previous
consistency checks. This typically indicates inconsistencies that had been undetected
before the upgrade, not new errors.

Testing and Refining the Repository

When your repository is complete, you can run sample queries against it to test that it
is created properly. Correct any problems you find and test again, repeating this
process until you are satisfied with the results.

You can use the Oracle BI Server utilities nqcmd and NQClient to run test queries
against the repository. Both utilities connect using an Oracle BI Server ODBC DSN.
The Oracle BI Server must be running to use these utilities.

The nqcmd utility is available on both Windows and UNIX systems. The NQClient
utility is only available on Windows.

These utilities are intended for sanity testing. For heavier load testing, use Answers or
another client. Queries with many thousands of rows will not work with these clients.

Although you can use nqcmd and NQClient to run queries against other ODBC data
sources, this section only describes how to use these utilities to query the Oracle BI
Server.

This section contains the following topics:
= Using nqemd to Run Sample Queries

= Using NQClient to Run Sample Queries

Using nqgecmd to Run Sample Queries

Before running nqemd, you must first run bi-init.cmd (or bi-init.sh on UNIX) to launch
a command prompt or shell window that is initialized to your Oracle instance. You can
find this utility in:

ORACLE_INSTANCE /bifoundation/OracleBlApplication/coreapplication/setup

Then, run nqemd from the resulting shell window with the desired options. For
example:

ngcemd -dmy_dsn -umy_username [-pmy_password] -ssqgl_input_file -omy_result_file
You can pass a text file with SQL statements to the utility (script mode), or you can

enter SQL at the command line (interactive mode). Queries are run against the default
subject area, unless the object names used in the query are fully qualified.

Table 141 lists the command-line arguments for nqecmd.

Table 14-1 Command-line Arguments for nqgcmd

Argument Description

-? Lists the available command-line arguments.
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Table 14-1 (Cont.) Command-line Arguments for nqcmd

Argument

Description

-ddata_source_name

The ODBC data source name for the Oracle BI Server to which
you want to connect.

If you omit this parameter, you are prompted at the command
line to enter the DSN.

Tip: On Windows, you can see the available local ODBC data
source names by going to Control Panel > Administrative
Tools > Data Sources (ODBC). Click the System DSN tab to
see a list of the available DSNs (for example, AnalyticsWeb_
coreapplication).

-uuser_narme

A valid Oracle Business Intelligence user name.

-ppassword

The corresponding Oracle Business Intelligence user
password.

The password argument is optional. If you do not provide a
password argument, you are prompted to enter a password
when you run the command. To minimize the risk of security
breaches, Oracle recommends that you do not provide a
password argument either on the command line or in scripts.
Note that the password argument is supported for backward
compatibility only, and will be removed in a future release.

-ssql_input_file_name

The name and path of a text file that includes your test SQL
queries.

-ooutput_result_file_name

The name and path of a file to which the utility will write the
query results. This option is only used with -s.

-Ddelimiter

The delimiter used in the SQL input file (for example,
semicolon (;) or colon (:)). This option is only used with -s.

-a

Enables asynchronous processing.

This option is typically used with -s, when you are passing a
SQL input file with multiple SQL statements.

-Z

Enables UTFS output instead of ACP in the output result file.

You might need to include this option to display international
characters in query results.

-utflé

Enables UTF16 instead of ACP for communication between
ngemd and the Oracle BI ODBC driver.

You might need to include this option to display international
characters in query results.

-NotForwardCursor

Disables the ODBC forward only cursor.

Including this argument overrides the setting specified in the
ODBC DSN.

-V

Displays the version of the nqemd utility.

-SessionVar session_variable_
name=session_variable_value

Includes the specified session variable and sets it to the
specified value.

Although -C, -R, -, -H, -q, and -NoFetch are listed by the utility as available
arguments, these options are not typically used.

If you run nqemd in interactive mode rather than script mode (or in other words, if
you do not pass a SQL input file), nqemd shows a menu of options after you provide
the data source name and user credentials. Although many options are shown, you
typically only use Q, T, and C against the Oracle BI Server.
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Enter Q to type a query at the command line. You must enter the query on a single
line, and you cannot use a semicolon as a delimiter. Pressing Enter sends the SQL to
the Oracle BI Server.

Enter T to browse presentation tables, or C to browse presentation columns. The utility
prompts you for catalog pattern, user pattern, table pattern, and table type pattern
before returning results.

For catalog pattern, enter the subject area that contains the tables you want to see. For
table pattern, enter the specific table. You can enter percent (%) to see all subject areas
or all tables, use % with other characters to replace a set of characters, or use
underscore (_) with other characters to replace a single character.

User pattern and table type pattern are not used in queries against the Oracle Bl
Server, so enter % for these options.

You can also enter D to view a static list of data types supported by the Oracle BI
Server.

Using NQClient to Run Sample Queries

To run NQClient, choose Start > Programs > Oracle Business Intelligence > B ODBC
Client.

After you run the utility, select File, then select Open DataBase to connect to the
Oracle BI Server. Enter values as follows:

s DSN: The ODBC data source name for the Oracle BI Server to which you want to
connect.

You can see the available local ODBC data source names by going to Control
Panel > Administrative Tools > Data Sources (ODBC). Click the System DSN tab
to see a list of the available DSNs (for example, AnalyticsWeb_coreapplication).

= UID: A valid Oracle Business Intelligence user name.
= Password: The corresponding Oracle Business Intelligence user password.

= Database: The subject area to which you want to direct your queries (optional). If
you do not specify this parameter, queries are run against the default subject area
defined in either the DSN or in the repository.

Table 14-2 lists the additional options in NQClient.

Table 14-2 NQClient Options

Option Description

Utility menu: View Schema | Opens the DataBase Schema window to enable you to browse
Presentation layer objects and attributes.

Select a presentation table from DataBase Tables, then select a
presentation column from Columns in the Current Table.
Available attributes and values for the selected column are
displayed in the Attributes of the Current field.

Utility menu: SQL Query This option is not used.

List

Utility menu: Enter SQL Opens the SQL Statement Editor. Enter a SQL query and click
Query Execute. Results appear in the SQL Query Result grid.
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Table 14-2 (Cont.) NQClient Options

Option Description

File menu: Set Time-out Lets you enter a query timeout value to specify a timeout
period for long-running queries. Enter the number of seconds
and click OK.

You must set the timeout value before connecting to the Oracle
BI Server.

Making the Repository Available for Queries

After you build a repository and it is consistent, you need to upload the repository
using Fusion Middleware Control so that all Oracle BI Server instances can access it.
Uploading the repository allows the Oracle BI Server to load the repository into
memory upon startup and makes the repository available for queries.

See "Publishing the Default Metadata Repository" in Oracle Fusion Middleware System
Administrator’s Guide for Oracle Business Intelligence Enterprise Edition for information
about how to perform this task.

When the repository is uploaded and you can connect to it, run sample queries against
it to test that it is created properly. Correct any problems you find and test again,
repeating this process until you are satisfied with the results.

Creating Data Source Connections to the Oracle Bl Server for Client
Applications

If you want to enable end user client applications to connect to the new repository,
you must define an ODBC data source connection to the Oracle BI Server for each
application. Note that Oracle BI Presentation Services has the same relationship to the
Oracle BI Server as any other client application.

See "Integrating Other Clients with Oracle Business Intelligence" in Oracle Fusion
Middleware Integrator’s Guide for Oracle Business Intelligence Enterprise Edition for
information about creating ODBC data source connections for the Oracle BI Server.

Publishing to the User Community

After testing is complete, notify the user community that the data sources are available
for querying. Presentation Services users only need to know the URL to type in their
browser. Client/server users (for example, users accessing the Oracle Bl Server with a
query tool or report writer client application) need to know the subject area names, the
computer on which the server is running, and their user IDs and passwords. They also
need to have the ODBC DSN for the Oracle BI Server installed on their computers, and
they may need to know the logical names of repositories if multiple repositories are
used and the data source name (DSN) being created does not point to the default
repository.
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Setting Up Data Sources on Linux and UNIX

Most repository development is performed on Windows, because the Administration
Tool runs only on Windows. When you move to a production system, however, you
can choose to run the Oracle BI Server on a Linux or UNIX platform. This chapter
describes how to set up data sources for use with Oracle Business Intelligence when
the Oracle BI Server is running on Linux or UNIX.

See "System Requirements and Certification" for information about supported Linux
and UNIX platforms.

This chapter contains the following topics:

= About Setting Up Data Sources on Linux or UNIX

s Configuring Data Source Connections Using Native Gateways

= Using DataDirect Connect ODBC Drivers on Linux and UNIX

s Configuring Database Connections Using Native ODBC Drivers
s Configuring Oracle RPAS ODBC Data Sources on AIX UNIX

s Configuring Essbase Data Sources on Linux

s Configuring DB2 Connect on IBM z/OS and s/390 Platforms

About Setting Up Data Sources on Linux or UNIX

When the Oracle BI Server is running on Linux or UNIX, most data source connections
are for query-only access. The Administration Tool is used for importing objects and is
a Windows-only tool. Because of this, data source connections for import must be set
up on Windows.

Note that some data source connections on Linux and UNIX do support write
operations for special functions, like data source connections for write-back, usage
tracking, and annotations for Oracle Scorecard and Strategy Management.

When the Oracle BI Server is running on Linux or UNIX and you need to update
database object settings (such as the database type) or connection pool settings, you
can copy the repository file to a Windows computer, make the changes using the
Administration Tool on Windows, and then copy the repository file back to the Linux
or UNIX computer.

There are three types of data source connections on Linux and UNIX platforms:

= Native data source gateway connections, such as OCI for Oracle Database or DB2
CLI for IBM DB2
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s ODBC connections using the DataDirect Connect ODBC drivers that are bundled
with Oracle Business Intelligence

= Native ODBC connections using external drivers, such as for Teradata data
sources

Note that you cannot have a single repository that contains both DataDirect Connect
ODBC connections and native ODBC connections.

Configuring Data Source Connections Using Native Gateways

You can connect to both Oracle Database and DB2 using native gateways (OCI and
DB2 CLI, respectively). To configure these connections, install the appropriate
database client on the computer running the Oracle Bl Server, then edit the user.sh file
to set environment variables for the database client.

For Oracle Database, ensure the following:

s The computer running Oracle Business Intelligence must use the Oracle Call
Interface (OCI) to connect to the database.

= You must install the Oracle Database Client on the computer running the Oracle BI
Server to connect to an Oracle Database.

s In the tnsnames.ora file, the Oracle Database alias (the defined entry name) must
match the Data Source Name used in the repository connection pools of all
physical Oracle databases.

When connecting to an Oracle Database data source, you can include the entire
connect string, or you can use the net service name defined in the tnsnames.ora
file. If you choose to enter only the net service name, you must set up a
tnsnames.ora file in the following location within the Oracle Business Intelligence
environment, so that the Oracle Bl Server can locate the entry:

ORACLE_HOME /network/admin
You might need to create the admin directory, if it does not already exist.

Only certain versions of the Oracle Database Client are supported. See "System
Requirements and Certification" for more information.

To connect to Oracle Database or DB2 using native connections:

1. Open the user.sh file. You can find this file at:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/user.sh

2. Include the appropriate environment variable settings for the database client of
your choice. Make sure to point to the appropriate libraries, depending on

whether you are using a 32-bit or 64-bit database. See Example 15-1 for sample
values.

For an Oracle database using an OCI connection, establish the Web client before
you input the tnsnames entry.

3. Save and close the file.

Example 15-1 Sample user.sh Entries for Oracle Database and DB2 (32-Bit)

This example shows sample entries in user.sh for Oracle Database and DB2 on various
platforms.

S
# Linux: Oracle BI 32 bit mode
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BHEHH R R R R R R
#set +u

# Oracle Parameters

# Make sure that Oracle DB 32 bit Client is installed
#ORACLE_HOME=/export/home/oracle/10g

#export ORACLE_HOME
#TNS_ADMIN=$ORACLE_HOME/network/admin

#export TNS_ADMIN
#PATH=$ORACLE_HOME/bin:/opt/bin:SPATH

#export PATH

#LD_LIBRARY PATH=$ORACLE_HOME/lib:S$LD_LIBRARY PATH
#export LD_LIBRARY_PATH

# If you have Linux 64 bit Platform, and would like to run Oracle BI 32 bit

# then you must install Oracle DB 64 bit client, and this client comes with

# 32 bit libraries under $ORACLE_HOME/1ib32. The LD_LIBRARY PATH in this case
# shall be like this:

#LD_LIBRARY PATH=$ORACLE_HOME/1ib32:$LD_LIBRARY_ PATH

#export LD_LIBRARY_PATH

# DB2 Parameters

#make sure the /DB2ISTANCE/sqgllib/lib points to 32 lib file
#. /DB2ISTANCE/sgllib/db2profile

FhEF R R R
# Solaris: Oracle BI 64 bit mode

BHEHH R R R R
#set +u

# Oracle Parameters

# Make sure to install Oracle DB 64 bit Client
#ORACLE_HOME=/export/home/oracle/10g

#export ORACLE_HOME

#TNS_ADMIN=$ORACLE_HOME/network/admin

#export TNS_ADMIN

#PATH=$ORACLE_HOME/bin:/opt/bin: $PATH

#export PATH

#LD_LIBRARY PATH 64=$ORACLE_HOME/lib:$LD_LIBRARY PATH 64:/opt/j2se/jre/lib/sparc
#export LD_LIBRARY_PATH 64

#make sure the /DB2ISTANCE/sqgllib/lib points to 64 lib file

#. /DB2ISTANCE/sgllib/db2profile
#LD_LIBRARY_PATH_64=/DB2ISTANCE/sqllib/1lib:$LD_LIBRARY_ PATH_64
#export LD_LIBRARY_PATH_64

R
# HPUX Itanium: Oracle BI 64 bit mode

B R R R R R R R R
#set +u

# Oracle Parameters
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#ORACLE_HOME=/export/home/oracle/10g

#export ORACLE_HOME

#TNS_ADMIN=$SORACLE_HOME/network/admin

#export TNS_ADMIN

#PATH=$ORACLE_HOME/bin:/opt/bin:$SPATH

#export PATH

#SHLIB_PATH=$ORACLE_HOME/lib:$SHLIB_PATH: /opt/j2se/jre/lib/hp700
#export SHLIB_PATH

#make sure the /DB2ISTANCE/sqllib/lib points to 64 1lib file
#. /DB2ISTANCE/sgllib/db2profile
#SHLIB_PATH=/DB2ISTANCE/sqllib/lib:$SHLIB_PATH

#export SHLIB_PATH

FhEF R R R
# AIX: Oracle BI 64 bit mode
S A
#set +u

# Oracle Parameters

#ORACLE_HOME=/export/home/oracle/10g

#export ORACLE_HOME

#TNS_ADMIN=$ORACLE_HOME/network/admin

#export TNS_ADMIN

#PATH=$ORACLE_HOME/bin: /opt/bin: $PATH

#export PATH

#LIBPATH=$ORACLE_HOME/lib:$LIBPATH: /opt/j2se/jre/lib/sparc
#export LIBPATH

#make sure the /DB2ISTANCE/sqllib/lib points to 64 1lib file
#. /DB2ISTANCE/sqgllib/db2profile

Note that the shell script excerpts shown are examples only and are not
recommendations for particular software platforms. See "System Requirements and
Certification" for information about supported software platforms.

Troubleshooting OCI Connections

If you are having trouble connecting to an Oracle Database using OCI, check to ensure
that the following conditions are true:

s The computer running the Oracle BI Server must use Oracle Call Interface (OCI) to
connect to the database.

= If you choose not to use the entire connect string in the repository connection pool,
you must ensure that a valid tnsnames.ora file is set up in the following location
within the Oracle Business Intelligence environment, so that the Oracle BI Server
can locate the entry:

ORACLE_HOME /network/admin
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If you choose not to use the entire connect string in the repository connection pool,
ensure that the net service name in the tnsnames.ora file matches the Data Source
Name used in the connection pool.

For example, in the following example of a tnsnames.ora entry, the corresponding
Oracle BI repository connection pool Data Source Name is ITQAZ2.

ITOA2 =

(DESCRIPTION =

(ADDRESS_LIST =

(ADDRESS = (PROTOCOL = TCP) (HOST = ITQALAB2) (PORT = 1521))

(CONNECT_DATA =

(SERVICE_NAME = ITQALAB2.corp)

)
)

The following procedure shows how to check repository database and connection pool
settings against the Oracle tnsnames.ora settings.

To check that the repository database and connection pool settings are correct:

1.
2.

Open your repository in the Administration Tool.

In the Physical layer, double-click the database you want to check to display the
Database dialog.

On the General tab, in the Data source definition: Database field, ensure that the
appropriate Oracle Database version is selected. Then, click OK.

Open the Connection Pool dialog for this data source. You might need to expand
the database object in the Physical layer to see the Connection Pool object.

In the Connection Pool dialog, check that the following is true:

— The Call interface field displays the appropriate value for the release of the
Oracle Database you are using.

— The Data source name field displays the Oracle Database net service name
that you defined in the tnsnames.ora entry.

— The User name and password fields contain the correct values.
Change the values if necessary, then click OK.

In the Oracle Business Intelligence environment, open the tnsnames.ora file
located in the following directory:

ORACLE_HOME /network/admin
Check that a valid net service name exists with the following characteristics:
— Matches the connection pool settings for the Data Source Name

- Specifies the targeted Oracle physical database

About Updating Row Counts in Native Databases
This topic applies if both of the following are true:

You are using the Update Rowcount functionality in the Administration Tool in
offline mode

You are running a heterogeneous environment, such as the Oracle BI Server on
UNIX, while remote administrators run the Administration Tool on Windows
computers.
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When using the Update Rowcount functionality in offline mode, the Administration
Tool uses local data sources on the client computer, not the server data sources.
Therefore, Oracle Database or DB2 clients must be configured on the Windows
computer running the Administration Tool so that the following conditions are true:

= Data sources point to the same database identified in the Oracle Business
Intelligence user.sh file on the UNIX server.

s The name of the local data source must also match the name of the data source
defined in the Connection Pool object in the physical layer of the Oracle BI
repository (.rpd) file.

If these conditions are not true, and if the server and client data sources are pointing at
different databases, then erroneous updated row counts or incorrect results appear.

Using DataDirect Connect ODBC Drivers on Linux and UNIX

Oracle Business Intelligence provides DataDirect Connect ODBC drivers and driver
managers for Linux and UNIX operating systems for connectivity to Microsoft SQL
Server, Sybase ASE, and Informix databases.

After Oracle Business Intelligence is installed, the DataDirect Connect ODBC 32-bit
drivers are installed in ORACLE_HOME /odbc/lib. The 64-bit drivers are installed in
ORACLE_HOME /odbc/lib64.

Note that communication between database clients and servers is typically
independent of the widths and data paths. In other words, the 32-bit database drivers
can communicate with 64-bit database servers, and vice versa.

You do not need to set the ODBCINI environment variable to set up the DataDirect
Connect ODBC drivers. This variable is set automatically during installation.

Refer to "System Requirements and Certification" for information about supported
operating systems, databases, and driver versions for the DataDirect Connect ODBC
drivers.

This section contains the following topics:

= Configuring the DataDirect Connect ODBC Driver for Microsoft SQL Server
Database

= Configuring the DataDirect Connect ODBC Driver for Sybase ASE Database
s Configuring the DataDirect Connect ODBC Driver for Informix Database

Configuring the DataDirect Connect ODBC Driver for Microsoft SQL Server Database

The name of the DataDirect ODBC driver file to connect to a Microsoft SQL Server
database is SEmsss23.s0 (SEmsss23.s1 on HP-UX PA-RISC). See "System Requirements
and Certification" for supported versions of Microsoft SQL Server.

To configure the DataDirect Connect ODBC Driver to connect to Microsoft SQL
Server:

1. Open the user.sh file. You can find this file at:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/user.sh

2. In the section for your operating system, include the appropriate library path
environment variable for the DataDirect Connect libraries. Make sure to point to

the appropriate library, depending on whether you are using a 32-bit or 64-bit
database. Note the following:
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10.
11.
12.
13.
14.

s For Solaris and Linux, the library path variable is LD_LIBRARY_PATH.
s For HP-UX, the library path variable is SHLIB_PATH.

= For AIX, the library path variable is LIBPATH.

For example, to set the library path variable for the 32-bit driver on Linux:

FHEH R R R R R R R
# Linux: Oracle BI 32 bit mode
FhEH R

#SQLServer 2000 Parameters

LD_LIBRARY_ PATH=/user/local/OracleBI/odbc/lib:$ LD_LIBRARY_ PATH
export LD_LIBRARY_PATH

Save and close the file.
Open the odbc.ini file. You can find this file at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/odbc.ini

Create an entry for your database, ensuring that the ODBC connection name is
identical to the data source name specified in the connection pool defined in the
repository. Be sure to set the Driver parameter to the file name and location of the
DataDirect Connect driver for Microsoft SQL Server. In the following example, the
Driver parameter is set to the 64-bit DataDirect Connect driver, and the data
source name is SQLSERVER_DB.

[SQLSERVER_DB]
Driver=/usr/OracleBI/odbc/1lib64/SEmsss23.so
Description=DataDirect 5.1 SQL Server Wire Protocol
Address=111.111.111.111,1433
AlternateServers=

AnsiNPW=Yes

ConnectionRetryCount=0
ConnectionRetryDelay=3
Database=dbschema_name

LoadBalancing=0

LogonID=

Password=

QuoteID=No

ReportCodePageConversionErrors=0

Save and close the odbc.ini file.
Open your repository in the Administration Tool on a Windows computer.

In the Physical layer, double-click the database object for the Microsoft SQL Server
database.

Click the Features tab and scroll to the IDENTIFIER_QUOTE_CHAR parameter.
Then, replace the value for this parameter with ' ' (single quotes). The default
value is double quotes (" ").

Click OK.

Save and close the repository.

On the Linux or UNIX computer, shut down Oracle Business Intelligence.

Copy the repository from the Windows computer to the Linux or UNIX computer.

Start Oracle Business Intelligence on the Linux or UNIX computer.
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Configuring the DataDirect Connect ODBC Driver for Sybase ASE Database

The name of the DataDirect ODBC driver file to connect to a Sybase ASE database is
SEase23.s0. See "System Requirements and Certification" for information about
supported versions of Sybase ASE.

To configure the DataDirect Connect ODBC Driver to connect to Sybase ASE
Database:

1.

Open the user.sh file. You can find this file at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/user.sh

In the section for your operating system, include the appropriate library path
environment variable for the DataDirect Connect libraries. Make sure to point to
the appropriate library, depending on whether you are using a 32-bit or 64-bit
database. Note the following;:

s For Solaris and Linux, the library path variable is LD_LIBRARY_PATH.
»  For HP-UX, the library path variable is SHLIB_PATH.

»  For AIX, the library path variable is LIBPATH.

For example, to set the library path variable for the 32-bit driver on Linux:

LD_LIBRARY_PATH=/user/local/OracleBI/odbc/lib:$ LD_LIBRARY_ PATH
export LD_LIBRARY_PATH

Save and close the file.
Open the odbc.ini file. You can find this file at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/odbc.ini

Create an entry for your database, ensuring that the ODBC connection name is
identical to the data source name specified in the connection pool defined in the
repository. Be sure to set the Driver parameter to the file name and location of the
DataDirect Connect driver for Sybase ASE Database. For NetworkAddress,
provide the IP address or fully qualified host name and the port number.

In the following example, the Driver parameter is set to the 64-bit DataDirect
Connect driver, and the data source name is SybaseASE_DB.

[SybaseASE_DB]
Driver=/usr/OracleBI/odbc/1ib64/SEase23.so
Description=DataDirect 5.3 Sybase Wire Protocol
AlternateServers=

ApplicationName=

ApplicationUsingThreads=1

ArraySize=50

AuthenticationMethod=0

Charset=

ConnectionRetryCount=0
ConnectionRetryDelay=3

CursorCacheSize=1

Database=Paint

DefaultLongDataBufflLen=1024
EnableDescribeParam=0
EnableQuotedIdentifiers=0
EncryptionMethod=0

GSSClient=native

HostNameInCertificate=
InitializationString=
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Language=

LoadBalancing=0

LogonID=my_id
NetworkAddress=111.111.111.111,5005
OptimizePrepare=1

PacketSize=0

Password=
RaiseErrorPositionBehavior=0
ReportCodePageConversionErrors=0
SelectMethod=0
ServicePrincipalName=
TruncateTimeTypeFractions=0
TrustStore=

TrustStorePassword=
ValidateServerCertificate=1
WorkStationID=

Save and close the odbc.ini file.

Configuring the DataDirect Connect ODBC Driver for Informix Database

The name of the DataDirect ODBC driver file to connect to an Informix database is
SEifcl23.s0. See "System Requirements and Certification" for information about
supported versions of Informix.

To configure the DataDirect Connect ODBC Driver to connect to Informix:

1.

Open the user.sh file. You can find this file at:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/user.sh
In the section for your operating system, include the appropriate library path
environment variable for the DataDirect Connect libraries. Make sure to point to

the appropriate library, depending on whether you are using a 32-bit or 64-bit
database. Note the following;:

s For Solaris and Linux, the library path variable is LD_LIBRARY_PATH.
»  For HP-UX, the library path variable is SHLIB_PATH.

»  For AIX, the library path variable is LIBPATH.

For example, to set the library path variable for the 32-bit driver on Linux:

LD_LIBRARY_PATH=/user/local/OracleBI/odbc/lib:$ LD_LIBRARY_ PATH
export LD_LIBRARY_PATH

Save and close the file.
Open the odbc.ini file. You can find this file at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/odbc.ini

Create an entry for your database, ensuring that the ODBC connection name is
identical to the data source name specified in the connection pool defined in the
repository. Be sure to set the Driver parameter to the file name and location of the
DataDirect Connect driver for Informix. Also, you must specify the HostName
parameter (you can use the fully qualified host name or the IP address) and the
PortNumber parameter.

In the following example, the Driver parameter is set to the 64-bit DataDirect
Connect driver, and the data source name is Informix_DB.
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[Informix_DB]
Driver=/usr/OracleBI/odbc/1ib64/SEifcl23.s0
Description=DataDirect Informix Wire Protocol
AlternateServers=

ApplicationUsingThreads=1
CancelDetectInterval=0
ConnectionRetryCount=0
ConnectionRetryDelay=3

Database=

HostName=111.111.111.111

LoadBalancing=0

LogonID=informix

Password=mypassword

PortNumber=1526
ReportCodePageConversionErrors=0
ServerName=

TrimBlankFromIndexName=1

Save and close the odbc.ini file.

Configuring Database Connections Using Native ODBC Drivers

Oracle Business Intelligence bundles UNIX ODBC drivers for some data sources, but
not all. For these data sources, including Teradata, you must install your own ODBC
driver, then update the user.sh and odbc.ini files to configure the data source.

To configure a database connection using a native ODBC driver:

1.
2

Install the ODBC driver for your data source.

Open the user.sh file. You can find this file at:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/user.sh
In the section for your operating system, include the appropriate library path
environment variable for the native ODBC driver. Make sure to point to the

appropriate library, depending on whether you are using a 32-bit or 64-bit
database. Note the following:

=  For Solaris and Linux, the library path variable is LD_LIBRARY_PATH.
s For HP-UX, the library path variable is SHLIB_PATH.

»  For AIX, the library path variable is LIBPATH.

For example, to set the library path variable for Teradata on Linux:

LD_LIBRARY_ PATH=/usr/odbc/lib:/usr/lpp/tdodbc/odbe/drivers:$ LD_LIBRARY PATH
export LD_LIBRARY_PATH

Note that for Teradata in particular, you need to put /usr/odbc/lib at the
beginning of the library path variable before all other entries. This step is only
required for Teradata.

Save and close the file.

Open the odbc.ini file. You can find this file at:
ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/odbc.ini
Create an entry for your database, ensuring that the ODBC connection name is

identical to the data source name specified in the connection pool defined in the
repository. Be sure to set the Driver parameter to the file name and location of the
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native ODBC driver for your database, with the library suffix appropriate for your
operating system (for example, . so for Solaris and AIX, or . s1 for HP-UX).

The following example provides details for a Teradata data source on Solaris, with
a data source name of Terav502.

[Terav502]

Driver=/usr/odbc/drivers/tdata.so
Description=NCR 3600 running Teradata V2R5.2
DBCName=172.20.129.42

LastUser=

Username=

Password=

Database=

DefaultDatabase=name of_target_database or_user

Note that the DefaultDatabase parameter can be left empty only if you have
selected the option Require fully qualified table names in the General tab of the
Connection Pool dialog for this data source in the Administration Tool.

7. Still in the odbc.ini file, add an entry to the section [ODBC Data Sources] with the
details appropriate for your data source. The following example provides details
for a Teradata data source with a data source name of Terav502.

Terav502=tdata.so
8. Using the Administration Tool, open the repository and add the new DSN you

created as the Connection Pool Data source name for the appropriate physical
databases. See "Creating or Changing Connection Pools" for more information.

9. Restart the Oracle BI Server.

Configuring Oracle RPAS ODBC Data Sources on AIX UNIX

You can access Oracle RPAS ODBC data sources when the Oracle BI Server is running
on an AIX UNIX platform. To configure this database connection, first update the
odbc.ini file to configure the Oracle RPAS ODBC data source, then use the rdaadmin
tool to define dimension tables as not normalized at run time.

See "Setting Up Oracle RPAS Data Sources" for information about configuring Oracle
RPAS ODBC data sources on Windows.

To configure Oracle RPAS ODBC as a data source on AIX UNIX:
1. Log on as a separate telnet session.
2. Open the odbc.ini file. You can find this file at:

ORACLE_INSTANCE/bifoundation/OracleBIApplication/coreapplication/setup/odbc.ini

3. In the RPAS data source section, edit the values. For example:

[RPAS Sample]

Data Source Name=RPAS Sample

Driver=[client RPASClient/lib/raix/oaodbc.so
DriverUnicodeType=1

Description=0penRDA DSN

The Data Source Name you provide must match the value entered for

DATABASE: in Step 3 of the following procedure. Also, you must add the line
DriverUnicodeType=1 as shown in the preceding example.

Setting Up Data Sources on Linux and UNIX 15-11



Configuring Essbase Data Sources on Linux

To use the rdaadmin client tool to define dimension tables as not normalized at run
time:

1. Locate the rdaadmin client tool in the following location:
/bin/rdaadmin

2. Run the rdaadmin client tool by typing the following command:
rdaadmin

3. Enter appropriate text when prompted, as follows:
DATABASE: [Oracle RPAS_database_name]

The database name must match the name given for the Data Source Name in the
previous task (for example, RPAS Sample).

ADDRESS: [ip_address]

PORT: [port_number]

An example port number value is 1707.

CONNECT_STRING: [NORMALIZE_DIM TABLES=NO]

This value treats dimension tables as not normalized at run time.
TYPE: []

SCHEMA_PATH: []

REMARKS: []

4. The RPAS environment variable OPENRDA should be declared in the Oracle BI
Server session on UNIX. For example, declare the variable as follows using the 64
bit rdaadmin client tool:

OPENRDA_INI=/rpasclient64/config/raix/openrda.ini export OPENRDA_INI

Configuring Essbase Data Sources on Linux

The Oracle BI Server uses the Essbase client libraries to connect to Essbase data
sources. You must ensure that the Essbase client libraries are installed on the computer
running the Oracle BI Server before you can set up a connection to Essbase data
sources. See "System Requirements and Certification" for information about supported
versions of the Essbase Client for use with Oracle Business Intelligence.

After you install the Essbase client libraries, ensure that the PATH environment
variable includes the location of the Essbase client driver. For example, to configure
access to Essbase client libraries on Linux for Oracle BI 32-bit mode, add the Essbase
Client Libraries directory to LD_LIBRARY_PATH:

LD_LIBRARY_PATH=SLD_LIBRARY PATH:Essbase Client_Libraries_directory

For example:

LD_LIBRARY_ PATH=$LD_LIBRARY_PATH:/export/home/Hyperion/AnalyticServicesClient/bin
export LD_LIBRARY_PATH

You also need to ensure that an additional environment variable is set appropriately
(either ESSBASEPATH or ARBORPATH, depending on your client version). For more
information, see Oracle Hyperion Enterprise Performance Management System Installation
and Configuration Guide (or the equivalent title for your client version).
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Finally, you need to update opmn.xml with the appropriate Essbase client library
information. See "Updating Essbase Information in opmn.xml" for more information.

Configuring DB2 Connect on IBM z/OS and s/390 Platforms

IBM DB2 Connect does not support the option of automatically disconnecting when an
application using it receives an interrupt request.

When the native database uses DB2 Connect workstation, then you must change the
setting of the parameter INTERRUPT_ENABLED. This parameter must be changed on
any Oracle Business Intelligence computer if the database or any data source resides
on IBM DB2 on a mainframe running z/OS or s/390 platforms.

Note: If IBM DB2 is used, DB2 Connect must be installed on the
Oracle BI Server computer. The version of DB2 Connect must match
the most recent DB2 instance that was configured as a data source.

To configure the INTERRUPT_ENABLED parameter:

1. Configure a database alias to be used as the native CLI Data Source Name. For
example, create a new database entry using DB2 Configuration Assistant.

2. Using the database alias created and the name of the actual target DB2 database,
set the INTERRUPT_ENABLED parameter using the following syntax:

uncatalog dcs db local_dcsname
catalog dcs db local_dcsname as target_dbname parms \",, INTERRUPT_ENABLED\"

where:

- local_dcsname represents the local name of the host or database (database
alias name)

- target_dbname represents the name of database on the host or database
system

Note: Be sure to use backslashes to pass the quotation marks as part
of the string.

The following example uses an OS390 DB2 instance:

uncatalog dcs db DB2_390
catalog dcs db DB2_390 as Q10B parms \",, INTERRUPT ENABLED,,,,,\"
catalog database DB2_390 as DB2_390 at node NDEIEF20 authentication dcs

Setting Up Data Sources on Linux and UNIX 15-13



Configuring DB2 Connect on IBM z/OS and s/390 Platforms

15-14 Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise Edition



16

Managing Oracle Bl Repository Files

This chapter provides information about topics related to managing your repository
files, including comparing and merging repositories, equalizing objects, and querying
and managing metadata.

This chapter contains the following topics:

s Comparing Repositories

= Equalizing Objects

s Merging Repositories

= Querying and Managing Repository Metadata
= Changing the Repository Password

Comparing Repositories

This section explains how to use the Compare repositories dialog in the
Administration Tool. This feature enables you to compare all repository objects in two
different repositories.

If you are using an Oracle BI Applications repository and have customized its content,
you can use this option to compare your customized repository to a new version of the
repository received with Oracle BI Applications.

See "Merging Repositories" for more information about merging your customized
Oracle BI Applications repository with a new version of the repository.

To compare two repositories:
1. In the Administration Tool, open a repository in offline mode.

The repository that you open in this step is referred to as the current repository.
See "Using Online and Offline Repository Modes" for instructions on opening a
repository.

2. From the File menu, select Compare.

3. In the Select Original Repository dialog, select the repository you want to compare
to the open repository.

4. In the Open Offline dialog, enter the repository password and click OK.

5. Use the Compare repositories dialog to review the differences between the two
repositories. Figure 16-1 shows the Compare repositories dialog.
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Figure 16-1 Compare Repositories Dialog
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Table 16-1 lists and describes the values in the Change column.
Table 16-1 Compare Repositories Dialog: Change Column
Change Description
Created Object was created in the current repository and does not exist
in the original repository.
Deleted Object exists in the original repository but has been deleted
from the current repository.
Modified Object exists in the original repository but has been modified in
the current repository.

Table 16-2 lists and describes some of the buttons in the Compare repositories
dialog.

Table 16-2 Compare Repositories Dialog: Buttons

Button Description

Filter Opens the Comparison Filter dialog to enable you to filter the
objects that appear in the Compare repositories dialog by type
of change and type of object. You can specify what you want to
appear and what you want to be hidden. If you select Group
created and deleted objects, the tool filters out the child objects
of created and deleted objects, so that only the parent objects are
shown. By default, all items are shown.

Find Search by an object Name and Type (such as Initialization
Block).
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Table 16-2 (Cont.) Compare Repositories Dialog: Buttons

Button Description

Select Enables you to select a repository to compare with the current
repository.

Find Again Search again for the most recent Find value.

Diff Differences between the current repository and the original
repository.

Save Saves a list of the differences between the two repositories.

Stats Provides the number of changes by Change type.

View 1 Opens an object in the original repository in read-only mode.

Edit 2 Opens an object in the current repository in read /write mode.

Equalize Opens the Equalize Objects dialog so that you can model
changes to the upgrade ID of the objects. See "Equalizing
Objects" for more information.

Create Patch Creates a patch file that contains the differences between the
repositories. See "Performing Patch Merges" for more
information.

Mark Marks the object you select. Boxes appear around created and

modified objects. To remove marks, from the File menu, choose
Turn off Compare Mode.

Turning Off Compare Mode

This option enables you to remove marks applied to objects while using the Compare
Repositories and Merge Repositories options. The Turn off Compare Mode option is
only available after you have clicked Mark during the File > Compare action. If no
repository object is marked, this option is not available.

To enable the Turn off Compare Mode option:

= In the Administration Tool, select File, then select Turn off Compare Mode.

Equalizing Objects

If you have objects in two repositories that have the same name but different upgrade
IDs, you may want to treat them as the same object. To accomplish this, you can use
the equalizerpds utility to equalize the objects by giving them both the same upgrade
ID. Alternatively, you can equalize objects as part of the merge process.

You can also use the Equalize Objects dialog (available from the Compare repositories
dialog) to preview what the repository will look like after you run the equalizerpds

utility.

This section contains the following topics:

= About Equalizing Objects

= Using the Equalize Objects Dialog

= Using the equalizerpds Utility

About Equalizing Objects

Objects may need to be equalized because the Administration Tool tracks the history
of each repository object using the upgrade ID of the object. The upgrade ID is a
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unique identifier for each object. Sometimes, the upgrade ID can change because of
user actions or during merge. When this occurs, and a subsequent comparison is done,
the Administration Tool treats the new upgrade ID as a new object, and the missing
original upgrade ID as a deleted object.

For example, assume you have two identical repositories. In one repository, delete a
presentation column, then re-create it again. When you compare the two repositories
using the Compare repositories dialog, there are two entries for the presentation
column: one that shows the old object as deleted, and one that shows the new object as
created. Without using the Compare repositories dialog, it is hard to tell that this
action occurred, because the Administration Tool typically shows only the object name
and properties, not the underlying upgrade ID.

It is very useful run the equalizerpds utility on your repositories before merging them
to equalize your changes. Equalizing any opposing changes (such as a column that has
been duplicated, and then renamed) cleans up the underlying upgrade IDs and
prevents unintended renaming during the merge.

When you equalize objects, you can lose track of object renames because legitimate
object renames become different objects. In other words, intentional renames you did
in the repository might be changed to different upgrade IDs, so subsequent merges
erroneously treat the renamed object as a new object. To avoid this situation, enter the
before and after na